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Welcome Welcome

Welcome
This help provides in-depth information on how to use the RSA6100A Series Real-Time Spectrum
Analyzers. This online help contains the most complete descriptions of how to use the spectrum analyzer.
For a shorter introduction to the spectrum analyzer, refer to the RSA6100A Series Real Time Spectrum
Analyzer Quick Start User Manual.
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About Tektronix Spectrum Analyzers Your Tektronix Spectrum Analyzer

Your Tektronix Spectrum Analyzer
The RSA6100A Series will help you to easily discover design issues that other signal analyzers may miss.
The revolutionary DPX spectrum display offers an intuitive live color view of signal transients changing
over time in the frequency domain, giving you immediate confidence in the stability of your design,
or instantly displaying a fault when it occurs. This live display of transients is impossible with other
signal analyzers. Once a problem is discovered with DPX, the RSA6100A Series of Real-Time Spectrum
Analyzers (RTSA) can be set to trigger on the event, capture a continuous time record of changing RF
events and perform time-correlated analysis in all domains. You get the functionality of a wideband vector
signal analyzer, a spectrum analyzer and the unique trigger-capture-analyze capability of a Real-Time
Spectrum Analyzer — all in a single package.

Discover
DPX Minimum Event Time Capture: 24 μs (option 110), 31 μs (standard); 10.3 μs (option 110 +
option 200), 24 μs (option 200).

Trigger
Tektronix exclusive 40 MHz and 110 MHz DPX Density and Frequency Mask triggers offer easy
event-based capture of transient RF signals by triggering on any change in the frequency domain.

Capture
All signals within a 110 MHz bandwidth span are captured into memory (Option 110 only, 40 MHz
acquisition bandwidth standard).

Up to 1.7 seconds acquisition length at 110 MHz bandwidth provides complete analysis over time
without making multiple acquisitions.

Analyze
Extensive time-correlated multi-domain displays connect problems in time, frequency, phase and
amplitude for quicker understanding of cause and effect when troubleshooting.

Power measurements and signal statistics help you characterize components and systems: ACLR,
Multi-Carrier ACLR, Power vs. Time, CCDF, Phase Noise, and Spurious.

Advanced Measurement Suite (Opt. 20): Pulse measurements including rise time, pulse width, duty,
ripple, power, frequency and phase provide deep insight into pulse train behavior.

General Purpose Digital Modulation Analysis (Opt. 21): Provides vector signal analyzer functionality.
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About Tektronix Spectrum Analyzers Product Software

Product Software
The instrument includes the following software:

System Software: The product software runs on a specially configured version of Windows XP.
As with standard Windows XP installations, you can install other compatible applications. If
you need to reinstall the operating system, follow the procedure in the Restoring the Operating
System chapter in the RSA6100A Series Real-Time Spectrum Analyzers Service manual
(Tektronix part number 077-0250-XX). You can download a PDF version of the Service manual
at www.tektronix.com/manuals. Do not substitute any version of Windows that is not specifically
provided by Tektronix for use with your instrument.

Product Software: The product software is the instrument application. It provides the user interface
(UI) and all other instrument control functions. You can minimize or even exit/restart the instrument
application as your needs dictate.

Occasionally new versions of software for your instrument may become available at our Web site. Visit
www.tektronix.com/software for information.

Software and Hardware Upgrades
Tektronix may offer software or hardware upgrade kits for this instrument. Contact your local Tektronix
distributor or sales office for more information.
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About Tektronix Spectrum Analyzers > Accessories Standard Accessories

Standard Accessories
The standard accessories for the RSA6100A Series instruments are shown below. For the latest information
on available accessories, see the Tektronix Web site .

Quick Start User Manual
English - Option L0, Tektronix part number 071-1909-XX

Japanese - Option L5, Tektronix part number 071-1911-XX

Russian, Option L10, Tektronix part number 071-1912-XX

Simplified Chinese - Option L7, Tektronix part number 071-1910-XX

Applications Instructions
Tektronix part number 071-2590-XX

Product Documentation CD-ROM
The Product Documentation CD-ROM contains PDF versions of all printed manuals. The Product
Documentation CD-ROM also contains the following manuals, some of which are available only in
PDF format:

Declassification and Security Instructions manual PDF, Tektronix part number 077-0170-XX

Service Manual PDF, Tektronix part number 077-0250-XX

Programmer Manual PDF, Tektronix part number 077-0249-XX

Specifications and Performance Verification PDF, Tektronix part number 077-0251-XX

Release notes

Other related materials

NOTE. To check for updates to the instrument documentation, browse to www.tektronix.com/manuals
and search by your instrument’s model number.
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About Tektronix Spectrum Analyzers > Accessories Recommended Accessories

Important Documents Folder
Certificate of Calibration documenting NIST traceability, 2540-1 compliance, and ISO9001 registration

Power Cords
North America - Option A0, Tektronix part number 161-0104-00)

Universal Euro - Option A1, Tektronix part number 161-0104-06

United Kingdom - Option A2, Tektronix part number 161-0104-07

Australia - Option A3, Tektronix part number 161-0104-05

240V North America - Option A4, Tektronix part number 161-0104-08

Switzerland - Option A5, Tektronix part number 161-0167-00

Japan - Option A6, Tektronix part number 161-A005-00

China - Option A10, Tektronix part number 161-0306-00

India - Option A11, Tektronix part number 161-0324-00

No power cord or AC adapter - Option A99

Optical Wheel Mouse

Product Software CD

Recommended Accessories
The recommended accessories for the RSA6100A Series instruments are shown in the following table. For
the latest information on available accessories, see the Tektronix Web site .

Item Ordering part number
Additional Removable Hard Drive for use with Option 06
(Windows XP and instrument software installed)

RSA61RHD

Transit Case 016-1963-00
Rackmount Installation Kit 016-1962-00
Additional Quick Start User Manual (paper) 071-1909-XX
Additional Documents CD (all manuals in PDF format) 063-3930-XX
xxx
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About Tektronix Spectrum Analyzers > Options Options

Options
To view a listing of the software options installed on your instrument, select Help > About Your
Tektronix Real-Time Spectrum Analyzer. There is a label on the rear-panel of the instrument that
lists installed hardware options.

Options can be added to your instrument. For the latest information on available option upgrades, see
the Tektronix Web site.
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About Tektronix Spectrum Analyzers > Documentation
and Support

Documentation

Documentation
In addition to the online help, the following documents are available:

Quick Start User Manual (071-1909-XX - English). The Quick Start User Manual has information
about installing and operating your instrument. The Quick Start User Manual is also available in
Simplified Chinese (071-1910-XX), Japanese (071-1911-XX), and Russian (071-1912-XX).

Application Examples Reference (071-2590-XX). The Application Examples Reference provides
examples of specific application problems and how to solve those problems using an RSA6100A
Series spectrum analyzer.

Programmer Manual (077-0249-XX). The Programmer Manual is provided as a printable PDF file,
which is located on the Documents CD. See the Documents CD-ROM for installation information.
The Programmer manual is also available in printed form as an optional accessory.

Service Manual (077-0250-XX). The Service manual is provided as a printable PDF file, which is
located on the Documents CD. See the Documents CD-ROM for installation information. The Service
manual includes procedures to service the instrument to the module level and restore the operating
system.

Specifications and Performance Verification Technical Reference Manual (077-0251-XX). This is
a PDF-only manual that includes both the specifications and the performance verification procedure.
It is located on the Documents CD.

Declassification and Security Instructions (077-0170-XX) This document helps customers with
data security concerns to sanitize or remove memory devices from the RSA6100A Series Real-Time
Spectrum Analyzers. It is located on the Documents CD.

The most recent versions of the product documentation, in PDF format, can be downloaded from
www.tektronix.com/manuals. You can find the manuals by searching on the product name.

Other Documentation
Your instrument includes supplemental information on CD-ROM:

Documents CD (Tektronix part number 063-3930-XX)
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Orientation Front Panel Connectors

Front Panel Connectors

Item Connector Description
1 Trig Out Trigger output connector. 50 Ω, BNC, High > 2.0 V, Low < 0.4 V, (output

current 1 mA).
2 Trig In External Trigger input connector, –2.5 V to +2.5 V (user settable).
3 USB 1.1 USB 1.1 Mouse connector.
4 USB 2.0 USB 2.0 connector.
5 RF Input RF input connector 50 Ω.
xxx

Front-Panel Controls
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Orientation Front-Panel Controls

Reference Item Function Menu Equivalent
1 Media DVD-RW or removable hard disk

drive.
2 Displays Opens the Displays dialog box

enabling you to select which
displays to open.

Setup > Displays

3 Settings Opens/closes the Settings control
panel for the selected display.

Setup > Settings

4 Trigger Opens/closes the Trigger control
panel.

Setup > Trigger

5 Acquire Opens/closes the Acquire control
panel.

Setup > Acquire

6 Analysis Opens/closes the Analysis control
panel.

Setup > Analysis

7 Freq Press to adjust the measurement
frequency.

Setup > Analysis > Frequency

8 Span (Spectrum) Press to adjust the span or press
and hold to display the Freq & Span
control panel for the General Signal
Viewing displays.

9 Amplitude Opens/closes the Amplitude control
panel.

Setup > Amplitude

10 BW (Spectrum) Press to adjust the bandwidth or
press and hold to display the BW
control panel for the General Signal
Viewing displays.

xxx
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Orientation Front-Panel Controls

Reference Item Function Menu Equivalent
11 Tab Moves the cursor to the next entry

in the dialog box or control panel.
Same as pressing the Tab key on an
external keyboard.

12 Run Starts and stops acquisitions. Run > Start Run > Stop
13 Peak (Markers

section)
Moves the active marker to the
maximum peak of the trace in the
selected display. If markers are
turned off, the marker reference (MR)
will appear at the maximum peak.

Markers > Peak

14 Select (Markers
section)

Selects the next marker. If markers
are turned off, the MR marker (marker
reference) will appear.

15 Define (Markers
section)

Opens the Markers control panel.
If markers are turned off, the MR
marker (reference) will appear.

16 Esc Exits a dialog box without saving
changes: the same as Esc on an
external keyboard.

17 Control knob Changes values in numeric and list
controls. Pressing the knob (clicking
it) is the same as pressing the Enter
key on a keyboard.

18 Arrow keys Move the Markers. The Up arrow
moves the selected marker to the
next highest peak. The down arrow
moves the selected marker to the
next lower peak value. The right and
left arrows move the selected marker
to the next peak.

xxx

Reference Item Function Menu Equivalent
19 Keypad Enters values in numeric controls.
20 Enter Completes data entry in controls.

Same as pressing the Enter key on
an external keyboard.

xxx
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Orientation Touch Screen

Reference Item Function Menu Equivalent
21 Recall Opens the Recall dialog box. File > Recall
22 Save Opens the Save As dialog box. File > Save As
23 Touch Screen Off Turns the touch screen on and off. It

is off when lighted.
24 Help Displays the online help. Help > Online Manual
25 Print Displays the Print dialog box. File > Print
26 Preset Returns the instrument to the default

or preset values.
Setup > Preset

xxx

Touch Screen
You can use touch to control the instrument in addition to the front-panel controls, mouse, or extended
keyboard. Generally, touch can be used anywhere that click is mentioned in this online help.

To disable the touch screen, push the front-panel Touch Screen Off button. When the touch screen is off,
the button is lighted. You can still access the on-screen controls with a mouse or keyboard.

You can adjust the touch screen operation to your personal preferences. To adjust the touch screen settings,
from Windows, select Start > Control Panel > Touch Screen Calibrator.

NOTE. If the instrument is powered on in Windows Safe Mode, the touch screen is inoperative. You will
need to use a mouse or keyboard to restore normal operation.

Touch-Screen Actions
You can use the touch screen to change marker settings and how waveforms are displayed by using the
Touch-screen Actions menu.
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Orientation Touch-Screen Actions

To use the Touch-screen Actions menu, touch the display in a graph area and hold for one second, then
remove your finger. You can also use a mouse to display the Touch-screen Action menu by clicking
the right mouse button.
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Orientation Touch-Screen Actions

Icon Menu Description
Select Selects markers and adjusts their position.

Span Zoom Zooms the graph area about the selected point. Touch the graph
display at a point of interest and drag to increase or decrease the
span about the point of interest. Span Zoom adjusts the span
control and can affect the acquisition bandwidth.

CF Pan Adjusts the Center Frequency according to horizontal movement.

Zoom Adjusts horizontal and vertical scale of the graph. The first
direction with enough movement becomes the primary scale of
adjustment. Adjustment in the secondary direction does not occur
until a threshold of 30 pixels of movement is crossed.
Dragging to the left or down zooms out and displays a smaller
waveform (increases the scale value). Dragging to the right or up
zooms in and displays a larger waveform (decreases the scale
value).

Pan Adjusts horizontal and vertical position of the waveform. The first
direction with enough movement becomes the primary direction of
movement. Movement in the secondary direction does not occur
until a threshold of 30 pixels of movement is crossed.

- Reset Scale Returns the horizontal and vertical scale and position settings
to their default values.

- Marker to peak Moves the selected marker to the highest peak. If no marker is
turned on, this control automatically adds a marker.

- Next Peak Moves the selected marker to the next peak. Choices are Next
left, Next right, Next lower (absolute), and Next higher (absolute).

- Add marker Defines a new marker located at the horizontal center of the graph.
- Delete marker Removes the last added marker.
- All markers off Removes all markers.

Trigger On This Use to visually define trigger parameters in the DPX Spectrum
display.

xxx

Touch-Screen Menu for Spurious Display
The Touch-screen actions menu in the Spurious display has some minor changes compared to the standard
version used in other displays.
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Orientation Elements of the Display

Icon Menu Description
- Single-range Changes the current multi-range display to a single range display.

The displayed range is the range in which you display the
touchscreen-actions menu. Selecting Single-range from the menu
is equivalent to selecting Single on the Settings > Parameters tab.

- Multi-range Changes the current single-range display to a multi-range display.
Selecting Multi-range from the menu is equivalent to selecting
Multi on the Settings > Parameters tab.

- Marker -> Sel Spur Moves the selected marker to the selected spur.
xxx

Elements of the Display
The main areas of the application window are shown in the following figure.

14 RSA6100A Series Real-Time Spectrum Analyzers Help



Orientation Elements of the Display

Specific elements of the display are shown in the following figure.
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Orientation Elements of the Display
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Orientation Elements of the Display

Ref
number

Setting Description

1 Displays Opens the Select Displays dialog box so that you can select measurement
displays.

2 Markers Opens or closes the Marker toolbar at the bottom of the window.
3 Settings Opens the Settings control panel for the selected display. Each display has

its own control panel.
4 Trigger Opens the Trigger control panel so that you can define the trigger settings.
5 Acquire Opens the Acquire control panel so that you can define the acquisition settings.
6 Analysis Opens the Analysis control panel so that you can define the analysis settings

such as frequency, analysis time, and units.
7 Frequency Displays the frequency at which measurements are made. For spectrum

displays, this is called “Center Frequency”. To change the value, click the
text and use the front panel knob to dial in a frequency. You can also enter
a frequency with the front panel keypad or use the front panel up and down
buttons.

8 Reference Level Displays the reference level. To change the value, click the text and enter a
number from the keypad or use the front panel up and down buttons.

9 Amplitude Opens the Amplitude control panel so that you can define the Reference Level,
configure internal attenuation, and enable/disable the (optional) Preamplifier.

10 Replay Runs a new measurement cycle on the last acquisition data record using any
new settings.

11 Run Starts and stops data acquisitions. When the instrument is acquiring data, the
button label has green lettering. When stopped, the label has black lettering.
You can specify the run conditions in the Run menu. For example, if you
select Single Sequence in the Run menu, when you click the Run button,
the instrument will run a single measurement cycle and stop. If you select
Continuous, the instrument will run continuously until you stop the acquisitions.

12 Check mark indicator The check mark indicator in the upper, left-hand corner of the display indicates
the display for which the acquisition hardware is optimized.

xxx
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Orientation Rear-Panel Connectors

Rear-Panel Connectors

Item Description
1 AC Input, main power connector
2 GPIB
3 IF Output (optional)
4,5 Real Time IQ Output (optional)
6 +28 V DC Output, switched
7 Headphone, audio output connector
8 Trig2 ln
9 COM 2, serial port for connecting peripherals
10 VGA external monitor output
11 PS2 keyboard input
12 USB2.0 ports for mouse and other peripherals (printers, external hard disks)
13 TekLink - reserved for future use
14 Ref Out, reference frequency output
15 Ref In, reference frequency input
16 Ethernet network connector
xxx

Setting Up Network Connections
Because the instrument is based on Windows XP, you configure network connections for the instrument
the same way you would for any PC based on Windows XP. See Help and Support in the Windows Start
menu to access the Windows Help System for information on setting up network connections.
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Operating Your Instrument Restoring Default Settings

Restoring Default Settings
To restore the instrument to its factory default settings:

Select File > Preset to return the analyzer to its default settings.

Preset resets all settings and clears all acquisition data. Settings and acquisition data that have not been
saved will be lost.

Running Alignments
Alignments are adjustment procedures. Alignments are run by the instrument using internal reference
signals and measurements and do not require any external equipment or connections.

There are two settings for Alignments:

Automatically align as needed

Run alignments only when the Align Now button is pressed

If Automatically align as needed is selected, alignments run whenever the spectrum analyzer detects
a sufficient change in ambient conditions to warrant an alignment.

If Run alignments only when "Align Now" button is pressed is selected, the spectrum analyzer never
runs an alignment unless you manually initiate an alignment using the Align Now button.

NOTE. There are a few critical adjustments that must run occasionally even if Automatically align is
not enabled.

Alignment Status
When the spectrum analyzer needs to run an alignment, it displays a message on screen. If no message is
displayed, you can assume that the spectrum analyzer is properly aligned.

NOTE. If you must use the instrument before it has completed its 20-minute warm-up period, you should
perform an alignment to ensure accurate measurements.

Initiating an Alignment
1. Select Setup > Alignments.

2. Select the Align Now button.
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Operating Your Instrument Application Presets

The spectrum analyzer will run an alignment procedure. Status messages are displayed while the
alignment procedure is running. If the instrument fails the alignment procedure, an error message will be
displayed. If the instrument fails an alignment, run Diagnostics (Tools > Diagnostics) to see if you can
determine why the alignment failed.

NOTE. While an alignment is running, both the IF and IQ outputs are disabled.

Alignments during warm-up. During the 20-minute warm-up period, the spectrum analyzer will use the
alignment data generated during the previous use of the instrument as it warms to operating temperature
(if Auto mode is selected). During the specified period for warm-up, the instrument performance is not
warranted.

Alignments during normal operation. Once the spectrum analyzer reaches operating temperature, an
alignment will be run. If an alignment becomes necessary during a measurement cycle (if Auto mode is
selected), the measurement is aborted and an alignment procedure is run. Once an alignment procedure is
completed, the measurement cycle restarts.

NOTE. The first time the instrument runs after a software upgrade (or reinstall), the instrument will
perform a full alignment after the 20–minute warm-up period. This alignment cannot be aborted and it
occurs even if alignments are set to run only when manually initiated.

Alignments Are Not Calibrations
Alignments are adjustment procedures run by the instrument using internal reference signals and
measurements. Calibrations can only be performed at a Tektronix service center and require the use of
traceable test equipment (signal sources and measuring equipment) to verify the performance of the
instrument.

Application Presets
Menu Bar: File > Application Presets

The spectrum analyzer includes a set of configuration files that are tailored to specific applications. These
configuration files, referred to as Application Presets, open selected displays and load settings that are
optimized to address specific application requirements. You can add to the default application presets by
creating your own application presets. See Creating Application Presets (see page 24). You access the
application presets through the Application Presets menu item.

To load an application preset:

1. Select File > Application Presets. This opens the Applications Presets dialog window.

2. Select the application preset that suits your needs.

3. Click OK to recall the application preset.
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Operating Your Instrument Application Presets

Application Preset Description
Modulation Analysis The Modulation Analysis setup application preset provides you with the most common

displays used during modulation analysis.
Pulse Analysis The Pulse Analysis application preset provides you with the most common displays

used during pulse analysis, and makes changes to the default parameters to settings
better optimized for pulsed signal analysis. Option 20 is required to use the pulse
measurements applications preset.

Spectrum Analyzer The Spectrum Analysis application presets provide you with the settings commonly used
for general purpose spectrum analysis.

Time-Frequency Analysis The Time-Frequency preset configures the instrument with settings suited to analyzing
signal behavior over time.

xxx

Modulation Analysis
The Modulation Analysis application preset opens the following displays:

DPX Spectrum Display: Shows you a continuous spectrum monitoring of the specified carrier
frequency.

Signal Quality: Shows a summary of modulation quality measurements (EVM, rho, Magnitude
Error, Phase Error, and others).

Constellation: Shows the I and Q information of the signal analyzed in an I vs. Q format.

Symbol Table: Shows the demodulated symbols of the signal.

To use the Modulation Analysis preset:

1. Select File > Application Presets >Modulation Analysis. Click OK.

2. Set the measurement frequency using the front-panel knob or keypad. Your signal should appear in
the DPX spectrum display.

3. Set the reference level so that the peak of your signal is about 10 dB below the top of the DPX
spectrum display.

4. Set the modulation parameters for your signal. This includes the Modulation Type, Symbol Rate,
Measurement Filter, Reference Filter and Filter Parameter. All of these settings are accessed by
pressing the Settings button.

For most modulated signals, the Modulation Analysis application preset should present a stable display of
modulation quality. Additional displays can be added by using the Displays button, and other settings can
be modified to better align with your signal requirements.

Pulse Analysis
The Pulse Analysis application preset opens the following displays:

DPX Spectrum: The DPX spectrum display is opened with the maximum available span.

Time Overview: Shows amplitude vs. time over the analysis period.
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Operating Your Instrument Application Presets

Pulse Trace: Shows the trace of the selected pulse and a readout of the selected measurement from
the pulse table.

Pulse Measurement Table: This shows a full report for the user-selected pulse measurements.

You can make a selected pulse and measurement appear in the Pulse Trace display by highlighting it in the
Pulse Measurement Table. Key pulse-related parameters that are set by the Pulse Analysis application
preset are:

Measurement Filter: No Filter.

Measurement Bandwidth: This is set to the maximum real-time bandwidth of the instrument
(40 MHz in a base instrument or 110 MHz with instruments with Option 110). Note: The label
on the “Measurement Bandwidth” setting is just “Bandwidth”. Like the main instrument Preset
command and the other application presets, the Pulse Analysis application preset also sets most other
instrument controls to default values.

Analysis Period: This is set to 2 ms to ensure a good probability of catching several pulses for
typical signals.

To use the Pulse Analysis preset:

1. Select File > Application Presets > Pulse Analysis. Click OK.

2. Set the Center Frequency control to the carrier frequency of your pulsed signal.

3. Set the Reference Level to place the peak of the pulse signal approximately 0-10 dB down from
the top of the Time Overview display.

You may need to trigger on the signal to get a more stable display. This is set up in the Trigger control
panel. (“Trig” button). Using the Power trigger type with the RF Input source works well for many
pulsed signals.

4. Set the Analysis Period to cover the number of pulses in your signal that you want to analyze. To do
this, click in the data entry field of the Time Overview window and set the analysis length as needed.

Spectrum Analysis
The Spectrum Analysis application preset opens a Spectrum display and sets several parameters. There are
two presets are available for spectrum analysis, as follows.

Spectrum Analysis (0.1- 6.2 GHz): This sets the frequency range to 0.1 to 6.2 GHz, and sets
RF/IF optimization toMinimize Sweep Time. This application preset is configured for use with the
RSA6106A, but it can be also used with the RSA6114A.

Spectrum Analysis (0.1-14 GHz): This sets the frequency range to 0.1 to 14 GHz, and sets the
RF/IF optimization toMinimize Sweep Time. This application preset is configured for use with the
RSA6114A. If you use this preset on the RSA6106A, you will have to manually adjust the center
frequency and span. If you have Option 110 installed in your instrument, usingMinimize Sweep Time
will improve the screen update rate for wide spans approximately 3X compared to the auto settings. If
Option 110 is not installed, no improvement in sweep speed is gained by minimizing sweep time.

To use the either of the spectrum analysis application presets:
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1. Select File > Application Presets > Spectrum Analysis (0.1-14 GHz) or Spectrum Analysis
(0.1-6.2 GHz) as appropriate. Click OK.

2. Set the measurement frequency using the front-panel knob or keypad.

3. Adjust the span to show the necessary detail.

Time-Frequency Analysis
The Time-Frequency Analysis application preset opens the following displays:

Time Overview: Shows a time-domain view of the analysis time ‘window’.

Spectrogram: Shows a three-dimensional view of the signal where the X-axis represents frequency,
the Y-axis represents time, and color represents amplitude.

Frequency vs. Time: This display’s graph plots changes in frequency over time and allows you to
make marker measurements of settling times, frequency hops, and other frequency transients.

Spectrum: Shows a spectrum view of the signal. The only trace showing in the Spectrum graph
after selecting the Time-Frequency Analysis preset is the Spectrogram trace. This is the trace from
the Spectrogram display that is selected by the active marker. Stop acquisitions with the Run button
because its easier to work with stable results. In the Spectrogram display, move a marker up or down
to see the spectrum trace at various points in time.

The analysis period is set to 5 ms.

To use the Time-Frequency application preset:

1. Select File > Application Presets > Time-Frequency Analysis. Click OK.

2. When the preset’s displays and settings have all been recalled and acquisitions are running, adjust the
center frequency and span to capture the signal of interest.

3. Set the Reference Level to place the peak of the signal approximately 0-10 dB down from the top of
the Spectrum graph.

4. If the signal is transient in nature, you might need to set a trigger to capture it. For more information
on triggering in the time and frequency domain, see Triggering (see page 316)

When the signal has been captured, the spectrogram shows an overview of frequency and amplitude
changes over time. To see frequency transients in greater detail, use the Frequency vs. Time display.

The Time-Frequency Analysis preset sets the analysis period to 5 ms. The Spectrum Span is 40 MHz. The
RBW automatically selected for this Span is 300 kHz. For a 300 kHz RBW, the amount of data needed
for a single spectrum transform is 7.46 μs. A 5 ms Analysis Length yields 671 individual spectrum
transforms, each one forming one trace for the Spectrogram to display as horizontal colored lines. This
preset scales the Spectrogram time axis (vertical axis) to -2, which means that the Spectrogram has done
two levels of time compression, resulting in one visible line for each four transforms. This results in 167
lines in the Spectrogram for each acquisition, each covering 29.84 μs.
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Creating Application Presets
You can add your own application presets to the list that appears in the Application Presets dialog box.
Create a Setup file and save a copy of it to C:\RSA6100A Files\Application Presets. The name you give
the file will be shown in the Application Presets list along with the sets provided by Tektronix. For
instructions on how to save a Setup file, see Saving Data (see page 333).

If the Tektronix application presets files are accidentally deleted, you can restore them by reinstalling the
RSA6100A software. The software installation process will not remove user files you have placed in the
Application Presets directory.

Setting Options
Menu Bar: Tools > Options

There are several settings you can change that are not related to measurement functions. The Option
settings control panel is used to change these settings.

Settings tab Description
Save and Export Use this tab to specify whether or not save files are named automatically and what

information is saved in acquisition data files.
GPIB Use this tab to set the primary GPIB address for the instrument.
Security Selecting the Hide Sensitive readouts check box causes the instrument to replace

measurement readouts with a string of asterisks.
Colors Use this tab to select different color schemes for the measurement graphs.
xxx

Save and Export
The Save and Export tab allows you to specify whether or not files are saved with an automatically
generated name, and how much data is saved in an acquisition data file.
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All Files — The Automatically increment filename/number function can automatically name saved
files by appending a number to a base file name. Use this tab to enable/disable automatic naming of
files. For example, if Automatically Increment Filename Number is disabled, when you select Save
from the File menu, you will have to enter a name for the file.

Acquisition data files — This setting specifies whether saved data files include the entire acquisition
record or only the data for the analysis length (a subset of the acquisition record).

TIQ acquisition data files — Specifies which data records to save. You can choose from the following:

Current acquisition: Saves the current acquisition.

Current frame: If Fast Frame is enabled, saves only the current frame. The current frame is the
one most recently analyzed.

Selected frames: If Fast Frame is enabled, saves the specified frames.

All in history: Saves all acquisition records in the history.

Colors
The Color scheme setting provides three color schemes for the measurement graphs. The color scheme
setting does not change the overall instrument application or Windows color scheme.

Thunderstorm — This scheme displays graphs in shades of blue. This provides a less vibrant color
scheme than the default setting.

Blizzard — This scheme displays graphs with a white background to save ink when printing.

Classic — The default setting. This scheme displays the graph area with a black background.
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Selecting Displays
Menu Bar: Setup > Displays

Application Toolbar: Displays

Use the Select Displays dialog to choose the displays that appear on the screen.

To select displays:

1. Press the Displays button or select Setup > Displays.

2. Select one of the choices under Folders. The folder chosen determines the choices available in
Available displays.

3. Double-click the desired display in the Available displays box or select the desired display and
click Add.

4. Click OK.

Interactions Between Displays
Different displays can require different settings, for example acquisition bandwidth, analysis length, or
resolution bandwidth, to achieve optimum results. The instrument automatically adjusts some settings
to optimize them for the selected display. The check mark indicator in the upper, left-hand corner of the
display indicates the display for which the acquisition hardware is optimized. Depending on instrument
settings, some displays might stop displaying results if they are not the selected display.
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Available Measurements
The automatic measurements available include RF power measurements, analog modulation
measurements, digital modulation measurements, and pulse measurements.

Power Measurements

Measurement Description
Channel Power The total RF power in the selected channel (located in the ACPR display).
Adjacent Channel Power Ratio Measure of the signal power leaking from the main channel into adjacent channels.
Multi-Carrier Power Ratio The ratio of the signal power in the reference channel or group of channels to the power

in adjacent channels.
Peak/Avg Ratio Ratio of the peak power in the transmitted signal to the average power in the transmitted

signal (located in the CCDF display).
CCDF The Complementary Cumulative Distribution Function (CCDF). CCDF shows how much

time a signal spends at or above a given power level relative to the average power of
a measured signal.

xxx
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Digital Modulation Measurements

Measurements for all modulation types except nFSK, C4FM, OQPSK and SOQPSK
Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

xxx
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Measurements for OQPSK and SOQPSK modulation types
Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Offset EVM Offset EVM is like EVM except for a difference in the time alignment of the I and Q
samples. For EVM, I and Q samples are collected at the same time, for every symbol
decision point (twice the symbol rate for offset modulations). For Offset EVM, the I and Q
symbol decision points are time-aligned before collecting the I and Q samples. In this
case, one I and one Q sample is collected for each symbol (half as many samples as the
same number of symbols for (non-offset) EVM.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

xxx
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Measurements for nFSK modulation types
Measurement Description
Peak FSK err Peak value of the frequency deviation error at the symbol point.
RMS FSK Err RMS value of the frequency deviation error at the symbol point.
Peak Mag Err The Peak magnitude difference between the measured signal and the reference signal

magnitude.
RMS Mag Err The RMS magnitude difference between the measured signal and the reference signal

magnitude.
Freq Error The frequency difference between the measured carrier frequency of the signal and the

user-selected center frequency of the instrument.
Freq Deviation Frequency distance from the center frequency at the symbol point.
Symbol Rate Error This compares the user-entered symbol rate to the instrument calculated symbol rate of

the analyzed signal.
Symbol Rate When in Auto-symbol rate, the instrument calculates the symbol rate of the signal and

the instrument calculates the error between the user entered value and the instrument
calculated value.

xxx

Measurements for C4FM modulation type
Measurement Description
RMS Error Magnitude RMS value of the frequency deviation error at the symbol point.
Carrier Frequency Error Frequency difference between averaged signal frequency and the center frequency.
Deviation Frequency distance from the center frequency at the symbol point.
Length Number of symbols in the analysis area.
xxx

Analog Modulation Measurements

Measurements for AM modulation
Measurement Description
+AM Positive peak AM value.
-AM Negative peak AM value.
Total AM Total AM value, which is equal to the peak-peak AM value divided by 2.
xxx
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Measurements for FM modulation
Measurement Description
+Pk Positive peak frequency deviation.
–Pk Negative peak frequency deviation.
RMS RMS value of the frequency deviation.
Pk-Pk/2 Peak-to-peak frequency deviation divided by 2.
Pk-Pk Peak-to-peak frequency deviation.
xxx

Measurements for PM modulation
Measurement Description
+Pk Positive peak phase deviation.
–Pk Negative peak phase deviation.
RMS RMS value of the phase deviation.
Pk-Pk Peak-to-peak phase deviation.
xxx

Pulse Measurements

Measurement Description
Average ON Power The average power transmitted during pulse on.
Peak Power Maximum power during pulse on.
Average Transmitted Power The average power transmitted, including both the time the pulse is on and the time

it is off, and all transition times.
Pulse Width The time from the rising edge to the falling edge at the –3 dB / –6 dB level (50%) of the

user selected 100% level. Level is user selectable for Volts or Watts.
Rise Time The time required for a signal to rise from 10% to 90% (or 20% to 80%) of the user

selected 100% level.
Fall Time The time required for a signal to fall from 90% to 10% (or 80% to 20%) of the user

selected 100% level.
Repetition Interval The time from a pulse rising edge to the next pulse rising edge.
Repetition Rate The inverse of repetition interval.
Duty Factor (%) The ratio of the width to the pulse period, expressed as a percentage.
Duty Factor (Ratio) The ratio of the pulse width to the pulse period.
Ripple Ripple is the peak-to-peak ripple on the pulse top. It does not include any preshoot,

overshoot, or undershoot. By default, the first 25% and the last 25% of the pulse top is
excluded from this measurement to eliminate distortions caused by these portions of
the pulse.
If the Amplitude units selected in the Amplitude panel (affects all amplitude measurements
for the analyzer) are linear, the Ripple results will be in %Volts. For log units, the Ripple
results will be in %Watts. The default for the general Units control is dBm, so the Ripple
results default is %Watts.
See also Ripple (see page 391).
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Measurement Description
Ripple dB The Ripple measurement expressed in dB.
Droop Droop is the power difference between the beginning and the end of the pulse On time. A

straight-line best fit is used to represent the top of the pulse. The result is a percentage
referenced to the Average ON Power.

Droop dB The Droop measurement expressed in dB.
Overshoot The amount by which the signal exceeds the 100% level on the pulse rising edge. Units

are %Watts or %Volts.
Overshoot dB The Overshoot measurement expressed in dB.
Pulse-Pulse Phase Difference The phase difference between the selected pulse and the first pulse in the analysis

window. The instantaneous phase is measured at a user-adjustable time following the
rising edge of each pulse.

Pulse-Pulse Freq Difference The difference between the frequency of the current pulse and frequency of the previous
pulse. The instantaneous frequency is measured at a user-adjustable time following the
rising edge of each pulse.

RMS Freq Error The RMS Frequency Error measurement is the RMS average of the Freq Error vs. Time
trace, computed over the Measurement Time.

Max Freq Error The maximum frequency error is the difference between the measured carrier frequency
of the signal and the user-selected center frequency of the analyzer.

RMS Phase Error The RMS Phase Error measurement is the RMS average of the Phase vs Time trace,
computed over the Measurement Time.

Max Phase Error The phase is measured at each point during the pulse’s ON time. The phase error for
each point is the difference between the measured phase value and the calculated ideal
phase value. After the phase error is calculated for all points in the acquisition record,
the largest error in the positive direction and the largest in the negative direction are
determined. Whichever of these two values has the greater absolute value is designated
the Max Phase Error.

Freq Deviation The Frequency Deviation measurement is the difference between the maximum and
minimum measured values of the signal frequency during the Measurement Time.

Phase Deviation The Phase Deviation is the difference between the maximum and minimum Phase values
measured during the ON time of a pulse.

Impulse Response Amplitude The difference in dB between the levels of the main lobe and highest side lobe.
Impulse Response Time The difference in time between the main lobe and highest side lobe.
Time This is the time in seconds relative to the time reference point in the first acquisition

record in the data set.
xxx
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Overview
The displays in the General Signal Viewing folder (Displays > Folders > General Signal Viewing) are:

Amplitude vs Time

DPX Spectrum

Frequency vs Time

Phase vs Time

RF I & Q vs Time

Spectrogram

Spectrum

Time Overview

These displays provide extensive time-correlated multi-domain views that connect problems in time,
frequency, phase and amplitude for enabling you to more quickly understand cause and effect when
troubleshooting.
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DPX Primer
With the DPX Spectrum display you can detect and accurately measure transients as brief as 10.3 µs. The
instrument computes up to 292,000 spectrums per second (with Option 200; up to 48,833 without Option
200) of the digitized input signal. Then it displays all these spectrums as a color-graded bitmap that reveals
low-amplitude signals beneath stronger signals sharing the same frequency at different times.

The strong signal in the DPX spectrum graph, shown in Figure 1, is a repeating pulse at a fixed frequency.
There is also a lower-power CW signal that steps very quickly through the same span. During the pulse’s
on time, the power of the two signals is additive, resulting in nearly undetectable differences in the pulse
envelope shape. But during the time the pulse is off, the sweeping signal is detected and shown in its true
form. Both signals are visible in the bitmap because at least one full cycle of their activities occurs
within a single DPX display update.

Figure 1

Compare the display of a traditional swept spectrum analyzer (Figure 2) and that of a real-time spectrum
analyzer with a DPX spectrum display (Figure 3). The signal captured is a typical WLAN interchange
between a nearby PC and a more-distant network access point (AP). The laptop signal is nearly 30 dB
stronger than the AP’s signal because it is closer to the measuring antenna.
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Figure 2

Figure 3

The traditional swept spectrum analyzer display, Figure 2, uses line traces that can show only one level for
each frequency point, representing the largest, the smallest or the average power. After many sweeps, the
Max Hold trace shows a rough envelope of the stronger laptop signal. +Peak detection was selected for the
other trace in an attempt to capture the weaker but more frequent AP signal, but the bursts are very brief,
so the likelihood of seeing one in any particular sweep is small. It will also take a long time to statistically
capture the entire spectrum of a bursted signal due to the architecture of the swept spectrum analysis.

The DPX spectrum display, Figure 3, reveals much more insight on the same signal. Since it is a
bitmap image instead of a line trace, you can distinguish many different signals occurring within each
update period and/or different version of the same signal varying over time. The heavy band running
straight across the lower third of the graph is the noise background when neither the laptop nor the AP
is transmitting. The red lump of energy in the middle is the ON shape of the AP signal. Finally, the
more delicate spectrum above the others is the laptop transmissions. In the color scheme used for this
demonstration (“Temperature”), the hot red color indicates a signal that is much more frequent than
signals shown in cooler colors. The laptop signal, in yellow, green and blue, has higher amplitude but
doesn’t occur nearly as often as the AP transmissions because the laptop was downloading a file when
this screen capture was taken.
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How DPX Works
This section explains how DPX spectrum displays are created. The input RF signal is conditioned and
down-converted as usual for a spectrum analyzer, then digitized. The digitized data is sent through an
FPGA that computes very fast spectral transforms, and the resulting frequency-domain waveforms are
rasterized to create the bitmaps.

The DPX bitmap that you see on screen is composed of pixels representing x, y, and z values for frequency,
amplitude, and hit count (instruments with Option 200 provide Density as the z-axis value in place of hit
count). A multi-stage process, shown in Figures 4a - 4d, creates this bitmap, starting with analog-to-digital
conversion of the input signal.

Simplified Flow of Multi-stage Processing from RF Input Through to Spectrum Processing:

Figure 4a. RF signals are downconverted and sampled into a continuous data stream.

Figure 4b. Samples are segmented into data records for FFT processing based on the selected resolution bandwidth.

Figure 4c. Data records are processed in the DPX transform engine

Figure 4d. Overlapping the FFTs shortens the minimum event duration required for 100% probability of intercept.

Collecting spectral data. Sampling and digitization is continuous. The digitized data stream is chopped
into data records whose length is based on the desired resolution bandwidth (RBW). An additional
requirement is placed on FFT length by the desired number of points in a trace (Option 200 only). Table 1
shows this relationship and the FFT length is reported in the display if desired. Then the DPX transform
engine performs a discrete Fourier transform on each record, continually producing spectral waveforms.

RF signals are downconverted and sampled into a continuous data stream.

Samples are segmented into data records for FFT processing based on the selected resolution
bandwidth.
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Data records are processed in the DPX transform engine.

Overlapped processing is used to improve minimum event duration performance.

Table 1: Minimum FFT length versus trace length (independent of span and RBW), Option 200
Trace length (points) Minimum FFT length
801 1,024
2,401 4,096
4,001 8,192
10,401 16,384
xxx

As long as spectral transforms are performed faster than the acquisition data records arrive, the transforms
can overlap each other in time, so no events are missed in between. Minimum event length for guaranteed
capture depends on the length of the data records being transformed. An event must last through two
consecutive data records in order for its amplitude to be accurately measured. Shorter events are detected
and visible on screen, but may be attenuated. The DPX Spectrum RBW setting determines the data
record length; narrow RBW filters have a longer time constant than wide RBW filters. This longer time
constant requires longer FFTs, reducing the transform rate. Additional detail on minimum signal duration
is provided in Guaranteed Capture of Fast Events (see page 43).

The spectral waveforms are plotted onto a grid of counting cells called the “bitmap database”. The number
held by each database cell is the z-axis count. For simplicity, the small example grid used here in Figure 6
is 11x10, so our spectral waveforms will each contain 11 points. A waveform contains one (y) amplitude
value for each (x) frequency. As waveforms are plotted to the grid, the cells increment their values each
time they receive a waveform point.

Figure 5. Example 3-D Bitmap Database after 1 (left) and 9 (right) updates. Note that each column contains
the same total number of “hits”.

The grid on the left shows what the database cells might contain after a single spectrum is plotted into it.
Blank cells contain the value zero, meaning that no points from a spectrum have fallen into them yet.

The grid on the right shows values that our simplified database might contain after an additional eight
spectral transforms have been performed and their results stored in the cells. One of the nine spectrums
happened to be computed as a time during which the signal was absent, as you can see by the string of “1”
occurrence counts at the noise floor.
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Frame updates. The maximum rate for performing the variable-length frequency transforms that produce
those waveforms can be greater than 292,000 per second. Measurement settings that slow this transform
rate include narrowing the RBW and increasing the number of points for the line traces available in the
DPX Spectrum display along with the bitmap. Even at their slowest, spectral transforms are performed
orders of magnitude faster than a physical display can respond, and also too fast for humans to see, so
there’s no need to update the screen or measurements at this rate. Instead, the grid collects thousands of
waveforms into “frames”, each covering about 50 milliseconds (ms). A 50 ms frame contains the counts
from up to 14,600 waveforms. After each frame’s waveforms have been mapped into the grid, the cell
occurrence counts are converted to colors and written to the DPX bitmap, resulting in a bitmap update
rate of around 20 per second.

Frame length sets the time resolution for DPX measurements. If the bitmap shows that a -10 dBm
signal at 72.3 MHz was present for 10% of one frame’s duration (5 ms out of 50 ms), it isn’t possible to
determine just from the DPX display whether the actual signal contained a single 5 ms pulse, one hundred
50 microsecond (μs) pulses, or something in between. For this information, you need to examine the
spectral details of the signal or use another display with finer time resolution, such as Frequency vs.
Time or Amplitude vs. Time.

Converting occurrence counts to color. About 20 times per second, the grid values are transferred to the
next process step, in which the z-axis values are mapped to pixel colors in the visible bitmap, turning
data into information (Figure 6). In this example, warmer colors (red, orange, yellow) indicate more
occurrences. The color palette is user-selectable, but for now we will assume the default “temperature”
palette.

Number of Occurrences Color
0 black
1 blue
2 light blue
3 cyan
4 green blue
5 green
6 yellow
7 orange
8 red orange
9 red

Figure 6. Example Color-mapping algorithm
xxx

The result of coloring the database cells, Figure 7, according to the number of times they were written into
by the nine spectrums, one per pixel on the screen, creates the DPX displays.
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Figure 7. Color-coded low-resolution example (left) and a real DPX display (right).

In addition to the choice of palette, there are z-axis scaling adjustments for Maximum, Minimum, and
Curve. Maximum sets the occurrence value that will be mapped to the highest color in the palette.
Minimum sets the occurrence value for the lowest color. In the “temperature” palette, the highest color is
deep red and the lowest is dark blue. Occurrence values less than the selected Minimum are represented
with black pixels, while pixels that exceed the selected Maximum are red in hue but somewhat transparent.
Values between Maximum and Minimum are represented by the other colors of the palette.

Adjusting the Minimum above the black default allows you to concentrate most of your color resolution
over a small range of medium or higher occurrence rates to visually discriminate between different signals
that have nearly equal probability values.

To see why adjustable color scaling is useful compare Figures 8 and 9. On the Scale tab, the Max control is
set to 100% in Figure 8. The range of colors now covers the full z-axis range of densities from 0 to 100%.
The signals used to create this bitmap are fairly diffused in both frequency and amplitude, so most pixels
have low occurrence counts or density values and the upper half of the color palette is unused.

Figure 8. DPX spectrum bitmap with default color scale settings.

RSA6100A Series Real-Time Spectrum Analyzers Help 39



General Signal Viewing > DPX Spectrum DPX Primer

When the Auto Color button is selected, the Maximum control’s value is set to the highest pixel value
in the current bitmap, shown in Figure 9. Now none of the available colors remain unused. The entire
palette is mapped to the occurrence values present at the time the button is selected, providing better
visual resolution for low densities. Selecting the Autoscale button in the DPX display scales all three
axes based on current results.

Figure 9. The Auto Color function optimizes the color scale settings.

Color Mapping Curves
The mapping between z-axis values and color does not have to be linear. The Curve control lets you
choose the shape of the mapping equation. A Curve setting of 1 selects the straight-line relationship.
Higher Curve numbers pull the curve upwards and to the left, concentrating color resolution on lower
densities. Settings less than 1 invert the curve, moving the focus of the color range towards higher density
values. Figure 10 shows the mapping curves.

Figure 10. Representative color mapping curves for the “Temperature” palette.

Using the same signal shown in Figures 8 and 9, the impact of the Curve control can be observed. With
the Curve control set to 1 in the Scale tab, shown in Figure 11, the mapping between color and density is
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linear, so the colors spread evenly across the full density range. The color distribution is visible in the
colored palette illustration to the left of the Curve control in the Settings panel.

Figure 11. Over a narrow Signal Density range, the color curve is set to 1.

When the Curve control is set to 0.5, as shown in Figure 12, the best color resolution is in the upper half of
the density range, and only the dark blues are assigned to densities below 50%. Note the difference in
the palette illustration.

Figure 12. Adjusting to values less than 1, increases the contrast for viewing events in the top half of the selected
density range.

In Figure 13, the Curve control is increased to 3. The majority of colors shifts to the lower half of the
density scale, but various shades of orange and red are still available for densities above 50%.

Figure 13. For color curve settings greater than 1, better contrast is provided for events near the low end of the
density range.
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Swept DPX
DPX Spectrum is not limited in span by its real-time bandwidth. Like the regular Spectrum display, DPX
Spectrum steps through multiple real-time frequency segments, building a wide-span display with line
traces and the bitmap (Option 200 only). See Figure 14.

Figure 14. Off-air ambient signals over a 1 GHz span in the swept DPX display.

The analyzer “dwells” in each frequency segment for one or more DPX frames, each containing the results
of up to 14,600 spectral transforms. Dwell time is adjustable, so you can monitor each segment of the
sweep for up to 100 seconds before moving to the next step. While dwelling in a segment, the probability
of intercept for signals within that frequency band is the same as in normal, real-time spans: 100% capture
of events as short as 10.3 μsec.

A full pixel bitmap is created for every segment and compressed horizontally to the number of columns
needed for displaying the frequency segment. Compression is done by averaging pixel densities of the
points being combined together. The final swept bitmap contains a representation of the same pixel bitmap
resolution, just like the non-swept bitmaps. Line traces are also created in full for each segment, and then
horizontally compressed to the user-selected number of trace points for the full span.

A complex algorithm for determining the number and width of each frequency segment has been
implemented. The variables in the equation include user-adjustable control settings like Span, RBW, and
number of trace points, RF and IF optimization, and Acquisition BW. Installed hardware options also can
affect the span segmentation. The number of segments ranges from 10 to 50 for each 1 GHz in a sweep.

A helpful piece of information for operators is the actual Acquisition Bandwidth used for capturing each
segment. “Acq BW” is shown in the Acquire control panel on the Sampling Parameters tab. Acq BW is
typically set automatically by the instrument, based on the needs of all the open displays, but can also be
set manually. In either case, the displayed bandwidth is used for every frequency segment in the swept
DPX display, though in practice, the displayed portion of the segment is somewhat narrower than the
actual Acquisition BW, for performance reasons.

The entire instrument frequency range of many GHz can be covered in a DPX sweep. The Dwell Time
control sets the amount of time DPX spends in each segment. This control, circled in Figure 15, can be
set between 50 ms and 100 seconds.
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Figure 15. During swept DPX operation, the Dwell time control adjusts the observation time of each frequency
segment used to construct the composite DPX spectrum display.

Guaranteed Capture of Fast Events
The main reason that swept-tuned and step-tuned spectrum analyzers can’t provide 100% Probability of
Intercept, POI, for a signal that isn’t continuously present is that they spend only a short period of time
tuned to each segment of their frequency span during each sweep. If something happens in any part of
the span other than where it is tuned at that instant, that event will not be detected or displayed. There
is also a period of time between sweeps, retrace time, during which the analyzer is not paying attention
to the input signal. FFT-based analyzers, including vector signal analyzers, also miss signals during
the time between acquisitions. Their POI depends on a combination of factors including span, number
of FFT points, acquisition time, memory read/write time, and signal processing speed. Vector analyzers
process information sequentially, so when read/write from data and processing is occurring, data is not
being acquired.

RSAs, on the other hand, capture data across all frequencies within their real-time span during every
acquisition. With Tektronix’ exclusive Frequency Mask trigger and DPX Density trigger, POI increases to
100%, insuring capture of any spectral event matching the trigger definition. When operating in free run as
a simple spectrum analyzer, the RSA has a POI similar to other FFT-based analyzers, with gaps between
each acquisition. Processing is done concurrent with the acquisitions.

Guaranteed Capture in DPX Real-Time Spans
The DPX Spectrum display captures any signal that is at least 10.3 microseconds long (for instruments
with Option 200) and within the real-time bandwidth. This performance is possible because the RSA
computes up to 292,000 spectrum transforms per second. The faster the spectrum updates, the shorter the
time between acquisitions and the greater the probability that any signal will be detected.

Table 1 shows the specified minimum signal duration (MSD) for 100% probability of intercept under
various combinations of Span and RBW in DPX for a representative RSA model. As you can see, MSD is
affected by multiple factors.

Table 2: Minimum signal duration specifications for RSA6100A series spectrum analyzers 1

Span
(MHz)

RBW
(kHz)

Span/RBW
Ratio

FFT
Length Spectrum/sec

MSD for
100% POI (μs)

110 1000 110 1024 292,969 10.3
110 300 367 2048 146,484 20.5
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Table 2: Minimum signal duration specifications for RSA6100A series spectrum analyzers 1 (cont.)

Span
(MHz)

RBW
(kHz)

Span/RBW
Ratio

FFT
Length Spectrum/sec

MSD for
100% POI (μs)

110 100 1100 4096 73,242 41.0
110 30 3667 16384 18,311 163.9
110 20 5500 32768 9,155 327.7

xxx

1 With Options 110 and 200 under various combinations of control parameters.
To demonstrate the POI in action, a challenging bi-stable signal is used. A CW sinusoid sits at 2.4453 GHz
most of the time, but every 1.28 seconds, its frequency changes for about 100 μs before returning to
normal. The duty factor of this transient is less than 0.01%.

Figure 16 shows a swept analyzer set up for a 5-second sweep of its MaxHold trace. It shows that there is
something occurring around the signal. This sweep rate was empirically determined to be the optimum rate
for reliable capture of this signal in the shortest time. Faster sweep times can reduce the probability of
intercept and result in fewer intersections of the sweep with the signal transient.

Figure 16. Swept spectrum display of the infrequent transient.

The DPX display shown in Figure 17 shows the exact same event, also captured over a 5 second period. A
lot more information can be discovered about the transient. It is obvious at first glance that the signal is
hopping by about 3 MHz, with 1.2 MHz of frequency overshoot on transitions
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Figure 17. The DPX spectrum display after 5 seconds. The MaxHold trace is cyan.

Guaranteed Capture in DPX Swept Spans
Probability of intercept (POI) for signals within a single segment, while DPX is dwelling in that segment,
is the same as for non-swept DPX operation (POI = 100% for events as brief as 10.3 microseconds).
But just as in traditional swept analyzers, during the time the acquisition is tuned to any one segment,
the analyzer is not monitoring signals in any of the other segments, so probability of capture in segments
other than the current one is zero. Because of the wide real-time bandwidth, the number of segments
needed to cover the span is much less than for swept analyzers, so the overall probability of intercept is
significantly better for DPX sweeps.

Another factor affecting POI is number of trace points. The bitmap is always 801 points wide, but the
line traces allow user selection for number of points. 801 is the default and the other choices are 2401,
4001, and 10401. Frequency transforms for traces containing more than 801 points take longer, and this
lower waveform update rate increases the minimum signal duration proportionally. This caution applies
for swept and non-swept operation. The trace length control is on the Prefs tab in the DPX control panel.

DPX Density Measurements
“Density” is a measure of the amount of time during a defined measurement period during which signals
are present within a particular area of the DPX Spectrum bitmap. A clean CW tone gives a 100% reading,
while a pulse that is on for one microsecond out of every millisecond reads 0.1%. This section describes
how density is computed from hit counts.

If we plot 41 more waveforms into the example grid we used previously in Figure 6 (in addition to the nine
we already plotted), each column ends with a total of 50 hits (Figure 18). The density for any one cell in a
column is its own count value divided by 50, expressed in percent as shown in Figure 19. The math is
very simple: a cell with 24 counts has a 48% density. In practice, instead of batches of 50 waveforms, we
collect a frame of thousands of waveforms before each update to the density bitmap.
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Figure 18. Grid showing cell counts after 50 waveforms. For each column, the sum of z-axis values is 50.

Figure 19. Grid after converting occurrence counts to percent density values. The sums of the cell density
measurements within each column are all 100%.

Measuring Density with Markers
Hit counts are cleared after every frame update, as long as Persistence is not turned on. The density
value for any pixel is simply the percent of time it was occupied during the most recent 50 ms frame.
Markers can be used to see the Density value for one or more individual points on the screen, enabling
measurements of the signal density at any interesting point in the DPX Spectrum display.

In Figure 20, Wireless LAN signals are analyzed in the presence of a Bluetooth radio signal in the 2.4 GHz
ISM band.
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Figure 20. DPX spectrum display of WLAN and Bluetooth signals, with a marker on the highest signal.

The “Marker to Peak” function was used to find the peak signal recorded in the display. The marker
readout in the upper left corner of Figure 20 shows the Density, Amplitude, and Frequency for the
pixel you selected with the marker. By adding additional markers, you can measure the signal density
differences between multiple signals of interest.

Marker Peak Search in the DPX Bitmap
Markers on the DPX bitmap can search for peaks, similar to marker peak searching on spectrum line
traces. For a human, it is pretty easy to discern “signals” in the bitmap picture. Your brain intuitively
identifies strings of contiguous bright pixels. This isn’t so easy for a computer. The first thing the RSA
must do for any peak search is analyze pixel density values to identify apparent signals. Then it can sift
through these density peaks for the amplitude peaks you want to find.

Z-axis density values for the pixels in each column of the bitmap are internally converted into histograms
to find density peaks indicating the presence of signals. Table 2 shows the five middle columns from
the example grid we used to illustrate density measurements in a previous section (Figure 19). The
density values for each pixel in the middle, highlighted column are plotted on the y axis in the bar chart in
Figure 21. The bar chart x axis is bitmap row number, numbering from the top of the table.

Table 3: Bitmap section showing density values.
0% 0% 0% 0% 0%
0% 0% 8% 0% 0%
0% 0% 12% 0% 0%
0% 0% 26% 0% 0%
0% 0% 36% 0% 0%
0% 2% 6% 2% 0%
4% 8% 0% 8% 0%

86% 82% 4% 76% 12%
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Table 3: Bitmap section showing density values. (cont.)

10% 8% 6% 14% 86%
0% 0% 2% 0% 2%

xxx

Figure 21. Bar chart of the density values in the bolded column of Table 2.

Assume that Density Threshold is set to 5% and Density Excursion to 5% also. Starting with x=1 in the
bar chart, test each bar against the threshold. The threshold criteria is met at x=2. Keep testing until you
find a bar that is shorter than the previous bar by at least the Excursion setting. In this case it is x=6. This
tells us that a “signal” covers rows 2 through 5. Its density peak is at row 5.

Now you can look for another peak. Continue looking at bars to the right and you will find a density
value at row 9 that meets the threshold criteria, but since there are no bars to the right of it that meet the
excursion criteria, we can’t declare row 9 a signal because it fails to meet the excursion criteria. If row 1
had 1% density, then row 9 would be a density peak.

Once density peaks are found for all columns in the bitmap, we can start looking for the amplitude peaks.
When the Peak button is selected, the analyzer checks the histograms of every column in the bitmap and
finds the density peak with the highest amplitude. The amplitude search has its own versions of Threshold
and Excursion settings, but in dBm and dB units. When Next Peak Down command is given, the search
will scan inside the current column for the next density peak. Next Peak Right examines each column to
the right of the current marker location to locate density peaks that also meet the amplitude peak criteria.

To demonstrate the value of marker peak search in the DPX bitmap, we will use the time-multiplexed
signals showing multiple amplitude levels from an example earlier in this manual. The Peak button
and its menu equivalent place the active marker on the peak signal in Figure 22. The peak signal is the
density peak of highest amplitude in the bitmap.
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Figure 22. The marker was positioned by selecting the Peak button. Density, frequency, and amplitude measurements
at the marker are displayed in the upper left corner of the graph.

The Marker Toolbar, at the bottom of Figure 22, allows easy navigation of peak signals (Peak Left, Peak
Right, Next Peak Up, or Next Peak Down). Selecting the arrow keys enables the marker to search for
amplitude/density peaks at other frequencies, while the Next Peak Up and Next Peak Down arrows
enable the marker to search for other high-density points at the same frequency.

In the Define Peaks tab of the Define Markers control panel, Figure 24, you can adjust the density threshold
and excursion controls to modify search behavior. The amplitude threshold and excursion controls also
apply to DPX marker searches. Smoothing keeps the marker from finding multiple peaks within the same
apparent signal by averaging an adjustable number of pixel densities together, but it does not affect the
single-pixel measurement readout displayed by the marker.

Figure 24. Amplitude and Signal Density controls can be adjusted to define Peak search behavior.

Density Measurements over an Adjustable Area (“The Box”)
The density for a single pixel is its ratio of actual hits vs. possible hits over a defined time period, and
markers display these density values. For measuring density over an area larger than one pixel, Option 200
includes a measurement box you can resize and drag around in the DPX Spectrum display with your
mouse or finger.

If you could make the box so narrow that it contained only points within a single column of pixels, the
density of this area would be the sum of the included pixels’ density values. For example, if the box was
three pixels tall and the density values for these pixels were 4, 2, and 7% respectively, the overall density
for the three-pixel area would be 13%. Imagine a box one pixel wide and as tall as the graph. Assume that
the input signal’s amplitude was such that all hits fell at or near the vertical center of the screen. Since
100% of the waveforms written to the bitmap passed through the box, the density for the box is 100%.
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When you widen the box to cover a broader range of frequencies, software computes the density sum for
the included pixels in each column inside the box. The aggregate density value for this box is the average
density, calculated by adding the column density sums then dividing by the number of columns. For a 100%
result, there must not be any hits above the top edge of the box or below its bottom edge. In other words,
every waveform drawn across the graph entered the box through its left side and exited the box through its
right side, with no excursions out the top or bottom. Figure 24 demonstrates this principle on a CW signal.
As you can see on the left-hand side, no amplitudes exist above or below the box; the density of the signal
is 100%. On the right hand side, there are signals below the box, therefore the density is less than 100%.

Figure 24. Density of signals defined within an area. Left: Correct measurement of a CW signal. All columns in the
box include the signal. Right: Incorrect measurement area. The measurement is accurate, but probably not what you
expected. Some columns in the box contain no hits, so they contribute zeros to the calculation of average density.

The density measurement box’ vertical size and location are always set in dB and dBm, no matter what
units you have selected for measurements. (Amplitude control panel > Units tab) The box is not draggable
when the selected units are linear (such as Amps, Volts, Watts…), though you can still adjust its size and
location using the Frequency and Amplitude controls in both the DPX Settings > Density and Trigger >
Event tabs. Since the vertical scale is non-linear, a box of constant amplitude changes visual height as it
changes vertical position, a disconcerting effect if you are trying to drag it.

Figure 25. DPX Density control panel is used to define the area of interest for DPX density measurements.

A readout will appear somewhere in the graph. If the box is off-screen, the readout will be accompanied by
an arrow pointing towards the invisible box. Grab this readout with your mouse or finger and drag the
density readout to the area you want to measure.
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To adjust the box size, a mouse is the easiest way to drag the sides and corners of the rectangle. For precise
settings, use the knob, arrow keys, or keyboard to adjust frequency and amplitude values for the rectangle.
These controls are located in the right half of the Density tab in the control panel.

Persistence
Previous sections of this topic have assumed that persistence was not applied to the DPX bitmap. Without
persistence, hit counts in the grid are cleared after each frame update. Now we will describe how
persistence modifies this behavior, starting with infinite persistence because it is simpler than variable
persistence.

Hit counts are not cleared between frames if infinite persistence is enabled. When the instrument is set
up for continuous acquisitions, hits keep collecting until you stop acquisitions or click the Clear button
above the DPX display. Software keeps track of the total number of waveforms computed during the
entire collection period. Density equals the total number of hits to a cell divided by the total number of
waveforms.

Variable persistence is trickier. A single-occurrence signal shown in the bitmap does not disappear
suddenly upon the next frame update, nor does it linger forever. It fades gradually away. The user sets
a time constant for the Dot Persistence control which determines how long it takes for signals to fade.
Fading is accomplished by reducing the hit count in every cell, after each frame update, by a factor based
on the persistence time constant. The longer the time constant, the less the hit counts are reduced.

Figure 26. Example of fast transient discovery with and without variable persistence turned on. In the display on the
left, with variable persistence of 10 seconds, the occasional sub-second transient that spikes up above the normal
signals is held in the display rather than disappearing as soon as the signal goes away. The display on the right, with
persistence turned off, requires watching the display continually to see the brief signal.

Not only are single-occurrence signals allowed to remain in the display for awhile by variable persistence,
additional hits keep piling on. The result is that cell values are no longer pure hit counts; they include
counts due to new hits from waveforms plus proportionally reduced counts from prior frames. As part
of translating hit counts into density values, a new software algorithm uses a finite-series equation to
discriminate between the effects of persistence and the arrival of new hits. The inflationary effects of
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persistence on cell counts are removed, so density readings represent the true ratio of actual hits to possible
hits over the persistence interval.

The density computation for variable persistence is a very good estimate of true signal density, with errors
of less than 0.01%. For exact density measurements, use either no persistence or infinite persistence.

Another subtlety of persistence is its smoothing effect on the density measurement of intermittent signals.
Consider a pulse that is on for 10 ms and off for 90 ms of each 100-ms cycle. We’ll make the simplifying
assumption that the pulse ON time always falls entirely within a single DPX frame update (50 ms). If
persistence is not applied, the density measurement is computed on each individual frame. The results
will be 20% for each frame containing the ON time and 0% for the other frames. If infinite persistence
is enabled, however, the density measurement will settle to 10% after the second frame, and remain at
this value for as long as the pulsing continues. With persistence, the density is effectively computed
over many frames.

Persistence Effects on Density
Persistence does not alter colors in a density-based bitmap. Its effect is to extend the amount of time over
which densities are calculated, leaving signal events visible for the persistence duration.

Before the introduction of density measurements and extra-long hit counters, persistence caused colors
to “bloom”, becoming more and more intense over time as the hit counts increased. Longer persistence
intervals caused increased blooming, turning crisp signals into fat red stripes. When hit counts are
converted to density values (requires Option 200), the display is not subject to this effect. As long as the
input signals maintain reasonably stable repetition rates and duty ratios, their density values will also
remain stable despite ever-increasing hit counts in the underlying grid cells.

If you are accustomed to the original hit-count-based persistence displays, it may seem counterintuitive
that repeating signals in a density-based bitmap will not get brighter and redder over time with infinite
persistence. A quick review of the density algorithm explains why: the hit count is divided by the total
number of waveforms over the persistence interval. For example, if a signal occupies a pixel 50% of the
time over a period of 15 minutes, the density reading will be 50% throughout the entire 15 minutes,
though the underlying hit count is steadily increasing.

Z-Axis Resolution
Another factor that can cause color bloom is overflow of the hit counters. If a pixel could only count up to
1000 hits, its density and color values would clip at 100% after just 1000 hits, even if waveform points
continue to arrive in the same pixel location. With waveform points being written to the bitmap at rates
approaching 300k/sec, counts add up really fast for highly-repetitive signals. Deeper counters permit
higher hit counts, so overflow happens much later, as shown in Table 3.

Table 4: Comparison of DPX z-axis resolution and its effect on saturation.
RSA6100A Series Standard RSA6100A Series Option 200

Hit Count 16-bit integer 36-bit custom float (equivalent to
33-bit integer)
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Table 4: Comparison of DPX z-axis resolution and its effect on saturation. (cont.)

RSA6100A Series Standard RSA6100A Series Option 200
Maximum Hit Count
Minimum Time until Overflow (for
pixels with 100% density)

<50 msec 8.1 hours

xxx

Clipping due to overflow of the counters in one or more cells will not occur until hours have passed, or
even days.

One more benefit to having deeper hit counters is better visual resolution of density. RSAs with the
highest-performance DPX hardware installed use floating-point numbers to count hits, allowing us to count
billions of waveforms while retaining one-hit resolution, providing better than 99 dB of dynamic range
for density measurements. Density measurements in μ%, n%, and even f% ranges are quite possible for
extremely rare signals captured with infinite persistence.

With straight-line mapping between density and color (Curve setting of 1), resolution is fixed by the
number of colors in the palette. For non-linear mappings (Curve settings higher or lower than 1), most
of the colors are concentrated at either the low or high end of the density scale, so you can visually
discriminate finer differences between density values in that range.

Persistence Adjustments
Dot Persistence can be enabled for the “Bitmap” trace using the Settings control panel. The Persistence
can be displayed as Infinite or Variable. For Variable Persistence, you can select the time constant for
fading in seconds as shown in Figure 27.

Figure 27. The trace settings control panel allows user control of persistence parameters.

Figure 28 demonstrates the observed behavior of variable persistence when a CW signal, represented in
the first frame, is turned off. Even if the event was instantaneous and was confined within a single frame,
you will observe the color changing to indicate lower and lower density values, until the signal finally
disappears entirely.
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Figure 28. With variable persistence, a brief CW signal captured by DPX remains in the display for an adjustable
period of time before fading away.

DPX Density Trigger
The standard DPX display shows you a clear picture of transients and other hard-to-find signals. The
version of DPX in the RSA6100A Option 200 goes well beyond helping you discover these difficult to find
signals by actually triggering on their appearance to capture them into acquisition memory for in-depth
analysis. If you can see it in the DPX bitmap, you can trigger on it.

Other trigger methods can detect signals that exceed an amplitude threshold, or even a sophisticated
amplitude-vs-frequency mask, but they can’t find a signal at a particular frequency if another signal of
higher amplitude is sometimes present at that same frequency. The Runt trigger addresses some of these
signal-under-signal cases, but not all. As shown in Figure 29, the DPX Density trigger can discriminate
signals within a precise amplitude-frequency range without the operator having to know any characteristics
of the target signal besides where it might show up in the DPX Spectrum graph.

Figure 29. Example of Density Trigger. Left: A free-run DPX spectrum display showing pulses with varying frequency.
Occasionally, a short pulse in the middle appears for a split instant, but it is hard to capture it with just a Run/Stop
button. Right: The triggered DPX displays shows the low-amplitude pulse that was not apparent in the untriggered
display. The analyzer was set to trigger whenever the average density in the user-drawn box measured 50% or higher.

The DPX Density trigger uses the same screen-based measurement box as the DPX Density measurement.
While the target signal is absent, the density measurement characterizes the “normal” signals within the
box. When the target signal finally appears, the density value increases. The trigger system monitors the
density measurement and activates a trigger whenever the density value exceeds the adjustable density
threshold. The only thinking you have to do is to set this threshold to a level somewhere between the
normal density readings and the density due to the trouble-making signal. However, the instrument
software can compute the threshold value automatically.
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Trigger On This™
The Trigger On This™ function allows you to point and click to set up the DPX Density trigger. By
right-clicking on a spot within the DPX Spectrum display, or pressing and holding your finger on the
RSA6100A Series touchscreen display for about a second, a menu selection will appear. Selecting Trigger
On This causes a DPX Density box to appear and automatically adjusts the threshold. The DPX Spectrum
display will now only update whenever the automatic threshold is exceeded. Subsequently, if needed for
your signal, open the Trigger control panel to adjust the density threshold or the size of the measurement
box until the event is reliably captured.

Automatic Threshold Adjustment by Trigger On This™
The trigger density threshold automatically set by Trigger On This is 80% of the measured value. If the
signal was present at the moment you selected Trigger On This, the threshold will be 20% less than the
signal density, so the next time the signal is present long enough (or present enough times) to exceed
the threshold density, it will cause a trigger. If the signal happened to be missing when you selected
Trigger On This, the threshold value will be even lower. If you clicked in a part of the display with no
signal activity at all, the threshold will be set to zero. Any signal that shows up here will fire the trigger,
as shown in Figure 32.

Figure 30. The analyzer triggered when the density in the DPX measurement box exceeded the threshold set by
Trigger On This. You can see in the Spectrogram and Frequency-vs-Time displays that the signal event which caused
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the trigger was a quick frequency hop. The Time Overview shows that the signal amplitude never changed, so a
power level trigger would not have worked.

DPX Density Trigger Timing
The time resolution for DPX density measurements is the frame length, around 50 ms. A basic
implementation of the DPX Density trigger concept is also frame-based, so a trigger event that occurs
anywhere within a frame will not be recognized until the end of the frame. Therefore, the worst case
trigger uncertainty is 50 ms.

DPX Density trigger doesn’t always have to wait until the end of a frame before firing. For the
common configuration of triggering when the measured density is higher than the threshold, the density
measurement in the trigger can be computed many times within each frame and it can fire the trigger
as soon as the threshold is exceeded.

Consider the case where the threshold is zero. As soon as a single waveform causes a hit within the
measurement box, we know that the density is greater than zero. It takes a little longer to test for a 5 or
10% density, and even more time for thresholds at or near 100%.

The DPX Density trigger can also be set to fire when the measured density is below the threshold value.
This is useful when you suspect that your signal is missing some of the time. For a signal that is supposed
to be CW, you can set the trigger controls to acquire when the density measurement of the signal peak
drops below 100%. When using the “lower than” form of the DPX Density trigger, the time resolution is
one frame because of the following logic: We can’t be sure the actual density is less than, say, 15% until at
least 85% of the full test time has elapsed. In order to keep things simple and fast in the trigger module, the
RSA just waits until the end of each 50 ms frame to do the “lower than” comparisons.

Persistence and DPX Density Trigger
The smoothing effect of persistence on density measurements can help in determining a good threshold
value. With persistence turned off, an infrequent signal’s density reading jumps between higher and lower
values as it turns on and off, and it can be hard to read these flashing numbers. By turning persistence
on, you instruct the instrument to average the density over a longer time period. This density result is
somewhere between the ON and OFF density values - the very definition of a good trigger threshold.

Unlike the DPX Density measurement, the DPX Density trigger is not affected in any way by persistence.
Density calculations in the trigger system are made with hit count data received from each individual DPX
frame, before any persistence is applied. Even when the density measurement reading in the display
is averaged over many frames due to persistence, the trigger is computing density for each frame and
comparing these quick snapshots against the threshold setting.
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DPX Spectrum Overview
The DPX Spectrum display enables you to see how traces change over time and thus displays signal events
that cannot be seen on a swept spectrum analyzer. A DPX Spectrum indicates how traces change in two
ways. First, it uses color shading to show how consistent the shape of a trace is. Second, it uses persistence
to hold signals on the screen so you can see them longer.

DPX Spectrum Display
The DPX Spectrum display works by using a two-dimensional array to represent points on the display.
Each time a trace writes to a point on the display, a counter in the array is incremented. A color is assigned
to each point in the display based on the value of its counter. Thus, as acquisitions occur over time, a
colored waveform, the Bitmap, develops on the display that shows how frequently a display point has
been written to.

An important feature of the DPX Spectrum display is persistence. Persistence sets how long a point on
the display will be visible. You can set the Display Persistence to be Variable or Infinite. In variable
persistence mode, you specify a decay period that limits how long a point will be displayed. In infinite
persistence mode, once a point in the display has been written to, it will remain visible indefinitely.

To display the DPX Spectrum view:

1. Select Freq and use the front panel knob or number keys to set the measurement frequency.

2. Select the Displays button or Setup > Displays. This displays the Select Displays dialog box.

3. From the Folders box, select General Signal Viewing.

4. Select DPX Spectrum from the Available displays box.

5. Click the Add button. This will add the DPX Spectrum icon to the Selected Displays box (and remove
it from the Available displays box).

6. Click the OK button. This displays the DPX Spectrum view.
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Available Traces for Display — Standard Instrument
Five traces can be shown in the DPX Spectrum display—one bitmap and four line traces. The default traces
are Bitmap and +Peak detection. The other three traces are –Peak detection, average detection, and math.

Trace Description
Bitmap Displays the density of acquired data. The number of data points acquired at each pixel

(representing a particular amplitude level at a specific frequency is indicated by color).
+Peak detected Line trace. Displays the maximum amplitude values acquired in each update. Normal and

Hold functions are available for this trace.
–Peak detected Line trace. Displays the minimum amplitude values acquired in each update. Normal and

Hold functions are available for this trace.
Average detected Line trace. Displays the average of all the values acquired in each update. Normal and Hold

functions are available for this trace.
Math Trace Line trace. Displays the difference between two traces. The two traces used are set in the

Traces tab of the Settings panel.
xxx

Determining Which Trace Types Are Displayed
You can see the status of all the traces by selecting the Trace drop-down list. Traces that are not displayed
are preceded by "Enable". In the following figure, you can tell that the Bitmap and -Peak Trace traces are
displayed but the +Peak, Average, and Math Traces are not displayed.

Selecting Enable -Peak Trace from the Trace list displays the -Peak detected values trace.
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You can see whether a trace is enabled by looking at its Show check box. The "selected trace" is selected
in the Trace list. The Show check box is checked when the selected trace is enabled. To the right of the
show box are readouts for detection of the selected trace (+Pk, Avg (VRMS), ...) and its function (Hold,
Normal,...). You can enable/disable the selected trace by checking or unchecking Show.

Selecting Traces for Display — Standard Instrument
To select a trace for display:

1. Use the Settings control panel:

Select Setup > Settings or click the Settings button.

Select the Traces tab.

Select the trace from the drop-down menu.

Select the Show check box.

2. Select a trace from the Trace drop-down list.

Specifying How +Peak, –Peak, and Average Traces Are Displayed
You control how the +Peak, –Peak and Average (Avg (VRMS)) traces are displayed from the Traces tab of
the Settings control panel. From the Traces tab, you can also specify whether these traces display results
from single updates or results collected over multiple updates.
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To change how the traces are displayed:

1. Select Setup > Settings or click the Settings button.

2. Select the Traces tab.

3. Select the trace type from the drop-down list.

4. If you select +Peak Trace or -Peak Trace, use the Function drop-down list to select either Normal or
Hold.

a. Select Normal to set the trace to display the maximum/minimum values acquired in each
individual update.

b. Select Hold to set the trace to display the maximum/minimum values acquired over time. The
trace values are updated only if they exceed the existing values.

5. If you select Avg (VRMS), use the Function drop-down list to select either Normal or Average.

a. Select Normal to set the trace to display the average values acquired in each update.

b. Select Average to set the trace to display an average of the average values. Use the Count box to
enter the number of times the trace is averaged.

Available Traces for Display — Option 200 Instrument
Five traces can be shown in the DPX Spectrum display—one bitmap and four line traces. The default
traces are Bitmap and Trace 1. The other three traces are 2, 3, and math. Line traces 1, 2, and 3 have
user-selectable Detection and Function settings. The final line trace is Math, allowing you to subtract
one line trace from another.

Selecting Traces for Display — Option 200
This is done almost the same as with the standard instrument, except that the choices available for Trace
are different. Instead of +Pk, –Pk, and Avg traces, you can select Trace 1, 2 , and 3. Additionally, you can
set the Detection method for each of these traces to +Pk, -Pk, or Avg (VRMS).

Reference. Changing the DPX Spectrum Display Settings (see page 61)
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DPX Spectrum Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The measurement settings for the DPX Spectrum display are shown in the following table.

Settings tab Description
Freq & Span (see page 98) Sets frequency and span parameters for the DPX Spectrum display.
BW (see page 103) Sets Resolution Bandwidth.
Traces (Bitmap) Tab (see
page 61)

Allows you to configure the Bitmap Trace.

Traces (see page 63) Allows you to select the number and types of traces to display and their functions.
Traces (Math) Tab (see
page 103)

Allows you to configure the Match Trace.

Scale (see page 67) Sets the vertical and horizontal scale parameters.
Prefs (see page 106) Specifies whether certain display elements are visible.
Density (see page 68) Specifies location and size for DPX Density triggering measurement box.
Audio Demod (see page 69) Enables and sets parameters for audio demodulation function.
xxx

Traces Tab – Bitmap
The Traces Tab allows you to set the display characteristics of displayed traces in the DPX Spectrum
display. The Traces tab for the DPX Spectrum display has two versions: one for the DPX Bitmap trace
(described in this topic) and one for line traces (see page 63).

Option 200 traces tab (Bitmap trace)
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Traces tab settings for the bitmap trace (Standard and Option 200)
Setting Description
Trace drop-down list Select Bitmap to set the parameters of the DPX Spectrum Bitmap trace.
Show Specifies whether or not the selected trace is displayed.
Intensity (standard instrument
only)

Use Intensity to control the visibility of events. An increased intensity level allows a
single, short event to be seen. This also makes such an event subject to the persistence
controls. This allows you to see the effect of the Persistence controls on infrequent
events. Range is 1-100%. Resolution: 1.

Dot Persistence Allows a dot to remain visible if it is not updated with new data. Choices for this setting
are Variable and Infinite.

Variable The Variable dot persistence setting controls how long a point in the display is visible
before fading. This setting has no units associated with it.
Standard instrument Range: 1–1000. Resolution 0.1.
Option 200 instrument Range: 50 ms–100 s.

Infinite The Infinite dot persistence setting prevents a point in the display from fading.
Freeze Halts updates to the selected trace.
Save Trace As... Saves the selected trace to a file for later recall and analysis.
Show Recalled Trace Displays a saved trace instead of a live trace.
xxx

Dot Persistence
Dot Persistence is the characteristic of the DPX Spectrum display that determines how long a pixel in
the display remains visible.

To set the Persistence:

1. Select Setup > Settings.

2. Select the Traces tab.

3. Select Dot Persistence.

4. Select either Infinite or Variable.

5. If you select Variable, enter a value in the text box. The Variable persistence value can be set from 1 to
1000 in the base instrument, and from 0.05 to 100 seconds with Option 200.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
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2. Type a name for the saved trace and click Save.

Show Recalled Trace
You can recall a previously saved trace for comparison to a live trace. First, specify a trace for recall and
second, enable Show Recalled Trace.

To select a trace for recall:

1. Select the ... button to display the Open dialog box.

2. In the Open dialog, navigate to the location of the saved trace.

3. Select the desired trace file.

4. Select OK to complete your selection.

5. Select the Show recalled trace check box.

6. Verify that the trace’s Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).

Traces Tab
The Traces Tab allows you to set the display characteristics of displayed traces in the DPX Spectrum
display. The Traces tab for the DPX Spectrum display has two versions. One for non-Bitmap traces
(described in this topic) and one for the DPX Bitmap trace (see page 61).
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Option 200 Traces tab

Setting Description
Trace drop-down list Selects which trace to configure. For standard instruments, the available traces are

Bitmap, +Peak detected, -Peak detected, Average, and Math. In instruments with Option
200, the available traces are Bitmap, Trace 1, Trace 2, Trace 3, and Math.

Show Specifies whether or not the trace shown in the Trace setting is displayed.
Freeze Halts updates to the selected trace.
Detection (Option 200 only) Sets the Detection method used for the trace. Not available for saved traces. Available

detection methods are +Peak, -Peak, and Avg (VRMS) Not all detection methods are
available in all displays.

Function Selects the trace processing method. Available settings are: Normal, Average, and Hold.
Save Trace As... Saves the selected trace to a file for later recall and analysis.
Show Recalled Trace Displays a saved trace instead of a live trace.
Count Enables user adjustable number of averages . This setting is only present when Function

= Average.
xxx

Detection
Trace Detection occurs when the trace is being decimated by the measurement. For example, if the
maximum number of trace points is 100,000, and the selected analysis region is 200,000 samples, the
measurement must decimate the 200,000 resulting trace points by 2 to prevent exceeding the 100,000 trace
point limit. Since only one value can be selected for each trace point, an algorithm must be used to select
(detect) the appropriate value to use.

The available detection methods are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.
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DPX Trace Processing
The +Peak, -Peak, and Average traces can be processed to display in different ways. The Function setting
controls trace processing.

Hold - Displays the value in the trace record for each display point. Each new trace display point is
compared to the previous maximum value and the greater value is retained for display and subsequent
comparisons. Available for traces using +Peak or -Peak detection.

Normal - Displays the trace record for each display point without additional processing. Available
for all detection selections.

Average - Default setting for the Average. Multiple traces are averaged together to generate the
displayed trace. There is one vertical value for each underlying frequency data point. Once the
specified number of traces have been acquired and averaged to generate the displayed trace, each new
trace takes the place of the oldest trace in the calculation. The Count setting specifies how many
traces are averaged. Available for traces using Average detection.

Trace averaging uses the exponential method. If Count = 10, the newest trace’s contribution to the
averaged trace is 10%. When Count is not checked, the algorithm assumes the maximum number of
traces contributing to the average is .

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for comparison to a live trace. First, specify a trace for recall and
second, enable Show Recalled Trace.
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To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.

3. Check the Show Recalled Trace check box.

4. Verify that the trace’s Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).
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Scale Tab
The Scale tab allows you to change the vertical scale settings and set the color scheme used for the Bitmap
trace. Changing the scale settings changes how the trace appears on the display but does not change
control settings such as Measurement Frequency.

Setting Description
Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale.
Offset Adjusts the Reference Level away from the top of the trace display.
Reset Scale Sets Scale to its default value and Offset to zero. Disabled when Units (Setup > Analysis

> Units) is set to Watts or Volts.
Autoscale Resets the scale of the vertical axis to contain the complete trace. Disabled when Units

(Setup > Analysis > Units) is set to Watts or Volts.
Horizontal Controls the horizontal position and scale of the trace display.

Scale Changes the horizontal scale.
Position Adjusts the horizontal position of the signal. This does not change the center frequency.
Autoscale Resets the scale of the horizontal axis to contain the complete trace.

DPX Bitmap Controls the appearance and scale of the Digital Phosphor Bitmap trace.
Color Allows you to select the color palette used for the Bitmap trace.
Max Sets the hit density represented by the top of the color scale. "Clipping" occurs for

densities greater than this value.
Range: 1p% - 100%; Default: 100%.

Min Sets the hit density represented by the bottom of the color range. Range: 0 - 80%;
Default: 0.

Curve Adjusts how colors are mapped to the signal density. The mapping can be linear (Curve
= 1), or it can be set to concentrate the resolution on the lower level of the range (Curve >
1) or the mapping can be set to show the best resolution on the upper range of density
or hit count (Curve < 1).

Auto Color Adjusts the Max and Min settings to display the broadest range of colors.
xxx
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Density Tab – Option 200
The Density tab specifies the parameters of the measurement box used for measuring average signal
density of an area in the bitmap. The measurement box is also used by DPX Density triggering.

To measure the average signal density over a rectangular portion of the DPX bitmap, you can adjust the
size and location of the measurement area using these controls, or by dragging the measurement box in
the graph. You move the box by dragging the readout. You adjust the size of the box by dragging the
corners or edges.

Setting Description
Show Measurement Shows or hides the measurement box in the graph when Triggering is not set to DPX

Density. If Triggering is set to DPX Density, the measurement box is always visible.
Frequency Specifies the frequency at the center of the measurement box. The +/- value specifies

the width of the measurement box.
Amplitude Specifies the amplitude of the center of the measurement box. The +/- value specifies

the height of the measurement box.
xxx
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Audio Demod Tab
Audio demodulation can help you identify unknown radio signals. You control the audio demodulation
function with the Audio Demod tab. You access the Audio Demod tab from the Settings control panel of
the DPX Spectrum display.

NOTE. Audio Demodulation is available only in real-time acquisition mode (not swept acquisition), and
the Trigger mode must be set to Free Run (not Triggered).

Setting Description
On/Off Enables/disables audio demodulation.
Audio Gain Adjusts the volume of the demodulated audio.
AM Selects Amplitude Modulation as the demodulation method.
FM Selects Frequency Modulation as the demodulation method.
Tune with Specifies how the frequency to be demodulated is specified. You can select markers

or the frequency control.
Receiver Freq Readout of the frequency to be demodulated.
Receiver BW Adjusts the equivalent receiver bandwidth for the audio demodulation. The range of

values is 1 kHz to 500 kHz.
xxx

AM / FM
Note that these buttons select the demodulation method; they do not specify a frequency band.

Tune with
The choices for this setting are: one of the markers (MR, M1, M2, M3, M4) or the Frequency control
(either the front-panel knob or the Freq control in the application).

To use a marker to specify the frequency to be demodulated:

1. SelectMarkers > Define Markers to display the Define Markers control panel.

2. Select Add to turn on the next marker.
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NOTE. The first marker defined will always be MR. The MR marker is the reference for delta marker
readouts.

3. Select the trace to which the marker should be attached from the drop-down list.

4. Click Add to add additional markers. Assign them to the appropriate trace.

5. Click the close button to remove the Define Markers control panel.

Select markers. Select one of the markers in the Tune with drop-down list and then set the location of the
marker to the frequency you want to demodulate. If the marker you select is not enabled, the analyzer will
tune to the frequency the marker was last set to.

Receiver BW
The Receiver BW setting will not change the acquisition bandwidth. Thus, if the acquisition bandwidth
is too narrow, audio demodulation will be disabled. The following three cases illustrate the relationship
between the Acquisition BW, Receiver Frequency, and Receiver BW.

Case 1. In this case, the upper limit of the Receiver BW exceeds the upper limit of the acquisition
bandwidth. When this occurs, audio demodulation is disabled and an error message is displayed.

Case 2. In this case, the upper and lower limits of the Receiver BW exceed the upper and lower limits
of the acquisition bandwidth. When this occurs, audio demodulation will be disabled and an error
message is displayed.
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Case 3. In this case, the upper and lower limits of the Receiver BW fall within the upper and lower
limits of the acquisition bandwidth. This is the desired relationship between the three settings, and audio
demodulation is enabled.
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Time Overview Display
The Time Overview display shows the entire acquisition record and shows you how the spectrum time and
analysis time fit within the acquisition record. This enables you to see how you can adjust the spectrum
time and analysis time to measure portions of the data.

You can specify the maximum number of trace points in the Time Overview display. You can set the
maximum number of trace points to 1K, 10K, 100K, 1M points or to Never decimate. If the Acquisition
Length includes more than 10,000 sample points (and Max trace points is not set to Never decimate), the
trace is decimated (using the +Peak method, similar to +Peak detection in a Spectrum display) to 10,000
points. This decimated trace is what is used for marker measurements.

The Time Overview window displays the Spectrum Length and Analysis Length. The Spectrum Length
is the period of time within the acquisition record over which the spectrum is calculated. The Analysis
Length is the period of time within the acquisition record over which all other measurements (such as
Amplitude vs. Time) are made. The Spectrum Length and Analysis Length can be locked together so
that the data used to produce the Spectrum display is also used for measurement displays; however, they
do not have to be tied together. They are by default specified separately and used to analyze different
parts of the acquisition record.

Elements of the Display
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Item Element Description
1 Analysis Time Control Click a button to select the value to be adjusted. In order, the buttons

represent Analysis Offset, Analysis Length, Spectrum Offset, and Spectrum
Length.

2 Position and Scale Adjusts the vertical scale and position.
3 Amplitude vs. Time graph The trace represents the entire acquisition record (at full horizontal scale).

The graph indicates the Analysis Length or Spectrum Length on the graph
with a darker background.

4 Autoscale button Resets the horizontal scale to display the entire acquisition record and the
vertical scale to show all trace points.

5 Horizontal Offset Adjusts the horizontal offset.
6 Results Timeline This fuchsia line indicates the portion of the record actually used for

calculating the selected result. For example: if a pulse measurement is
selected, it shows the period of the specific pulse. For a constellation display,
it shows the points included in the demodulation.

7 Horizontal Scale Adjusts the span of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the acquisition record by adjusting
the offset.

8 Spectrum Length and Offset
Indicator

This red line indicates the Spectrum Length and Offset. The longer the time,
the longer the bar. Adjusting the offset shifts the bar left or right.

9 Actual length display Displays the actual time for the selected value. If the user-adjusted length
extends past the end of the acquisition record, the realizable analysis length
is less than requested.

10 Analysis Length and Offset
Indicator

This blue line indicates the Analysis Length and Offset. The longer the time,
the longer the bar. Adjusting the offset shifts the bar left or right.

11 Setting Adjustment box Click in this box to adjust the value selected by the Analysis Time Control
buttons.

xxx

NOTE. The area with black background (not gray) in the Amplitude vs. Time Graph highlights the control
selected in the Analysis Time Control drop-down list.

Changing the Time Overview Display Settings (see page 74)
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Time Overview Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Setup settings for Time Overview are shown in the following table.

Settings tab Description
Scale (see page 105) Adjusts the vertical and horizontal scale and offset of the display.
Trace (see page 74) Allows you to select the types of trace to display and its function.
Prefs (see page 106) Specifies whether or not certain display elements are shown.
xxx

Trace Tab
The Trace Tab allows you to set the display characteristics of displayed traces.

Setting Description
Show Shows / hides the selected trace.
Detection Sets the Detection method used for the trace. Not available for saved traces. Available

detection methods are +Peak, -Peak, +/-Peak, Avg (VRMS), and Sample. Not all
detection methods are available in all displays.

Function Selects the trace processing method. Available settings are: Normal, Average, Max
Hold, and Min Hold.

(Number of Traces) Sets the number of traces averaged to generate the displayed trace. (Present only
when Function is set to Average.)

Freeze Halts updates to the selected trace.
Save Trace As Saves the selected trace to a file for later recall and analysis.
Show Recalled trace Displays a saved trace instead of a live trace.
xxx
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Detection
Trace Detection occurs when the trace is being decimated by the measurement. For example, if the
maximum number of trace points is 100,000, and the selected analysis region is 200,000 samples, the
measurement must decimate the 200,000 resulting trace points by 2 to prevent exceeding the 100,000 trace
point limit. Since only one value can be selected for each trace point, an algorithm must be used to select
(detect) the appropriate value to use.

The IQ samples in a data acquisition can be detected in a variety of ways. The number of IQ samples
available to each trace point varies with both analysis length and trace length. For example, with Spectrum
Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one
IQ sample pair per trace point. In this case, the detection method chosen has very little effect, as the
+Peak, -Peak, Avg (VRMS) and Sample values are all equal. Changing the Spectrum Length causes the
available detection methods to differ in value because they have a larger set of samples for the various
detection methods to process.

The available detection methods (depending on the display) are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

+/-Peak – Selects the highest and lowest values of all the samples contained in two consecutive
acquisition intervals.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Sample – The result is calculated based on the first sample available in the set of IQ samples for
each trace point.

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Multiple traces are averaged together to generate the displayed trace. There is one vertical
value for each underlying frequency data point. Once the specified number of traces have been
acquired and averaged to generate the displayed trace, each new trace takes the place of the oldest
trace in the calculation. The Number of Traces setting specifies how many traces averaged.
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Max Hold - Displays the maximum value in the trace record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Min Hold - Displays the minimum value in the trace record for each display point. Each new trace
display point is compared to the previous minimum value and the lesser value is retained for display
and subsequent comparisons.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box.

3. Click the ... button to display the Open dialog box.
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4. Navigate to the desired file and click Open.

5. Check the Show Recalled Trace check box.

6. Verify that the trace’s Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).
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Spectrum Display
To display a spectrum:

1. Click the Displays button or select Setup > Displays.

2. From the Folders box, select General Signal Viewing.

3. Double-click the Spectrum icon in the Available displays box. This adds the Spectrum icon to the
Selected displays box (and removes it from the Available displays box). Alternatively, you can click
the Spectrum icon and then click the Add button to select Spectrum for display.

4. Click the OK button.

Elements of the Spectrum Display
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Item Display element Description
1 Vert Offset Sets the top of graph value. This is only a visual control for panning the graph.

The Reference Level is adjusted in the Toolbar and the Ampl control panel.
By default, Vert Offset = Ref Level.

2 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.
3 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its

value is italicized.
4 VBW Enables the VBW (Video Bandwidth) filter. See Setup > Settings > BW Tab

(see page 103).
5 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on

screen.
6 Position Default function is CF - center frequency (equivalent to the Freq setting).

If Horizontal scaling has been manually adjusted in Settings > Scale, then
Offset will replace CF as the setting at the bottom-left corner of the screen.

7 Span / Scale Default function is Span - frequency difference between the left edge of
the display and the right edge. If Horizontal scaling has been manually
adjusted in Settings > Scale, then Scale will replace Span as the setting at
the bottom-right corner of the screen.

8 Clear Restarts multi-trace functions (Avg, Hold).
9 Function Readout of the Detection and Function selections for the selected trace.
10 Show Controls whether the selected Trace is visible or not. When trace is Off, the

box is not checked.
11 Trace Selects a trace. Touching here pops up a context menu listing the available

traces, whether they are enabled or not. If user selects a trace that is not
currently enabled, it will be made enabled.

xxx

Touchscreen Actions on Markers in the Graph Area

Action Description
Mouse click within 1/2 div. of
a marker

Selects the marker and updates the marker display to show the selected marker’s values.

Touch marker to select and
then use knob, or arrow keys

Adjust the setting associated with the Marker.

Touch and drag a marker Changes marker position to the "drop point".
xxx

Changing the Spectrum Display Settings (see page 80)
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Spectrum Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Setup settings for the Spectrum display are visible when Spectrum is the selected display.

Settings tab Description
Freq & Span (see page 98) Sets frequency and span parameters for the Spectrum Analysis display.
BW (see page 103) Sets Resolution Bandwidth and windowing parameters.
Traces (see page 99) Sets Trace display parameters.
Traces (Math) (see page 103) Sets the traces used to create the Math trace.
Scale Tab (see page 81) Sets vertical and horizontal scale and position parameters.
Prefs Tab (see page 106) Specifies whether or not certain display elements are shown.
xxx
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Scale Tab
The Scale tab allows you to change the vertical scale settings. Changing the scale settings changes how
the trace appears on the display but does not change control settings such as Measurement Frequency. In
effect, these controls operate like pan and zoom controls.

Setting Description
Vertical

Scale Changes the vertical scale.
Position Vertical Position adjusts the top of graph amplitude value. This control allows you to

move (“pan”) the traces up and down in the graph without changing the Reference Level.
Autoscale Resets the Offset so that the trace appears below the top of the graph.

Horizontal
Scale Allows you to change the range of frequencies shown in the graph without changing the

span or measurement frequency.
Position Allows you pan the graph.
Autoscale Resets Scale to the Span setting.

Reset Scale Resets all settings to their default values.
Log scale Resets the display to show the frequency axis in a logarithmic scale.
xxx
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Spectrogram Display
The Spectrogram is a display with the vertical axis (time) composed of successive spectral displays, each
having the amplitude represented by color or intensity. The horizontal axis represents frequency. The most
recently acquired spectrum results are added to the bottom of the spectrogram. The addition of a new
spectrum can occur at the fastest rate that new spectra can be plotted, or, if you choose, new spectra can be
added at a timed rate. The spectrogram view is well-suited to displaying long-term trends of spectral data.
The maximum number of lines that can be displayed in a spectrogram is 125,000.

The spectrogram can also be displayed in a 3-D waterfall format. In the 3-D waterfall format, the
spectrogram displays the time axis along a simulated Z-axis.

NOTE. Spectrogram data is shared with the Spectrum display. There is no linkage between DPX and
Spectrogram.

To display a Spectrogram:

1. Select the Displays button or select Setup > Displays. This displays the Select Displays dialog box.

2. From the Folders box, select General Signal Viewing.

3. Double-click the Spectrogram icon in the Available Displays box. This adds the Spectrogram icon
to the Selected displays box.

4. Click the OK button. This displays the spectrogram view.

5. To display a 3-D version of the spectrogram, select the 3-D checkbox.

Elements of the Spectrogram Display
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Item Display element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Spectrogram display is the optimized display.
2 Time/div Sets the length of time represented by each vertical division. Divisions are

indicated by tick marks along the left edge of the graph.
3 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its

value is italicized.
4 VBW Enables the VBW (Video Bandwidth) filter. See Setup > Settings > BW Tab

(see page 103).
5 3-D checkbox Enables and disables the 3-D view.
6 Selected records indicators Shows the positions of the start and stop records selected on the Select data

records tab. Drag the indicators to select which records will be played by
Replay All. Note that these are not visible while acquisitions are running; the
instrument must be stopped for the indicators to be visible.

7 T Trigger indicator. This icon indicates the trigger point within the current
acquisition.

8 Pos Position indicates the bottom line visible in graph. Changing this setting
scrolls the window up and down through the displayed acquisition records.

9 Autoscale Resets Vertical and Horizontal scale and Pos to default values.
10 CF Sets the Center Frequency.
11 Span Sets the span of the spectrogram display.
12 Current data record indicator A blue line indicates the current data record. When the analysis length is

short, the blue line appears as a thin line much like the selected indicator
line. When the analysis length is relatively long, the blue line appears more
like a blue bar.

13 Position scroll bar Changes the position of the trace in the window. Changing the position scroll
bar is the same as adjusting the Pos setting.

RSA6100A Series Real-Time Spectrum Analyzers Help 83



General Signal Viewing > Spectrogram Spectrogram Display

Item Display element Description
14 Selected indicator This inverse-colored line indicates the Spectrogram line that will appear in

the Spectrum display when the Spectrogram trace is enabled. This line is
attached to the selected marker.

15 Clear Clears the spectrogram display; however, data records in acquisition history
remain in memory and are available for replay. To clear memory, select File >
Acquisition Data Info > Delete All Data.

16 Marker indicators These icons indicate the position of markers in the spectrogram. You can
move markers by dragging the desired marker indicator.

17 Detection setting Displays the selected Detection method (see Settings > Trace (see page 85)
tab).

18 Marker readout Marker readout for the selected marker. In the Spectrogram display, the
marker readout includes a date and timestamp. The time is displayed
in a 24-hour format. The timestamp readout can be shown or hidden
independently of the other marker readouts (see Settings > Prefs (see
page 106)).

19 Time Scale status readout Three readouts can appear here depending on settings: Time/update,
Spectrums/line, and Overlap. See Time Scale Status Readout (see page 84).

xxx

Time Scale Status Readout
Three types of readouts can appear in the display depending on settings:

Time/update – Displays minutes:seconds when Spectrum Monitor is selected in the Settings > Time
& Freq Scale tab in the Vertical (Time) section.

Spectrums/line – Displays an integer number when vertical scale is Normal and each line contains the
results from one or more frequency transforms (whether zoomed out or not).

Overlap – Displays the overlap percentage when vertical scale is Normal and each line’s transform
shares some points with the transforms of lines before and after it (zoomed in). Overlap can only be
done when the Analysis Length > 2x RBW frame length.

The Spectrogram can show results from one or multiple acquisitions and it can show one or multiple
lines for each acquisition.

Changing the Spectrogram Display Settings (see page 85)
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Spectrogram Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Setup settings for the Spectrogram display are visible when Spectrogram is the selected display.

Settings tab Description
Freq & Span (see page 98) Sets frequency and span parameters for the Spectrogram display.
BW (see page 103) Sets Resolution Bandwidth and windowing parameters.
Trace (see page 85) Sets Trace display parameters.
Amplitude Scale (see page 86) Selects between 2-D and 3-D, sets height scale, position and orientation for 3-D display.

Sets color parameters for the spectrogram trace.
Time & Freq Scale (see
page 86)

Sets the vertical and horizontal scale parameters for the spectrogram trace. The
Spectrum Monitor controls are also on this tab.

Prefs (see page 106) Specifies whether or not certain display elements are shown.
xxx

Trace Tab
The Spectrogram Trace tab controls let you specify the Detection method, save traces, and recall saved
traces for display. The Spectrogram Trace tab does not have all the controls that other Trace tabs contain,
however, it does have a unique display element, the Selected Line readout. For details on Detection,
Freeze, and saving and recalling traces, see the Traces Tab (see page 99).

Selected Line
Displays the time at the Selected Line. If Markers are enabled, the selected line is positioned by the
selected marker. If no markers are enabled, the selected line is the first line in the current analysis period.
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Amplitude Scale Tab
The Amplitude Scale tab allows you to change the vertical and horizontal scale settings, enable the 3-D
Waterfall display, and set the color scheme used for the spectrogram trace.

Setting Description
Height (3-D only)

Scale Changes the vertical scale for trace Amplitude in the graph (not the vertical scale for
Time).

Position Specifies the level displayed at the bottom edge of the graph. (Bottom front edge in
the 3-D view).

Autoscale Adjusts the vertical position and scale of the trace lines to bring them into the visible
portion of the graph.

3–D Waterfall Displays the spectrogram in a 3-D format.
Northeast Shifts the perspective of the 3-D graph so that the oldest traces move back and to the

right.
Northwest Shifts the perspective of the 3-D graph so that the oldest traces move back and to the left.
Reset Scale Resets the Height and Color settings to their default values.
Color (Power)

Color Displays a drop-down list that allows you to set the color scheme used for the
spectrogram trace.

Max Sets the maximum power level represented by the top of the color scale.
Min Sets the minimum power level represented by the bottom of the color scale.

xxx

Time & Freq Scale Tab
The Time and Freq Scale tab allows you to change the vertical and horizontal scale settings, enable the 3-D
Waterfall display, and set the color scheme used for the spectrogram trace.
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Setting Description
Vertical (Time)

Normal For most Spectrogram applications. Primary time scale control is Time/div. Time scale
can be zoomed in or out.

Spectrum Monitor For long-term signal monitoring applications. In spectrum monitor mode, each line in the
spectrogram represents the period of time specified by the Time/update parameter. Time
scale can be zoomed out, but not zoomed in (no overlap).

Time/update Sets the time, in minutes and seconds, represented by each line of the spectrogram.
Only available in Spectrum Monitor.

Reset Scale Resets the Time/div and Pos settings to their default values.
Autoscale Scales the vertical (time) axis to compress all existing trace lines into the visible area

of the graph. Resets the Position value to zero, placing the most recent spectrogram
line at the bottom of the spectrogram display. Only Position is affected by Autoscale
when Spectrum Monitor is selected.

Time/div Sets the time displayed per division.
Visible elapsed time Displays the length of time visible in the display. This does not represent the total time

available to view.
Position Adjusts vertical position of the trace within the graph area. Setting represents the offset,

in divisions, between the bottom of the graph and the bottom (most recent) line in the
results trace.

Time at position Displays the time of the spectrogram line shown at the bottom of the graph. This time is
relative to the Time Zero Reference of the current acquisition.

Horizontal (Frequency)
Scale Sets the frequency range of the graph without changing the Span value.
Position Sets the frequency displayed at the center of the graph. Changing this value does not

change the Freq setting.
Autoscale Sets the frequency scale to the Spectrogram Span value.
xxx

Spectrum Monitor
Spectrum Monitor performs long term monitoring. The monitor mode compresses time into each line
of the spectrogram, which enables you to monitor long periods of time (from 1 second per line up to
600 minutes per line). With extended memory (Option 02) installed in the instrument, you can capture up
to 125,000 lines. With standard memory installed in the instrument, the maximum number of lines you
can capture is 31,250.

During each line’s collection period, spectrum transforms are computed for each acquisition taken by the
instrument. As each transform completes, it is incorporated into the current spectrogram line. How each
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line of the spectrogram is created in spectrum monitor mode depends on the detection setting (Settings >
Trace). For example, if Detection is set to +Peak, each spectrogram line is effectively a peak hold display
of all the spectral data captured since the prior line.
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Amplitude Vs Time Display
The Amplitude vs. Time display plots the signal amplitude against time. The amplitude appears on the
vertical axis while time is plotted along the horizontal axis.

Note that the trace(s) in the Amplitude vs. Time display can be set to a maximum of 100,000 points
(however, the actual number of trace points can extend up to 1,000,000 points if Max trace points is set
to Never Decimate). If the Analysis Length includes more than the selected Max trace points value, the
trace is decimated (using the method specified with the Detection control) to be equal to or less than the
Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or
undecimated) trace is what is used for marker measurements and for results export. You can set the Max
trace points on the Settings > Prefs tab.

To show Amplitude vs. Time display:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select General Signal Viewing in the Folders box.

3. In the Available displays box, double-click the Amplitude vs. Time icon or select the icon and click
Add. The Amplitude vs. Time icon will appear in the Selected displays box and will no longer
appear under Available displays.

4. Click OK.

Elements of the Display
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Item Display element Description
1 Vert Offset Adjusts the vertical display offset.
2 Vertical scale adjustment Adjusts the vertical scaling.
3 Span Adjust the bandwidth of the data to be analyzed. (Not the period of time

shown in the display.)
4 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
5 Offset Adjust the horizontal offset.
6 Max and Min readouts Displays the maximum and minimum amplitudes, as well as when those

values occur.
7 Scale Sets the time spanned by the graph.
8 Clear button Restarts multi-trace functions (Avg, Hold).
9 Trace function Displays the current trace function setting (Settings > Trace tab > Function).
xxx

Reference. Changing Amplitude vs Time Display Settings (see page 90)

Amplitude Vs Time Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The settings for the Amplitude vs. Time display are shown in the following table.

Settings tab Description
BW (see page 91) Sets the Bandwidth Method used for setting the measurement bandwidth.
Traces (see page 99) Allows you to select the type of trace to display and their functions.
Traces (Math) (see page 103) Sets the traces used to create the Math trace.
Scale (see page 105) Sets the vertical and horizontal scale parameters.
Prefs (see page 106) Specifies whether certain display elements are visible.
xxx
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BW Tab
The BW (Bandwidth) tab allows you to specify the Bandwidth Method used for setting measurement
bandwidth. This determines what Acq BW the measurement will request.

Settings Description
Span The frequency span used for analysis in the Amplitude vs. Time display. If the spectrum

display is open, the span is automatically set to the analyzer bandwidth.
Time-domain Bandwidth Time-domain Bandwidth is a filter used to process the input signal before the acquisition

system analyzes the signal.
xxx
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Frequency Vs Time Display
The Frequency vs. Time Display shows how the signal frequency varies with time.

Note that the trace(s) in the Frequency vs. Time display can be set to a maximum of 100,000 points
(however, the actual number of trace points can extend up to 1,000,000 points if Max trace points is set
to Never Decimate). If the Analysis Length includes more than the selected Max trace points value, the
trace is decimated (using the method specified with the Detection control) to be equal to or less than the
Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or
undecimated) trace is what is used for marker measurements and for results export. You can set the Max
trace points on the Settings > Prefs tab.

To display the Frequency vs. Time Display:

1. Select the Displays button or Setup > Displays.

2. In the Select Displays dialog, select General Signal Viewing in the Folders box.

3. In the Available displays box, double-click the Frequency vs. Time icon or select the icon and click
Add. The Frequency vs. Time icon will appear in the Selected displays box and will no longer
appear under Available displays.

4. Click OK to display the Freq vs. Time display.

Elements of the Display
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Item Display element Description
1 Top of graph adjustment Use the knob to adjust the frequency range displayed on the vertical axis.
2 Offset adjustment Adjusts the frequency shown at the center of the display.
3 Autoscale button Adjusts the offset and range for both vertical and horizontal to provide the

best display.
4 Maximum and Minimum

frequency readouts
Displays the maximum and minimum values, as well as when those values
occur.

5 Horizontal Scale Sets the time spanned by the graph.
6 Clear button Restarts Average trace.
7 Trace function Displays the current trace function setting (Settings > Trace > Function).
xxx

Changing Frequency vs Time Display Settings (see page 93)

Frequency Vs Time Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Setup settings for Frequency vs. Time are shown in the following table.

Settings tab Description
Freq & Span (see page 98) Sets the frequency and span parameters.
Trace (see page 99) Sets the trace display parameters.
Scale (see page 105) Sets the Vertical and Horizontal scale and offset parameters.
Prefs (see page 106) Specifies whether certain display elements are visible.
xxx
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Phase Vs Time Display
The Phase vs. Time display plots the signal phase against time. The phase appears on the vertical axis
while time is plotted along the horizontal axis.

Note that the trace(s) in the Phase vs. Time display can be set to a maximum of 100,000 points (however,
the actual number of trace points can extend up to 1,000,000 points if Max trace points is set to Never
Decimate). If the Analysis Length includes more than the selected Max trace points value, the trace is
decimated (using the method specified with the Detection control) to be equal to or less than the Max trace
points setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated)
trace is what is used for marker measurements and for results export. You can set the Max trace points
on the Settings > Prefs tab.

To display Phase vs. Time:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select General Signal Viewing in the Folders box.

3. In the Available displays box, double-click the Phase vs. Time icon or select the icon and click
Add. The Phase vs. Time icon will appear in the Selected displays box and will no longer appear
under Available displays.

4. Click OK to show the Phase vs. Time display.

Elements of the Display
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Item Display element Description
1 Top of graph adjustment Adjusts the vertical scale. Use the knob to adjust the value of the top of the

graph.
2 Vertical offset adjustment Adjusts the phase error shown at the vertical center of the display.
3 Autoscale button Adjusts the vertical and horizontal settings so that the entire trace fits in the

view.
4 Horizontal Offset Adjusts the horizontal position of the trace.
5 Max and Min readouts Displays the maximum and minimum value of the phase error within the

analysis times and the times at which they occurred.
6 Horizontal Scale Sets the time spanned by the graph.
7 Clear button Restarts multi-trace functions (Avg, Hold).
8 Trace function Shows the trace function as set on the Settings > Trace tab.
xxx

Changing the Phase vs Time Display Settings (see page 95)

Phase Vs Time Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The settings for the Phase vs. Time display are shown in the following table.

Settings tab Description
Freq & Span (see page 98) Sets the frequency and span parameters.
Trace (see page 99) Sets the trace display parameters.
Scale (see page 105) Sets the Vertical and Horizontal scale and offset parameters.
Prefs (see page 106) Specifies whether certain display elements are visible.
xxx
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RF I & Q vs Time Display
This is a plot of the baseband In-Phase (I) and Quadrature (Q) components of a modulated carrier. The plot
is in the time domain, with I and/or Q values the Y-axis.

Note that the trace(s) in the RF I & Q vs. Time display can be set to a maximum of 100,000 points
(however, the actual number of trace points can extend up to 1,000,000 points if Max trace points is set
to Never Decimate). If the Analysis Length includes more than the selected Max trace points value, the
trace is decimated (using the method specified with the Detection control) to be equal to or less than the
Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or
undecimated) trace is what is used for marker measurements and for results export. You can set the Max
trace points on the Settings > Prefs tab.

To display an RF I & Q vs. Time display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select General Signal Viewing.

3. Double-click the RF I&Q vs. Time icon in the Available Displays box. This adds the RF I & Q vs.
Time icon to the Selected displays box.

4. Click the OK button.

Elements of the Display
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Item Display element Description
1 Top of Graph adjustment Use the knob to adjust the vertical scaling.
2 Vertical offset adjustment Adjusts the level shown at the center of the display.
3 Autoscale button Adjusts the offset and scale for both vertical and horizontal to provide the

best display.
4 Maximum and Minimum level

readouts
Displays the maximum and minimum values, within the Analysis Time, as well
as the times at which they occurred.

5 Scale Sets the time spanned by the graph.
6 Clear button Restarts multi-trace functions (Avg, Hold).
7 Trace function Displays the current trace function setting (Settings > Trace > Function). If the

traces are averaged, the number of averages is displayed.
8 Trace Control Selects which trace is displayed (using the drop-down list) and which trace is

active (click on the trace name to display a menu).
xxx

Changing the RF I & Q vs Time Display Settings (see page 97)

RF I & Q vs Time Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Setup settings for RF I&Q vs. Time are shown in the following table.

Settings tab Description
Freq & Span (see page 98) Sets the frequency and span parameters.
Trace (see page 99) Sets the trace display parameters.
Scale (see page 105) Sets the Vertical and Horizontal scale and offset parameters.
Prefs (see page 106) Specifies whether certain display elements are visible.
xxx
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General Signal Viewing Shared Measurement
Settings

General Signal Viewing Shared Measurement Settings
The control panel tabs in this section are identical or very similar for each of the displays in the General
Signal Viewing folder (Setup > Displays). Some tabs are shared by all the displays, some tabs are shared
by only a couple of displays.

For some tabs, the control values are shared across all the General Signal Viewing displays. For other
control values, each display has unique values for the controls. Details are provided for the specific tabs.

Common controls for general signal viewing displays
Settings tab Description
Freq & Span (see page 98) Sets the frequency and span parameters.
Trace (see page 99) Sets the trace display parameters.
Traces – Math (see page 103) Sets the traces used to create the Math trace.
BW (see page 103) Sets the Bandwidth Method used for setting the measurement bandwidth.
Scale (see page 105) Sets the Vertical and Horizontal scale and offset parameters.
Prefs (see page 106) Specifies whether certain display elements are visible.
xxx

Freq & Span Tab
The Freq & Span tab provides access to settings that control frequency settings for the trace display. The
control values set in this tab are shared by all the General Signal Viewing displays.
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Traces Tab

Setting Description
Center The frequency at the center of the selected Span.
Start The lowest frequency in the span.
Stop The highest frequency in the span.
Step Size Sets the increment/decrement size for Center, Start and Stop values.
Span The difference between the start and stop frequencies. This is the measurement

bandwidth for the general signal viewing displays.
Dwell time (DPX Spectrum
display only)

The amount of time the DPX sweep remains in a frequency segment collecting data
and updating the bitmap and traces before moving on to the next higher frequency
segment. The minimum Dwell Time setting is 50 ms, the normal update rate for DPX
computations. Maximum Dwell Time per frequency segment is 100 s. The number of
frequency segments and their start/stop frequencies are internally determined based on
span, acquisition bandwidth, RBW and other parameters.

Max Span Sets the Span to the maximum value.
xxx

Center, Start, Stop, and Span Frequencies Are Correlated
Changing the values for Center frequency, Start frequency, Stop frequency or Span will change the values
for the other settings, depending on which setting you change. For example, if you change the Center
frequency, the Start and Stop frequencies will be adjusted automatically to maintain the same Span.

Note however that if the Start and Stop frequencies are changed so that they are closer than the minimum
span setting, the Start and Stop frequencies will be adjusted to maintain the minimum Span setting.

Setting Changed Manually Settings Changed Automatically As
a Result

Setting Not Automatically Changed

Start Center, Span Stop
Stop Center, Span Start
Center Start, Stop Span
Span Start, Stop Center
xxx

Traces Tab
The Traces Tab allows you to set the display characteristics of displayed traces.
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Traces Tab

Setting Description
Trace Selects a trace. (This setting is not present for every display.)
Show Shows / hides the selected trace.
Detection Sets the Detection method used for the trace. Not available for saved traces. Available

detection methods are +Peak, -Peak, +/-Peak, Avg (VRMS), Sample, CISPR Avg, CISPR
Pk, and CISPR QPk. Not all detection methods are available in all displays.

Function Selects the trace processing method. Available settings are: Normal, Average, Max
Hold, and Min Hold.

Count Sets the number of traces averaged to generate the displayed trace. (Present only when
Function is set to Average, Min Hold, or Max Hold.)

Freeze Halts updates to the selected trace.
Save Trace As Saves the selected trace to a file for later recall and analysis.
Show Recalled trace Displays a saved trace instead of a live trace.
xxx

Trace
Available traces for Spectrum are: Trace 1, Trace 2, Trace 3, Math, and Spectrogram. Other displays
support fewer traces. Traces 1-3 are based on the input signal and enable you to display the input signal
using different processing. For example, you could display Trace 1 with Function set to Normal, Trace 2
with Function set to Max Hold and Trace 3 with Function set to Min Hold.

The Math trace is the result of subtracting one trace from another.

The Spectrogram trace applies only to the Spectrum display and is available only if the Spectrogram
display is shown. The Spectrogram trace shows the trace selected in the Spectrogram as a spectrum trace.

Detection
Trace Detection is used to reduce the results of a measurement to the desired number of trace points. For
example, if the maximum number of trace points is 100,000, and a measurement over the selected analysis
length yields 200,000 points, the measurement must decimate these 200,000 trace points by 2 to prevent
exceeding the 100,000 trace point limit. Since only one value can be represented for each trace point, an
algorithm must be used to select (detect) the appropriate value to use.

The results array from an analysis can be detected (or “decimated”) in a variety of ways. The number
of results points produced for each trace point varies with both analysis length and trace length. For
example, the frequency transform used for the Spectrum display produces just one output value for each
desired trace point. In this case, the detection method chosen has no effect, as no decimation is required.
Increasing the Analysis Length (or for the Spectrum display, the Spectrum Length), causes the available
detection method’s output traces to differ from each other because they have a larger set of samples for the
various detection methods to process.

The available detection methods (depending on the display) are:

+Peak – The highest value is selected from the results to be compressed into a trace point.

-Peak – The lowest value is selected from the results to be compressed into a trace point.
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Traces Tab

+/-Peak – Both the highest and lowest values are selected from the results to be compressed into a
trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the results values it includes. When displayed in either linear (Volts, Watts) or Log (dB,
dBm), the correct RMS value results.

Sample – The first value is selected from the set of results to be compressed into a trace point.

CISPR Peak – The trace value is calculated by the methods described for peak detectors in the
CISPR documents.

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Multiple traces are averaged together to generate the displayed trace, which will contain just
one vertical value for each underlying frequency data point. Once the specified number of traces have
been acquired and averaged to generate the displayed trace, additional traces contribute to the running
average, except in Single Sequence run mode. In the case of Single Sequence, the instrument stops
running after the specified number of traces have been averaged together. The Number of Traces
setting specifies how many traces are averaged. The averaging is performed on the linear (Voltage)
values, resulting in the correct RMS average).

Max Hold - Displays the maximum value in the trace record for each display point. Each new trace’s
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Min Hold - Displays the minimum value in the trace record for each display point. Each new trace’s
display point is compared to the previous minimum value and the lesser value is retained for display
and subsequent comparisons.

Saving Traces
To save a trace for later analysis:

1. Select the Save TraceAs button. This displays the Save As dialog box.
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2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box.

3. Click the ... button to display the Open dialog box.

4. Navigate to the desired file and click Open.

5. Check the Show Recalled Trace check box.

6. Verify that the trace’s Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).
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Traces Tab – Math Trace
This tab is not a distinct tab, it is just how the Traces tab appears when Math is selected in the Traces
drop-down list.

Trace 4 is a mathematically-derived trace defined as Trace A minus Trace B. You can select Trace 1, 2, or
3 to serve as either Trace A or Trace B.

Setting Description
Trace When set to Trace 4 (Math), this tab is displayed.
Show Shows / hides the selected trace.
Freeze Halts updates to the selected trace.
Save Trace As... Saves the selected trace to a file for later recall and analysis.
Trace minus Trace Selects which traces serve as Trace A and Trace B.
xxx

BW Tab
The BW (bandwidth) tab allows you to change Resolution Bandwidth and Video Bandwidth settings, and
set the windowing method used by the transform process by selecting a filter shape.
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Setting Description
RBW Sets the Resolution Bandwidth value to be used in the spectrum analysis view. The

value is italicized when Auto is selected.
Auto When Auto is checked, the RBW is calculated as a percentage of the Span. Kaiser is

selected as the windowing method. When Auto is unchecked, the RBW is set by the user.
Selecting any Window other than Kaiser changes the RBW setting to manual.

Span/RBW ratio If Auto is checked, this value is used to calculate the RBW. If Auto is unchecked, this
setting is not selectable.

Filter Shape Specifies the windowing method used for the transform (when Auto is unchecked).
(Spectrum and Spectrogram displays only.)

VBW Adjusts the VBW (Video Bandwidth) value. (Spectrum and Spectrogram displays only.)
xxx

Filter Shape Settings
In the analyzer, computationally efficient discrete Fourier transform algorithms such as FFT (Fast Fourier
Transform) or CZT (Chirp-Z Transform) are generally employed to transform time-domain signals into
frequency-domain spectra. There is an assumption inherent in the mathematics of Discrete Fourier
Transforms that the data to be processed is a single period of a periodically repeating signal. The
discontinuities between successive frames will generally occur when the periodic extension is made to the
signal. These artificial discontinuities generate spurious responses not present in the original signal, which
can make it impossible to detect small signals in the presence of nearby large ones. This phenomenon is
called spectral leakage.

Applying a filter, such as Kaiser, to the signal to be transformed is an effective method to combat the
spectral leakage problem. Generally the filter has a bell shape. Multiplying the transform frame by the
filter function eliminates or reduces the discontinuities at the ends of the frame, however, at the expense of
increased RBW.

Filter Shape Characteristics
The choice of filter shape depends on its frequency response characteristics such as side-lobe level,
equivalent noise bandwidth and maximum amplitude error. Use the following guidelines to select the
best filter shape.

Filter Shape Characteristics
Kaiser (RBW) Best side-lobe level, shape factor closest to the traditional Gaussian RBW.
-6dB RBW (MIL) These filters are specified for bandwidth at their -6 dB point, as required by military

EMI regulations.
CISPR These filters comply with the requirements specified in the P-CISPR 16 -1-1 document

for EMI measurements.
Blackman-Harris 4B Good side-lobe level.
Uniform (None) Best frequency resolution, poor side-lobe level and amplitude accuracy.
FlatTop Best amplitude accuracy, best representation of brief events captured near the beginning

or end of the time-domain data frame, poor frequency resolution.
Hanning Good frequency resolution, high side-lobe roll-off rate.
xxx
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VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the RBW
setting. VBW is disabled when the Filter shape is set to CISPR.

NOTE. If you are following a procedure that says to "set VBW to three times the RBW value or greater", it
means that the test should be conducted with no VBW effects. In the RSA6100A, this condition is met by
disabling the VBW function.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

The Scale tab values are unique to each display. Also, note that each display uses horizontal and vertical
units that are appropriate for the display. For example, for the Spectrum display uses power (dBm) units
and frequency (Hz) units; the Amplitude vs. Time display uses power (dBm) and time (seconds) units; and
the Phase vs. Time display uses phase (degrees) and time (seconds) units.

Setting Description
Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale.
Offset Vertical Offset adjusts the reference level away from top of the graph.
Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.
Scale Sets the period of time shown in the graph.
Offset Allows you to pan a zoomed trace.
Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Reset Scale Resets all settings to their default values.
xxx
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Prefs Tab
The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display, but include such items as enabling/disabling Marker
Readout, switching the Graticule display on/off, and Marker Noise mode.

Each of the General Signal Viewing displays maintains its own separate values for the controls that appear
on the Prefs tab. Some parameters appear with most displays while others appear with only one display.
For example, the Show Marker readout in graph check box appears in the Prefs tab for every display.
However, the Show Power Trigger level check box only appears on the Amplitude vs Time Prefs tab.

The following table explains the controls that can appear on the Prefs tab.

Setting Description
Show: Selects the horizontal settings that appear below the graph area. You can choose Start,

Stop or Center, Span.
Max trace points Sets the number of trace points used for marker measurements and for results export.
Show trace legend Enables display of a legend in the measurements area that shows the Detection method

and Function setting for displayed traces. The color of the legend text matches the color
of the associated trace.

Show graticule Select to display or hide the graticule.
Show Parameter Readouts For the DPX Spectrum display, enables/disables the display of DPX parameters. The

parameters readout shows 100% Probability of Intercept, Transforms/s, and FFT Points.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show timestamp in graph
(selected line)

For spectrogram displays, this readout shows or hides the timestamp associated with the
selected line or marker position.

Show Power Trigger Level Displays or hides a green line in the graph that indicates the level at which the power
trigger is set. The line is not displayed if Trigger is set to Free Run.

Marker Noise mode Select to enable or disable the Marker Noise mode. Use this mode to measure noise on
the trace. See Using Noise Markers in the Spectrum Display (see page 288).

xxx

Show Parameter Readouts (DPX Spectrum Only)
The elements of the Show Parameter Readouts are:

100% POI – This is the minimum event duration required to ensure 100% Probability of Intercept or
event capture. This duration depends on interaction between span, RBW, and FFT length. You can
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use the POI time value to determine if you are at risk of either missing a narrow transient or of its
captured amplitude being less than the actual signal.

Minimum signal duration vs. RBW, option 200

Span RBW (kHz) FFT length Spectrums/s
Minimum signal duration for
100% POI, μs

1000 1024 292,969 5.8
300 2048 146,484 14.8
100 4096 73,242 37.7

30 16,384 18,311 134.8

110 MHz

20 32,768 9,155 229.5
1000 1,024 292,969 5.8

300 1,024 292,969 11.4
100 2,048 146,484 30.9

30 4,096 73,242 107.4
20 8,192 36,621 147.4

40 MHz

10 16,384 18,311 294.8
xxx

Transforms/s – This is the number of transforms/second being performed by the DPX engine.
It is a function of the selected resolution bandwidth and number of trace points. The desired
RBW determines the number of points required in each transform, which alters the transform rate.
Additionally, the selected trace length may place requirements on the number of points required in
the transform independent of the selected resolution bandwidth.

FFT Points – The approximate number of points in the FFT of the input signal. FFT points provides
an indication of frequency resolution, but it is not an exact measurement. Note that higher numbers
for FFT points mean that the instrument is taking a longer string of input samples for each FFT,
which decreases the time resolution.

Minimum FFT length versus trace length (independent of span and RBW), Option 200
Trace length (points) Minimum FFT length
801 1,024
2,401 4,096
4,001 8,192
10,401 16,384
xxx
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Overview
The displays in the Analog Modulation folder (Displays > Folders > Analog Modulation) are:

AM

FM

PM

The Analog Modulation displays provide measurements and time-domain trace displays.
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AM Display
The Amplitude Modulation Display is a graph of Modulation Factor vs Time. The AM display includes
three numeric readouts.

To show the AM display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select Analog Modulation.

3. Double-click the AM icon in the Available Displays box. This adds the AM icon to the Selected
displays box.

4. Click the OK button. This shows the AM display.

Elements of the Display
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Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the AM display is the optimized display.
2 Top of Graph Sets the %AM indicated at the top of the graph by increasing or decreasing

the vertical scale. Changing the top value affects the bottom of graph value
because the graph scales about vertical center. Also, note that the top of
graph setting interacts with the internal vertical scale setting (which is not
user settable).

3 Position Specifies the %AM shown at the center of the graph display.
4 Bottom Readout Displays the value of the modulation factor shown at the bottom of graph.
5 Measurement readouts Displays numeric values for the +AM (positive modulation factor), –AM

(negative modulation factor), and Total AM.
6 Position Specifies the horizontal position of the trace on the graph display.
7 Scale Adjusts the horizontal range of the graph. By decreasing the scale (time

across the entire graph), the graph essentially becomes a window that you
can move over the trace by adjusting the position.

8 Clear Erases the trace from the graph.
9 Trace Detection readout Displays the Settings > Trace > Detection setting.
xxx

Changing the AM Settings (see page 110)

AM Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The AM Settings control panel provides access to settings that control parameters of the AM Display.

Setting Description
Parameters (see page 111) Sets the Carrier Amplitude Detection method. You can choose either Average or Median.
Trace (see page 112) Sets Trace display parameters.
Scale (see page 114) Sets vertical and horizontal scale and position parameters.
Prefs (see page 115) Specifies whether or not certain display elements are shown. Specifies the maximum

number of points shown in the display graph.
xxx
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Parameters Tab
The Parameters tab enables you to specify two parameters that control the carrier amplitude detection.

Setting Description
Average Selects the Average method for computing the average baseline for measurements.
Median Selects the Median method for computing the average baseline for measurements.
Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.
xxx

AM Modulation
An amplitude modulated carrier can be described mathematically by:

A, in the above equation, represents the carrier amplitude, a(t) represents the time-varying modulation
and ω0 represents the carrier frequency.

The signal modulation envelope is given by:

There are several ways to express the AM modulation depth, expressed as a percentage.

Peak method

Trough Method

Max-Min Method

In each case, the value of the carrier amplitude, A, needs to be estimated from the input signal.

The instrument represents signals in a sampled form. The sampled envelope can be expressed as a function
of sample index K and sampling period T as:

The instrument allows the choice of two methods for estimating the carrier amplitude:
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Average Method

Median Method

In both cases, the instrument computes the average and the median over the analysis period. It should be
noted that the two methods give the same result for sinusoidal modulation where the sampling frequency
is much higher than the modulation frequency.

Trace Tab
The Trace Tab allows you to set the display characteristics of a trace.

Setting Description
Show Shows/hides the trace. If the instrument continues to run, the measurement results below

the graph display continue to update even if the trace is hidden.
Detection Sets the Detection method used for the trace. Available detection methods are +Peak,

-Peak, and Avg (VRMS). Not available for saved traces.
Function Selects the trace processing method. The only available setting is Normal.
Freeze Halts updates to the trace.
Save Trace As Saves the trace to a file for later recall and analysis.
Show recalled trace Displays a saved trace instead of a live trace.
xxx

Detection
Detection refers to the method of processing the data acquisition points when creating a trace. The IQ
samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to
each trace point varies with both analysis length and trace length. For example, with Spectrum Length set
to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak,
and Avg (VRMS) are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods are:
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+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Trace Processing
Traces can be processed to display in different ways. The Detection setting controls trace decimation,
when needed. When the trace points each cover more than one sample data point, the vertical results
values for multiple data points are combined into each trace point. Each trace point ends up with a single
vertical value.

Average - Each trace point is computed by averaging together the multiple results points it represents.

+Peak - Each trace point represents the highest vertical value among the results it includes.

–Peak - Each trace point represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.
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Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.

3. Check the Show Recalled Trace check box.

4. Verify that the Show check box is selected.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description
Vertical

Scale Changes the range shown between the top and bottom of the graph.
Position Adjusts the level shown at the center of the graph.
Autoscale Resets the Position so that the entire trace is in the graph.

Horizontal
Scale Changes the range shown between the left and right sides of the graph.
Position Adjusts the position of the acquisition record shown at the left edge of the graph.
Autoscale Resets the Scale and Position settings to provide the optimum display.

xxx
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Prefs Tab
The Prefs tab enables you to change appearance characteristics of the AM display.

Setting Description
Show graticule Shows or hides the graticule.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the AM display can be set to a maximum of 100,000 points (however, the
actual number of trace points can extend up to 500,000 points if Max trace points is
set to Never Decimate). If the Analysis Length includes more than the selected Max
trace points value, the trace is decimated (using the method specified with the Detection
control) to be equal to or less than the Max trace points setting (except when Max trace
points is set to Never Decimate). This decimated (or undecimated) trace is what is used
for marker measurements and for results export.

xxx
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FM Display
The Frequency Modulation Display shows Frequency Deviation vs. Time. The vertical axis units are
Hertz and the horizontal axis units are seconds. When taking measurements, only the first burst in the
Analysis period is analyzed. No trace points are shown for data outside the first detected burst, nor are
measurements made on data outside the first detected burst.

To show the FM display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select Analog Modulation.

3. Double-click the FM icon in the Available Displays box. This adds the FM icon to the Selected
displays box.

4. Click the OK button. This shows the FM display.

Elements of the Display
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Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the FM display is the optimized display.
2 Top of Graph control Sets the frequency indicated at the top of the graph. Since the Position value

at the vertical center of this graph remains constant as the Top of Graph value
is adjusted, the Vertical Scale increases as the Top of Graph value increases,
which also affects the bottom of graph readout. Vertical Scale can also be
controlled from the Settings control panel’s Scale tab.

3 Position Specifies the frequency shown at the center of the graph display. Changing
this value moves the trace up and down in the graph, which affects the Top of
Graph and Bottom of Graph values as well.

4 Bottom of Graph Readout Displays the frequency value at the bottom of the graph.
5 Measurement readouts Displays numeric values for the +Pk (positive frequency deviation), –Pk

(negative frequency deviation), RMS (RMS value of the deviation), Pk-Pk
(peak-to-peak frequency deviation), and Pk-Pk/2 (peak-to-peak frequency
deviation divided by two).

6 Position Specifies the horizontal position of the trace on the graph display.
7 Scale Adjusts the time range of the graph. By decreasing the scale (full-scale time

over 10 divisions), the graph essentially becomes a window that you can
move over the acquisition record by adjusting the horizontal position.

8 Clear Clears the trace and numeric measurement results.
9 Trace Detection readout Displays the Settings > Trace > Detection setting.
10 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq

Error, it shows the difference between the instrument Frequency setting and
the measured value of the signal’s carrier frequency. When it displays Freq
Offset, it shows the frequency offset specified on the Settings > Parameters
tab. If Freq Error is displayed, it also indicates that the Carrier frequency
detection setting is Auto. If Freq Offset is displayed, it indicates that the
Carrier frequency detection setting is manual.

xxx

Changing the FM Settings (see page 118)
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FM Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The FM Settings control panel provides access to settings that control parameters of the FM Display.

Setting Description
Parameters (see page 119) Sets the burst detection threshold, measurement bandwidth, and carrier frequency

detection method.
Trace (see page 120) Sets Trace display parameters.
Scale (see page 122) Sets vertical and horizontal scale and position parameters.
Prefs (see page 123) Specifies whether or not certain display elements are shown. Specifies the maximum

number of points shown in the display graph.
xxx
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Parameters Tab
The Parameters tab enables you to specify parameters for carrier detection.

Setting Description
Burst detect threshold This parameter specifies the power level used to determine whether a burst is present.

A valid burst is required to take measurements. The burst detected first is used for
the analysis. The units for burst detect threshold are dBc, relative to the maximum
acquisition sample data points level.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.
Frequency offset Displays the carrier signal’s offset from the instrument’s measurement frequency. Auto is

used to select the method for determining the carrier frequency. When Auto is selected,
the instrument determines the carrier frequency by analyzing the signal. When Auto is
deselected, you can set the carrier frequency offset using Frequency Offset.

Load from Marker Pressing this button sets the frequency offset to the frequency offset of the selected
marker. (Pressing this button automatically deselects Auto.)

xxx

Frequency Offset
In Auto (Auto is selected), the instrument scans the measurement bandwidth about the measurement
frequency and looks for the highest-powered signal. This is defined as the carrier frequency. In Manual
(Auto is deselected), the carrier frequency is specified by adding/subtracting the specified Frequency offset
from the measurement frequency. Range: -(Measurement BW*1.1)/2 to +(Measurement BW*1.1)/2. If
the Load Δ from marker button is pressed, the frequency offset is determined from the phase difference
between the two markers on screen compared to the time between the two markers. This function is useful
for removing frequency slope from the phase modulated signal.

Load from Marker
When the Auto check box is selected, the instrument scans the measurement bandwidth about the center
frequency and looks for the highest-powered signal. This is defined as the carrier frequency. When
the Auto check box is deselected, the carrier frequency is specified by adding/subtracting the specified
Frequency offset from the center frequency. Pressing the Load from marker button loads the marker
frequency into the Frequency offset box.
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Trace Tab
The Trace Tab allows you to set the display characteristics of displayed trace.

Setting Description
Show Shows / hides the trace. If the instrument continues to run, the measurement results

below the graph display continue to update even if the trace is hidden.
Detection Sets the Detection method used for the trace. Available detection methods are +Peak,

-Peak, and Avg (VRMS). Not available for saved traces.
Function Selects the trace processing method. The only available setting is Normal.
Freeze Halts updates to the trace.
Save Trace As Saves the trace to a file for later recall and analysis.
Show Recalled trace Displays a saved trace instead of a live trace.
xxx

Detection
Detection refers to the method of processing the data acquisition points when creating a trace. The IQ
samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to
each trace point varies with both analysis length and trace length. For example, with Spectrum Length set
to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak,
and Avg (VRMS) are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.
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Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Each trace point is computed by averaging together the multiple results points it represents.

+Peak - Each trace point represents the highest vertical value among the results it includes.

–Peak - Each trace point represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.

3. Check the Show Recalled Trace check box.

4. Verify that the Show check box is selected.
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Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description
Vertical

Scale Changes the range shown between the top and bottom of the graph.
Position Adjusts the frequency shown at the center of the graph.
Autoscale Resets the Position so that the entire trace fits within the graph.

Horizontal
Scale Changes the range shown between the left and right sides of the graph.
Position Adjusts the position of the acquisition record shown at the left edge of the graph.
Autoscale Resets the Scale and Position settings to provide the optimum display.

xxx
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Prefs Tab
The Prefs tab enables you to change appearance characteristics of the FM display.

Setting Description
Show graticule Shows or hides the graticule.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the FM display can be set to a maximum of 100,000 points (however, the
actual number of trace points can extend up to 500,000 points if Max trace points is
set to Never Decimate). If the Analysis Length includes more than the selected Max
trace points value, the trace is decimated (using the method specified with the Detection
control) to be equal to or less than the Max trace points setting (except when Max trace
points is set to Never Decimate). This decimated (or undecimated) trace is what is used
for marker measurements and for results export.

xxx
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PM Display
The Phase Modulation Display shows Phase vs. Time. The vertical axis units are degrees and the
horizontal axis units are seconds. When taking measurements, only the first burst in the Analysis period is
analyzed. No trace points are shown for data outside the first detected burst, nor are measurements made
on data outside the first detected burst.

Elements of the Display
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Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the PM display is the optimized display.
2 Top of Graph control Sets the phase value indicated at the top of the graph. Since the Position

value at the vertical center of this graph remains constant as the Top of Graph
value is adjusted, the Vertical Scale increases as the Top of Graph value
increases, which also affects the bottom of graph readout. Vertical Scale can
also be controlled from the Settings control panel’s Scale tab.

3 Position Specifies the phase shown at the center of the graph display. Changing this
value moves the trace up and down in the graph, which affects the Top of
Graph and Bottom of Graph values as well.

4 Bottom of Graph Readout Displays the phase value at the bottom of the graph.
5 Measurement readouts Displays numeric values for the +Pk (positive phase deviation), –Pk (negative

phase deviation), Pk-Pk (peak-to-peak phase deviation), and RMS (RMS
value of the phase deviation).

6 Position Specifies the horizontal position of the trace on the graph display.
7 Scale Adjusts the time range of the graph. By decreasing the scale (full-scale time

over 10 divisions), the graph essentially becomes a window that you can
move over the acquisition record by adjusting the horizontal position.

8 Clear Clears the measurement results.
9 Trace Detection readout Displays the Trace Detection setting (see Settings > Trace > Detection).
10 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq

Error, it shows the difference between the instrument Frequency setting and
the measured value of the signal’s carrier frequency. When it displays Freq
Offset, it shows the frequency offset specified on the Settings > Parameters
tab. If Freq Error is displayed, it also indicates that the Carrier frequency
detection setting is Auto. If Freq Offset is displayed, it indicates that the
Carrier frequency detection setting is manual.

xxx

Changing the PM Settings (see page 126)
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PM Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The PM Settings control panel provides access to settings that control parameters of the PM Display.

Setting Description
Parameters (see page 126) Sets the Carrier Frequency Detection method. You can choose either Automatic or

Manual. Sets burst threshold and phase detection method.
Trace (see page 127) Sets Trace display parameters.
Scale (see page 130) Sets vertical and horizontal scale and position parameters.
Prefs (see page 131) Specifies whether or not certain display elements are shown. Specifies the maximum

number of points shown in the display graph.
xxx

Parameters Tab
The Parameters tab enables you to specify parameters that control the carrier frequency and phase detection.
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Setting Description
Burst detect threshold Specifies the power level used to determine whether a burst is present. A valid burst is

required to take measurements. The burst detected first is used for the analysis. The
units for burst detect threshold are dBc, relative to the maximum acquisition sample
data points level.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.
Frequency offset Displays the carrier signal’s frequency offset from the instrument’s Measurement

Frequency. Auto is used to select the method for determining the carrier frequency. When
Auto is selected, the instrument determines the carrier frequency by analyzing the signal.
When Auto is deselected, you can set the carrier frequency offset using Frequency Offset.

Load Δ from Marker Pressing this button disables the Auto Frequency Offset function and sets the Frequency
offset to the frequency offset calculated from the difference between MR (the marker
reference) and the selected marker (or M1 if MR is currently the selected marker).

Phase offset Displays the phase offset. When Auto is selected, the instrument determines the phase
offset. When Auto is deselected, the user sets the phase offset with this control.

Load from marker Pressing this button sets the phase offset to the phase offset of the selected marker.
(Pressing this button automatically deselects Auto.)

xxx

Frequency Offset
In Auto (Auto is selected), the instrument scans the measurement bandwidth about the Measurement
Frequency and looks for the highest-powered signal. This is defined as the carrier frequency. In Manual
(Auto is deselected), the carrier frequency is specified by adding/subtracting the specified Frequency offset
from the Measurement Frequency. Range: -(Measurement BW*1.1)/2 to +(Measurement BW*1.1)/2. If
the Load Δ from marker button is pressed, the frequency offset is determined from the phase difference
between the two markers on screen compared to the time between the two markers. This function is useful
for removing frequency slope from the phase modulated signal.

Phase Offset
In Auto (Auto is selected), the instrument sets the phase offset to fit the waveform to the screen centering
0° phase on the vertical axis. The actual phase offset is indicated on the Phase Offset readout. In Manual
(Auto is deselected), the instrument sets the phase offset using the value specified in Phase offset. For
example, when Phase offset is set to 10°, the waveform shifts upward by 10° on screen. Selecting Load
from marker sets the phase offset to the value of the selected marker. Range: –180 to +180°.

Trace Tab
The Traces Tab allows you to set the display characteristics of displayed trace.
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Setting Description
Show Shows / hides the trace. If the instrument continues to run, the measurement results

below the graph display continue to update even if the trace is hidden.
Detection Sets the Detection method used for the trace. Available detection methods are +Peak,

-Peak, and Avg (VRMS). Not available for saved traces.
Function Selects the trace processing method. The only available setting is Normal.
Freeze Halts updates to the trace.
Save Trace As Saves the trace to a file for later recall and analysis.
Show Recalled trace Displays a saved trace instead of a live trace.
xxx

Detection
Detection refers to the method of processing the data acquisition points when creating a trace. The IQ
samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to
each trace point varies with both analysis length and trace length. For example, with Spectrum Length set
to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak,
and Avg (VRMS) are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.
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Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Each trace point is computed by averaging together the multiple results points it represents.

+Peak - Each trace point is represents the highest vertical value among the results it includes.

–Peak - Each trace point is represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.

3. Check the Show Recalled Trace check box.

4. Verify that the Show check box is selected.
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Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description
Vertical

Scale Changes the range shown between the top and bottom of the graph.
Position Adjusts the phase shown at the center of the graph.
Autoscale Resets the Position so that the entire trace in the graph.

Horizontal
Scale Changes the range shown between the left and right sides of the graph.
Position Adjusts the phase shown at the left edge of the graph.
Autoscale Resets the Scale and Position settings to show the entire trace within the graph.

xxx

130 RSA6100A Series Real-Time Spectrum Analyzers Help



Analog Modulation > PM Prefs Tab

Prefs Tab
The Prefs tab enables you to change appearance characteristics of the PM display.

Setting Description
Show graticule Shows or hides the graticule.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the PM display can be set to a maximum of 100,000 points (however, the
actual number of trace points can extend up to 500,000 points if Max trace points is
set to Never Decimate). If the Analysis Length includes more than the selected Max
trace points value, the trace is decimated (using the method specified with the Detection
control) to be equal to or less than the Max trace points setting (except when Max trace
points is set to Never Decimate). This decimated (or undecimated) trace is what is used
for marker measurements and for results export.

xxx
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Overview
The displays in the RF Measurements folder (Displays > Folders > RF Measurements) are:

CCDF

Channel Power and ACPR

MCPR

Occupied Bandwidth

Phase Noise (Option 11)

Spurious

The RF Measurements power measurements and signal statistics help you characterize components and
systems. With Option 11, the RF Measurements also includes Phase Noise and Jitter Measurements.

Power Measurements

Measurement Description
Channel Power The total RF power in the selected channel (located in the ACPR display).
Adjacent Channel Power Ratio Measure of the signal power leaking from the main channel into adjacent channels.
Multi-Carrier Power Ratio The ratio of the signal power in the reference channel or group of channels to the power

in adjacent channels.
Peak/Avg Ratio Ratio of the peak power in the transmitted signal to the average power in the transmitted

signal (located in the CCDF display).
CCDF The Complementary Cumulative Distribution Function (CCDF). CCDF shows how much

time a signal spends at or above a given power level relative to the average power of
a measured signal.

xxx
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Channel Power and ACPR (Adjacent Channel Power Ratio) Display
Use the Channel Power and ACPR measurement to measure channel power by itself, or adjacent channel
leakage ratio with one main channel.

Measuring Adjacent Channel Power Ratio
1. Select the Displays button.

2. Select RF Measurements from the Folders box.

3. Double-click Chan Power and ACPR in the Available displays box. Click OK to complete your
selection.

4. Press the front-panel Freq button and use the front panel keypad or knob to adjust the frequency to
that of your main channel.

5. Press the Settings button. This displays the control panel for Chan Power and ACPR (the tab displayed
will be the tab displayed the last time the Settings panel was opened).
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6. To set the number of adjacent channels, select the Channels tab. Enter the number of channels in
the Number of adjacent pairs value box. If zero is entered for the number of adjacent pairs, the
resultant measurement will be channel power only.

NOTE. As you add adjacent channels, the span of the display is adjusted so that all the channels can be
seen. Use the horizontal scale and offset to zoom the display in on any portion of the trace.

7. To set the spacing between channel centers, enter the required value in theChannel Spacing value box.

8. To set the channel bandwidth, enter the required value in the Channel Bandwidth value box.

9. After you have configured the channel settings, click the close button ( ) in the Settings panel or
press the Settings button again to remove the settings panel.

10. Press the Run button to take the measurements.

Viewing Results
Measurement results are displayed in a table below the graph and within the graph itself (which can be
enabled/disabled in the Settings > Prefs tab). To see all measurements, you might need to scroll the
table. The size of the results table can be changed by dragging the horizontal divider bar between the
graph and table areas.

Heading Description
Channel Identifies the displayed channels. A1 means the first adjacent channel. A2 means

second adjacent channel. Adjacent channels are numbered according to their offset from
the Main channel. The closest channel is numbered 1. The next closest channel is
numbered 2; and so forth.

Lower The power measured for the lower adjacent channel. Adjacent channel power
measurements are displayed in dB relative to the Main channel.

Upper The power measured for the upper adjacent channel. Adjacent channels power
measurements are displayed in dB relative to the Main channel.

Avg Channel Power (Main) The power measured for the Main channel. The detection type used for measuring
channel power and adjacent channel powers is Average. This means that the average of
the linear (pre-log) samples is used to determine the power. The Main channel power is
displayed in dBm.

xxx
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Setting Channel Power and ACPR Settings Parameters (see page 136)

RF Channel Power Measurement
The RF channel power gives an indication of the total average (and other measures ) RF power in
a given channel.

For some communications systems, there is an “out-of-service” total power measurement defined in the
specifications that calls for a specified constant modulation. In this case, the output power should be
relatively constant. For many measurements, this may not be the case, and the Power Measurement
results will vary as the signal varies.

Average power is the square root of the sum of the squares of the voltage samples over the measurement
time.

The defined “channel” width for the Power Measurement defines the bandwidth and shape of the filter
used to remove any RF power on frequencies outside of the channel bandwidth.

Channel Power
The total RF power in the selected frequency band. The detection type used for measuring channel power
is Average. This means that the average of the linear (pre-log) samples is used to determine the channel
power. To measure channel power, use the ACLR measurement, and set the number of adjacent channels
to zero. This results in only the channel power being measured.

Average Channel Power
The total RF power in the selected channel (located in the ACPR display).

Adjacent Channel Leakage Power Ratio
Adjacent Channel Leakage power Ratio (ACLR) is the ratio of the mean power centered on the
assigned channel frequency to the mean power centered on an adjacent channel frequency. In the 3GPP
specification, both the main channel and adjacent channels are required to be filtered with RRC (Root
Raised Cosine) filters.
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Adjacent Channel Power
Measure of the signal power leaking into nearby channels.

Channel Power and ACPR Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The settings for the Channel Power and ACPR display are shown in the following table.

Settings tab Description
Freq & RBW (see page 143) Specify the frequency and resolution bandwidth used for the ACPR measurement.
Measurement Params (see
page 144)

Specify several parameters that control the measurement, such as channel filter, chip
rate, averaging, and correcting for noise floor.

Channels (ACPR) (see
page 136)

This tab specifies the BW and offset parameters of the Channels for the selected ACPR
measurement.

Scale (see page 203) Specifies the vertical and horizontal scale settings.
Prefs (see page 204) Specifies whether certain display elements are visible.
xxx

Restore defaults. Sets parameters for a 1-channel WCDMA measurement.

Channels Tab for ACPR
The Channels tab is where you specify parameters for the channels measured in the ACPR display.

136 RSA6100A Series Real-Time Spectrum Analyzers Help



RF Measurements > Channel Power and ACPR Channels Tab for ACPR

Setting Description
Number of adjacent pairs Specifies the number of adjacent channel pairs. Range: 1 - 50; Resolution 1.
Channel Bandwidth Specifies the frequency width of each channel (all channels share the same value).
Channel Spacing Specifies the difference in frequency between the centers of each channel.
xxx

The following figure illustrates the settings controlled from the Channels tab.

Changing the Number of Adjacent Pairs
1. Select Number of adjacent pairs number entry box.

2. Enter a value for the number of adjacent pairs using the knob or the keypad.

NOTE. As you change the value for the number of adjacent pairs, the analyzer will update the spectrum
display to identify the adjacent channels.

3. Select the Close box when you have finished making changes.
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Changing the Channel Bandwidth
1. Select the Channel Bandwidth number entry box.

2. Enter a value for the number of adjacent pairs using the knob or the keypad.

NOTE. As you change the value for the number of adjacent pairs, the analyzer will update the display to
indicate the channel bandwidth

3. Select the Close box when you have finished making changes.

Channel Spacing
1. Select Channel Spacing number entry box.

2. Enter a value for the difference in center frequency between channels using the knob or the keypad.

NOTE. As you change the value for the number of adjacent pairs, the analyzer will update the display to
indicate the channel bandwidth

3. Select Close when you have finished making changes.
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MCPR (Multiple Carrier Power Ratio) Display
Use the MCPR measurement to measure adjacent channel power ratio for multiple main channels or
when adjacent channel pairs have different offsets and/or bandwidths. The MCPR display show the
Reference Power and the ratio of each adjacent channel to the Reference Power. You can select whether
the Reference Power is the total of all active channels or a single channel.

Measuring Multiple Carrier Power Ratio
1. Press the front-panel Displays button.

2. From the Select Displays window, select RF Measurements from the Folders box.

3. Double-click theMCPR icon in the Available displays box. Click OK to complete your selection.

4. Press the front-panel Freq button and use the front panel keypad or knob to adjust the frequency to
that of the main channel. SelectMeas. Freq to set the measurement frequency. Use the front panel
knob to adjust the frequency.

5. Press the Settings button. This displays the control panel for MCPR (the tab displayed will be the tab
displayed the last time the Settings panel was opened).

6. Click on the Channels tab. To set the number of Main channels, enter the number of Main channels in
the Number text entry box underMain Channels.

NOTE. As you add channels, the span of the display will be adjusted so that all the channels can be seen.

7. To set the bandwidth of all main channels, enter a value in the BW value box.

8. To set the spacing between the main channels, enter a value in the Spacing value box.

9. To prevent a main channel power level from being included in the Power Reference (Total) calculation,
select the channel to be excluded in the Inactive box.

10. To add adjacent channels, click the Add... button under Adj Chans.

RSA6100A Series Real-Time Spectrum Analyzers Help 139



RF Measurements > MCPR MCPR (Multiple Carrier Power Ratio) Display

11. To edit Frequency Offset or Bandwidth, click within the value box and use the front-panel knob or
your keyboard to set the value. Click Close to save your changes.

NOTE. Frequency Offset is the difference between the center frequency of the selected channel and
the Measurement Frequency. All channels (Main or Adjacent) are specified by their offset from the
Measurement Frequency.

12. After you have configured the Main and Adjacent channels, click the close button ( ) in the
Settings panel or the Settings button to remove the settings panel.

13. Click the Run button ( ) to take the measurements.

Viewing Results
MCPR measurement results are displayed both in the spectrum graph and in a table below the spectrum
display. Individual Main channel power measurements appear in the graph under their channel identifiers.
Individual adjacent channel power ratios also appear in the graph under the adjacent channel identifier.
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The following table details the entries in the results table.

Heading Description
Ch Identifies the adjacent channels. Adjacent channels are numbered according to their

offset from the Main channel. The closest channel is numbered 1. The next closet
channel is numbered 2; and so forth. The prefix “L” means lower; “U” means upper.

Offset The offset is the difference in frequency between the Measurement Frequency and the
center frequency of the channel.

Lower Displays the ratio of the lower adjacent channel power to the Power Reference.
Upper Displays the ratio of the upper adjacent channel power to the Power Reference.
Power Reference Depending on the selected Power Ref, this readout displays either the power of the

selected main channel or the total power in the active main channels.
xxx

Depending on the number of adjacent channels, to see all the measurements, you might need to drag
the divider bar between the main display and the results table at the bottom of the window to change
the height of the results table.

Setting MCPR Measurement Parameters (see page 144)
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Multiple Carrier Power Ratio
The ratio of the signal power in an adjacent channel to the power in one or more main channels.

MCPR Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Setup control panel tabs for MCPR (Multiple Carrier Power Ratio) are:

Settings tab Description
Freq & RBW (see page 143) Specify the frequency and resolution bandwidth used for the MCPR measurements.
Measurement Params (see
page 144)

Specifies parameters controlling how the MCPR measurement is made.

Channels (see page 146) Specifies the parameters of the channels to be measured.
Scale (see page 203) Specifies the vertical and horizontal scale and offset values.
Prefs (see page 204) Specifies whether or not certain display elements are shown.
xxx

Restore Defaults. Sets parameters for a 4-carrier WCDMA measurement.
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Freq & RBW Tab for ACPR and MCPR Displays
The Freq & RBW tab specifies frequency parameters for the Channel Power & ACPR measurements and
MCPR measurement.

Setting Description
Center Freq Specifies the center/measurement frequency.
Step The Step control sets the increment/decrement size for the knob adjustment of the

center frequency. Arrow key adjustment of frequency is also affected (it is 10x the knob
adjustment). If Auto is enabled, the spectrum analyzer will adjust the Step size as
required.

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is
Independent of the Spectrum view’s RBW setting.

VBW Adjusts the VBW (Video Bandwidth) value. VBW Maximum = current RBW value. VBW
Minimum = 1/10,000 RBW setting.

xxx

NOTE. While the center frequency and step settings on this control tab are shared between ACPR, MCPR
and Occupied Bandwidth, the RBW setting is not shared. The RBW setting is unique for each measurement.

VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the
RBW setting.

NOTE. If you are following a procedure that says to “set VBW to three times the RBW value or greater”, it
means that the test should be conducted with no VBW effects. In the RSA6100A Series instruments, this
condition is met by disabling the VBW function.
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Measurement Params for ACPR and MCPR Displays
TheMeasurement Params tab is where you set parameters that control the ACPR andMCPRmeasurements.
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Parameter Description
Average Enables/disables measurement averaging. Averaging can be enabled in either the

Frequency Domain or Time Domain.
Frequency-domain averaging This setting takes the average linear value of the traces (so that rms values are

preserved). The number of averages is user-defined. Frequency domain averaging
is available in spans larger (or smaller) than the maximum real time bandwidth.
This is the mode to use unless you need to extract maximum dynamic range from
an ACPR measurement.

Time-domain averaging This setting takes the average linear value of the traces. It is useful if you need to
extract maximum dynamic range from an ACPR measurement. The number of traces
is user defined. But, the signals must be triggered and repeating. That is, the signal
needs to be exactly the same for each acquisition. When this condition is met, each
waveform contains the same signal, but the random noise changes from acquisition
to acquisition and the average value of the random noise is lowered, while the signal
value remains constant. Time domain averaging is not available in spans wider
than the maximum real-time bandwidth.

Number Specifies the number of acquisitions to be averaged when Averaging is set to
Frequency Domain. Specifies the number of successive capture records that are
averaged when Averaging is set to Time Domain.

Correct for Noise Floor Enables/disables the Noise Floor Correction function.
Optimization Sets the Noise Floor Correction function to optimize for the greatest dynamic range

or the widest real-time bandwidth.
Power Reference Specifies power against which the results are compared. Choices available are each

of the existing main channels and “Total power in main channels”.
Only present when MCPR is the selected display.

Channel Filter Specify the channel filter used. Select between None (default) and Root-raised
Cosine.

Filter Parameter Value entry box for the Root-raised Cosine filter Adjacent Channel Filter.
Present only when the Channel Filter is set to RRC.

Chip Rate Value entry box for the RRC chip rate.
Present only when the Channel Filter is set to RRC.

xxx

Correct for Noise Floor
When this setting is enabled, the instrument applies a correction to the ACPR or MCPR measurement to
reduce the effect of instrument noise on the results. It generates this correction by taking a preliminary
acquisition to measure the instrument noise floor. Once this is done, the measurement proceeds, applying
the correction to each result. When any relevant settings (reference level, attenuator, frequency, or span)
are changed, the instrument performs a new noise measurement and correction.

Optimization
There are two settings for Optimization: Dynamic Range and Realtime BW.

Realtime BW: Choose Realtime BW when you want to see time-correlated results in other displays.
Optimizing for real-time bandwidth causes the instrument to set its acquisition bandwidth to span the
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channel set, as long as the bandwidth of the channel set is less than the real-time bandwidth of the
instrument (40 MHz or 110 MHz, depending on model). However, if the bandwidth of the channel set
exceeds the realtime bandwidth of the instrument, the instrument will have to switch to swept mode and
stitch multiple acquisitions together to make the ACPR/MCPR measurement. If the instrument must
switch to swept acquisition mode, time-correlated results in other displays are not possible.

Dynamic Range: Choose Dynamic Range when maximum dynamic range is more important than
time-correlated results in other displays. The Dynamic Range setting optimizes the dynamic range by
using a 40 MHz (or less) real-time bandwidth setting to make the acquisition. If the channel set bandwidth
is greater than 40 MHz, the instrument uses the swept acquisition mode to stitch multiple 40 MHz
bandwidth acquisitions together to capture the entire width of the channel set.

Channels Tab for MCPR
Path: Setup > Settings > Channels

Application Toolbar / Front Panel: Settings

The Channels tab is where you specify the parameters for the channels measured in the MCPR display.
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Setting Description
Main Channels
Number Sets the number of Main channels.
BW Sets the bandwidth of the Main channels.
Spacing Sets the frequency difference between the centers of the Main channels.
Inactive Selected channels are ignored by the measurement routine.
Adj Chans
Add... Opens the Edit Channel Parameters dialog, which you use to specify the parameters of a

new pair of adjacent channels. You can add up to 50 adjacent channel pairs.
Edit... Opens the Edit Channel Parameters dialog box. (You must first select a channel to

enable the Edit button.)
Delete Deletes the selected main channel or adjacent channel pair.
Add Adj. Add a new pair of adjacent channels at the bottom. Their parameters are copied from

the channels just above them.
Channel Definition table A table of the parameters for every channel. Offset is the frequency difference between

the Center Frequency and center of the selected channel. Nothing in the table is editable
directly.

xxx

The following figure illustrates the settings controlled from the Channels tab.

Editing Channel Parameters
To edit the offset or bandwidth of a Main channel:

1. Select the value in the BW or Spacing number entry boxes.

2. Adjust the value as required. All the Main channels share the same BW and Spacing.

3. Select the appropriate check box to make a channel Inactive, as appropriate.

4. Select the Close box when you have finished making changes.
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To edit the offset or bandwidth of an Adjacent channel:

1. Select the channel to be edited in the channel definition table.

2. Select Edit. This displays the Edit Channel Parameters dialog box.

3. Adjust the values for the Frequency Offset or Bandwidth as required.

4. Select the Close box when you have finished making changes.

Adding Channels
To add a main channel:

1. Select the Number entry box.

2. Use the knob to enter a value for the desired number of Main channels.

3. Select the Close box when you have finished making changes.

To add an adjacent channel pair:

1. Select Add.... This displays the Edit Channel Parameters dialog box.

2. Use the knob to enter values for the Frequency Offset and Bandwidth as required. The Frequency
Offset is measured from the Center frequency of the Main channels.

3. Select the Close box when you have finished making changes.

Deleting Channels
To delete a main channel:

1. Select the Number entry box.

2. Use the knob to reduce the number of channels or enter a new value using the front-panel keypad.

3. Select the Close box when you have finished making changes.

To delete an adjacent channel:

1. Select the channel to be deleted in the channel definition table.

2. Select Delete. This removes the selected channel from the channel table.

3. Select the Close box when you have finished making changes.
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Occupied BW & x dB BW Display
The Occupied BW display shows the bandwidth within which 99% (a user-defined value, the default is
99%) of the power transmitted within the measurement bandwidth falls.

To show the Occupied BW display:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select RF Measurements in the Folders box.

3. In the Available displays box, double-click the Occupied Bandwidth icon or select the icon and
click Add. The Occupied Bandwidth icon will appear in the Selected displays box and will no
longer appear under Available displays.

4. Click OK to display the Occupied Bandwidth.

Elements of the Display

RSA6100A Series Real-Time Spectrum Analyzers Help 149



RF Measurements > Occupied BW & x dB BW Occupied BW & x dB BW Display

Item Display element Description
1 Check mark indicator The check mark indicator denotes the display for which the acquisition

hardware is optimized. This indictor appears only when the display is the
selected display.

2 Averaging readout Appears when averaging is enabled (Settings > Parameters tab > Average
results). Displays "Avg: n of m" while averaging the results and "Avg: m"
once the requested number of results have been averaged.

3 Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the
graph.

4 Trace function readout Displays either Normal or MaxHold to indicate trace function.
5 Clear Resets count for Average and MaxHold functions. Enabled only when

Averaging or MaxHold is enabled. Pressing Clear will clear the trace and, if
acquisition is running, restart the averaging or hold process.

6 Graph Displays the input signal. Shaded areas indicate the measurement bandwidth
(Settings > Parameters tab > Measurement BW).

7 Blue lines The blue lines indicate where the selected results (selected in the Main
results area) are being measured on the trace.

8 Grid divider Determines the portion of the display allocated to the graph and detailed
results area. You can move the grid divider all the way to the top or bottom
and any position in between.

9 Detailed results area Displays additional measurements results.
10 Position and dB/div Position sets the top of graph value. The dB/div setting is the vertical scale

value.
11 Main results area Displays results for Occupied Bandwidth (OBW) and x dB bandwidth. Use

the two radio buttons to select which of the two results are illustrated in the
graph with the blue lines and arrows. There are also controls for adjusting
OBW % Power, x dB BW, and RBW.

12 VBW Enables the VBW (Video Bandwidth) filter. Displays current VBW filter setting.
See Setup > Settings > Freq & RBW tab (see page 143).

xxx

Detailed Results Readouts

Measurement Description
Freq Error The frequency difference between the measured carrier frequency of the signal and the

user-selected center frequency of the analyzer.
OBW Level left The signal level at the left edge of the occupied bandwidth.
OBW Level right The signal level at the right edge of the occupied bandwidth.
OBW Ref Power The total power measured within the measurement bandwidth.
x dB BW Ref Power The peak power measured within the measurement bandwidth.
xxx

Changing the Occupied Bandwidth Settings (see page 151)
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Occupied Bandwidth
Bandwidth within which some defined percentage of the power transmitted on a single channel lies.

Occupied BW & x dB BW Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The control panel tabs for the Occupied Bandwidth display are shown in the following table.

Settings tab Description
Freq & RBW (see page 199) Allows you to specify the Center Frequency, Step size and RBW.
Parameters (see page 152) Allows you to specify the Occupied BW % Power, x dB level, Measurement BW, enable

averaging and the Max Hold function.
Scale (see page 203) Allows you to set the vertical and horizontal scale parameters.
Prefs (see page 204) The Prefs tab enables you to set characteristics of the measurement display.
xxx
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Parameters Tab
The Parameters tab enables you to specify parameters that control the Occupied BW measurement.

Setting Description
Occupied BW % Power Specifies the proportion of power within the occupied bandwidth (referenced against the

total power in the measurement bandwidth).
x dB level x dB level defines the x dB BW level search threshold.
Measurement BW Specifies the frequency range used by the measurement.
Max Hold spectral data Enables the Max Hold function.
Average results Enables/disables results averaging. Note that this is not an averaging of the trace, but an

averaging of the results.
Count Specifies the number of results averaged to calculate the Occupied BW. Range: 2 to

10,000.
xxx

x dB Level
The x dB level determines the x dB BW. The instrument analyzes the spectrum trace to locate the
frequencies at which the level is x dB down from the peak level calculated over the measurement
bandwidth. The frequency difference between the upper and lower crossing thresholds is the x dB BW.

Range: -80.0 to -1.0 dB; Resolution: 0.1%; Inc/dec small: 0.1%, large: 1%; Default: -26 dB

Max Hold Spectral Data
Max Hold displays the maximum value in the acquisition record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.
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Spurious Display
To show the Spurious display:

1. Click the Displays button or select Setup > Displays.

2. From the Folders box, select RF Measurements.

3. Double-click the Spurious icon in the Available displays box. This adds the Spurious icon to the
Selected displays box (and removes it from the Available displays box). Alternatively, you can click
the Spurious icon and then click the Add button to select Spectrum for display.

4. Click the OK button.

Elements of the Spurious Display

RSA6100A Series Real-Time Spectrum Analyzers Help 153



RF Measurements > Spurious Spurious Display

Item Display element Description
1 dB/ div Sets the vertical scale value. The maximum value is 20.00 dB/division.
2 Vert Position Sets the top of graph value. This is only a visual control for panning the graph.

The Reference Level is adjusted in the Toolbar and the Ampl control panel.
By default, Vert Position = Ref Level.

3 Check Mark Indicator Indicates the display for which the acquisition hardware is optimized.
4 Pass / Fail readout Indicates whether one or more spurs have exceeded a limit specified on

the Settings > Limits tab.
5 Ref: If enabled, displays the power reference level.
6 Trace function Indicates the trace processing method. If Average or Max Hold is selected,

this readout displays the number of traces being processed (averaged or
compared for the Max Hold value).

7 Clear Restarts multi-trace functions (Average, Max Hold).
8 Stop Adjusts the graph stop frequency. This setting affects only visual scaling, not

measurement parameters.
9 Green bar Indicates the range that is selected on the Settings > Ranges and Settings >

Limits tabs.
10 Spur table Displays spur measurements. See the following table for details.
11 Start Adjusts the graph start frequency. This setting affects only visual scaling, not

measurement parameters.
12 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on

screen. Selects Multi-range display mode.
13 Bottom-of-graph readout Indicates the amplitude at the bottom of the graph. This value changes with

the dB/div and Vertical Position settings.
xxx

Elements of the Spurious Graph Display
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Item Display element Description
1 The green line or shading indicates an Abs (absolute) limit. The absolute limit

is enabled when the mask is set to Abs, Abs & Rel, or Abs OR Rel. Note that
absolute and relative amplitude masks can overlap.

2 The gray-shaded area indicates a portion of the spectrum where no
measurements are being taken.

3 The cyan line or shading indicates a Relative limit. The relative limit is
enabled when the mask is set to Rel, Abs & Rel, or Abs OR Rel. Note that
absolute and relative amplitude masks can overlap.

4 abs rel Reminder that green-shaded areas highlight absolute limits and cyan-shaded
areas highlight relative limits.

5 This indicates the selected spur, when it is in violation of the limits. In Run
mode, this is the peak spur violation. The selected marker is highlighted in
the Spur table below the graph with a blue background.

6 A spur marker. Indicates a spur that does not exceed the mask settings. See
the Settings > Limits tab (see page 164).

7 A violation marker. Indicates a spur that exceeds the mask settings. See the
Settings > Limits tab (see page 164).

--- Indicates the selected spur when it is not in violation of the limits. The
selected marker is highlighted in the Spur table below the graph with a blue
background.

8 1, 2, 3... A Spur number. The number indicates the row in the spur table that
corresponds to the spur. The instrument can display up to 999 spurs.

9 A, B, C, D... Identifies the enabled ranges.
10 Green bar Indicates the range selected on the Settings > Limits (see page 164) and

Settings > Ranges (see page 162) tabs.
11 Ref Indicates the location of the power reference. See Settings > Reference

(see page 159).
xxx

Elements of the Spur Table
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Column Description
Spur A number that identifies a spur in the graph area. The instrument can display a maximum

of 999 spurs.
Range The letter representing the frequency range where the spur is located.
Freq Abs The absolute frequency at which the spur occurs.
Freq Rel The relative frequency at which the spur occurs. The relative frequency is the difference

between the absolute frequency (absolute) and the carrier frequency.
Ampl Abs The absolute amplitude of the spur.
Ampl Rel The relative amplitude at which the spur occurs. The relative amplitude is the difference

between the absolute amplitude and the carrier amplitude. See the Settings > Limits tab.
Lim Abs The value of the absolute amplitude limit at the spur frequency. This value can vary even

with small spur frequency changes if the start and stop limit values are different. See
the Settings > Limits tab (see page 164).

Lim Rel The relative amplitude limit at which the spur occurs. This value can vary even with small
spur frequency changes if the start and stop relative amplitude limit values are different.
See the Settings > Limits tab (see page 164).

Blue background The cell in the Spur column with a blue background identifies the selected spur.
Red background Cells in the Spur column with a red background identify violations.

Cells in the results area with a red background identify the measurement that exceeded a
limit.

xxx

Rearranging the Columns in the Spur Table
You can rearrange the order of the columns in the Spur Table. To move a column, click on the column
heading and drag it to the desired position.

Sorting the Rows in the Spur Table
You can sort the rows in the Spur table by clicking on the column heading. For example, if you click on
the Freq Abs heading, the results in the Spur table will be sorted by frequency. If you click on Range, the
rows will be sorted by range. Clicking a second time on the same heading reverses the order.

Changing the Spurious Display Settings (see page 157)
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Spurious Display Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The control panel tabs for the Spurious display are shown in the following table.

Settings tab Description
Parameters (see page 157) Specifies whether the graph displays one range or multiple ranges. Specifies whether all

spurs are shown or only spurs over specified limits. Enables the use of CISPR filters
and detectors.

Reference (see page 159) Specifies the Power Reference level.
Ranges (see page 162) Specifies start and stop frequencies of ranges and which ranges to take measurements in.

Sets parameters that define a spur. Review, save and load the Range table from this tab.
Limits (see page 164) Specifies Pass/Fail limit parameters.
Trace (see page 200) Specifies the trace Function.
Scale (see page 203) Specifies the vertical and horizontal scale settings.
Prefs (see page 204) Specifies the appearance features of the graph area.
xxx

Restore defaults. Sets the Spurious parameters to their default values.

Parameters Tab
The Parameters tab enables you to specify settings that control the Spurious measurement.
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Setting Description
Frequency Ranges
Multi Enables the instrument to display all enabled ranges in the graph.
Single Limits the graph to the display of only one range. The displayed range is set to the range

that contains the selected spur.
List Spurs
All spurs Displays any spur that exceeds the Threshold and Excursion values set on the Ranges

tab.
Over Limit Displays only spurs that exceed both the Threshold and Excursion values set on the

Ranges tab and the limits specified on the Limits tab.
RF & IF Optimization Specifies how the gain and bandwidth should be optimized (in the RF and IF stages of

the front end). Choices are Auto, Maximize Dynamic Range and Minimize Noise.
xxx

RF & IF Optimization
You can select RF & IF optimizations to achieve the best dynamic range, fastest sweep speed or minimum
displayed noise. These choices affect the RF and IF attenuation levels, the selection of the acquisition
bandwidth, digitizer and the resolution of the mathematical operation performed on the acquisitions used in
varying conditions of span, reference level and resolution bandwidth. The following paragraphs describe
the effects of choosing each of the available choices.

Minimize sweep time. Selecting Minimize Sweep Time causes the instrument to use the widest available
acquisition bandwidth when sweeping across spans greater than the maximum available real-time span.
For instruments without Option 110 (110 MHz acquisition BW), this control has no effect. For instruments
equipped with Option 110, the swept update rate is improved by approximately 3X compared to all other
RF/IF optimization choices.

Maximize dynamic range. Selecting Maximize Dynamic Range has four effects:

RF attenuation is set to allow higher drive levels at the RF mixer.

IF gain levels are changed to optimize the IF for the higher signal levels that result for allowing
higher drive levels at the mixer.

Selects the acquisition path used in the instrument, taking into account the user selection of Resolution
Bandwidth (RBW). When an RBW of less than 30 kHz is selected, the instrument will use a
narrow-band (312.5 kHz) acquisition path, regardless of the selected span. This results in the best
rejection of out-of-span signals in the IF stage of the analyzer, but comes at the cost of slower update
rates for all spectrum analyzer spans greater than 312.5 kHz.

Whenever spans are set to ≤312.5 kHz, the resolution of the mathematics used in calculations of
all signal results is increased from 16 bits to 28 bits. This is made possible by the high levels of
decimation applied to signals processed in these narrow bandwidths.

Minimize noise. This mode increases the system gain at points past the RF mixer. This has the effect of
reducing the displayed average noise level.
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Auto. The Auto setting is an optimized trade-off of the competing performance choices. This setting is the
instrument default from the factory and is part of the ‘Preset’ function.

The table below summarizes the conditions.

Settings RF Mixer Level
for signal at
Ref. Level

Selected Acquisition
Bandwidth

IF Gain/Loss
settings

Notes and Trade-offs

Auto -25 dBm Driven by selected span.
If span is greater than the
available acquisition BW,
unit sweeps using 40 MHz
acquisitions.

Neutral Swept Speed, Dynamic
Range, Noise Floor

Minimize
Sweep Time

-25 dBm Unit uses widest available
acquisition BW for spans
greater than maximum
acquisition BW.

Neutral For units equipped with
Option 110, swept update
rate is approximately 3
times faster than Auto.
No effect in units without
Option 110.

Maximize
Dynamic Range

-20 dBm Driven by span and
user-selected RBW. For
RBW < 30 kHz, the high
dynamic range 312.5 kHz
path is used regardless of
selected span. Sweeps
are made in 40 MHz
acquisitions.

Might result in very slow
sweep speeds in wide
spans when RBW <
30 kHz.

Minimize Noise -25 dBm Same as Auto Gains set to
minimize noise
level.

Might result in earlier IF
overload under some
signal conditions.

xxx

Reference Tab
The Reference tab enables you to specify the Power Reference parameter. The Power reference parameter
is used to calculate relative values in the Spur table and to calculate relative amplitude limits.
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Setting Description
Power Reference Specifies the power reference level used for relative values and limits.
No reference Power level readings are calculated only for absolute values, no relative values are

calculated.
Manual level The reference level for relative measurements is specified by the Reference power

level setting.
Carrier The reference level for relative measurements is based on the power level calculated at

the specified carrier frequency.
xxx

Setting the Power Reference Level to No Reference

To set the power reference to No Reference:

Select No reference from the Power reference drop-down list.

Setting the Power Reference Level to Manual Level

To set the power reference to manual level:

1. SelectManual level from the Power reference drop-down list. This displays the Reference power
level entry box.

2. Specify the desired power level in the Reference power level entry box.
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Setting the Power Reference Level to Carrier

To set the power reference to Carrier:

1. Select Carrier from the Power reference drop-down list. This displays several parameters.

2. To set the Carrier frequency, click Edit. This displays the Edit Range and Carrier frequencies
dialog box.

3. Specify the necessary values in the Frequency and Channel width entry boxes under Carrier.
Click OK.

4. Specify the Threshold level.

5. Specify the Integration BW. The Integration BW is the bandwidth over which the carrier is measured.

6. Although Auto is the recommended setting, you can specify the Resolution Bandwidth by changing
the value in the Res BW entry box.

7. Set the Detection method. Select either +Peak or Average.

NOTE. If the power level measured over the Integration BW about the carrier frequency is below the
threshold level, the instrument concludes that no carrier is present and no relative measurements will be
taken. Absolute measurements will still be taken.
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Ranges Tab
Use the Ranges tab to specify the parameters that control the Spurious measurement. From the Ranges tab,
you specify the start and stop frequencies for ranges, whether or not a range is enabled, the parameters
that specify what constitutes a spur, measurement filter shape and bandwidth, and the detection method
used for processing signals.

Setting Description
Range Selects the frequency range to which the settings on this tab are applied.

Start Readout of the start frequency for the selected range.
Stop Readout of the stop frequency for the selected range.
Edit Click this button to edit the Spurious Frequency Plan, which defines the range frequency

values and whether or not a signal is measured in a range (enabled/disabled).
Enabled Specifies whether or not measurements are taken in the specified range.

Filter shape Specifies the filter shape used for the Spurious measurement.
BW Specifies the bandwidth used for the selected filter shape.

Auto Sets the BW automatically. If CISPR is selected for Filter shape, this control is disabled.
Detection Sets the processing method used for compressing excess intermediate data into the

desired number of trace points.
Threshold Specifies the level that must be exceeded for a signal peak to be recognized as a spur. A

signal peak must also exceed the Excursion setting to be considered a spur.
Excursion Specifies the peak to peak magnitude that must be exceeded for a signal peak to be

recognized as a spur. A signal transition must also exceed the Threshold setting to be
considered a spur.

VBW Adjusts the VBW (Video Bandwidth) value. VBW Maximum: RBW current value; VBW
Minimum: 1/10,000 RBW setting. Disabled when Filter shape is set to CISPR.

Review table Click to display the Ranges table. The Ranges Table shows the enabled ranges, and all
the settings specified on the Ranges and Limits tabs associated with the enabled ranges.

Save table Click to save the current Range table to a file.
Load table Click to load a saved Range table from a file.
xxx

162 RSA6100A Series Real-Time Spectrum Analyzers Help



RF Measurements > Spurious Ranges Tab

Changing the Range Start and Stop Frequencies

To change the range start and stop frequencies, edit the Spurious Frequency Plan:

1. Click the Edit button on the Settings > Range tab.

2. Click the Enabled box for a range to take measurements in the range.

3. Click on the frequency setting to change it. Type in a number for the frequency and a letter as a
multiplier, then press Enter on the front panel. You can use k, m, or g to set the frequency multiplier.

4. Click OK to save your changes.

You can enable a range on the Ranges control panel tab by selecting the range from the Range drop-down
list and clicking the Enabled check box. If you need to change the frequency of a range, you must edit
the spurious frequency plan using the Edit button.

Specifying Spur Requirements
A spur is a signal peak that exceeds both the Threshold and Excursion settings on the Ranges tab. The
Threshold and Excursion settings are absolute values; they are not calculated relative to a reference. The
Threshold and Excursion settings are specific to the selected range. If you want to use different settings for
spurs in different ranges, you have to set the values separately for each range. The Excursion control is
used to avoid interpreting a single spur as multiple narrower spurs by requiring the amplitude to drop by
the Excursion amount between spurs. Raising the Threshold value means that fewer, larger signals will
be identified as spurs.

To specify the spur requirements for a range:

1. Select the Range for which you want to specify the spur requirements.

2. Set the Threshold value.

3. Set the Excursion value.
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Limits Tab
Use the Limits tab to specify the pass/fail parameters for the Spurious measurement. When the Mask
setting is set to any value except off, the instrument identifies any signal peak that exceeds the specified
limits as a violation and displays Fail on the screen. If no signal peak exceeds the limits, the instrument
displays Pass on the screen.
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Setting Description
Range Selects the frequency range to which the settings on this tab are applied.

Start Readout of the start frequency for the selected range.
Stop Readout of the stop frequency for the selected range.
Edit Click this button to edit the Spurious Frequency Plan, which defines the range frequency

and whether or not measurements are taken in a range (enabled/disabled).
Enabled Specifies whether or not measurements are taken in the specified range.

Mask Selects the type of limits used for Pass/Fail testing. Spurs that exceed the mask settings
are considered violations.

Abs Spurs that exceed the Absolute limits settings are identified as violations.
Rel Spurs that exceed the Relative limits settings are identified as violations.
Abs & Rel Spurs that exceed both the Absolute and Relative limits settings are identified as

violations.
Abs OR Rel Spurs that exceed either the Absolute or Relative limits settings are identified as

violations.
Off Turns off limit testing for the selecting range. Measurements are still taken in the range,

but violations are not flagged. Signal peaks that exceed the Threshold and Excursions
values will still be identified as spurs.

Absolute ampl Absolute amplitude limits are not based on the measured carrier amplitude or manual
reference. Start and stop values can be different.

Start Specifies the limit at the start frequency of the range.
Stop Specifies the limit at the stop frequency of the range.
Same Sets the limit at the start and stop frequencies to the value set for the start frequency.

Relative ampl Relative amplitude limits are calculated from the Power Reference. If the Power
Reference is set to the Carrier level, the relative amplitude limits will change with the
carrier level. Start and stop values can be different.

Start Specifies the limit at the start frequency of the range.
Stop Specifies the limit at the stop frequency of the range.
Same Sets the limit at the stop frequency to the value set for the start frequency.

Review table Click to display the Ranges table. The Ranges Table shows the enabled ranges, and all
the settings specified on the Ranges and Limits tabs associated with the enabled ranges.

Save table Click to save the current Range table to a file.
Load table Click to load a saved Range table from a file.
xxx

Performing Pass/Fail Limit Testing
To set limits:

1. Press Settings to display the Spurious Settings panel.

2. Press Limits to display the Limits tab.

3. Press Edit to display the Range and Carrier Frequencies dialog box.

4. Adjust the start and stop frequencies as required for each range you want to test.
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5. For ranges that you wish to test, verify that the Enabled box is checked. Click OK.

6. Select a range you want to test from the Range drop-down list.

7. Select the desiredMask type from the drop-down list.

8. Set the limits as desired in the Absolute ampl and Relative ampl boxes. The values you can edit
depend on the mask type you select.

9. Repeat steps 5, 6 and 7 for each range you want to test.

10. Verify that the Threshold and Excursion values on the Ranges (see page 162) tab are set as required.
These are the values that define a spur.

11. Press the close box to remove the Settings panel.

12. Click Run to begin testing.
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CCDF Display
The CCDF (Complementary Cumulative Distribution Function) is a statistical characterization that plots
power level on the x-axis and probability on the y-axis of a graph. Each point on the CCDF curve shows
what percentage of time a signal spends at or above a given power level. The power level is expressed in
dB relative to the average signal power level. The CCDF Display also shows the Average power level
and the Peak/Average ratio.

To show the CCDF display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select RF Measurements.

3. Double-click the CCDF icon in the Available Displays box. This adds the CCDF icon to the Selected
displays box.

4. Click the OK button.

Elements of the CCDF Display
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Item Display element Description
1 100% The top of the graph represents the 100% probability that the signal will be at

or above the average signal level.
2 Power level select Adjust to display the value of the CCDF curve at a specific power level. The

selected power level is indicated by a small triangle on the CCDF curve.
3 CCDF value Readout of the value of the CCDF curve at the selected power level.
4 Avg Readout of the Average power level and the CCDF value at the Average

power level.
5 Readout Table Readout of the CCDF curve at six points.
6 Pk / Avg Readout of the Peak to Average power ratio.
7 Measurement time Readout of the length of time used for the measurement. Displays --- s when

the Measurement time is set to continuous.
xxx

Changing the CCDF Display Settings (see page 168)

CCDF Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The control panel tabs for the CCDF Display are shown in the following table.

Settings tab Description
Parameters (see page 169) Specifies the time to be measured.
Traces (see page 200) Select the trace to be measured and select reference trace for display.
Prefs (see page 204) Specifies whether on not certain display elements are shown.
xxx

Restore defaults. Sets the CCDF parameters to their default values.
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Parameters Tab
The Parameters tab enables you to specify several parameters that control signal acquisition for the
CCDF Display.

Setting Description
Single When Single is selected, the CCDF measurement is based on the Analysis Time

parameters set on Analysis control panel (Setup > Analysis > Analysis Time), shared by
all displays. In Single, CCDF is time-correlated with the other open displays.

Total Time When Total Time is selected, you can adjust its value. The value set here does not affect
the Analysis Length value set in the Analysis control panel. If the Total Time value is
longer than the Analysis Length, CCDF uses multiple acquisitions to collect signal data.

Continuous When Continuous is selected, the CCDF measurement combines each new record
(Actual Analysis Length) into the existing result. It does not erase and start over until
user presses STOP or CLEAR.

Span Specifies the range of frequencies used for analysis.
xxx

Single
To have statistically meaningful results, CCDF works best when calculated on at least 1 ms of data.
Depending on the Analysis Time setting, the CCDF display may present error messages:

If the Actual Analysis Time is greater than 1 ms, the CCDF Display will calculate the trace without
any problems.

If the Actual Analysis time is less than 1 ms, the CCDF Display will measure the data as best if
can, but if it receives fewer than 20 samples, the CCDF display will clear the trace and report "Not
enough samples".
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Phase Noise Display
Phase Noise measures and graphs the power in a 1 Hz bandwidth referenced to the carrier power. This is
repeated for many frequency points across a user-adjustable span.

To show the Phase Noise display:

1. Click the Displays button or select Setup > Displays.

2. From the Folders box, select RF Measurements.

3. Double-click the Phase Noise icon in the Available displays box. This adds the Phase Noise icon to
the Selected displays box (and removes it from the Available displays box). Alternatively, you can
click the Phase Noise icon and then click the Add button to select Phase Noise for display, or drag the
Phase Noise icon to the Selected Displays box.

4. Click the OK button.

Elements of the Phase Noise Display
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Item Display element Description
1 Check Mark Indicator Indicates the display for which the acquisition hardware is optimized.
2 Vert Position (dBc/Hz) Sets the top of graph value. This is only a visual control for panning the graph.
3 Trace selector Selects a trace.
4 Show check box Shows/hides the selected trace.
5 Detection method / Average

count
Displays the Detector method used for the trace. If Average detection is
enabled, the number of averaged traces appears here.

6 Measurement Marker readout Readout of the value of the phase noise at the selected offset. The Phase
Noise measurement marker does not affect the results reported in the
readouts or table below the graph, nor is it associated with markers in any
other display.

7 Clear Restarts multi-trace function (Average).
8 Horizontal stop Readout of the Right Horizontal frequency value. This setting affects only

visual scale, not measurement bandwidth. (See Settings > Scale (see
page 122))

9 Measurement marker Indicates the position of the measurement point.
10 Integration frequency range

indicators
The gray-shaded areas denote the frequencies outside the integration
frequency range. (See Settings > Frequency (see page 298))

11 Phase Noise Table Displays the phase noise values at different offsets.
12 Horizontal start Readout of the Left Horizontal frequency value. Affects only visual scaling,

not measurement bandwidth. (See Settings > Scale (see page 122))
13 Measurement results

readouts
Display of the different measured values.

xxx

Elements of the Measurement Results Readout / Phase Noise Table
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Readout Description
Carrier power The power level at the carrier frequency.
Freq Error The measured carrier frequency error.
RMS Phase Noise The RMS value of the phase noise, measured over the Integration BW.
Jitter The jitter in seconds, measured over the Integration BW. Includes the effects of random

and coherent jitter.
Residual FM The residual frequency modulation, measured over the Integration BW.
Trace 1 The phase noise on trace 1 at different frequency offset values. Note that if Trace 1 is set

to +/- Peak detection, the value displayed in the table is the +Peak value.
Trace 2 The phase noise on trace 2 at different frequency offset values. Note that if Trace 2 is set

to +/- Peak detection, the value displayed in the table is the +Peak value.
xxx

Changing the Phase Noise Settings (see page 174)

How Phase Noise Is Measured
If carrier tracking is on, the instrument measures phase noise relative to the highest-amplitude signal within
about 20 MHz of the user-entered frequency. The difference between center frequency and the frequency
of the measured carrier is reported as frequency error. If carrier tracking is not on, the instrument measures
phase noise relative to the amplitude at the user-entered frequency.

The unit will tune to a number of offsets from the carrier frequency, and calculate the spectrum for the
frequency range about each offset using a resolution bandwidth appropriate for the offset frequency.
This is done to optimize speed while maintaining acceptable frequency resolution. A table of the values
used for measurement frequency offset, resolution bandwidths, hardware IF filter bandwidths and RF
attenuations is shown below.

Measurement frequency
offset range

Measured
span

RBW use
for spectrum
calculation Hardware IF filter RF Attenuation

10 Hz to 100 Hz 312.5 kHz 1 Hz 40 MHz Auto from ref level
100 Hz to 1 kHz 312.5 kHz 2 Hz 40 MHz Auto from ref level
1 kHz to 10 kHz 312.5 kHz 20 Hz 40 MHz Auto from ref level
10 kHz to 100 kHz 3 MHz 200 Hz 40 MHz Auto from ref level
100 kHz to 1 MHz 3 MHz 1 kHz 40 MHz Auto from ref level
1.0 MHz to 1.9 MHz 300 kHz 1 kHz 1 MHz Auto from ref level (-5 dB) 1

1.9 MHz to 20.0 MHz 300 kHz 1 kHz 1 MHz Auto from ref level (-20 dB) 1

20 MHz to 100 MHz 20 MHz 10 kHz 40 MHz Auto from ref level (-5 dB) 1

100 MHz to 1000 MHz 20 MHz 100 kHz 40 MHz Auto from ref level (-5 dB) 1

xxx

1 Attenuator adjustment when ‘optimize dynamic range’ is selected
After acquisition and calculation, the spectrum is corrected to display power in a 1 Hz bandwidth
referenced to the carrier power (dBc/Hz). The correction algorithm does not discriminate between noise
signals and coherent signals in making the dBc/Hz correction. Since all measured signals are corrected as
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if they were noise, coherent signal measurement results can contain errors in level. This is a key difference
between an SA-based measurement and a dedicated phase noise tester.

The largest difference between operation of a swept spectrum analyzer and a real-time spectrum analyzer
when measuring phase noise is a result of the wide acquisition bandwidths found in the real-time spectrum
analyzer. The real-time spectrum analyzer can select between 1 MHz, 40 MHz and 110 MHz IF filters
when performing acquisitions. By contrast, a traditional spectrum analyzer uses an IF bandwidth that can
range from a few kHz wide up to 10 MHz wide, depending upon the selected resolution bandwidth.
When the IF bandwidth is small it is able to reject out-of-band carriers so they don’t overload the final
IF and digitizers in the instrument. This allows the spectrum analyzer to begin to reduce attenuation as
the phase noise measurement tunes farther away from the carrier, improving dynamic range. The same
thing is done in the real-time spectrum analyzer, but the 1 MHz final IF section in the real-time spectrum
analyzer can’t reject signal within about 1 MHz whereas a conventional spectrum analyzer can reject
signals within a few kHz of the desired carrier. This is the reason for the shape of the phase noise plot seen
in the following illustration.

In the previous illustration, the effect of choosing ‘optimize dynamic range’ is seen. In the offsets between
10 Hz and 1 MHz, the 40 MHz acquisition bandwidth is used, and the RF attenuator is set based on the
reference level of the instrument to prevent overload of the RF/IF signal path.

At an offset of >1 MHz, a 1 MHz IF bandwidth is applied, 5 dB of RF attenuation is removed from the
signal path and the noise ‘floor’ of the measurement is reduced. At 2 MHz offset from carrier, 20 dB of
attenuation is removed with a resultant increase in dynamic range. Finally, at 20 MHz offsets, the 40 MHz
filter is used again with 20 dB attenuation removed. In order to be able to use the 40 MHz BW filter at a
20 MHz offset, the measurement frequency is moved so that the carrier is 30 MHz from the measurement
point, and well down the filter rejection skirt.
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Phase Noise Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The control panel tabs for the Phase Noise display are shown in the following table.

Settings tab Description
Frequency (see page 298) Specify Measurement BW and Integration BW. Enable carrier frequency tracking and

specify the Carrier threshold level.
Parameters (see page 176) Specifies the Optimization method.
Traces (see page 200) Specifies trace parameters such as detection method and whether smoothing in enabled.

Traces can also be saved and loaded for reference from this tab.
Scale (see page 203) Specify vertical and horizontal scale settings.
Prefs (see page 204) Specify appearance features of the graph area.
xxx

Restore defaults. Sets the Phase Noise parameters to their default values.

Frequency Tab
Use the Frequency tab to specify parameters used for taking the Phase Noise measurement.
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Setting Description
Measurement BW This sets the frequency range for the phase noise measurement range. The instrument’s

Frequency control is used to set the "carrier frequency of interest". The widest available
start/stop range is from 10 Hz greater than the carrier frequency (“Stop Offset”) to 1
GHz above the carrier (“Stop Offset”). Very small start offsets will take significant time
to measure as very narrow resolution bandwidths are used in to achieve small-offset
measurements. Large-offset stop frequencies cause small effects on measurement time,
but will increase the displayed scale of the phase noise plot.

Start Offset Sets the starting point for the Phase Noise plot. Offset is from the carrier frequency.
The minimum start offset is 10 Hz. The maximum start offset is 100 MHz. The setting
is limited to powers of ten (1, 10, 100...).

Stop Offset Sets the stopping point for the Phase Noise plot. Offset is from the carrier frequency.
The minimum start offset is 100 Hz. The maximum stop offset is 1 GHz. The Stop offset
value must be at least 10X the Start offset value. The setting is limited to powers of
ten (1, 10, 100...).

Integration BW Integration bandwidth sets the frequency range over which integrated results for phase
noise (labeled “RMS Phase Noise”) and jitter are calculated. Integration start and stop
cannot exceed the measurement bandwidth. If you set the integration bandwidth
greater than the measurement, the error message ‘Setup error: Integration BW exceeds
Measurement BW’ will appear.

Start Offset Specifies the Integration BW’s start offset from the carrier frequency.
Stop Offset Specifies the Integration BW’s stop offset from the carrier frequency.
Track carrier frequency The instrument finds the carrier signal and measures its frequency at least once each

time the Phase Noise measurement is taken and reports the error between the Freq
setting and the measured frequency of the carrier. When Track carrier frequency is
enabled, the measurement adjusts its tuning to counteract the carrier error or drift. When
carrier tracking is disabled, the measurement is made using the Freq setting specified by
the user.

Carrier threshold The minimum power level required for the signal to be recognized as a carrier. If no
signal is found above this level within 20 MHz of the Freq setting, the Phase Noise
measurement will fail.

xxx
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Parameters Tab
The Parameters tab enables you to specify acquisition settings that control the Phase Noise measurement.

Setting Description
Optimization Selects setting to optimize for speed or dynamic range.
Speed Optimizes acquisition for speed.
Dynamic Range Optimizes the acquisition for dynamic range. For this setting, the instrument uses

small bandwidth steps and attenuator optimization to maximize the dynamic range of
the measurement.

Average Specifies whether averaging is used or not. This setting affects integrated numeric results
and the trace display. The range for this setting is 2 to 100. The default setting is disabled.

xxx
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Settling Time Measurement Overview
The Settling Time measurement (Option 12) is used to measure frequency and phase settling time
of frequency-agile oscillators and subsystems. Automated measurements can reduce user-to-user
measurement variations, improve repeatability and measurement confidence, and save time in gathering
results.

Measurement Definitions

Settling time. The time measured from a reference point to when the signal of interest settles to within
user-defined tolerance.

Settled frequency. The final reference frequency, determined automatically or manually. The tolerance
band is centered about this settled frequency.

Settled phase. The final reference phase, determined automatically or manually. The tolerance band is
centered about this settled phase.

Mask Testing
Mask testing is a tool to automatically determine the pass/fail state of the Device-Under-Test. The mask
is defined over three or fewer user-defined time zones, with an independent limit band for each time
zone. If the mask is violated, the area of violation is highlighted in red on screen, and a Fail message is
displayed. The pass/fail status of the mask test can be queried over GPIB for rapid results. To configure
Mask testing, see the Mask tab (see page 193).

The instrument’s Search function can watch the Settling Time measurement for either pass or fail results,
and perform actions such as stopping or saving data when the defined condition occurs. See Search (Limits
Testing) Settings (see page 290) for details on configuring Search.

Frequency Settling Time Theory of Operation
The following paragraphs describe how a frequency and phase settling measurement is made.
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Frequency settling time flow diagram
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Phase settling time flow diagram

Acquisition hardware collects I and Q samples at the measurement frequency. Sample Rate is based
on the measurement bandwidth setting.
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The instantaneous phase is computed as:

The instantaneous frequency is the derivative of the phase:

Data smoothing is applied (if selected by the user). This filtering method uses ±n adjacent samples to
produce an average value that is used to replace the values of the original 2n samples. An example
is shown below.

If averaging is turned on, the smoothed data array is averaged with data arrays of previous acquisitions on
a point-by-point basis. Smoothing has the advantage of reducing noise-like variations in the measurement,
but carries the risk of masking real measurement data. The amount of smoothing applied must be
determined by evaluating the waveform you see for artifacts that result from the process.

Next, Settled Frequency is calculated. Settled frequency is the average frequency determined by looking
back in time from the point set by the Measurement Length control over a minimum of 256 samples. This
value is used to determine the frequency level about which to center the Tolerance range. The measurement
then searches backward through the data until it finds the first point that exceeds the tolerance range. A
maximum of 20 million acquisition data samples can be processed by the measurement.

Settling Time is measured as the time from the start reference to the point where the frequency remains
within the tolerance band. The start reference can be any of three points:
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The trigger point

The beginning of the analysis period. This result can only be computed when the instrument can find a
previous settled state within the measurement period

The point at the end of the previous frequency hop where the frequency first leaves the tolerance band.
This result can only be computed when the instrument can find a previous settled state within the
measurement period.

Settling time start reference points

All measurements are now complete and the numeric settling time values can be sent to the display.
However, no result traces have been produced yet. Detection is used to reduce the measured points (which
can number up to 10 million) to a number more easily processed by the display processor. +/- Peak
detection is always used, preserving the maximum positive and negative excursions for display. Reducing
the number of points in the result reduces the time resolution of the markers. If averaging is on, the
measurement results are computed on the average of the undecimated results.

Phase Settling Time Overview
Phase settling time is determined, as described previously, with the addition of tilt correction.

The instrument estimates tilt (or slope of the phase) using linear least square fitting over (at least)
256 samples of the phase vs. time waveform, looking backwards from the point set by the Measurement
Length. The instrument adjusts the phase waveform so that its phase is of zero value at the point set
by the Measurement Length.
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Settling Time Displays
The Frequency Settling Time measurement is used to measure the frequency settling time of
frequency-agile oscillators and subsystems. The Phase Settling Time measurement is used to measure
the phase settling time of phase-agile oscillators and subsystems. Automated measurements can reduce
user-to-user measurement variations, improving repeatability and measurement confidence and saving
time in gathering results. To measure phase settling, a phase reference is required. This means that the
measurement tool must be frequency- referenced to the device under test, or must act as the frequency
reference to the device under test. To lock the reference to an external source, go to Setup > Configure
In/Out > Frequency Reference and choose External. Values from 1 MHz to 25 MHz in 1 MHz steps
can be used as an external reference.

To show a Settling Time display:

1. Click the Displays button or select Setup > Displays.

2. From the Folders box, select RF Measurements.

3. Double-click the Freq Settling icon or the Phase Settling icon in the Available displays box. This
adds the selected display to the Selected displays box (and removes it from the Available displays box).

4. Click the OK button.

Frequency settling time display
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Phase settling time display
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Elements of the Display

Item Display element Description
1 Top of graph Sets the frequency/phase that appears at the top of the graph. However,

note that the top of graph setting, vertical scale setting (Settings > Scale
tab), and Vertical Position settings interact. Adjusting this value changes the
frequency/phase at the top of the graph by adjusting the scale setting.
Phase Settling Time: Sets

2 Vertical Position Sets the frequency/phase value at the vertical center of the graph.
3 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on

screen.
4 Horizontal Position Sets the horizontal position of the trace on the graph.
5 Measurement readouts Displays measurement results. See Measurement Readout Text Color below.
6 Signal transition start indicator A blue vertical line that indicates the staring point of the Settling Time

measurement that is based on the signal transition away from the previous
settled state, if a previous settled state is found within the measurement
period.

7 Trigger point indicator An orange line and “T” (which appears below the graph) that indicates the
location of the trigger point in time.

8 +/- Tolerance indicators A pair of blue horizontal lines that show the tolerance range.
9 Settled time indicator A blue vertical bar that shows the point on the trace at which the measurement

has determined the signal frequency or phase to be settled.
10 Measurement length indicator A magenta vertical line that specifies the end of the allowed measurement

period. This is a control, not a result.
11 Scale Adjusts the horizontal (time) scale of the graph.
12 Clear Restarts multi-trace functions (Avg, Hold) and erases the trace.
13 Function Displays the Detection and Function selections for the selected trace.

(Detection is always +/-Peak for Settling Time measurements.)
14 Show Controls whether the selected Trace is visible or not. When trace is Off, the

box is not checked.
15 Trace Selects a trace. Touching here displays a menu that shows the available

traces and whether they are enabled or not. If you select a trace that is not
currently enabled, it will be enabled.

xxx

Measurement Readout Text Color
The measurement readouts can appear in either black text or red text. Measurement results that appear
in black text indicate:

the signal is settled AND

the signal is settled longer than the minimum settled duration AND

the settling time is valid OR the settling time from trigger is valid

If any of the conditions listed are not met, the measurement results text is red.
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Elements of the Frequency Settling Time Graph
The following illustration shows the various indicators that appear in the Frequency Settling Time graph.

NOTE. The blue vertical bar that indicates the end of the previous settled state may not always appear.
For frequency settling time, this can happen because the starting frequency is outside the measurement
bandwidth.

Elements of the Phase Settling Time Graph
The following illustration shows the various indicators that appear in the Phase Settling Time graph. For
most phase settling time measurements, there is not a previous settled state within the measurement
period, making it impossible to measure the settling time from the previous settled value. However, the
settling time from trigger is typically available.
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NOTE. The blue vertical bar indicating the measurement start time may not appear. Zero phase is
referenced to the measured hop, as the phase will not typically have a settled value during the previous hop.

Measuring Settling Time
1. Select the Displays button.

2. Select RF Measurements from the Folders box.

3. Double-click the Freq Settling icon or Phase Settling icon in the Available displays box. Click OK
to complete your selection.

4. Select General Signal Viewing from the Folders box.

5. Double-click the Time Overview icon in the Available displays box. Click OK to complete your
selection.
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6. Press the front-panel Freq button and use the front-panel keypad or knob to adjust the frequency to
that of the signal you want to measure.

7. Select the Trig button.

8. In the Trigger control panel, select Triggered. Configure the trigger settings an needed to achieve a
triggered signal.

For the next step in measuring settling time, you must set the starting point of the measurement. To do
this, you will use the Time Overview display.

9. Select the Time Overview display.

10. At the left edge of the graph, drag across the graph to adjust the analysis offset. Adjust the Analysis
Offset to locate the start of the settling time measurement just ahead of the signal transition where
you want to measure the settling time. Any portion of the signal in the gray area will be excluded
from the settling time measurement.

Setting the starting point of the settling time measurement

Even if the signal transition is difficult to see on the Time Overview display, you can set the starting
point based on the location of the Trigger indicator below the graph. Or open the Frequency vs. Time
graph to see the frequency transition.

11. Click in the Settling Time display to select it.

12. Select the Settings button to display the Settling Time Settings control panel.

13. On the Define tab, adjust the Meas BW (see page 191) to improve the signal-to-noise ratio as
appropriate. Make sure the bandwidth covers the settled frequency, particularly when the instrument
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Measurement Frequency is not locked to the spectrum Center Frequency (Analysis control panel >
Frequency tab).

14. Set the Target reference (see page 191) to Auto or Meas freq as appropriate. If you select Meas freq,
also set Offset to fine-tune the measurement frequency if necessary.

15. Set the Tolerance (see page 191) as required for your measurement.

If your signal must be settled for a period of time before it is considered settled, you can specify a
minimum settled duration for the settling time measurement.

16. Select the Time Params tab. Adjust the Min settled duration (see page 192) as required.

To get the measurement made in the correct location on the signal, you must adjust the measurement
length. You do this by dragging the magenta line in the Settling Time graph.

17. Drag the measurement length indicator (magenta line) to the correct location on the signal. Choose a
point at which the signal appears to be well settled. The measurement will then find the exact time at
which the signal actually settled to within the specified tolerance.

Note the difference in the settling time in the two illustrations that follow. In both examples, the Target
reference is set to Auto. The only difference is the measurement length, as shown by the magenta line.

Frequency settling time display before setting the measurement length
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Frequency settling time display after setting the measurement length

Settling Time Settings
The settings for the Frequency and Phase Settling Time displays are shown in the following table.

Settings tab Description
Define (see page 190) Sets the measurement parameters that characterize the settling time measurement.
Time Params (see page 192) Sets measurement end-time and minimum settled duration parameters.
Mask (see page 193) Enable or disables mask testing and sets the parameters that specify the three zones

used for mask testing.
Trace (see page 193) Specifies trace display characteristics and which traces are displayed.
Scale (see page 203) Sets vertical and horizontal scale and position parameters.
Prefs (see page 204) Specifies whether or not to show certain display elements, the maximum number of points

in the exported trace, and the displayed precision of the settling time measurement.
xxx
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Settling Time Displays Shared Measurement Settings
The control panel tabs in this section are shared by the Frequency and Phase Settling Time displays. These
control panel tabs are not shared with other RF Measurement displays. With few exceptions, each display
shares values for each of the controls on these tabs. For example, Vertical Scale values are independent for
each of the displays (degrees for Phase Settling Time and Hertz for Frequency Settling Time).

Common controls for settling time measurement displays
Settings tab Description
Define (see page 190) Specifies the parameters that characterize the settling time measurement.
Time Params (see page 192) Specifies the Measurement length and minimum settled duration for the settling time

measurement.
Mask (see page 193) Specifies the parameters used for Mask testing.
Trace (see page 193) Specify which traces to show and how they are computed.
Scale (see page 196) Specifies the vertical and horizontal scale settings.
Prefs (see page 197) Specifies display parameters of the Settling Time displays.
xxx

Define Tab for Settling Time Displays
The Define tab for the Frequency Settling Time measurement controls several parameters that affect
how the measurement is made.

Meas Freq
Select the frequency of the signal to be measured. Measurement Frequency can be selected as the target
frequency (see Target Reference).

NOTE. If Lock Center Frequency of Spectrum Display to Measurement Frequency is unchecked, then
Measurement Frequency is independent of Center Frequency) Range: Entire input frequency of the
instrument
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Define Tab for Settling Time Displays

Meas BW
This control limits the bandwidth of the Settling Time measurement. You use the measurement bandwidth
setting to improve the signal-to-noise ratio of the measurement, resulting in lower measurement uncertainty.
However, if the measurement bandwidth is set too low, resulting in fewer samples per second, it can reduce
the number of points within the measurement length below the 256 stable samples required, thus causing
the analysis to fail. The measurement bandwidth is 100 Hz to 110 MHz (Option 110) or 100 Hz to 40 MHz
(Standard) . To see the effect of measurement bandwidth on measurement uncertainty, see the RSA6100A
Series Specifications and Performance Verification Reference, Tektronix part number 077-0251-XX. This
manual is supplied on the Documents CD or can be downloaded from www.tek.com/manuals.

Target Reference
The target reference is a calculated or user-specified value of final settled frequency within the
measurement period. When set to Auto, the instrument determines this value by averaging at least the last
256 samples at the end of the measurement period. When set toMeas freq, the Target Reference is set to
the Measurement Frequency of the instrument. You can enter a manual offset from the target frequency to
fine-tune the Target Reference whenMeas freq is selected.

Tolerance(+/-)
The Tolerance is the frequency or phase range within which the signal must remain to be considered
settled. This is set as a ± value by the user. In the frequency settling time measurement, the tolerance
band is centered about the target value. In the phase settling time measurement, the tolerance band is
centered about the settled phase value.

The target frequency depends on the Target reference value setting:

If Target Reference is set to AUTO, then the target value is the settled value (the frequency at which
the signal is considered settled).

If Target Reference is set to MeasFreq, then the Target value =Meas Frequency + Offset.

Offset
Offset is used for fine-tuning the Target Reference whenMeas freq is selected. The value for Offset is
entered manually.
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Time Params Tab for Settling Time Displays
The Time Params tab is used to set the Measurement length and minimum settled duration parameters.

Measurement Length
Measurement length locates the end of the measurement period for settling time. This value is set
independently of the analysis period for other measurements in the analyzer. This allows other
measurements to display multiple frequency hops during an analysis, while focusing the settling time
analysis on a single hop. You can set the measurement length either by entering a value in the entry box, or
by dragging the magenta bar to the desired location in the graph. Traces and the display to the right of
the measurement time are shown in grey to indicate that this section of the waveform is not being used
in the measurement. If your signal does not settle to within your tolerance band, make sure that the
measurement time ends during the settled portion of the waveform. The beginning of the settling time
measurement is set with the analysis offset control, the same as other measurements in the instrument.
Use analysis offset to exclude earlier hops from the measurement. See Analysis Time (see page 296)
for setting the analysis offset control.

If there is more than one phase or frequency hop in the signal to be analyzed, use the Measurement Length
control to instruct the analyzer which hop to measure. First, adjust the main Analysis Offset control to a
point in time slightly earlier than the transition you wish to measure. Do this in the Time Overview display
or the Analysis Settings control panel. Then adjust the Measurement Length so the end of the Settling Time
measurement falls within the apparent settled period after the signal transition. The reason it is important
for the user to set this control is that the Settling Time measurements start at this point and look backwards
in time (towards the signal transition) to find the latest trace point that is not inside the tolerance band.

NOTE. If your signal does not settle to within your tolerance bands, make sure that the measurement time
ends during the settled portion of the waveform.

Min Settled Duration
The minimum settled duration is the amount of time the signal must remain within the tolerance band to be
considered settled. Some user specifications require that the signal be settled for a minimum period. If this
is not required in your application, set this value to the default of 0 seconds.
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Mask Tab for Settling Time Displays
The Mask tab is used to specify the parameters used for Mask testing.

Enable Mask Test
Enables or disables mask testing.

Start 1, 2, 3
Sets the starting point for the time zone of interest. If you don’t want to use all three zones, set the Start
Time for the unneeded zones to a time after the end of the Measurement Length.

Stop
Sets the end point for the final time zone of interest.

Limit (+/-)
Sets the mask violation limits for each time zone.

Mask Time Reference
When mask testing is enabled, the Mask time reference selection specifies the starting point of the mask.
You can choose to start the mask test at the trigger point or at the point on the trace where the signal began
its transition from its previous settled frequency or phase level to the level you intend to measure.

This capability is useful because some applications do not have a trigger signal available. For those
situations where a trigger signal is available, the specification for the device-under-test may require
that measurements be referenced to that signal.

Trace Tab for Settling Time Displays
The Traces Tab allows you to set the display characteristics of displayed traces.
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Smooth
Smooth is a low-pass filter function that uses n points in the trace to determine the smoothed value. For
example, in the case of n=3, 3 consecutive points are averaged to determine the result of the smoothed
output. This is very useful for single-shot signals that contain significant noise where multiple trace
averages cannot be used. However, smoothing does have limits, and the user should visually determine
whether smoothing is removing noise from the measurement, or if it is affecting the signal. The following
illustration shows the effect smoothing has on the displayed trace.

The range for the Smooth function is 2–1000. The setting resolution is 1. The knob increments this value
by 1, and the arrow keys increment it in steps of 1, 2, 5, 10. When smoothing is enabled, it applies
to both traces. Smooth is turned off by default.

Average
This sets the number of acquisitions to be averaged together to produce the result. Averaging reduces
random variations but maintains the correct waveshape for repeating signal aberrations. To use averaging,
the signal must be repetitive. For example, the tuning direction must always be same for each measurement
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to be averaged. Signals that vary in tuning direction will tend to average positive-going effects with
negative-going effects and the settling time characteristics will cancel out.

The range for the Average function is 2–1000. The resolution is 1. When averaging is enabled, it applies
to both traces. Average is turned off by default.

Trace
Selects a trace for display. Choices are Trace 1 and 2. Either trace can be a recalled trace.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box.

3. Click the ... button to display the Open dialog box.

RSA6100A Series Real-Time Spectrum Analyzers Help 195



RF Measurements > Common Controls for Settling Time
Displays

Scale Tab for Settling Time Displays

4. Navigate to the desired file and click Open.

5. Check the Show Recalled Trace check box.

6. Verify that the trace’s Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).

Scale Tab for Settling Time Displays
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description
Vertical

Scale Changes the vertical scale or span of the graph.
Position Sets the frequency (or phase) at the vertical center of the graph.
Autoscale Resets the Scale and Position to center the trace in the graph.

Horizontal
Scale Sets the range of time shown in the graph.
Position Allows you to pan the graph left and right.
Autoscale Resets Scale and Position to the automatically determined settings.

xxx
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Prefs Tab for Settling Time Displays
The Prefs tab allows you to change display parameters of the Settling Time displays.

The following table explains the controls that can appear on the Prefs tab.

Setting Description
Max trace points Sets the number of trace points used for marker measurements and for results export.
Show graticule Select to display or hide the graticule.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Settling Time decimal places Specifies the precision of the settling time measurement readout that appears below the
graph. This setting does not affect the precision of internal calculations.

xxx
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RF Measurements Shared Measurement Settings
The control panel tabs in this section are shared by multiple displays in the RF Measurement folder (Setup
> Displays). With few exceptions, each display maintains separate values for each of the controls on these
tabs. For example, Scale values are independent for each of the displays.

Common controls for RF measurement displays
Settings tab Description
Freq & RBW (see page 199) Allows you to specify the Center Frequency, Step size and RBW.
Traces (see page 200) Specifies trace parameters such as detection method and whether smoothing in enabled.

Traces can also be saved and loaded for reference from this tab.
Scale (see page 203) Specify vertical and horizontal scale settings.
Prefs (see page 204) Specify appearance features of the graph area.
xxx

198 RSA6100A Series Real-Time Spectrum Analyzers Help



RF Measurements > Common Controls for RF
Measurements Displays

Freq & RBW Tab

Freq & RBW Tab
The Freq & RBW tab specifies frequency parameters for some of the RF Measurements displays.

Setting Description
Meas Freq Specifies the measurement frequency.
Step The Step control sets the increment/decrement size for the knob adjustment of the

center frequency. Arrow key adjustment of frequency is also affected (it is 10x the knob
adjustment). If Auto is enabled, the spectrum analyzer will adjust the Step size as
required.

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is
Independent of the Spectrum view’s RBW setting.

VBW Adjusts the VBW (Video Bandwidth) value.
xxx

NOTE. While the measurement frequency and step settings on this control tab are shared between ACPR,
MCPR and Occupied Bandwidth, the RBW setting is not shared. The RBW setting is unique for each
measurement.

VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the
RBW setting.

NOTE. If you are following a procedure that says to "set VBW to three times the RBW value or greater", it
means that the test should be conducted with no VBW effects. In the RSA6100A Series instruments, this
condition is met by disabling the VBW function.
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Traces Tab
The Traces tab enables you to select traces for display. You can choose to display live traces and/or
recalled traces. The Trace tab (see page 193) for Settling Time displays is described in the Settling Time
controls section.

NOTE. Not all RF Measurements support multiple traces and/or save and recall of traces.

Setting Description
Trace Selects a trace for display. Choices are Trace 1, 2, and Gaussian (CCDF display only).

Trace 1 and 2 can be recalled traces.
Show Shows / hides the selected trace.
Freeze Halts updates to the selected trace.
Save Trace As... Saves the selected trace to a file for later recall and analysis.
Show recalled trace Used to select a saved trace for display.
Detection (Phase Noise only) Sets the Detector used for the trace. Only +/- Peak and Avg (VRMS) are available for the

Phase Noise display. This setting is not available for saved traces. +/-Peak detection
results in a trace with two Y values for each X location, with shading between.

Smoothing (Phase Noise only) When enabled, diminishes point-to-point trace variations. Smoothing +/- Peak traces
treats + and - lines independently. The smoothing value adjusts how many points are in
each filter set. Range: 1 - 20; Default: 5.

xxx

Detection
Trace Detection occurs when the trace is being decimated by the measurement. For example, if the
maximum number of trace points is 100,000, and the selected analysis region is 200,000 samples, the
measurement must decimate the 200,000 resulting trace points by 2 to prevent exceeding the 100,000 trace
point limit. Since only one value can be selected for each trace point, an algorithm must be used to select
(detect) the appropriate value to use.

The IQ samples in a data acquisition can be detected in a variety of ways. The number of IQ samples
available to each trace point varies with both analysis length and trace length. For example, with Spectrum
Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one
IQ sample pair per trace point. In this case, the detection method chosen has very little effect, as the
+Peak, -Peak, Avg (VRMS) and Sample values are all equal. Changing the Spectrum Length causes the
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available detection methods to differ in value because they have a larger set of samples for the various
detection methods to process.

The available detection methods (depending on the display) are:

+/-Peak – Selects the highest and lowest values of all the samples contained in an acquisition interval.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box.

3. Click the ... button to display the Open dialog box.
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1. Navigate to the desired file and click Open.

2. Check the Show Recalled Trace check box.

3. Verify that the trace’s Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).

Gaussian Trace
The Gaussian trace is a reference trace that you can compare your trace against. Because the Gaussian
trace is for reference, there are no settings for the trace other than whether or not it is shown.

202 RSA6100A Series Real-Time Spectrum Analyzers Help



RF Measurements > Common Controls for RF
Measurements Displays

Scale Tab

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Center Frequency.

Setting Description
Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units. This is only accessible when the vertical units are
set to dBm.

Offset Adjusts the Reference Level away from the top of the trace display.
Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.
Scale Allows you to, in effect, change the span.
Offset Allows you to pan a zoomed trace without changing the Measurement Frequency. Offset

is only enabled when the span, as specified by Freq / div , is less than the acquisition
bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.
Log (Spurious only) Resets the display to show the frequency axis in a logarithmic scale.
xxx
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Prefs Tab

Prefs Tab
The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display, but include such items as enabling/disabling Marker
Readout, switching the Graticule display on/off, and Marker Noise mode. Some parameters appear with
most displays while others appear with only one display.

Setting Description
Show graticule Shows or hides the graticule.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points In general, time-domain traces can include up to 100K points and frequency-domain
traces can include up to 10K points. When the analysis produces a results array longer
than the selected trace length, the trace is decimated (using the method specified with
the Detection control) to be equal to or less than the Max trace points setting (except
when Max trace points is set to Never Decimate). This decimated (or undecimated) trace
is what is used for marker measurements and for results export.

Settling Time decimal places
(Frequency and Phase Settling
Time displays only)

Specifies the number of decimal places shown in the results readout below the graph.
This setting does not affect the precision of internal calculations.

Show trace legend (Phase
Noise display only)

Displays or hides the trace legend.

xxx
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Overview
The displays in the Pulsed RF folder (Displays > Folders > Pulsed RF) are:

Pulse Statistics

Pulse Table

Pulse Trace

The Pulse measurements provide deep insight into pulse train behavior.

Pulse Measurements
The analyzer takes the following pulse measurements: Average ON Power, Peak Power, Average
Transmitted Power, Pulse Width, Rise Time, Fall Time, Repetition Interval (Sec), Repetition Rate
(Hz), Duty Factor (%), Duty Factor (Ratio), Ripple, Droop, Pulse-Pulse Phase Difference, Pulse-Pulse
Frequency Difference, RMS Frequency Error, Maximum Frequency Error, RMS Phase Error, Maximum
Phase Error, Frequency Deviation, Phase Deviation, and Time. See Available Measurements (see page 27)
for definitions.
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Pulse Table Display
The Pulse Table lists selected measurements in a spreadsheet format, showing the pulse numbers and all
the results for each measurement on all the detected pulses. Pulses are numbered from one.

Displaying the Pulse Table
1. Press the Displays button or select Setup > Displays.

2. Select PulsedRF in the Folders box.

3. Double-click Pulse Table in theAvailable displays box to add the display to the Selected displays box.

4. Click OK.

Selecting the Measurements to Show
1. With the Pulse Table selected, press the Settings button.

2. In the Pulse Table Settings control panel, select theMeasurements tab.
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3. Select the measurements you wish to take from the list of measurements.

4. Click the close box ( ) to remove the Settings control panel.

Changing the Pulse Table Display Settings (see page 207)

Pulse Table Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Settings control panel tabs for the Pulse Table Display are shown in the following table.

Settings tab Description
Measurements (see page 207) Selects the measurements to be show in the Pulse Table.
Params (see page 212) Specifies several parameters that control how pulses are counted and defined.
Define (see page 214) Specifies parameters that control where measurements are taken on a pulse.
Levels (see page 219) Specifies parameters that control the method and levels used to calculate some pulse

values.
Freq Estimation (see
page 220)

Specifies the reference used for computing frequency errors.

xxx

Restore defaults. Sets the Pulse Table parameters to their default values.

Measurements Tab
The Measurements tab is used to specify the measurements that appear in the Pulse Table.

Show in Pulse Table
Checked measurements appear in the Pulse Table.
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Pulse Trace Display
The Pulse Trace display shows one measurement result and a trace graph illustrating that measurement
for a selected pulse number. You can also choose to display arrows and lines in the graph that illustrate
where on the pulse the measurement is being taken.

Elements of the Pulse Trace Display
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Item Display element Description
1 Optimized indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Pulse Trace display is the optimized display.
2 Result Use this list to select the measurement to show. The measurement chosen

here selects the same result to be displayed in the Statistics view and
highlighted in the Table view. Selecting a result in any of these views causes
the same result to be selected in all of them.

3 Pulse Selects which pulse result is shown. Like the Result, this selection is shared
with the Statistics and Table views. The maximum number of pulses that
can be measured is limited to 10000.

4 Pulse threshold indicator This green triangle indicates the power threshold used to detect pulses. See
Settings > Params > Power threshold to detect pulses.

5 Autoscale Set the axes to values that show all trace points.
6 Horizontal offset and scale Located along the bottom edge of the trace display, these controls specify the

offset and scale on the horizontal axis.
7 Top of graph adjustment Sets the power level shown at the top of the graph. If the number is greater

than the Ref Level, a white line will appear in the graph to indicate the Ref
Level.

8 Vertical scale Sets the vertical scale value.
xxx

Changing the Pulse Trace Display Settings (see page 209)

Pulse Trace Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Setup settings for the Pulse Trace display are shown in the following table.

Settings tab Description
Params (see page 212) Specifies several parameters that control how pulses are counted and defined.
Define (see page 214) Specifies parameters that control where measurements are taken on a pulse.
Levels (see page 219) Specifies parameters that control the method and levels used to calculate some pulse

values.
Freq Estimation (see
page 220)

Specifies the reference used for computing frequency error.

Scale (see page 221) Specifies the vertical and horizontal scale settings.
Prefs (see page 222) Specifies whether on not certain display elements are shown.
xxx
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Pulse Statistics Display
The Pulse Statistics view displays a plot of a pulse measurement’s values for every pulse in the analysis
period. For example, the Pulse Statistics display will show the rise time measurement for each of 30
pulses, with rise time on the Y axis and pulse number on the X axis. Alternatively, the Statistics Display
can show an FFT trace for the values of a measurement over all the pulses analyzed. Numeric readouts of
Max, Min, and Average in this display summarize results for the selected pulse measurement.

Elements of the Pulse Statistics Display
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Item Display element Description
1 Optimized indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Pulse Statistics display is the optimized display.
2 Result Use this list to select which measurement statistics to display. The

measurement chosen here selects the same result to be displayed in the
Pulse Trace display and the Pulse Table display. Selecting a result in any of
these views causes the same result to be selected in all of them.

3 Pulse Selects which pulse’s result is shown. Like the Result, this selection is shared
with the Statistics and Table views.

4 Statistics summary Display of measurement statistics for the selected Result.
5 Vertical range Located at the top of the left graph edge and at the bottom of the left graph

edge, use these controls to adjust the values at the top of the graph and the
bottom of the graph.

6 Plot Selects from Trend, Time Trend, FFT, and Histogram for the graph.
7 Autoscale Set the axes to values that show all trace points.
8 Horizontal offset Adjusting this value moves the graph right or left.
9 Trigger indicator Indicates the trigger point on the pulse train if the trigger occurred during the

time frame of the pulse measurements.
10 Pulse indicator For Trend and Time Trend plot types, this indicates the pulse selected by the

Pulse setting. For the FFT plot type, this indicator marks the trace point at
the selected frequency. For Histogram plot types, this indicator marks the
selected results bin.

11 Scale Adjusts the horizontal scale.
xxx

Changing the Pulse Statistics Display Settings (see page 211)
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Pulse Statistics Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The settings for the Pulse Statistics Display are shown in the following table.

Settings tab Description
Params (see page 212) Specifies several parameters that control how pulses are counted and defined.
Define (see page 214) Specifies parameters that control where measurements are taken on a pulse.
Levels (see page 219) Specifies parameters that control the method and levels used to calculate some pulse

values.
Freq Estimation (see
page 220)

Specifies the reference used for computing frequency errors.

Scale (see page 221) Specifies the vertical and horizontal scale settings.
Prefs (see page 222) Specifies whether or not certain elements of the display are shown.
xxx

212 RSA6100A Series Real-Time Spectrum Analyzers Help



Pulsed RF > Common Controls for Pulsed RF Displays Pulsed RF Shared Measurement Settings

Pulsed RF Shared Measurement Settings
The control panel tabs in this section are shared by the displays in the Pulsed RF folder (Setup > Displays).
Changing a setting on one tab changes that setting for all the Pulsed RF displays.

Common controls for pulsed RF displays
Settings tab Description
Params (see page 212) Specifies several parameters that control how pulses are counted and defined.
Define (see page 214) Specifies parameters that control where measurements are taken on a pulse.
Levels (see page 219) Specifies parameters that control the method and levels used to calculate some pulse

values.
Freq Estimation (see
page 220)

Specifies the reference used for computing frequency errors.

Scale (see page 221) Specifies the vertical and horizontal scale settings.
Prefs (see page 222) Specifies whether or not certain elements of the display are shown.
xxx

Params Tab
The Params tab enables you to adjust several measurement parameters for Pulsed RF displays.

Setting Description
Measurement Filter Specify whether a filter is used to limit the bandwidth of the input signal.
Bandwidth Sets the bandwidth of the measurement filter.
Power threshold to detect
pulses

Specifies the level used for locating pulses in the data.

Minimum OFF time between
pulses

Specifies the time the signal must fall below the power threshold for two pulses to be
considered separate pulses.

Max number of pulses Specifies the number of pulses to measure within the analysis time.
xxx
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Measurement Filter
Three choices are available for the measurement filter:

No Filter - Max BW: The widest acquisition bandwidth available is used. The Bandwidth setting is
disabled, but shows the value in use.

No Filter: - This is the default. The Bandwidth control is enabled for you to specify an acquisition
bandwidth.

Gaussian - The Bandwidth control is enabled for you to specify a value. The instrument uses an
acquisition bandwidth two times wider than the entered value.

Power Threshold to Detect Pulses
Specifies the minimum power level the trace must exceed to be detected as a pulse. The range for this
setting is: -3 to -70 dBc. The setting resolution is 1 dB. The default value is -10 dB.

Max Number of Pulses
If the Analysis Time contains fewer pulses than specified, the analyzer will measure all the pulse within
the analysis time. If there are more pulses in the Analysis Time, than the specified number, the analyzer
measures the specified number of pulses and ignores the rest. The range for this setting is: 1 - 10000.
The setting resolution is: 1. If this setting is not checked, the analyzer will measure all pulses within the
Analysis Time, up to a maximum of 10000 pulses.

To determine the maximum number of pulses that can be analyzed, use the following equation:

where:

Pulse rate is the number of pulses per second (frequency).

Capacity is a length of time which is displayed on the Acquire > Sampling Parameters tab.

Note that the maximum number of pulses is affected by several parameters. For example, measurement
bandwidth affects the sample rate. The measurement algorithm also can reduce the maximum number of
pulses that can be analyzed (by increasing the sample rate) based on the characteristics of the signal.

Additionally, when FastFrame is enabled, determining the maximum number of pulses is even more
challenging. In FastFrame mode, the spectrum analyzer samples the signal around events of interest
and ignores the signal between events of interest. Thus, if the instrument is only looking at pulses and
ignoring the signal between pulses, the number of pulses that can be analyzed depends strongly on the
characteristics of the pulse itself (for example, fewer wide pulses can be analyzed than narrow pulses,
all other things being equal).
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Define Tab
The Define tab enables you to specify parameters that control where measurements are made on a pulse.
The settings available depend on the measurement selected.

The following paragraphs describe the settings that appear on the Define tab according to the
Measurement(s) selection.

Freq-Domain Linearity
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Setting Description
Time method Specifies how the measurement’s duration is determined. The choices are

Absolute and Relative.
Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point
from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: ±100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length (L) Length specifies the period of time that is used for pulse measurements The
measurement time begins at the Start point and continues for the amount of time
specified by Length.

Relative time method
Length In the Relative time method, Length specifies the percentage of the top of the pulse

that is used for measurements. The instrument automatically determines the pulse
top. The measurement length is centered within the pulse ON time.

xxx

Impulse Response
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Setting Description
Apply ampl corrections Enable/disable corrections that remove errors due to the window function and to

the time offset of the side lobe.
Keep-out time (+/-) The Keep-out time specifies a region that is ignored when the trace is analyzed for

side lobes. The setting defines a region to the left and to the right of the center
of the main lobe. Lobes that fall within this time region are not eligible to be the
“highest side lobe”.

Time method Specifies how measurement parameters are determined. The choices are
Absolute and Relative.

Absolute time method
Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point

from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: ±100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length (L) Amount of time that should be included in the measurement. The measurement
time begins at the Start point and continues for the amount of time specified by
Length.

Relative time method In the Absolute time method, Length specifies the period of time that is used for
pulse measurements.

Length In the Relative time method, Length specifies the percentage of the top of the pulse
that is used for measurements. The instrument automatically determines the pulse
top. The measurement length is centered within the pulse ON time.

xxx

Freq Diff, Phase Diff

Setting Description
Measure point Specifies the period in time after the 50% rising edge at which frequency and

phase difference measurements are made.
xxx
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Ripple

Setting Description
Length Length specifies the percentage of the top of the pulse that is used for

measurements. The instrument automatically determines the pulse top. The
measurement length is centered within the pulse ON time. Only the Relative Time
method is available for Ripple.

xxx

Overshoot
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Setting Description
Time method Specifies how measurement parameters are determined. The choices are

Absolute and Relative.
Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point
from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: ±100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length (L) Amount of time that should be included in the measurement. The measurement
time begins at the Start point and continues for the amount of time specified by
Length.

Relative time method
Ref Ref specifies the level along the pulse rising edge that is defined as the point

from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: ±100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length In the Relative time method, Length specifies the percentage of the top of the pulse
that is used for measurements. The instrument automatically determines the pulse
top. The measurement length is centered within the pulse ON time.

xxx

RSA6100A Series Real-Time Spectrum Analyzers Help 219



Pulsed RF > Common Controls for Pulsed RF Displays Levels Tab

Levels Tab
Use the Levels tab to set parameters that control the method and levels used to calculate some pulse values.

Setting Description
100% Level Specifies the method used to determine the 100% level(s).
50% Level Specifies the method used to determine the 50% level on the pulse.
Rise/Fall Levels Select whether to use the 10% to 90% or 20% to 80% points (based on voltage level)

to define the rise and fall times.
xxx

100% Level
Use the 100% Level settings to select the method used to determine the 100% level(s) used for calculating
pulse parameters, for example, Rise, Fall, and Width.

The Pulse Average Amplitude defines the pulse top as the average of the values of all the points along
the pulse top. This average is used as the 100% level, from which the 10, 20, 50, 80 and 90% levels are
calculated. Pulse measurements are referenced against these various levels. For example, Rise is the time
between the 10 and 90% (or 20 and 80%) levels on the rising edge of the pulse. When the Pulse Average
Amplitude method is selected, the same 100% level is used for both rising and falling edges.

Because some RF pulse types have droop (a height difference between the beginning and ending points of
the pulse top), the 100% percent level on the rising edge may not be equal to the 100% level on the falling
edge. The Independent method of pulse point location is designed for pulses with different 100% levels
at their rising and falling edges. The Independent method calculates the 100% level for the rising edge
separately from the 100% level of the falling edge. As a result, the 10, 20, 50, 80 and 90% levels are also
different for the rising and falling edges, allowing for more accurate measurements on pulses with droop.

50% Level
Select Voltage to use -6 dB as the 50% point. Select Power to use -3 dB as the 50% level.
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Freq Estimation Tab
Use the Freq Estimation tab to specify parameters used for determining frequency offset.

Setting Description
Modulation type Specifies which algorithm to use for estimating frequency error.
Pulse Frequency Reference Specifies the method used to determine the pulse frequency error and if applicable,

the chirp slope.
Auto Selecting Auto causes the instrument to calculate the frequency offset and if applicable,

the chirp slope.
Freq Offset If Auto is not enabled, specify the value for frequency offset here. If Auto is enabled, the

offset is set to zero and this readout displays the calculated frequency error.
Chirp BW If Auto is not enabled, specify the value for Chirp Slope here. If Auto is enabled,

this readout displays the calculated Chirp slope. This setting is used only when the
modulation type is set to Linear Chirp.

xxx

Modulation Type
Frequency estimation is performed by the instrument using selectable methods, depending on signal type.
The selections for modulation type are CW (constant phase), CW (changing phase), Linear Chirp and
Other. Select the method of frequency method based upon a best match to your signal based on the
following descriptions:

CW (constant phase): The signal is not designed to change in either frequency or phase during the
measured pulse train.

CW (changing phase): The signal does not change the carrier phase within each pulse, although it
could change the phase from one pulse to another pulse. The signal is not designed to make frequency
changes.

Linear Chirp: The signal changes frequency in a linear manner during each pulse. The signal has the
same carrier phase at the same time offset from the rising edge of the pulse.

Other: The signal is not one of the listed types. You must manually enter the Frequency Offset value.

The following table maps the appropriate signal type selection with the signal characteristics.
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Phase offset from one pulse to anotherSignature
Zero Any (unknown)

CW CW Constant Phase CW Changing Phase
LFM Linear Chirp N/A
xxx

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description
Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale. The units for this setting depend on the statistic selected
from the Result drop-down list in the Pulse Statistics display.

Position Adjusts the Reference Level away from the top of the trace display. The units for this
setting depend on the statistic selected from the Result drop-down list in the Pulse
Statistics display.

Autoscale Resets the scale of the vertical axis to contain the complete trace.
Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to change the span.
Position Allows you to pan a zoomed trace.
Full Scale (Pulse Trace
display only)

Specifies the Horizontal scale default.

Selected Sets the horizontal scale default to be based on the result value for the currently-select
pulse.

Max Pulse Sets the horizontal scale default to be based on the largest value for the selected pulse
measurement.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.
Plot (Pulse Statistics display
only)

Specifies the FFT, Trend, Time Trend, or Histogram plot.

Reset Scale Restores all settings to their default values.
xxx
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Prefs Tab
The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display.

Settings on the Pulsed RF Displays Prefs Tab
The following table describes the settings that appear on the Prefs tab of the Pulsed RF displays: Pulse
Statistics and Pulse Trace. There is no Prefs tab for the Pulse Table display.

Setting Description
Show graticule Displays or hides the graticule in the trace display.
Show Marker readout in
graph

When a marker is enabled, this setting displays or hides the maker readout, but not the maker
itself, on Time Trend plots.

Histogram readout
(present only when
Histogram is the selected
plot type)

Controls the parameters Histogram readout and Bins. Histogram readout can be set to either
Count or %. Count indicates the number of hits that fell into each bin. % indicates percentage
of the total count (for the acquisition) that fell into each bin.

Bins Specifies how many "bins" or histogram bars the results are distributed into.
xxx
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Overview
The displays in the General Purpose (GP) Digital Modulation folder (Displays > Folders > GP Digital
Modulation) are:

Constellation

Demod I & Q vs Time

EVM vs Time

Eye Diagram

Frequency Deviation vs Time

Magnitude Error vs Time

Phase Error vs Time

Signal Quality

Symbol Table

Trellis Diagram

The General Purpose Digital Modulation Analysis (Option 21) provides vector signal analyzer
functionality. A wide variety of modulation types are supported, allowing you to view your signals in
Constellation, Eye and Trellis diagrams, measure the quality of the modulation, display time-domain
waveforms for demodulated I & Q signals, EVM, Phase Error, Magnitude Error, and more.

Modulation Measurements

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).
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GP Digital Modulation Overview

Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and can be reported in units of percent or dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Magnitude Error The RMS magnitude difference between the measured signal and the ideal reference

signal.
IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates

the magnitude of the carrier feed-through signal.
Gain Imbalance The gain difference between the I and Q channels in the signal generation path.

Constellations with gain imbalance show a pattern with a width that is different from
height.

Rho ρ The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the analyzer.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Constellations with quadrature error will show some leakage of
I into Q and vice versa.

xxx
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GP Digital Modulation > Constellation Constellation Display

Constellation Display
The Constellation Display shows a digitally-modulated signal in constellation form.

To show the Constellation Display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Constellation icon in the Available Displays box. This adds the Constellation icon
to the Selected displays box.

4. Click the OK button. This shows the Constellation display.

Elements of the Constellation Display
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GP Digital Modulation > Constellation Constellation Settings

Item Display element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Constellation display is the optimized display.
2 Marker Readout Located to the left of the constellation plot or below it, depending on the size of

the window. If markers are enabled, the marker readout shows the time, mag,
phase, symbol marker and symbol value of the point with the selected marker.

3 EVM Readouts The EVM readouts are located below the Constellation plot. The readout
shows EVM Peak (%) and location, RMS (%).

4 Plot Constellation graph.
xxx

Changing Constellation Settings (see page 226)

Constellation Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings.

The settings for the Constellation view are shown in the following table.

NOTE. You might be able to save time configuring the Constellation display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 256)

Settings tab Description
Modulation Params (see
page 256)

Specifies the type of modulation, symbol rate, and filters to be used in demodulating
the input signal.

Freq & BW (see page 261) Sets values for frequency error/offset, measurement bandwidth, and frequency deviation
(not every control is present for every modulation type).

Advanced Params (see
page 262)

Specifies additional parameters that are less frequently used.

Find (see page 265) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 265) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 267) Allows you to set the trace display characteristics.
Prefs (see page 269) Enables you to set characteristics of the measurement display.
xxx
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GP Digital Modulation > Demod I & Q vs Time Demod I & Q vs Time Display

Demod I & Q vs Time Display
The Demod I & Q vs Time displays demodulated I and Q vs. Time. You can choose to display I only,
Q only, or both.

Elements of the Display
To show the Demod I & Q vs Time display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Demod I&Q vs Time icon in the Available Displays box. This adds the Demod
I&Q vs Time icon to the Selected displays box.

4. Click the OK button. This shows the Demod I&Q vs Time display.
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GP Digital Modulation > Demod I & Q vs Time Demod I & Q vs Time Display

Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Demod I & Q vs Time display is the optimized display.
2 Top of Graph Sets the I and Q amplitude value indicated at the top of the graph. Changing

the top value affects the bottom of graph readout. Also, note that the top of
graph setting interacts with the internal vertical scale setting (which is not
user settable) such that the range between the top and bottom of the graph
increases or decreases automatically.

3 Position Specifies the I and Q amplitude value shown at the center of the graph display.
4 Bottom Readout Displays the I and Q amplitude value shown at the bottom of graph.
5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
6 Position Specifies the horizontal position of the trace on the graph display.
7 Scale Adjusts the span of the graph. By decreasing the scale (time per division), the

graph essentially becomes a window that you can move over the acquisition
record by adjusting the offset.

8 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq
Error, it shows the difference between the instrument Frequency setting and
the measured value of the signal’s carrier frequency. When it displays Freq
Offset, it shows the frequency offset specified on the Settings > Freq & BW
(see page 261) tab. If Freq Error is displayed, it also indicates that the Carrier
frequency detection setting is Auto. If Freq Offset is displayed, it indicates
that the Carrier frequency detection setting is manual.

xxx

Changing Demod I&Q Settings. (see page 229)
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GP Digital Modulation > Demod I & Q vs Time Demod I & Q vs Time Settings

Demod I & Q vs Time Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings.

The settings for the Demod I & Q vs Time display are shown in the following table.

NOTE. You might be able to save time configuring the Demod I & Q display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 256)

Settings tab Description
Modulation Params (see
page 256)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 261) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 262)

Specifies additional parameters.

Find (see page 265) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 265) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 267) Allows you to set the trace display characteristics.
Scale (see page 268) Specifies the horizontal and vertical scale settings.
Prefs (see page 269) Enables you to set characteristics of the measurement display.
xxx
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GP Digital Modulation > EVM vs Time EVM vs Time Display

EVM vs Time Display
The EVM vs. Time Display shows the Error Vector Magnitude plotted over Time.

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).

To show an EVM vs. Time display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the EVM vs. Time icon in the Available Displays box. This adds the EVM vs. Time
icon to the Selected displays box.

4. Click the OK button. This displays the EVM vs. Time view.

Elements of the EVM vs Time Display
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GP Digital Modulation > EVM vs Time EVM vs Time Settings

Item Display element Description
1 Top of graph adjustment Use the knob to adjust the vertical scale.
2 Position Adjusts the vertical position.
3 Autoscale Adjusts the Horizontal and Vertical scale to show the entire trace.
4 Peak and RMS value readout Shows the maximum result, the time it occurred, and the RMS of the result

over the entire analysis length.
5 Scale Sets the length of time shown in the graph.
xxx

Changing the EVM vs Time Display Settings (see page 231)

EVM vs Time Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The settings for the EVM vs. Time display are shown in the following table.

NOTE. You might be able to save time configuring the EVM vs. Time display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 256)

Settings tab Description
Modulation Params (see
page 256)

Specifies the type of modulation used in the input signal and other parameters that
controls the demodulation of the input signal.

Freq & BW (see page 261) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 262)

Specifies Freq Offset, Magnitude normalization parameters, and enables swapping
I and Q.

Find (see page 265) The Find tab is used to set parameters for finding bursts within the data record.
Analysis Time (see page 265) The Analysis Time tab contains parameters that define how the signal is analyzed in the

general purpose digital modulation displays.
Trace (see page 267) Specifies the display characteristics of the displayed trace.
Scale (see page 268) Specifies the horizontal and vertical scale settings.
Prefs (see page 269) Specifies whether certain display elements are visible.
xxx
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GP Digital Modulation > Eye Diagram Eye Diagram Display

Eye Diagram Display
The Eye Diagram Display shows a digitally modulated signal overlapped on itself to reveal variations in
the signal.

To show an Eye Diagram display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Eye Diagram icon in the Available Displays box. This adds the Eye Diagram icon
to the Selected displays box.

4. Click the OK button. This displays the Eye Diagram view.

Elements of the Display
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GP Digital Modulation > Eye Diagram Eye Diagram Display

Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Frequency Deviation vs Time display is the optimized display.
2 Top of Graph The vertical scale is normalized with no units (except for nFSK and C4FM

modulation types where the vertical units are Hz).
3 Position Specifies the value shown at the center of the graph display.
4 Bottom Readout Displays the value indicated by the bottom of graph.
5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
6 Position Displays the horizontal position of the trace on the graph display.
7 Scale Adjusts the span of the graph in symbols.
8 Freq Error Displays the difference between the maximum and minimum measured

values of the signal frequency during the Measurement Time. The displayed
frequency error is followed by either Auto or Manual. This indicates the
selected carrier frequency detection method (see Settings > Freq & BW).

xxx

Changing Eye Diagram Settings (see page 234)
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GP Digital Modulation > Eye Diagram Eye Diagram Settings

Eye Diagram Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings.

The settings for the Eye Diagram display are shown in the following table.

NOTE. You might be able to save time configuring the Eye Diagram display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 256)

Settings tab Description
Modulation Params (see
page 256)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 261) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 262)

Specifies additional parameters.

Find (see page 265) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 265) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 267) Allows you to set the trace display characteristics.
Scale (see page 268) Specifies the horizontal and vertical scale settings.
Prefs (see page 269) Enables you to set characteristics of the measurement display.
xxx
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GP Digital Modulation > Frequency Deviation vs Time Frequency Deviation vs Time Display

Frequency Deviation vs Time Display
The Frequency Deviation vs Time display

To show a Frequency Deviation vs Time display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select Frequency Deviation vs Time.

3. Double-click the Frequency Deviation vs Time icon in the Available Displays box. This adds the
Frequency Deviation vs Time icon to the Selected displays box.

4. Click the OK button. This displays the Frequency Deviation vs Time view.

Elements of the Display
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GP Digital Modulation > Frequency Deviation vs Time Frequency Deviation vs Time Display

Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Frequency Deviation vs Time display is the optimized display.
2 Top of Graph Sets the frequency deviation value indicated at the top of the graph. Changing

the top value affects the bottom of graph readout. Also, note that the top of
graph setting interacts with the internal vertical scale setting (which is not
user settable) such that the range between the top and bottom of the graph
increases or decreases automatically.

3 Position Specifies the frequency deviation value shown at the center of the graph
display.

4 Bottom Readout Displays the value of the frequency deviation value shown at the bottom
of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
6 Position Specifies the horizontal position of the trace on the graph display.
7 Scale Adjusts the span of the graph. By decreasing the scale (time per division), the

graph essentially becomes a window that you can move over the acquisition
record by adjusting the offset.

8 Freq Error Displays the difference between the maximum and minimum measured
values of the signal frequency during the Measurement Time. The displayed
frequency error is followed by either Auto or Manual. This indicates the
selected carrier frequency detection method (see Settings > Freq & BW).

xxx

Changing Frequency Deviation vs Time Settings (see page 237)
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GP Digital Modulation > Frequency Deviation vs Time Frequency Deviation vs Time Settings

Frequency Deviation vs Time Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Setup settings for Frequency Deviation vs. Time are shown in the following table.

NOTE. You might be able to save time configuring the Frequency vs. Time display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 256)

Settings tab Description
Modulation Params (see
page 256)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 261) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 262)

Specifies additional parameters.

Find (see page 265) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 265) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 267) Allows you to set the trace display characteristics.
Scale (see page 268) Specifies the horizontal and vertical scale settings.
Prefs (see page 269) Enables you to set characteristics of the measurement display.
xxx
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GP Digital Modulation > Magnitude Error vs Time Magnitude Error vs Time Display

Magnitude Error vs Time Display
The Magnitude Error displays the magnitude of the symbol error. The amplitude appears on the vertical
axis while time is plotted along the horizontal axis.

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).

To display Magnitude Error vs. Time:

1. Select the Displays button or Setup > Displays. This displays the Select Displays dialog box.

2. Select GP Digital Modulation in the Folders box.

3. Double-click theMag Error vs. Time icon or select the icon and click Add. The icon will appear in
the Selected displays box and will no longer appear under Available displays.

4. Click OK.

Elements of the Display
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GP Digital Modulation > Magnitude Error vs Time Magnitude Error vs Time Display

Item Display element Description
1 Top of graph adjustment Use the knob to adjust the value of the vertical scale.
2 Position Adjusts the level shown at the bottom of the display.
3 Autoscale button Adjusts the vertical and horizontal settings to provide the best display.
4 Horizontal Position Adjusts the horizontal position of the signal. Units can be either Symbols or

Seconds (Settings > Analysis Time tab > Units).
5 Peak and RMS value readout Displays the Peak value of the magnitude error, the RMS value of the

magnitude error, and the time at which it occurs within the acquisition. Units
can be either Symbols or Seconds (Settings > Analysis Time tab > Units).

6 Horizontal Scale Sets the time spanned by the graph. Units can be either Symbols or Seconds
(Settings > Analysis Time tab > Units).

7 Freq Error Freq Error is the difference between the Center Frequency and the measured
frequency of the signal being tested. This readout will be Freq Offset if the
Freq Offset parameter on the Settings > Advanced Params (see page 262)
tab is set to Manual.

xxx

Changing Magnitude Error vs Time Display Settings (see page 240)
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GP Digital Modulation > Magnitude Error vs Time Magnitude Error vs Time Settings

Magnitude Error vs Time Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Setup settings for Magnitude Errors vs. Time are shown in the following table.

NOTE. You might be able to save time configuring the Magnitude vs. Time display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 256)

Settings tab Description
Modulation Params (see
page 256)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 261) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 262)

Specifies additional parameters.

Find (see page 265) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 265) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 267) Allows you to set the trace display characteristics.
Scale (see page 268) Specifies the horizontal and vertical scale settings.
Prefs (see page 269) Enables you to set characteristics of the measurement display.
xxx
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GP Digital Modulation > Phase Error vs Time Phase Error vs Time Display

Phase Error vs Time Display
The Phase Error vs. Time display shows the phase angle of the symbol error over time. The phase is
plotted along the vertical axis while time is plotted along the horizontal axis.

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).

To show the Phase Error display:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select GP Digital Modulation in the Folders box.

3. In the Available displays box, double-click the Phase Error icon or select the icon and click Add.
The Phase Error icon will appear in the Selected displays box and will no longer appear under
Available displays.

4. Click OK to display the Phase Error.

Elements of the Phase Error vs Time Display
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GP Digital Modulation > Phase Error vs Time Phase Error vs Time Display

Item Display element Description
1 Freq Error Freq Error is the difference between the Center Frequency and the measured

frequency of the signal being tested. This readout will be Freq Offset if the
Freq Offset parameter on the Settings > Advanced Params (see page 262)
tab is set to Manual.

2 Top of graph adjustment Adjusts the phase angle shown at the top of the graph.
3 Position Adjusts the vertical offset.
4 Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the

graph.
5 Offset Adjusts the horizontal offset.
6 Peak and RMS readouts Displays the Peak value of the phase error and the time at which it occurred.

Also displays the RMS value over the analysis length.
7 Scale Sets the time spanned by the graph.
xxx

Changing the Phase Error vs Time Display Settings (see page 243)
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GP Digital Modulation > Phase Error vs Time Phase Error vs. Time Settings

Phase Error vs. Time Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The settings for the Phase Error vs. Time display are shown in the following table.

NOTE. You might be able to save time configuring the Phase Error vs. Time display by pressing the
Standard Settings button from the Settings control panel. This allows you to select a preset optimized for a
standard from the Select Standard dialog box. See Standard Settings Button. (see page 256)

Settings tab Description
Modulation Params (see
page 256)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 261) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 262)

Specifies additional parameters.

Find (see page 265) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 265) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 267) Allows you to set the trace display characteristics.
Scale (see page 268) Specifies the horizontal and vertical scale settings.
Prefs (see page 269) Enables you to set characteristics of the measurement display.
xxx
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GP Digital Modulation > Signal Quality Signal Quality Display

Signal Quality Display
The Signal Quality display shows several measurements of signal quality. The measurements displayed
depend on the modulation type. There is a set of measurements displayed for all modulation types except
nFSK and C4FM. There is a second set of measurements displayed for nFSK and C4FM modulation types.

Signal Quality display for all modulation types except nFSK, C4FM, OQPSK, and SOQPSK

Signal Quality display for OQPSK and SOQPSK modulation types
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GP Digital Modulation > Signal Quality Signal Quality Display

Signal Quality display for nFSK modulation type

Signal Quality display for C4FM modulation type
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GP Digital Modulation > Signal Quality Signal Quality Display

Elements of the Display

Measurements for all modulation types except nFSK, C4FM, OQPSK and SOQPSK
Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

xxx
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GP Digital Modulation > Signal Quality Signal Quality Display

Measurements for OQPSK and SOQPSK modulation types
Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Offset EVM Offset EVM is like EVM except for a difference in the time alignment of the I and Q
samples. For EVM, I and Q samples are collected at the same time, for every symbol
decision point (twice the symbol rate for offset modulations). For Offset EVM, the I and Q
symbol decision points are time-aligned before collecting the I and Q samples. In this
case, one I and one Q sample is collected for each symbol (half as many samples as the
same number of symbols for (non-offset) EVM.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

xxx
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GP Digital Modulation > Signal Quality Signal Quality Display

Measurements for nFSK modulation types
Measurement Description
Peak FSK err Peak value of the frequency deviation error at the symbol point.
RMS FSK Err RMS value of the frequency deviation error at the symbol point.
Peak Mag Err The Peak magnitude difference between the measured signal and the reference signal

magnitude.
RMS Mag Err The RMS magnitude difference between the measured signal and the reference signal

magnitude.
Freq Error The frequency difference between the measured carrier frequency of the signal and the

user-selected center frequency of the instrument.
Freq Deviation Frequency distance from the center frequency at the symbol point.
Symbol Rate Error This compares the user-entered symbol rate to the instrument calculated symbol rate of

the analyzed signal.
Symbol Rate When in Auto-symbol rate, the instrument calculates the symbol rate of the signal and

the instrument calculates the error between the user entered value and the instrument
calculated value.

xxx

Measurements for C4FM modulation type
Measurement Description
RMS Error Magnitude RMS value of the frequency deviation error at the symbol point.
Carrier Frequency Error Frequency difference between averaged signal frequency and the center frequency.
Deviation Frequency distance from the center frequency at the symbol point.
Length Number of symbols in the analysis area.
xxx

Changing the Signal Quality Display Settings (see page 249)
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GP Digital Modulation > Signal Quality Signal Quality Settings

Signal Quality Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Setup settings for Signal Quality are accessible only when the Signal Quality display is selected.

NOTE. You might be able to save time configuring the Signal Quality display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 256)

Settings tab Description
Modulation Params (see
page 256)

The Modulation tab specifies the type of modulation used for the input signal and other
parameters.

Freq & BW (see page 261) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 262)

The Advanced Params tab specifies frequency offset, magnitude normalization method
and allows you to swap the I and Q signals.

Find (see page 265) Find tab is used to set parameters for finding bursts within the data record.
Analysis Time (see page 265) The Analysis Time tab contains parameters that define the portion of the acquisition

record that is used for analysis.
Prefs (see page 269) The Prefs tab enables you to set characteristics of the measurement display.
xxx
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Symbol Table Display
The Symbol Table Display is like the Constellation Display except that a text table is used to display data
bits at a symbol rather than a graph. The Synch Word characters, if used, are in bold font.

To display the Symbol Table:

1. Select the Displays button or select Setup > Displays. This displays the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Symbol Table icon in the Available Displays box. This adds the Symbol Table icon
to the Selected displays box.

4. Click the OK button. This displays the Symbol Table view.

Using Markers
Markers are indicators in the display that you can position on a trace to measure values such as frequency,
power, and time. A Marker always displays its position and, if the Delta readout is enabled, will display
the difference between its position and that of the Marker Reference. Within the Symbol Table, colored
cells indicate the location of markers. The selected Marker is highlighted with a light green background.
All other markers are highlighted with a light gray background. In the Symbol Table, the marker readout
below the table shows the marker location in time, symbol numbers and symbol value.

Changing the Symbol Table Display Settings (see page 251)
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Symbol Table Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Setup settings for the Symbol Table view are shown in the following table.

NOTE. You might be able to save time configuring the Symbol Table display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 256)

Settings tab Description
Modulation Params (see
page 256)

The Modulation tab specifies the type of modulation used for the input signal and other
parameters.

Freq & BW (see page 261) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 262)

The Advanced Params tab specifies additional parameters.

Find (see page 265) Find tab is used to set parameters for finding bursts within the data record.
Analysis Time (see page 265) The Analysis Time tab contains parameters that define the portion of the acquisition

record that is used for analysis.
Prefs (see page 269) The Prefs tab enables you to set characteristics of the measurement display.
xxx
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Trellis Diagram Display
The Trellis Diagram display

To show an Trellis Diagram display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Trellis Diagram icon in the Available Displays box. This adds the Trellis Diagram
icon to the Selected displays box.

4. Click the OK button. This displays the Trellis Diagram view.

Elements of the Display
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Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Frequency Deviation vs Time display is the optimized display.
2 Top of Graph Sets the phase value indicated at the top of the graph. Changing the top value

affects the bottom of graph readout. Also, note that the top of graph setting
interacts with the internal vertical scale setting (which is not user settable)
such that the range between the top and bottom of the graph increases or
decreases automatically.

3 Position Specifies the phase value shown at the center of the graph display.
4 Bottom Readout Displays the value of the phase value shown at the bottom of graph.
5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
6 Position Displays the horizontal position of the trace on the graph display.
7 Scale Adjusts the span of the graph in symbols.
8 Freq Error Displays the difference between the maximum and minimum measured

values of the signal frequency during the Measurement Time. The displayed
frequency error is followed by either Auto or Manual. This indicates the
selected carrier frequency detection method (see Settings > Freq & BW).

xxx

Changing the Trellis Diagram Settings (see page 254)
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Trellis Diagram Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings.

The settings for the Trellis Diagram display are shown in the following table.

NOTE. You might be able to save time configuring the Trellis Diagram display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 256)

Settings tab Description
Modulation Params (see
page 256)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 261) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 262)

Specifies additional parameters.

Find (see page 265) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 265) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 267) Allows you to set the trace display characteristics.
Scale (see page 268) Specifies the horizontal and vertical scale settings.
Prefs (see page 269) Enables you to set characteristics of the measurement display.
xxx
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GP Digital Modulation Shared Measurement
Settings

GP Digital Modulation Shared Measurement Settings
The displays in the GP Digital Modulation folder (Setup > Displays) are each a different format for
presenting the results of a single underlying analysis. For this reason, all controls that affect the analysis
parameters are shared by all the displays in the GP Digital Modulation folder.

Changing a setting on one tab changes that setting for all the GP Digital Modulation displays. For
example, if you change the Modulation Type for the Constellation Display, it also changes the Modulation
type setting for the Signal Quality display. There are some controls that affect only the way an individual
display presents its results, such as graph scaling.

Common controls for GP digital modulation displays
Settings tab Description
Modulation Params (see
page 256)

Specifies the type of modulation , symbol rate, and filters to be used in demodulating
the input signal.

Freq & BW (see page 261) Sets values for frequency error/offset, measurement bandwidth, and frequency deviation
(not every control is present for every modulation type).

Advanced Params (see
page 262)

Specifies additional parameters that are less frequently used.

Find (see page 265) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 265) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 267) Allows you to set the trace display characteristics.
Prefs (see page 269) Enables you to set characteristics of the measurement display.
xxx
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Standard Settings Button

Standard Settings Button
On every GP Digital Modulation control panel there is a button labeled Standard Settings. This button is
used to recall settings optimized for analyzing the selected standard. See the following table for a list of
the standards for which standard settings are available. Choosing a standard from the dialog box changes
only settings for GP Digital Modulation displays.

All of the presets in the Standard Settings Dialog make the following settings:

Analysis Length: Auto

Points per Symbol: 4

Data Differential: No

Burst Mode: Off

Burst Detection Threshold: –10 dBc

Parameter values set by presets in the standard settings dialog
Standard Modula-

tion
Symbol
Rate

Meas.
Filter

Reference
Filter

Filter
Parameter

Other

802.15.4 OQPSK 1e6 None Half sine NA
SBPSK-MIL SBPSK 2.4e3 None SBPSK-

MIL
NA

SOQPSK-MIL SOQPSK 2.4e3 None SOQPSK-
MIL

NA 1

CPM-MIL CPM 19.2e3 None None NA
SOQPSK-ARTM Tier 1 SOQPSK 2.5e6 None SOQPSK-

ARTM
NA 1

Project25 Phase 1 C4FM 4.8e3 C4FM-P25 RC 0.2
CDMA2000–Base QPSK 1.2288e6 IS-95

TXEQ_MEA
IS-95 REF NA

W-CDMA QPSK 3.84e6 RRC RC 0.22
xxx

1 Center Symbol Position, Half Shift Removed

Modulation Params Tab
Menu bar: Setup > Settings > Modulation Params

The Modulation Params tab specifies the type of modulation on the input signal and other parameters
that control the demodulation of the input signal.
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Modulation Params Tab

Parameter Description
Modulation type Specifies the type of modulation on the input signal.
Symbol Rate Specifies the symbol rate in Hertz.
Measurement Filter Specifies the filter used for measurements.
Reference Filter Specifies the filter used as a reference.
Filter Parameter Enter a value used for defining the Reference Filter. (Not present for some filter types)
Modulation index (Present only for CPM modulation type)
xxx

Modulation Type
The modulation types that can be demodulated and analyzed are:
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Modulation Params Tab

Modulation type Description
QPSK Quadrature Phase Shift Keying
8PSK 8-Phase Shift Keying
D8PSK Differential Eight Phase Shift Keying
PI/2DBPSK Pi/2 Differential Binary Phase Shift Keying
DQPSK Differential Quadrature Phase Shift Keying
PI/4DQPSK Pi/4 Differential Quadrature Phase Shift Keying
BPSK Binary Phase Shift Keying
OQPSK Offset Quadrature Phase Shift Keying
16QAM 16-state Quadrature Amplitude Modulation
32QAM 32-state Quadrature Amplitude Modulation
64QAM 64-state Quadrature Amplitude Modulation
128QAM 128-state Quadrature Amplitude Modulation
256QAM 256-state Quadrature Amplitude Modulation
MSK Minimum Shift Keying
2FSK 2-Frequency Shift Keying
4FSK 4-Frequency Shift Keying
8FSK 8-Frequency Shift Keying
16FSK 16-Frequency Shift Keying
CPM Continuous Phase Modulation
SOQPSK Shaped Offset Quadrature Phase Shift Keying
SBPSK Shaped Binary Phase Shift Keying
C4FM Constant Envelope 4-Level Frequency Modulation
xxx

Symbol Rate
Specifies the symbol rate for demodulating digitally modulated signals. The symbol rate and the bit rate
are related as follows:

(Symbol rate) = (Bit rate)/(Number of bits per symbol)

For example, the number of bits per symbol is 3 for 8PSK.

Measurement and Reference Filters
The available measurement and reference filters depend on the selected modulation type. If a particular
filter is not practical for a selected modulation type, it is not presented as an available filter. To determine
which filters are available, make certain that your desired modulation type is selected. See the following
table.
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Modulation Params Tab

Modulation type Measurement filters Reference filters
BPSK
PI/2DBPSK
8PSK
D8PSK
DQPSK
PI/4DQPSK
16QAM
32QAM
64QAM
128QAM
256QAM
QPSK

None
RootRaisedCosine
RaisedCosine
Gaussian
User
Rectangular (freq)
IS-95TX_MEA
IS-95TXEQ_MEA

None
RaisedCosine
Gaussian
User
Rectangular (freq)
IS-95REF

MSK None
Root Raised Cosine
RaisedCosine
Gaussian
User
Rectangular (freq)

None
Gaussian
User

OQPSK None
RootRaisedCosine
User
IS-95TX_MEA
IS-95TXEQ_MEA

None
Half sine
RaisedCosine
User
IS-95REF

SOQPSK None
User

SOQPSK-MIL
SOQPSK-ARTM
User

CPM None
User

None
User

2FSK
4FSK
8FSK
16FSK

None
Gaussian
RootRaisedCosine
RaisedCosine
Rectangular (freq)
User

None
Gaussian
RaisedCosine
User

C4FM C4FM-P25 RaisedCosine
User

SBPSK None
User

SBPSK-MIL
User

xxx
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Modulation Params Tab

The measurement filter is applied before the demodulation bit is detected and the ideal reference is
calculated.

The reference filter is applied to the internally generated ideal reference signal before the EVM is
calculated.

Filter Parameter
The filter parameter specifies the alpha for the Root Raised Cosine or Raised Cosine filter, or the
bandwidth-time product (BT) for the Gaussian filter, when selected as the Reference filter. Some filter
types have a fixed parameter value that is specified by industry standard, while other filter types by
definition have no filter parameter. For filter types with no filter parameter, there is no filter parameter
control present in the control panel.
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Freq & BW Tab

Freq & BW Tab
The Freq & BW tab specifies a group of settings that affect how measurements are made.

Freq & BW tab with nFSK or C4FM modulation type selected and Frequency Error readout enabled (Auto selected)

Freq & BW tab with SOQPSK modulation type selected and Frequency Offset enabled (Auto deselected)

Setting Description
Frequency Error / Frequency
Offset

When Auto is enabled, this readout displays frequency error and the measurement
is made at the calculated frequency. When Auto is disabled, this setting changes to
Frequency Offset. When set to Frequency Offset, this setting is used to demodulate a
signal that is not at the center frequency. The measurement is made at the user-entered
offset. The Measurement Filter (if any, specified on the Modulation Params tab) is applied
about the offset frequency whether set automatically or manually.

Measurement BW This setting allows you to override the automatic bandwidth calculation and directly enter
a bandwidth value. If you enter a value for the measurement bandwidth, be aware that
the actual bandwidth of data provided to the measurement will be at least as wide as
the value you request and may be as much as two times wider than requested. This
override of the selected measurement bandwidth is done so that the instrument uses
sufficient bandwidth relative to the chosen symbol rate to ensure good signal quality
measurements.

Frequency Deviation For nFSK modulation types, this setting specifies the frequency deviation. Select Auto to
make the instrument do this automatically. Deselect Auto to enter a value manually.
This setting is present for only nFSK and C4FM modulation types.

xxx
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Advanced Params Tab

Advanced Params Tab
The Advanced Params tab specifies additional parameters that control the demodulation of the signal.

Advanced Params tab for all modulation types except nFSK and C4FM

Advanced Params tab for modulation type nFSK

Advanced Params tab for modulation type C4FM
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Advanced Params Tab

Parameter Description
Mag Normalize
(not present for nFSK or C4FM
modulation types)

Select RMS Symbol Magnitude or Max Symbol Magnitude. This setting applies to Mag
Error and EVM.

Swap I and Q When enabled, the I and Q data are exchanged before demodulating.
Symbol rate search
(Present only for nFSK
modulation types)

Determines whether to automatically detect or manually set the symbol rate. When
selected, automatically detects the symbol rate to perform analysis. The calculated
symbol rate is displayed in the Signal Quality display. The Symbol Rate Error is also
calculated and displayed when Symbol rate search is enabled.

User Symbol Map (per
Modulation Type)

Enables the use of custom symbol maps. This enables you to specify the location of
symbols in the display. This control can be set independently for each of the modulation
types.

xxx

Mag Normalize
Specifies whether Magnitude Normalization uses the RMS Symbol Magnitude or the Maximum Symbol
Magnitude as the basis for normalization. Use RMS Symbol Magnitude on QPSK modulations (equal
magnitude symbol locations), and use Maximum Symbol Magnitude for signals that have a large difference
in magnitude among the symbol locations (such as 128QAM). It prevents the instrument from using the
very low magnitude center symbols when normalizing the constellation. The outer symbols are a better
normalization reference than the center in this case.

Swap I and Q
Use the Swap I and Q control to correct a signal sourced by a downconverter that inverts the frequency
of the signal under test.

User Symbol Map
A User Symbol Map is a text file that specifies the location of symbols in the display. The symbol map
is unique for each modulation type. The easiest way to create a custom symbol map is to start with
the default symbol map and modify it. The default symbol map file is located at C:\RSA6100A Files.
The default symbol map file is named DefaultSymbolMaps.txt. See Symbol Maps (see page 270) for
illustrations of the default symbol mapping.

To specify a user symbol map:

1. Click the ... button.

2. Navigate to the directory containing the user symbol text file you want to use.

3. Select the desired file in the Open window and click Open.

4. Select User Symbol Map to enable the user symbol map.

Editing the User Symbol Map. The symbol map is a plain text file and can be edited with any plain text
editor.
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Advanced Params Tab

CAUTION. Whenever you reinstall the program software, the existing DefaultSymbolMaps.txt file will be
overwritten. To create a custom symbol map, you should make a copy of the default symbol map file, edit
the copy to suit your needs, and save it with a new name. Guidance on how to edit the symbol map file
is contained within the default symbol map file.

The following excerpt from the default symbol map file explains the structure of the file and how to edit it.
## Symbol Mapping Definitions

## Version 1.2

## This file defines the mapping of modulation states to symbol values.

##

## File Format :

## -------------

## 1. Comments begin with ’##’ and may appear after the last field in a line

## 2. A symbol map begins and ends with a line containing the name of the

## modulation type. These names must exactly match the name of one of the

## modulation types in the RSA software

## 3. Empty cells may be included to preserve the constellation shape.

## 4. Blank lines are ignored.

## 5. A modulation type which does not match the name of an existing

## type will be ignored.

##

## Usage :

## -------

## 1. The file is intended to be edited with Notepad or similar text editor

The following text is an example of a symbol map.
## Symbol Map for 32 QAM

## (Resembles the shape of the constellation)

32QAM

00011 00010 00001 00000

01001 01000 00111 00110 00101 00100

01111 01110 01101 01100 01011 01010

10101 10100 10011 10010 10001 10000

11011 11010 11001 11000 10111 10110

11111 11110 11101 11100

32QAM
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Find Tab

Find Tab
The Find tab is used to set parameters for finding bursts within the data record. This is a post-acquisition
operation. Synch Word search controls are also on this tab.

Setting Description
Burst Detection: Mode Select whether to analyze bursts

- Auto: If a burst is found, analyze just that burst period. If a burst is not found, analyze
the whole analysis length.
- On: If a burst is found, analyze just that burst period. If a burst is not found, display
an error message.
- Off: Analyze the whole analysis length.
If the signal isn’t adequate for demodulation, an error message is shown.

Burst Detection: Threshold Sets the level required for the signal to qualify as a burst. Enter a value in dBc down
from top of the signal.

Use Synch Word When enabled, specifies the string of symbols to look for. Enter the search string with
external keyboard or the on-screen keyboard.

Clear Blanks the search string field.
xxx

Analysis Time Tab
The Analysis Time tab contains parameters that define how the signal is analyzed in the general purpose
digital modulation displays.
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Analysis Time Tab

The settings values on this tab are the same as those on the main Analysis control panel for the instrument
with the only difference being that Analysis Length can be set in either Seconds or Symbols in this location.

Setting Description
Analysis Offset Specifies the location of the first time sample to use in measurements.
Auto When enabled, causes the instrument to set the Analysis Offset value based on the

requirements of the selected display.
Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in

either seconds or symbols, depending on the Units setting. For most modulation types,
the Analysis Length set when Auto is enabled is 128 symbols. For some modulation
types, a longer length is used.

Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.

Time Zero Reference Specifies the zero point for the analysis time.
Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols)

being used by the analyzer; this value may not match the Analysis Length requested
(in manual mode).

Units Sets the units of the Analysis Length to either Symbols or Seconds.
xxx

Analysis Offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis
Offset outside the range of time covered by the current acquisition data. (all time values are relative
to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the
current range of acquisition data settings. When the next acquisition is taken, its Acquisition Length will
be increased to cover the new Analysis Length, as long as the Sampling controls are set to Auto. If the
Sampling parameters are set to manual, or if the instrument is analyzing saved data, the actual analysis
length will be constrained by the available data length, but in most cases, measurements are able to be
made anyway. The instrument will display a notification when measurement results are computed from
less data than requested. Range: 0 to [(end of acquisition) - Analysis Length)]. Resolution: 1 effective
sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed by a measurement. As you adjust
this value, the actual amount of time for Analysis Length, in Symbol or Seconds units, is shown below the
control in the "Actual" readout. This setting is not available when Auto is checked. Range: minimum
value depends on modulation type. Resolution: 1 symbol. A maximum of approximately 80,000 samples
can be analyzed (the actual value varies with modulation type).

Time Zero Reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time
displays). Choices are: Acquisition Start or Trigger.
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Trace Tab

Parameter Description
Acquisition Start Offset is measured from the point at which acquisition begins.
Trigger Offset is measured from the trigger point.
xxx

Trace Tab
Menu Bar: Setup > Settings > Trace

Application Toolbar/Front Panel: Settings

The Trace tab allows you to set the trace display characteristics of the selected display.

Example trace tab for constellation display

Note that some settings are not present for all modulation types and some settings are not present for
all displays.

Example trace tab for constellation display set to CPM modulation type

Example trace tab for Demod I&Q display
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Scale Tab

Setting Description
Content Selects whether to draw lines (vectors) between constellation points in the display.

Present for the Constellation display only.
Trace Selects the trace that is hidden or displayed based on whether or not Show is selected.
Show Specifies whether the trace selected by Trace is displayed or hidden.
Points per Symbol Select how many points to use between symbols when connecting the dots. Values:

1, 2, 4, 8.
Remove Q offset The I and Q data traces are normally displayed with an offset of half a symbol. When the

modulation type is set to SOQPSK or OQPSK, you can remove this offset by selecting
Remove Q offset. Present for Constellation, Demod I&Q, and Eye Diagram displays only.

Symbol point location Selects whether to evaluate the symbol value at the center or the end of the eye opening.
This control is only present for some of the supported modulation types.

Phase Multiplier Sets the multiplication constant for the phase multiplication display: ×1 (default), ×2, ×4,
×8, ×16, or ×32. The phase multiplication display facilitates observation of noisy CPM
signals by multiplying measurement signal phase by the constant to reduce the number
of phase states and expand the phase difference between adjacent symbols.

xxx

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency.
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Prefs Tab

Setting Description
Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.
Position Position adjusts the reference level away from top of the graph.
Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.
Scale Allows you to, in effect, change the span.
Position Allows you to pan a zoomed trace without changing the Measurement Frequency.

Position is only enabled when the span, as specified by Freq/div, is less than the
acquisition bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.
xxx

A Note About Units
The Units used for the horizontal scale can be either Seconds or Symbols. To set the units for the horizontal
scale, display the Analysis Time tab. On the tab, select the appropriate units from theUnits drop-down list.

Prefs Tab
The Prefs tab enables you to change appearance characteristics of the GP Digital Modulation displays.

Setting Description
Show graticule Shows or hides the graticule.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Radix Specifies how symbols are displayed in the Symbol Table display and in the Marker
readout in the Constellation display.

xxx
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Symbol Maps
This topic shows the symbol mapping for each digital modulation technique.

D8PSK
Phase shift
(radians)

Symbol value
(binary)

0 000
π/4 001
π/2 011
3π/4 010
π 110
5π/4 111
3π/2 101
7π/4 100
xxx

RSA6100A Series Real-Time Spectrum Analyzers Help 271



GP Digital Modulation > Symbol Maps Symbol Maps

Pi/2 DBPSK
Phase shift
(radians)

Symbol value
(binary)

+π/2 0
–π/2 1
xxx

DQPSK
Phase shift
(radians)

Symbol value
(binary)

0 00
π/2 01
π 11
3π/2 10
xxx

Pi/4 DQPSK
Phase shift
(radians)

Symbol value
(binary)

+π/4 00
+3π/4 01
–π/4 10
-3π/4 11
xxx

MSK
Phase shift
direction

Symbol value
(binary)

– 0
+ 1
xxx

272 RSA6100A Series Real-Time Spectrum Analyzers Help



GP Digital Modulation > Symbol Maps Symbol Maps

RSA6100A Series Real-Time Spectrum Analyzers Help 273



GP Digital Modulation > Symbol Maps Symbol Maps

274 RSA6100A Series Real-Time Spectrum Analyzers Help



GP Digital Modulation > Symbol Maps Symbol Maps

RSA6100A Series Real-Time Spectrum Analyzers Help 275



GP Digital Modulation > Symbol Maps Symbol Maps

CPM
Phase shift
(h = modulation index)

Symbol value
(binary)

–3h 11
–h 10
+h 01
+3h 00
xxx
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Overview: User Defined Measurement and Reference Filters
The Modulation Parameters control tab for GP Digital Modulation displays enables you to load custom
measurement and reference filters. If the existing filters do not meet your requirements, you can create
your own filters for use in the measurement and reference settings. This section describes the structure of
user filters and provides two examples of customized filters. See User Filter File Format (see page 276).

Loading a User Measurement Filter
To load a your own measurement filter:

1. From the Modulation Params control tab (Settings > Modulation Params), click on the drop-down
list for Measurement Filter.

2. Select one of the filter names that starts with User. This displays theManage user filters window.

3. Enter a name for the filter in one of the Name (editable) boxes. This name will appear in the
drop-down list on the Modulation Params tab, prefaced with User. The maximum number of
characters for the filter name is 20.

4. Click the Browse... button and navigate to the directory containing the filter you want to load. Select
the filter and click Open. If you wish to use a filter that is not in the list, select User other and
locate and open the file you wish to use.

5. Click OK to load the filter and return to the Modulation Params page.

User Filter File Format
The filter file is selected on the Modulation Params control panel tab used by the GP Digital Modulation
displays (Option 21 only). It stores the user-defined measurement or reference filter coefficient data in
CSV format. The following figure shows the file structure.
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User filter file structure

A filter file is a plain text file, in comma-separated-variable format. The file extension must be CSV.

The filter file contains the following variables:

Rate. Specifies the oversampling rate (the number of samples per symbol). The filter coefficient data will
be interpolated by the specified rate.

FilterI,FilterQ. Specifies IQ pairs (1 to 1024) of the filter coefficient in time domain.

Rules for Creating a Filter File
A line beginning with “#” is a comment line.

Enter a positive value for the oversampling rate.

A decimal number can be expressed by fixed point or floating point. For example, 0.01 and 1.0E-2 are
both valid.

“0” (zero) and “,0” (comma zero) can be omitted. For example, “1.5,0”, “1.5,”, and “1.5” are
equivalent.

Lines with only a comma and blank lines are skipped.

Example filters. For your reference, two example filters, Raised Cosine and Gaussian, are shown here.
Both filters contain 65 data points with an oversampling rate of 8.
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Raised Cosine (α = 0.3)
(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)
# Rate 0.0383599,0 0.973215,0 0.0743803,0
8 0,0 0.895591,0 0.0720253,0
# FilterI,FilterQ -0.047715,0 0.774975,0 0.0594205,0
0,0 -0.0984502,0 0.623332,0 0.0405144,0
-0.0062255,0 -0.143898,0 0.455249,0 0.0194761,0
-0.0136498,0 -0.174718,0 0.286147,0 0,0
-0.0209294,0 -0.181776,0 0.130455,0 -0.0151973,0
-0.0263419,0 -0.157502,0 0,0 -0.0246357,0
-0.0280807,0 -0.0971877,0 -0.0971877,0 -0.0280807,0
-0.0246357,0 0,0 -0.157502,0 -0.0263419,0
-0.0151973,0 0.130455,0 -0.181776,0 -0.0209294,0
0,0 0.286147,0 -0.174718,0 -0.0136498,0
0.0194761,0 0.455249,0 -0.143898,0 -0.0062255,0
0.0405144,0 0.623332,0 -0.0984502,0 0,0
0.0594205,0 0.774975,0 -0.047715,0
0.0720253,0 0.895591,0 0,0
0.0743803,0 0.973215,0 0.0383599,0
0.063548,0 1,0 0.063548,0
xxx
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Gaussian (BT = 0.5)
(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)
# Rate 0.00191127,0 0.978572,0 0.000401796,0
8 0.00390625,0 0.917004,0 0.000172633,0
# FilterI,FilterQ 0.00764509,0 0.822878,0 7.10E--05,0
2.33E-10,0 0.0143282,0 0.707107,0 2.80E-05,0
9.11E-10,0 0.0257149,0 0.581862,0 1.06E-05,0
3.42E-09,0 0.0441942,0 0.458502,0 3.81E-06,0
1.23E--08,0 0.0727328,0 0.345977,0 1.32E-06,0
4.21E-08,0 0.114626,0 0.25,0 4.37E-07,0
1.39E-07,0 0.172989,0 0.172989,0 1.39E-07,0
4.37E-07,0 0.25,0 0.114626,0 4.21E-08,0
1.32E-06,0 0.345977,0 0.0727328,0 1.23E-08,0
3.81E-06,0 0.458502,0 0.0441942,0 3.42E-09,0
1.06E-05,0 0.581862,0 0.0257149,0 9.11E-10,0
2.80E-05,0 0.707107,0 0.0143282,0 2.33E-10,0
7.10E-05,0 0.822878,0 0.00764509,0
0.000172633,0 0.917004,0 0.00390625,0
0.000401796,0 0.978572,0 0.00191127,0
0.000895512,0 1,0 0.000895512,0
xxx
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Using Markers
Markers are indicators in the display that you can position on a trace to measure values for the X and Y
axes, such as frequency, power, and time. A Marker always displays its position and, if enabled, will
display the difference between its position and that of the Marker Reference (MR).

You can display up to five markers including the marker reference. Markers can all be placed on the
same trace or they can be placed on different traces. There are two types of Markers: Reference and
Delta Markers. The Marker Reference (labeled MR in the graph) makes absolute measurements and is
also used for calculating differences when Delta readouts are enabled. The Delta Markers (labeled M1
to M4 in the graph) are used to measure other points on the trace or the difference between the Marker
Reference and the Delta marker.

The following table shows the appearance of the four types of marker readouts.

Marker Reference
Readout

Absolute Marker
Readout

Delta Marker Readout DPX Bitmap Marker Readout

xxx

The following table shows the appearance of the marker indicators as they appear on the trace.

Marker Reference Absolute Marker Delta Marker

xxx
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Controlling Markers with the Touchscreen Actions Menu
In addition to controlling the marker actions from the front panel or screen menu items, you can use the
touch screen actions menu to move markers or add and delete markers.

To use the Touchscreen Actions menu, touch the display and hold for one second, then remove your finger.
You can also use a mouse to display the Touchscreen Action menu by clicking the right mouse button.

Menu item Description
Marker to peak Moves the selected marker to the highest peak. If no marker is turned on, this control

automatically adds a marker.
Next Peak Moves the selected marker to the next peak. Choices are Next left, Next right, Next

lower (absolute), and Next higher (absolute).
Add marker Defines a new marker located at the horizontal center of the graph.
Delete marker Removes the last added marker.
All markers off Removes all markers.
xxx

Measuring Signal Density, Frequency and Power on a DPX Bitmap Trace
To measure the signal density, frequency and power at a point on a DPX Bitmap trace:

1. Select Markers > Define Markers.

2. Select the Marker Properties tab.

3. Click Add. This displays a drop-down list underMR (Marker Reference), found inside the Reference
box. The first marker defined is always designated the Marker Reference. Subsequently defined
markers are designated as Delta Markers (you can also select and adjust markers by clicking on an
existing marker on a trace).
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on a DPX Bitmap Trace

4. From the drop-down list, select Bitmap.

5. Click the close control panel button ( ) to remove the Define Markers control panel.

6. Touch or click on the MR marker on the trace to activate the marker.

7. Drag the marker to the desired location on the bitmap.

NOTE. Markers on the DPX Bitmap trace can be placed on any point in the display, unlike markers
in other displays that can be placed only on a trace. This enables you to measure the signal density,
frequency, and power level at any point on the graph.

Searching for peaks on the DPX bitmap trace. To locate peaks on the DPX Bitmap trace, use the arrow
buttons on the Marker toolbar. The left / right arrows move the selected marker to the next peak lower
or higher in frequency. The up and down arrows search for peaks at the same frequency. The peaks on
the DPX Bitmap trace are defined by the settings for the DPX Signal Density on the Markers > Define
Markers > Define Peaks (see page 285) tab.
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Display

Measuring Frequency and Power in the Spectrum Display
To measure the frequency and power at a point on a Spectrum trace:

1. Select Markers > Define Markers.

2. Select the Marker Properties tab.

3. Click Add. This displays a drop-down list underMR (Marker Reference), found inside the Reference
box. The first marker defined is always designated the Marker Reference. Subsequently defined
markers are designated as Delta Markers (you can also select and adjust markers by clicking on an
existing marker on a trace).

4. From the drop-down list, select the trace to which you want to assign the marker.

5. Click the close control panel button to remove the Define Markers control panel.

6. Click on the marker on the trace to activate that marker.

7. Use the knob or the arrow keys on the front panel to move the marker to the desired location on the
trace. You can also click on the marker location text box in the Markers toolbar at the bottom of the
screen and adjust it with your mouse wheel. The Peak button in the Markers toolbar and the arrow
buttons to the right of it control marker peak searching on the trace.

8. Read the frequency and power level of the marker position on the display.

9. Read the signal density, frequency and power level of the marker position on the display.
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Marker Action Controls

Marker Action Controls
Controls for enabling and moving markers and for initiating marker peak searches are found in several
locations. There are buttons for a few of the most common marker activities on the front panel of
the instrument, used along with the knob for adjusting marker positions. The Markers menu contains
selections for peak searches and the Marker toolbar also has buttons for peak searches. All graphs that
support the markers offer a pop-up menu for marker actions.

Peak
Selecting Peak from the Markers menu moves the selected marker to the highest level peak within the
acquisition record.

Next Peak
Selecting Next Peak displays a submenu that enables you to move the selected marker to the next peak.

Setting Description
Next Left Moves the selected marker to the next peak to the left of the current marker position.
Next Right Moves the selected marker to the next peak to the right of the current marker position.
Next Lower (absolute) Moves the selected marker to the lower level peak (in absolute terms) on the trace.
Next Higher (absolute) Moves the selected marker to the higher level peak (in absolute terms) on the trace.
xxx

Marker to Center Frequency
Changes the center frequency to match the frequency of the selected marker.
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Enabling Markers and Setting Marker Properties

Enabling Markers and Setting Marker Properties
The Define Markers Control Panel is used to enable markers and set their properties. You can set up to five
markers including the marker reference. Markers are shown in most displays.

Markers have two types of on-screen readouts: Absolute and Delta. When Readouts is set to Absolute,
each readout displays only the marker’s position on the trace. In Frequency displays, this means the
marker readout shows the frequency and power of the trace at the marker position. When Readouts is set
to Delta, each delta marker (M1-M4) readout displays both the marker’s position on the trace and the
difference between its position and the position of the Reference Marker (MR).

Defining Markers

1. SelectMarkers > Define Markers to display the Define Markers control panel.

2. Select Add to turn on the next marker. A drop-down list under the marker label allows you to assign
the marker to a trace.

NOTE. The first marker defined will always be MR. The MR marker is the reference for delta marker
readouts.

3. Select the trace to which the marker should be attached from the drop-down list.

4. Click Add to add additional markers.

5. Click the close button to remove the Define Markers control panel.

Defining Peaks
You can specify two amplitude values that define peaks. For the DPX Spectrum display, you can also
define peaks based on signal density characteristics.
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Enabling Markers and Setting Marker Properties

Amplitude
Peak Threshold Peak Threshold specifies the level that the signal must exceed to be considered a peak.
Minimum Excursion Minimum Excursion specifies how much the signal must decrease and then increase

before another peak can be declared.
DPX Signal Density
Density Threshold Density Threshold specifies the signal density (number of hits per displayed pixel) that

the DPX bitmap must exceed to be considered a trigger event.
Minimum Excursion Minimum Excursion specifies how much the signal density must decrease and increase

again before another peak can be declared.
Smoothing (pixels squared) Smoothing specifies the number of pixels around the marker that are averaged together

to reduce "noise" in the readout of signal density. The value of this control is the number
of pixels on each side of the square area used for averaging. With Smoothing = 1, no
averaging is done and the marker z-axis readout is the hit count (density) of a single
pixel. Use this control to characterize how wide or narrow a range of pixels should be
averaged to determine the signal density.

xxx

1. SelectMarkers > Define Markers to display the Define Markers control panel.

2. Select the Define Peaks tab.

3. To define the level for Peak Threshold, enter a value in the Peak Threshold number entry box.

4. To define the amount the trace must dip, enter a value in the Peak Excursion number entry box.

5. Click the close button to remove the Define Markers control panel.
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Using the Markers Toolbar

Using the Markers Toolbar
Front Panel / Application toolbar: Markers

Menu bar: View > Marker Toolbar

SelectMarker Toolbar to display or hide the Marker Toolbar in the application window. The Marker
Toolbar enables you to operate existing markers or define new markers.

Enabling a marker or adjusting the position of a marker automatically opens the Markers toolbar.

Icon / Readout Description
Opens the Define Markers control panel.

Selected marker readout. This readout shows which marker is selected. The pop-up
menu allows you to choose the selected marker, add markers, and turn all markers off.
Marker position controls. For frequency displays, this readout shows the marker position
in Hertz. For time displays, this readout shows the marker position in seconds. The
position of the selected marker can be changed by selecting the numeric readout and
using the knob to adjust the value.
Changes the analyzer’s Center Frequency to the frequency of the selected marker.
Not selectable for time markers.
Moves the marker to the highest peak on the signal. On displays that scale about zero
on the vertical axis (for example, Magnitude Error, EVM, and Frequency vs. Time), the
highest peak selected by the Peak button is an "absolute value", therefore, negative
peaks are included in the search for the highest peak.
Moves the selected marker to the next peak to the left of the current position.

Moves the selected marker to the next peak to the right of the current position.

Moves the selected marker to the next lower peak value. The peak value here refers to
the numeric value of the peak amplitude. Thus, when repeatedly moving the marker, it
can move to the right or left depending on the location of the next lower value.
Moves the selected marker to the next higher peak value. The peak value here refers to
the numeric value of the peak amplitude. Thus, when repeatedly moving the marker, it
can move to the right or left depending on the location of the next higher value.
Displays/hides the marker table from the display.

Removes the Marker Toolbar from the display.

xxx
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Using Noise Markers in the Spectrum Display

Using Noise Markers in the Spectrum Display
In the Spectrum display, you can set Markers to Noise Mode to measure noise on the trace. Markers in
Noise Mode operate just as they do in normal mode, but the readouts for the markers are in dBm/Hz
and dBc/Hz.

dBm/Hz is the power in milliwatts referenced to a 1 Hz bandwidth. To make this measurement, the
analyzer assumes that the measured signal is random noise. It then converts the measured power (made at
any RBW) to the power that would be measured had a 1 Hz filter been applied for the measurement.

dBc/Hz represents dBm/Hz referenced to a carrier. Here, it is assumed that the carrier is a CW signal,
and its signal level does not change when the RBW is changed, so the Reference Marker measurement
on the carrier is unchanged from any other marker measurement. However, the delta marker values
are converted to dBm/Hz, and then a difference value, in dBc/Hz, is calculated between each delta
measurement and the reference.

Measuring Noise
To measure noise on a Spectrum trace:

1. SelectMarkers > Define to display the Markers control panel.

2. Click Add. The first marker defined is always designated the Marker Reference. Subsequently defined
markers are designated as Delta Markers (you can also select and adjust markers by clicking on an
existing marker in the display).

3. Click Add again so that there are at least two markers defined.

4. Check that Readouts is set to Delta.

5. If you have more than one trace defined, use the drop-down list for each marker to set it to the trace
on which you want to measure noise.

6. Select the Settings button to display the Spectrum settings control panel.

7. Click the Prefs tab.

8. Click theMarker Noise Mode check box so it is checked.

9. Click the Traces tab.

10. Verify that Detection is set to Average for the trace you are using for this measurement.

11. Click the Ana (Analysis) button.

12. Select the Units tab.

13. Select dBm for the Amplitude units.

14. Click the Close button to remove the control panel.
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Using Noise Markers in the Spectrum Display

15. Move the markers to the desired locations on the trace.

16. Read the frequency and power level for the selected marker in the upper corners of the display. To
display the delta measurement in dBc/Hz, select the delta marker (M1, M2, M3 or M4) by clicking
on it or pressing the front-panel Select button until it is selected.
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The Search Tool (Limits Testing)
You can specify pass/fail conditions for the Spectrum, Spurious, Frequency Settling Time and Phase
Settling Time displays. When these conditions are met, the instrument can perform actions such as
stopping acquisitions or saving data.

Search (Limits Testing) Settings
Menu Bar: Tools > Search...

Selecting Search displays the Search control panel. These settings define search parameters and specify
actions to be performed when the search condition is met.

Setting Description
Enable Search Select to perform a search.
Define (see page 290) Specifies which result to search and what to search for.
Actions (see page 295) Specifies the action to take when the search condition is met.
xxx

Define Tab (Search)
The Define tab sets the parameters for a search. From this tab, you specify which trace to search and what
kind of violation to search for.
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Setting Description
Search in Specifies which result to search.
Search for Specifies what to search for. You can specify a search based on a signal level or a mask.
xxx

Search In
The choices for Searching are: Phase Settling: Mask Test, Freq Settling: Mask Test, Spectrum Trace
1, Spectrum Trace 2, Spectrum Trace 3, Spectrum Math Trace, Spectrogram Trace, and Spurious. The
available choices include only results from displays that are currently open.

NOTE. If you select a trace result that is not the selected trace in the target display, you will not see the
results of the Search until you select the trace in the target measurement display that is the "Search in"
trace.

Search For
The Search for setting has selections that vary based on which display’s results you are testing.

Pass/Fail Searches for Spurious and Settling Time
The Frequency Settling Time, Phase Settling Time measurements, and Spurious measurements each
include their own mask test functions that provide pass/fail results. Controls for defining and enabling
these mask tests are found in the displays’ own control panels. Search can be configured to look for
either a Pass result or a Fail result in one of these measurements and then perform your specified Search
actions when that result occurs.
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Greater Than/Less Than Searches for Spectrum
If you select a greater than/less than search, you also specify the level that defines a violation. When you
select either is greater than or is less than, a text entry box appears to the right of the drop-down list.
Use the text entry box to specify the signal level you wish to search for. While not as flexible as mask
testing, this type of search is quicker to set up.

Mask-Based Searches for Spectrum
If you specify a mask-based search for the Spectrum display, then you need to edit the mask to specify the
levels that define a violation. When you select is outside mask or is inside mask, an Edit limits button is
displayed. Select the Edit limits button to display the Mask Editor.

To edit a search mask for a Spectrum display search:

1. Click Edit limits... to display the Mask Editor.

2. Click New Table to create a table. This clears the existing points and loads the default table.

3. Select the X axis values setting:

a. Select Absolute to specify mask point locations based on signal frequency.

b. Select Relative to specify mask point locations as offsets from the center frequency.

4. To edit values in the table:

a. To edit an existing value, double-click on the cell you want to edit.

b. To add a new point to the table, click on Add Point. Edit the values as required and click Apply
when you are finished with your changes.
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To specify a frequency multiplier, you can type K, M, or G. For the power level, you only need to specify a
numeric value. The unit is set to the current Units setting (Setup > Analysis > Units).

1. To delete a point from the table, select the point to be removed, and click Delete.

2. To close the Mask Editor without saving your changes, click Cancel (if you have already clicked
Apply, this only cancels changes since the last time Apply was clicked).

3. If Search mode is already enabled and the instrument is in Run mode, you can run a Search using your
changed points without closing the Mask Editor, by clicking Apply.

4. To save changes and close the Mask Editor, click OK.

5. To save the mask to a file for later recall, click Save As....

6. From the Save As dialog, name the file and save it in the desired location.

Masks are saved only in CSV (Comma Separated Value) format.

Performing a Mask-Based Search
To perform a Search using a mask:

1. Select Tools > Search.

2. Click the Enable Search check box.

3. Select the trace that you wish to search from the Searching drop-down list.

4. Verify that the trace you selected to search is the selected trace in the display.

5. Select either is outside mask or is inside mask from the Search for drop-down list.

6. Click the Edit limits button.

7. Edit the table as necessary or click Load to use a previously saved mask.

8. If you load a saved a mask, use the Open dialog box to locate and open the mask file.

9. Click OK.

The following figure shows the results of an is outside mask Search. The vertical red bar highlights
results that match the Search definition.
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Actions Tab
The Actions tab is used to specify an action to be taken when the search condition is met.

Setting Description
During Run or Replay Actions specified here will occur in either Run mode or Replay mode.
Beep The analyzer beeps when the search condition is met.
Stop The analyzer stops when the search condition is met.
During Run Only Actions specified here are taken only during Run mode (while acquiring live data).
AutoSave acquisition data Saves acquisition data to a file when the search condition is met.
AutoSave trace Saves Trace data to a file when the search condition is met.
AutoSave picture Saves a screen capture to a file when the search condition is met.
xxx

AutoSave File Naming
When one of the AutoSave actions is enabled, the name of the saved file is automatically incremented
even if the Automatically generate filenames option (Tools > Options > Save and Export) is not enabled.
When the file is saved, it will be saved to the last location a file was saved. You can check this location
by selecting File > Save As. The Save dialog will show you the current save location. If you want to
save the file in a different location, save a file (any type) in the desired location. This resets the save
destination to the new location.

296 RSA6100A Series Real-Time Spectrum Analyzers Help



Analyzing Data > Analysis Settings Analysis Settings

Analysis Settings
Menu Bar: Setup > Analysis

Application Toolbar: Ana

The Analysis control panel provides access to settings that are used by all displays. These settings affect
only post processing and they do not control hardware settings.

Setting Description
Analysis Time (see page 296) Specifies the length of time to use in measurements.
Spectrum Time (see page 298) Specifies whether the Spectrum Analysis display uses the same Analysis Time

parameters as all the other displays or if it uses a different Offset and Length.
Frequency (see page 298) Specifies the measurement frequency (center frequency).
Units (see page 301) Specifies the Power units for all displays.
xxx

Analysis Time Tab
The Analysis Time tab contains parameters that define the portion of the acquisition record that is used
for analysis.
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Setting Description
Analysis Offset Specifies the location of the first time sample to use in measurements.
Auto When enabled, causes the instrument to set the Analysis Offset value based on the

requirements of the selected display.
Analysis Length Specifies the length of time to use in measurements.
Auto When enabled, causes the instrument to set the Analysis Length value based on the

requirements of the selected display.
Time Zero Reference Specifies the zero point for the analysis time.
Actual This is a displayed value, not a setting. It is the Analysis Length (time) being used by the

analyzer; this value may not match the Analysis Length requested (in manual mode).
xxx

Analysis Offset
Use analysis offset to specify where measurements begin. Range: 0 to [(end of acquisition) - Analysis
Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed by a measurement. After you
enter a value, this box changes to show the actual value in use, which is constrained by Acquisition Time.
This setting is not available when Auto is checked. Range: minimum value depends on modulation type
to Acquisition Length. Resolution: 1 effective sample (or symbol).

Time Zero Reference
The analysis offset is measured from this point. Choices are: Acquisition Start or Trigger Point.

Parameter Description
Acquisition Start Offset is measured from the point at which acquisition begins.
Trigger Point Offset is measured from the trigger point.
xxx
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Spectrum Time Tab
This tab controls whether the Spectrum display uses the same Analysis Time parameters as all the other
views or uses a different Offset and Length. These settings do not apply to the DPX Spectrum display
because it has no acquisition record or analysis time.

Settings Description
Spectrum Time Mode

Independent Causes the spectrum analysis views to use the settings unique to those displays.
Use Analysis Time settings Causes the spectrum analysis views to use the settings on the Analysis Time tab.

Spectrum Time (only available when Independent is selected)
Spectrum Offset Sets the beginning of Spectrum Time with respect to the selected time reference point

(selectable in the Analysis Time tab as either Acquisition Start or Trigger).
Spectrum Length The amount of data, in terms of time, from which spectrum traces are computed.
Auto When enabled, causes the instrument to set the Spectrum Length value based on the

RBW setting.
Actual This is a displayed value, not a setting. It is the Spectrum Length (time) being used

by the analyzer; this value may not match the Spectrum Length requested (in manual
mode). The actual spectrum length is always an integer multiple of the time needed to
support the RBW value.

xxx

Frequency Tab
The Frequency tab specifies two frequency values: the Measurement Frequency and the Spectrum Center
Frequency. The Measurement Frequency is the frequency at which most displays take measurements. The
Spectrum Center Frequency is the center frequency used by the Spectrum, DPX Spectrum, Spectrogram
and Time Overview displays.
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The following screen capture shows a display with both the Measurement Frequency and the Spectrum
Center Frequency locked together.

Normally, the Measurement Frequency and the Spectrum Center Frequency are locked together so
that both have the same setting. But in some situations, for example, where a signal contains a set of
channels, it is useful to unlock the Measurement Frequency from the Spectrum Center Frequency.
When the Spectrum Center Frequency is unlocked from the Measurement Frequency, you can adjust the
Measurement Frequency so that measurements can be taken at different frequencies without resetting the
center frequency. The following screen capture shows the magenta-colored measurement frequency
indicator still located at the center frequency.
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The following screen capture shows the measurement frequency indicator located at 2.0402 GHz while the
Spectrum Center Frequency is still located at 2.0000 GHz.

You can drag the Measurement Frequency indicator on the screen to set the measurement frequency. Note
the base of the Measurement Frequency indicator. The width of the box indicates the widest measurement
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bandwidth in use among the open displays. You can see how the width of this box changes with the
measurement bandwidth by, in this example, adjusting the Measurement BW setting for the Constellation
display (Settings > Freq & BW tab). As you adjust the setting, you will see how the width of the box at the
base of the Measurement Frequency Indicator changes.

Units Tab
The Units tab specifies the global Amplitude units for all the views in the analysis window.

NOTE. If you are using an External Loss Table for antenna corrections (Ampl > External Gain/Loss
Correction), set the Amplitude units to dBuA/m or dBuV/m.
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Replay Overview
The Replay function enables you to reanalyze data with different settings and even different measurements.
You can replay all the acquisitions in memory, a single acquisition, a single frame within an acquisition (if
Fast Frame is enabled), or any contiguous set of data records from acquisition history.

Displaying the Replay Control Panel
To display the Replay control panel:

Select Replay > Select data records from history....

Select Data Records Tab
The Select data records tab is used to select which data records to replay. A data record is the smallest unit
that can be replayed. Note that what constitutes a data record can vary. If FastFrame is not enabled, a
data record consists of a single acquisition. If FastFrame is enabled, each acquisition can contain multiple
frames, and a data record consists of a single frame.

Without FastFrame enabled

With FastFrame enabled

Acquisition Info Tab
Displays information about acquisition settings and sets the number of decimal places used for displaying
the time stamp.

RSA6100A Series Real-Time Spectrum Analyzers Help 303



Analyzing Data > Analyzing Data Using Replay Replay Overview

Replay Speed Tab
Sets the speed at which data records are replayed.
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Replay Menu
The Replay menu provides controls that let you choose how to replay acquisitions. The replay function
enables you to, in effect, “rerun” an analysis while applying different measurements to the same set of
acquisition data.

Menu item Description
Play all selected records Replays the sequence of records specified by Start and Stop on the Select data records

tab.
Play current record Replays the currently selected acquisition (or frame).
Play from selected Displays a submenu that you use to specify which records are to be replayed.

First record Replays the first record within the selected set.
Previous Replays the previous record within the selected set.
Next Replays the next record within the selected set.
Last record Replays the last record within the selected set.

Pause Suspends replay of the data records as soon as the current record’s replay action is
completed. Press Pause again to begin replay with the next record in the sequence.

Stop Halts the replay of acquisitions. If replay is started after Stop has been selected, replay
starts from the first acquisition.

Select all Selects all acquisitions for replay.
Select records from history Displays the Select data records tab of the Replay control panel. Use the Select data

records tab to specify which acquisitions and frames you would like to replay.
Replay toolbar Displays or hides the Replay toolbar.
xxx

Play All Selected Records
Use this selection to replay all the selected data records. The set of selected records may comprise a single
record, all records in acquisition history, or a subset of the records in history.

Play Current
Selecting Play current replays the current data record. You can identify the current acquisition record by
looking at the Replay toolbar. The first number to the right of the Select... button identifies the current
data record. For example, if the number is 2:10, it means the current record is the tenth frame of the
second acquisition in history.
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Play from Selected...
Select Play from selected to replay records as selected from the submenu. The records replayed can be
from the acquisition memory (history) or from a saved acquisition data file that has already been recalled
as the current acquisition data.

Pause
Select Pause to suspend playback. Selecting Pause again restarts the replay at the point it was paused.

Stop
Select Stop to halt the replay of data. Selecting any Replay action restarts replay of records from the
beginning.

Select All
Select Select all to select all data records for replay.

Select Records from History
Selecting Select records from history displays the Select data records tab of the Replay control panel.
The Select data records tab allows you to specify which records in the acquisition history will be used
when the Replay button is selected.

Replay Toolbar
Displays or hides the Replay toolbar that appears below the main tool bar.

Replay toolbar

306 RSA6100A Series Real-Time Spectrum Analyzers Help



Analyzing Data > Analyzing Data Using Replay Replay Toolbar

Icon Description
Replays the first record in the selected set.

Replays the previous record in the selected set.

Replays the current record in the selected set.

Replays the next record in the selected set.

Replays the last record in the selected set.

Replays all records in the selected set.

Replays all records in the selected set continuously until stopped.

Pauses replay. Pressing pause suspends replay with the current record. Selecting pause
again starts Replay with the next record.
Stops replay. Starting any replay action after pressing stop starts a new Replay action
rather than continuing from the record at which the previous replay action was stopped.
Pressing Select all selects all records in history for replay. Selecting Select all resets the
Start and Stop values on the Select data records tab of the Replay control panel.
Pressing Select displays the Select data records tab of the Replay control panel. The
Select data records tab allows you to select records from acquisition history for replay.
This readout shows information about the data record being replayed. The information
displayed shows the acquisition and frame number and time stamp for the current data
record.
The Info button display the Acquisition Info tab of the Replay control panel. The
Acquisition Info tab displays information about the acquisition data such as acquisition
bandwidth, sampling rate and acquisition length. All data records in the acquisition
history were acquired with identical parameters. When any of these parameters are
changed, all records in history are deleted as soon as the first record acquired under the
new parameter values is received.

xxx
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Amplitude Settings
Menu Bar: Setup > Amplitude

Application Toolbar: Ampl

The Amplitude control panel provides access to power-related settings that are used by all displays within
the RSA6100A application.

Setting Description
Internal Settings (see
page 307)

Sets the parameters that control the acquisition of the signal.

External Gain/Loss Correction
(see page 310)

Specifies whether a correction is applied to the signal to compensate for the use of
external equipment.

External Probe Correction (see
page 314)

Specifies whether a correction is applied to the signal if the analyzer detects a probe is
connected to the instrument. (Probes are connected to the analyzer through the RTPA2A
Real-Time Spectrum Analyzer TekConnect Probe Adapter.)

xxx

Internal Settings Tab
On the Internal Settings tab, you can specify the Reference Level for the spectrum analyzer’s RF front
end, the settings for the internal attenuator, enable/disable the internal preamp (Option 01, if installed),
and specify the RF & IF Optimization.
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Internal Attenuator
The Internal Attenuator setting can be set to Auto or manual. When Auto mode is enabled, the attenuation
setting is displayed but is not adjustable. When Auto is disabled, the attenuator operates in manual mode,
allowing you to set the internal attenuation. The internal attenuation setting range is 0 - 75 dB.

Internal Preamp
If your instrument has Option 01 installed, use this setting to switch the preamp on or off.

Monitor Attenuator Use
The input attenuator relays are rated for several million cycles. Some measurement settings result in high
rates of attenuator switching and could prematurely age the relays. Enabling this function causes the
instrument to monitor the attenuator switching rate. When a high rate of switching is maintained for more
than an hour, the instrument will halt acquisitions and display a message about the condition. To restart
acquisitions, press Run. If the check box is not selected, the monitoring function is disabled.

NOTE. This feature is provided to prevent accidental long-term high-rate attenuator switching (thus
extending attenuator life). If you need to run the instrument for extended period, such as overnight or over
a weekend, disable the setting to prevent the halting of acquisitions.

RF & IF Optimization
Specifies how the gain and bandwidth should be optimized (in the RF and IF stages of the front end). The
available settings are: Best for multiple displays, Auto, Minimize Sweep Time, Maximize Dynamic Range
(Spectrum/Spectrogram only) and Minimize Noise.

You can select RF & IF optimizations to achieve the best dynamic range, fastest sweep speed, or minimum
displayed noise. These choices affect the RF and IF attenuation levels, the selection of the acquisition
bandwidth, digitizer and the resolution of the mathematical operation performed on the acquisitions used in
varying conditions of span, reference level and resolution bandwidth. The following paragraphs describe
the effects of choosing each of the available choices.

Best for multiple displays (Default). This setting is the instrument default and is set as part of the Preset
function. When this is selected, the instrument considers all the open displays and chooses an Acquisition
Bandwidth wide enough to satisfy as many measurements as possible. Instead of optimizing the
measurement performance of the selected display, this setting decreases the incidence of non-selected
displays being unable to run because the acquisition bandwidth is set too small by the selected display.

Auto. The Auto setting is an optimized trade-off of the competing performance choices.

Minimize sweep time. Selecting Minimize Sweep Time causes the instrument to use the widest available
acquisition bandwidth when sweeping across spans greater than the maximum available real-time span.
For instruments without Option 110 (110 MHz acquisition BW), this control has no effect. For instruments
with Option 110, the swept update rate is improved by approximately 3X compared to all other RF/IF
optimization choices.
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Maximize dynamic range. Selecting Maximize Dynamic Range has several effects:

Sets RF attenuation to allow higher drive levels at the RF mixer.

Sets IF gain levels to optimize the IF for the higher signal levels that result from allowing higher
drive levels at the mixer.

Selects the acquisition path used in the instrument taking into account the user-specified Resolution
Bandwidth (RBW). When an RBW of less than 30 kHz is selected, the instrument uses a narrow-band
(312.5 kHz) acquisition path, regardless of the selected span or measurement bandwidth. This results in
the best rejection of out-of-band signals in the IF stage of the analyzer, but comes at the cost of slower
update rates for all spectrum analyzer spans and measurement bandwidths greater than 312.5 kHz.

Increases the resolution of the mathematics used in calculations of all signal results from 16 bits to
28 bits whenever span or measurement bandwidth is set to ≤312.5 kHz. This is made possible by the
high levels of decimation applied to signals processed in these narrow bandwidths.

Minimize noise. This mode increases the system gain at points past the RF mixer. This has the effect of
reducing the displayed average noise level.

The table below summarizes the conditions.
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Settings RF Mixer Level
for signal at
Ref. Level

Selected Acquisition
Bandwidth

IF Gain/Loss
settings

Notes and Trade-offs

Best for Multiple
Displays

-25 dBm Acquisition Bandwidth is
set to the value required
to service as many of the
open displays as possible.

Neutral Swept Speed, Dynamic
Range, Noise Floor

Auto -25 dBm Driven by the
measurement bandwidth
of the selected display. If
span is greater than the
available acquisition BW,
unit sweeps using 40 MHz
acquisitions

Neutral Swept Speed, Dynamic
Range, Noise Floor may
not be optimal

Minimize
Sweep Time

-25 dBm Unit uses widest available
acquisition BW for spans
greater than maximum
acquisition BW.

Neutral For units equipped with
Option 110, swept update
rate is approximately 3
times faster than Auto.
No effect in units without
Option 110.

Maximize
Dynamic Range

-20 dBm Driven by span and
user-selected RBW
when a spectrum-type
display is selected,
or by measurement
bandwidth and filter
bandwidth when other
display types are selected.
For RBW < 30 kHz,
the high dynamic range
312.5 kHz path is used
regardless of selected
span or measurement
bandwidth. Sweeps
are made in 40 MHz
acquisitions.

IF attenuation
increased to
improve dynamic
range. This
causes higher
noise level.

Might result in very slow
sweep speeds in wide
spans when RBW <
30 kHz.

Minimize Noise -25 dBm Same as Auto Set to minimize
noise level.

Might result in earlier IF
overload under some
signal conditions.

xxx

External Gain/Loss Correction Tab
The External Gain/Loss Correction tab allows you to apply a correction to a signal to compensate for the
use of external equipment, such as an amplifier or attenuator. You can specify whether the corrections on
this tab apply to all acquired data or only to a set group of displays.
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External Gain Value
Use the External Gain Value setting to apply a flat gain/loss correction to the signal. Positive values
represent a gain and negative values represent a loss. The range is –50 to +30 dB. Resolution is 0.1 dB.

NOTE. Selecting Preset clears the check box, but it does not change the value.

Apply Table Corrections To
Use the two selections to specify whether the enabled external loss tables are applied to all acquired data
or only to traces in the Spectrum, Spectrogram, Spurious, and Amplitude vs Time displays.

When choosing whether to correct sample data or traces, keep the following in mind:

If sample data is acquired while data correction is enabled, that data record is permanently corrected.
If the acquisition is saved and recalled, the recalled acquisition includes corrections. Corrections
are not saved separately from the raw data; they are used during the acquisition process to adjust
the data values.

Trace corrections can be applied at any time, as they are part of the measurement’s computations.
Using Replay will apply trace corrections to a trace if this control is enabled (and an external loss
table is specified and enabled).

Be aware that if you recall acquisition data that was saved with data corrections and you use Replay
with trace corrections selected and an external loss table enabled, the trace will be calculated using
corrected data and also corrected with trace corrections. This probably creates incorrect traces.

Trace Corrections Versus Data Corrections
Because of the real-time nature of the instrument and desire to frequently reanalyze stored acquisitions, it
is possible to apply amplitude corrections in real time. Applying real-time corrections to the incoming
data means that, the correction factors present during the acquisition are already part of the data when the
data is stored and then reanalyzed. This also allows the DPX Spectrum display to maintain its update rate
while presenting an amplitude-corrected display.

Real-time gain/loss factors are applied by creating a correction filter that is applied by the same digital
signal processing hardware used to correct for calibration and alignment factors in the instrument. This
process does have limitations. In creating a digital filter to represent the gain/loss table, a limited number
of filter taps are be used in order for the filter to be practically realizable. If your amplitude corrections
contain discontinuities or extremely sharp transitions, the filter used will contains errors and ringing.
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If the above is the case, we recommended that you use trace corrections. These are very similar to a
conventional spectrum analyzer, and may be applied to the spectrum, spectrogram, spurious search and
amplitude vs. time displays. These traces may contain transitions of any type within the maximum and
minimum correction values allowed in the tables.

External Loss Tables
Use an External Loss Table to apply a frequency dependent gain/loss correction to the signal. When an
External Loss Table is selected, the analyzer adjusts the signal according to the values in the table. An
external loss table allows you to compensate the signal level for variations in cable loss, antenna frequency
response or preamp frequency response.

You can create external loss tables from the analyzer application and save them as files. External loss tables
are saved as plain text files in CSV (Comma Separated Value) format. The tables have a CSV file extension.

You can change the title for each table. However, note that the title is only a label. It is not tied to the file
name of any table you may have loaded or saved.

NOTE. If you are using an External Loss Table for antenna corrections, be sure to set the Amplitude units
(Setup > Analysis > Units) to dBuA/m or dBuV/m.

Creating an External Loss Table
You can create an external loss table with the analyzer application. No external application is required.

To create an external loss table:

1. Click Edit.. to display the Table Editor.

2. Click New Table to create a table. This clears all entries in the existing table and loads the default table.
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3. To edit values in the table:

a. To edit an existing value, double-click on the cell you want to edit.

b. To add a new point to the table, click on Add Point. Edit the values as required.

c. Click Apply if you want to test your table without closing the editor (the table must be enabled
with the check box in the control panel and measurements must already be running).

To specify a frequency multiplier, you can type K, M, or G.

4. To delete a point from the table, select the point to be removed, and click Delete.

5. Select the Frequency Interpolation method:

Select Linear when the frequency scale of the spectrum or spurious measurements are linear.

Select Log when the frequency scale of the spectrum is logarithmic.

6. When you have entered all the necessary values, click Save As... (to save the table in a file) or
click OK.

7. From the Save As dialog, name the file and save it in the desired location.

External loss tables are saved in CSV (Comma Separated Value) format.

Loading an External Loss Table
To load an external loss table file:

1. Click Edit... to display the Table Editor.

2. Click Load.... to display the Open dialog box.

3. Navigate to the location of the desired file, select it and click Open.

4. Click OK.
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External Probe Correction Tab
The External Probe Correction tab is used to specify whether a correction factor is applied to the signal
when a Tektronix P7000 Series probe is connected to the spectrum analyzer through the Tektronix
RTPA2A Real-Time Spectrum Analyzer TekConnect Probe Adapter.

The spectrum analyzer can detect when an RTPA2A TekConnect probe adapter is connected to the
instrument. The only setting available on the tab specifies whether a correction is applied to the signal
or not. The amount of correction is specific to the probe and is communicated to the spectrum analyzer
through the RTPA2A TekConnect probe adapter.

When the spectrum analyzer detects an RTPA2A probe adapter, it automatically applies a correction.
However, you can choose not to apply the correction. This would enable you to keep the probe adapter
connected to the spectrum analyzer even if you chose not to use a probe to connect to a signal.

If the spectrum analyzer does not detect a probe adapter, the setting to correct for a probe is dimmed
and No probe detected is displayed on the tab.
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Continuous Versus Single Sequence

Continuous Versus Single Sequence
Menu Bar: Run > Single Sequence / Continuous

Selecting Single Sequence sets the acquisition mode so that when you press Run, a single acquisition
sequence is performed and the instrument stops once the acquisition sequence is completed. Selecting
Continuous sets the acquisition mode so that an acquisition sequence is started as soon as you select
Continuous and as one acquisition sequence completes, another begins.

Note that an acquisition sequence can require more than one acquisition. For example, in a spectrum view,
the trace function might be set to Average 100 acquisitions Thus, a complete acquisition sequence would
consist of 100 acquisitions that are averaged together to create the trace that is displayed.

Run
Menu Bar: Run > Run

Application Bar / Front Panel: Run

Selecting Run begins a new acquisition/measurement cycle.

Resume
Menu Bar: Run > Resume

Restarts data acquisition, but does not reset accumulated results, such as Average or MaxHold. This
allows you to stop acquisitions temporarily, then continue. If the accumulation is already complete, for
example, 10 acquisitions or 10 averages have already been completed, each subsequent Resume command
will cause one more acquisition to be taken, and its results added to the accumulation. Not available if
instrument settings have been changed.

Abort
Menu Bar: Run > Abort

Selecting Abort immediately halts the current acquisition/measurement cycle. In-process measurements
and acquisitions are not allowed to complete. Visibility and accuracy of results is unspecified after an abort.
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Triggering

Triggering
The spectrum analyzer has two triggering modes: Free Run and Triggered.

Free Run
In Free Run mode, the instrument initiates acquisitions without considering any trigger conditions. It is a
fast and easy way to see the signals. Free Run is usually adequate for the Spectrum display unless you
need to specify a particular time at which to collect the data record.

Triggered
In the Triggered mode, the instrument initiates an acquisition when a trigger event is recognized. The
conditions that define a trigger event depend on the selected trigger source. There are several source
selections available for choosing the signal to monitor for a trigger event. If the RF input is the selected
trigger source, you can choose to use power, frequency mask triggering, DPX Density (Option 200), or
Runt (Option 200) as the trigger types. If other inputs are selected as the trigger source, you can select the
slope and level of the trigger point. With the Gated source, you also specify the gating signal level.

Power level triggering. Power Level triggering triggers the instrument on time-domain signal transitions.
The incoming data is compared to a user-selected level in dBm. You can select the time-domain bandwidth
and trigger on the rising or falling edge.

Frequency mask triggering (Option 02). Frequency Mask Triggering allows you to trigger the instrument
when a signal in the frequency domain violates the mask. You can draw a mask to define the conditions
within the real-time bandwidth that will generate the trigger event. It allows you to trigger on weak signals
in the presence of strong signals. This triggering is also useful for capturing intermittent signals.

DPX density triggering (Option 200). DPX Density triggering uses characteristics of the DPX Spectrum
display to specify trigger parameters. When using DPX Density triggering, the percentage of time the
signal falls within the measurement box is used to define a trigger event. The measurement box is defined
by frequency and amplitude values.

Runt triggering (Option 200). Runt triggering allows you to define a trigger event based on a pulse
amplitude that crosses one threshold but fails to cross a second threshold before recrossing the first.

You can define the following event parameters by selecting the respective tab in the Trigger control panel:

Event source, event type, and event definition.

Time parameters that define what portion of the data record is used for pretrigger samples and whether
to delay the trigger for a set amount of time after the recognized event.

Advanced parameters define where a trigger occurs within the acquired memory or trigger each
segment in the swept acquisition mode.
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Triggering

Save on Trigger
An additional feature of the triggering capability is to save acquisition data when a trigger event occurs.
When the spectrum analyzer is run in Triggered mode, you can configure the instrument to save acquisition
data to a file. You can also set the instrument to save a picture of the screen when the trigger event occurs.
See Action Tab (Triggering) (see page 332) for details on configuring Save on trigger.

Setting Up Triggering
To set up triggering, use the Trigger control panel. To display the Trigger control panel:

Press Trigger on the front panel or click Trig in the Application toolbar or select Tools > Trigger.

Using Free Run
To set Triggering to Free Run:

Click the Free Run option button.

The spectrum analyzer will acquire a signal without regard to any triggering conditions.

Using Power Trigger
To trigger acquisitions based on the power of the signal:

1. Click the Triggered option button.

2. Select RF Input from the Source drop-down list.

3. Select Power from the Type drop-down list.

4. For further information on setting the power level parameters, see Event Tab (Triggering). (see
page 323)

Using Frequency Mask Triggering
To trigger acquisitions based on violations of a user-defined mask:

1. Click the Triggered option button.

2. Select RF Input from the Source drop-down list.

3. Select Frequency Mask from the Type drop-down list.
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Triggering

For further information on setting the frequency mask parameters, see Event Tab (Triggering) (see
page 323) and Mask Editor (see page 319). If Option 200 is installed, the frequency mask trigger includes
the ability to change the resolution bandwidth of the frequency transform used to compare to the trigger
mask. The standard FMT uses a fixed length FFT for frequency transforms.

Using DPX Density Triggering
To trigger acquisitions based on the density of the DPX Bitmap trace:

1. Click the Triggered option button.

2. Select RF Input from the Source drop-down list.

3. Select DPX Density from the Type drop-down list.

4. Set the DPX Density parameters as appropriate. You can do this two ways:

Entering values for Threshold, Frequency, and Amplitude using the front-panel controls.

Select Trigger On This from the Touchscreen Actions menu (right-click in the graph or press
and hold on the display for two seconds). Move and size the measurement box that appears to
set the values for Frequency and Amplitude.

NOTE. If the Amplitude units (Tools > Analysis > Units) is set to Watts or Volts, you cannot move the
measurement box using a mouse or the touchscreen. Set the amplitude units to any unit other than
Watts or Volts to move or resize the measurement box.

For further information on setting the power level parameters, see Event Tab (Triggering) (see page 323).

Using Runt Trigger
To trigger acquisition based on a runt signal:

1. Click the Triggered option button.

2. Select RF Input from the Source drop-down list.

3. Select Runt from the Type drop-down list.

4. For further information on setting the power level parameters, see Event Tab (Triggering) (see
page 323).
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Frequency Mask Trigger

Frequency Mask Trigger
The frequency mask trigger monitors all changes in frequency occupancy within the capture bandwidth
(40 MHz or 110 MHz).

The following topics describe the frequency mask trigger controls:

Event tab (see page 323): explains how to configure frequency mask triggering parameters.

Mask Editor (see page 319): explains how to create and edit frequency masks.

Triggering (see page 316): explains how to initiate frequency mask triggering.

Mask Editor (Frequency Mask Trigger)
The Mask Editor is used to create masks that are used by the Frequency Mask Trigger function. The
Frequency Mask Trigger ( FMT ) function is used to define trigger events to capture signal anomalies
based on their frequency and amplitude.

Displaying the Mask Editor
To display the Mask Editor:

1. Press Trigger on the front panel or select Trig from the Application toolbar.

2. Select the Event tab.

3. Set Source to RF Input.

4. Set Type to Frequency Mask.

5. Select Mask Editor.

Creating a Mask
The simplest way to create a mask is to use the Auto draw function.

To create a new mask using Auto draw:

1. Select the trace on which to base the mask from the Reference trace drop-down list. (Only traces that
are shown can be selected from the drop-down list. To show a trace that isn’t currently in the list,
open its display and enable the trace of interest.)

2. Specify the margins to be applied between the mask and the reference trace. Enter values for the X
Margin and the Y Margin.

3. Click Auto draw.

The following screen shows a mask created with Auto draw.
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Mask Editor (Frequency Mask Trigger)

To create a new mask without using Auto draw:

Click the New button.

Changing a Mask
A mask is a collection of points specified by their frequency (defined by their offset from the center
frequency) and their amplitude. You can change a mask by adding (or removing) points and editing points.

NOTE. When placing points in the frequency mask, keep in mind that in most cases, the Frequency Mask
Trigger has a range of 80 dB below Reference Level. However, for values of Reference Level lower than
-50 dBm, this range decreases as the RefLevel decreases. The FMT range is also reduced when the
Acquisition Bandwidth contains frequencies near 0 Hz. In both these situations, the underlying reason the
trigger range is reduced is because the instrument is using various amounts of "digital gain" in addition to
hardware gain. You are not prevented from placing mask points outside the usable range of the instrument,
but at the time the mask is applied, the instrument adjusts its range. When the mask is adjusted, you can
see this in the Spectrum display and the Mask Editor. The mask’s shaded fill shows the usable vertical
range. Points outside this range are shown, but will not cause a trigger.

Adding Points
To add a point to a mask:
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Mask Editor (Frequency Mask Trigger)

1. Click the Add points option button. (Alternatively, you can right-click on the desired point location
(or left-click and hold for about a second) and release.)

2. Click in the graph area where you want the new point added to the mask.

You can also add a point to the mask while it is in Edit Points mode:

Right-click in the graph area where you wish to add a point to the mask. You can also left-click and
hold the button down for one second. You can duplicate this method on the touchscreen by touching
the screen for one second.

If you add a point by accident, click Undo. You can click Undo until the Undo button is grayed out.

Editing Points
When you edit a point, you change its offset from the center frequency and/or its amplitude. There are
two ways to edit the offset and amplitude of a point on a mask. First, you can drag a point to the desired
position. Second, you can double-click on the offset or amplitude value in the table and enter a new value.

To edit a point on a mask:

1. Click the Edit Points option button.

2. Click on the point you wish to change.

3. Change the position of the point using the following methods:

a. Dragging it with the mouse to the desired position.

b. Clicking the arrow keys in the Mask Editor window to move the point to the desired position.
Use the left/right keys to change the frequency offset. Use the up/down arrow keys to change the
amplitude. Once you click an arrow key, you can use the front panel knob for fine adjustments.

4. To edit another point, click Next.

You can also edit a point by double-clicking on the value in the table that you want to change and typing
in a new value.

Deleting Points
To delete points from the mask:

1. Click the Edit Points option button.

2. Click on the point to be removed and click the X button to delete the point.

You can also delete a point by clicking on the point in the table that you want to delete and clicking
the X button.

If you delete a point by accident, click Undo. You can click Undo until the Undo button is grayed out.
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Mask Editor (Frequency Mask Trigger)

Saving a Mask
To save a mask:

Click the Save button.

To save an edited mask under a new name:

Click the Save As button.

Opening an Existing Mask
To open an existing mask:

1. Click on Open. This displays the Open dialog box.

2. Navigate to the location of the mask file.

3. Select the desired file and click Open.
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Trigger Settings

Trigger Settings
Menu Bar: Settings > Trigger

Application Toolbar: Trig

Front Panel: Trigger

The Trigger control panel allows you to set the parameters that define trigger events and how the
instrument responds to them.

Trigger Modes
There are two trigger modes: Free Run and Triggered.

Mode Description
Free Run Acquires and displays the signal without triggering.
Triggered Acquires a data record after the defined trigger event is recognized.
xxx

Trigger Tabs
Use the Trigger tabs to access controls for setting the different trigger parameters.

Tab Description
Event (see page 323) Sets parameters that control triggering on the selected trigger source.
Time Qualified (see page 330) Sets values used to adjust time of acquisition with respect to time of trigger event.
Advanced (see page 331) Sets controls for triggering in swept acquisitions.
Actions (see page 332) Sets parameters for Save on trigger function.
xxx

Event Tab
The Event tab is used to set the parameters that define trigger events. The parameters that appear on the
Event tab change depending on the selected Trigger source and type.
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Event Tab

Source
Source specifies the source of the signal to be monitored for a trigger event. The choices available are:
RF Input, Trig In (front), Trig 2 In (rear), Gated, and Line. The Source drop-down list is always visible
on the Event tab.

Type
Type defines the trigger type as Power , Frequency Mask, DPX Density, or Runt. The Type selection
is only present when Source is set to RF Input.

When Type is set to Power, a transition through an adjustable level of the selected source determines
a trigger event.

When Type is set to Frequency Mask, trigger events are defined by where and how the input signal
crosses or fails to cross the edge of the mask.

When Type is set to DPX Density, the amount of time a signal is present at a particular point in the
DPX Spectrum graph defines a trigger event.

When Type is set to Runt, a signal that exceeds a specified level and then fails to exceed a second
specified level defines a trigger event.

Source = RF input.

The following table describes the settings for each triggering type available when Source is set to RF Input.
Type specifies whether a Power level, Frequency Mask violation, DPX Density threshold violation, or
Runt signal will define a trigger event.

Table 5: Trigger types
Event Type Setting Description
Power For the Power setting, if the RF input signal crosses the specified

level (in the direction set by Slope), a trigger event occurs. A trigger
event does not occur if the power level of the signal simply exceeds
the level setting, there must be a power level transient that crosses
the specified level.

Slope The slope control determines whether the spectrum analyzer finds
the trigger point on the rising or falling edge of the RF input signal.

Level The Level setting determines the power level that will be recognized
as a trigger event. The Level is indicated in the Amplitude vs Time
and Time Overview displays with a dark cyan colored-line.
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Event Tab

Event Type Setting Description
Time-domain BW Time-domain BW is a filter used to process the trigger input signal

before the trigger system analyzes the signal.
Frequency Mask For the Frequency Mask setting, events where the trace crosses

the edge of the mask when it should not or when the trace does not
cross the edge of the mask when it should define the trigger event.
Use Mask Editor (on the Event tab when Type is set to Frequency
Mask) to create and modify Frequency Masks.

Violation Specifies the type of transition that defines a violation.
RBW Specifies the resolution bandwidth.
Auto Specifies whether the RBW is adjusted automatically or manually.

DPX Density For DPX Density, the percentage of time the signal falls within
the measurement box is used to define a trigger event. The
measurement box is defined by frequency and amplitude values.

Density Specifies whether a trigger event is defined by the DPX Density value
exceeding (Higher) the specified Threshold value or is defined by the
DPX Density value falling below (Lower) the specified Threshold
value.

Threshold Threshold specifies the density value used for determining a trigger
event. Density is a measure of how much time the signal is present
in a particular region in the DPX Spectrum graph. The range for
this value is 0 to 100%.

Frequency Specifies the frequency at the center of the measurement box. The
+/- value specifies the edges of the measurement box above and
below the Frequency setting.

Amplitude Specifies the amplitude of the center of the measurement box. The
+/- value specifies the edges of the measurement box above and
below the Amplitude setting.

Runt Defines a trigger event based on a pulse amplitude that crosses one
threshold but fails to cross a second threshold before recrossing
the first.

Pulse Specifies whether the runt trigger is defined by a positive-going pulse
or a negative-going pulse.

High level The High level defines the upper voltage limit (first threshold) of a
runt pulse.

Low level The Low level defines the lower voltage limit (second threshold) of a
runt pulse.

xxx

Source = Trig In (front).
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Event Tab

Setting Description
Slope The slope control determines whether the spectrum analyzer finds the trigger point on

the rising or the falling edge of the trigger input signal.
Level The Level setting determines the signal amplitude that will be recognized as a trigger

event.
xxx

Source = Trig 2 In (rear).

Setting Description
Slope The slope control determines whether the spectrum analyzer finds the trigger point on

the rising or the falling edge of the trigger input signal. The trigger level is automatically
set at a TTL level.

xxx

Source = Gated. When the Source is set to gated, the front panel Trig In source is monitored for the trigger
event and a signal on the rear panel Gate / Trig 2 In is used to determine when a trigger event is valid.
A transition through the selected Level on the TrigIn signal input (selectable as rising or falling edge)
will only be recognized as a trigger event if it occurs while the Trig2 signal is True (selectable as High or
Low). Note that only edges are trigger events, not stable signal levels.

Setting Description
Slope The slope control determines whether the spectrum analyzer finds the trigger point on

the rising or the falling edge of a signal.
Level The Level setting determines the signal amplitude that will be recognized as a trigger

event.
while Trig 2 In (rear) Specifies whether a High or Low signal at the Trig 2 In input (rear panel) allows a trigger

event on the Trig In (front) input to be accepted.
xxx
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Event Tab

Source = Line.

The spectrum analyzer triggers off of the AC line supply.

Source = RF Input and Type = Frequency Mask.

Setting Description
Violation These selections define the state or transitions of the signal used to define a trigger event.
Mask Editor Displays the Mask Editor so that you can create and edit Frequency Masks.
Load from file Invokes the Open dialog for selecting a previously saved frequency mask file.
RBW Sets the Resolution Bandwidth value to be used in the spectrum view. The value is

italicized when Auto is selected.
Actual This is a displayed value, not a setting. It is the RBW being used by the spectrum

analyzer; this value may not match the RBW requested (in manual mode).
xxx

Violation. Violations are state changes (or a sequence of state changes) defined by the whether a point on
the signal falls within the frequency mask or outside the frequency mask. A True violation occurs if even a
single point on the trace falls inside the mask (above the mask’s lower edge). Conversely, a False violation
occurs if no points on a signal fall inside the mask (all trace points are below the mask’s lower edge).
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Event Tab

A trigger event is initiated based on the type of violation that occurs and the sequence of violations
that occur.

Violation Description
T Only one state is required to initiate a trigger event. The signal has at least one data point

inside (above) the mask. The trigger event occurs when the instrument detects the first
signal with a point violating the mask. A trigger event could occur on the first acquisition.

F Only one state change is required to initiate a trigger event. The signal has all data points
outside (below) the mask. The trigger event occurs when the instrument has detected
the first spectral waveform that lies completely below (outside) the mask. A trigger event
could occur on the first acquisition.

T - F (Out) Two states are required to initiate a trigger event. The signal must be inside the mask
and then passes out of the mask. The trigger event occurs when the first non-violating
waveform is detected.

F - T (In) Two states are required to initiate a trigger event. The signal must be outside the mask
and then passes into the mask. The trigger event occurs when the first non-violating
waveform is detected.

T - F - T (Out & In) Three states are required to initiate a trigger event. The signal starts inside the mask and
then passes out of the mask. Next, the signal must pass into the mask. The trigger event
occurs at the second transition where the signal passes back into the mask.

F - T - F (In & Out) Three states are required to initiate a trigger event. The signal starts outside the mask and
then passes into the mask. Next, the signal must pass back outside the mask. The trigger
event occurs at the second transition where the signal passes back out of the mask.

xxx

Mask Editor. Launches the Mask Editor (see page 319) that enables you to create and edit Frequency
Masks.

Load from File. Enables you to load an existing frequency mask for use with Frequency Mask Trigger.
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Event Tab

Source = RF Input and Type = DPX Density. DPX Density triggering analyzes the density of the DPX
Bitmap trace to define trigger events. You specify the portion of the DPX Bitmap trace to analyze by
defining a measurement box. The measurement box is the only area of the DPX Spectrum graph that is
analyzed for trigger events.

Setting Description
Density Specifies whether a density value higher or lower than the threshold value defines a

trigger event.
Threshold Specifies the DPX Density threshold that defines a trigger event. The DPX Density

must be higher or lower (specified by the Density selection) than this value to define a
trigger event.

Frequency Specifies the center of the measurement box on the frequency axis (horizontal).
+/- Specifies the width of the measurement box.
Amplitude Specifies the enter of the measurement box on the power level (vertical) axis.
+/- Specifies the height of the measurement box.
xxx

Source = RF Input and Type = Runt. Runt triggering defines a trigger event based on whether or not a signal
transition fails to cross a user defined level. Two levels are defined for Runt triggering. A Runt signal is
one that passes through both levels in one cycle but only passes through one level on the next cycle.

Setting Description
Positive Specifies that a second signal transition cycle that fails to exceed the High level will

define a trigger event.
Negative Specifies that a second signal transition cycle that fails to fall below the Low level will

define a trigger event.
High level Specifies the High level used to define the trigger event.
Low level Specifies the Low level used to define the trigger event.
xxx
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Time Qualified Tab

Time Qualified Tab
The Time Qualified tab allows you to specify whether triggers are accepted based on timing characteristics.
Trigger events that pass the timing qualification result in an acquisition. Trigger events that do not pass
the timing qualification are ignored. Time-qualification can be applied to Power, Frequency Mask, Runt
and External triggers.

Setting Description
None No timing qualification is applied to trigger events. Acquisitions occur whenever a trigger

event occurs (as specified on the Event tab).
Shorter If the length of the trigger event is shorter than the time specified by the Time 1 setting,

then the trigger event is accepted and an acquisition is completed.
Longer If the length of the trigger event is longer than specified by the Time 1 setting, then the

trigger event is accepted and an acquisition is completed.
Inside If the length of the trigger event is longer than the time specified by the Time 1 setting and

shorter than the time specified by the Time 2 setting, then the trigger event is accepted
and an acquisition is completed.

Outside If the length of the trigger event is shorter than the time specified by the Time 1 setting or
longer than the time specified by the Time 2 setting, then the trigger event is accepted
and an acquisition is completed.

Time 1 Enter the Time 1 reference value here. Range: 20 ns–28 s.
Time 2 Enter the Time 2 reference value here. Range: 20 ns–28 s.
xxx

The following table shows how the appearance of the Time Qualified tab changes depending on whether
time qualified triggering is enabled or not enabled.

Tab appearance Description
When None is selected on the Time Qualified tab, the watch icon is dimmed.

When any selection other than None is selected on the Time Qualified tab, the watch
icon appears in color.

xxx

Minimum off time between trigger events. This readout shows how long the trigger conditions must be
absent between the end of one trigger event and the start of the next trigger event to be ensure that the end
of the first event is recognized. For example, if Freq Mask is selected and its RBW causes a minimum
off time of 500 µs, and your signal violates the mask for 600 µs of every 1 ms, (so that the OFF time is
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Advanced Tab (Triggering)

400 µs), it will appear to the analyzer that the signal is continuously in violation. Shorter and Inside
settings will not produce a trigger in this situation.

Advanced Tab (Triggering)
Menu Bar: Setup > Trigger > Advanced

Application Toolbar: Trig > Advanced

Allows you to set parameters for trigger position and holdoff settings.

Setting Description
Position Sets the point along the acquisition record the trigger event should occur.
Delay Sets how long after the trigger event specified by the Position setting, the spectrum

analyzer should wait before actually initiating the trigger event.
Holdoff Prevents triggers until there have been no trigger events for at least the specified time.

Range: 20 ns–10 s.
Trigger each frequency
segment in Swept acquisition
mode

Sets the spectrum analyzer to wait for a trigger for each acquisition in a swept spectrum
or other measurement requiring multiple acquisitions worth of span.

xxx

Holdoff
Holdoff on the spectrum analyzer does not work exactly like the traditional Holdoff setting on an
oscilloscope. On an oscilloscope, once the instrument triggers, the holdoff setting causes the oscilloscope
to refuse to accept another trigger until the holdoff time has expired. On the spectrum analyzer, once a
trigger event is identified, the instrument determines how long it has been since the previous trigger event
occurred and if the time since the previous trigger event is greater than the holdoff time, the trigger event
is accepted and an acquisition is completed. If the time since the previous trigger event is less than the
holdoff time, the latest trigger event is ignored (no acquisition occurs) and the holdoff time count restarts.

The most common reason for using holdoff is ensuring that the instrument triggers on the first pulse in a
burst. For this application, the difference between the spectrum analyzer holdoff and the traditional
oscilloscope holdoff has no effect on acquisitions.

The case where the difference can be noticed is when the time between trigger events is always less than
the specified holdoff time. An oscilloscope will trigger on the first event after the holdoff time expires,
no matter how short the time has been since the most recent rejected trigger event. In such a situation,
the spectrum analyzer will not ever trigger because it requires that there are no trigger events during
the holdoff time before an accepted trigger event.
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Actions Tab (Triggering)

Actions Tab (Triggering)
The Actions tab sets parameters for the Save on trigger function. The Save on trigger function allows you
to save an acquisition data file and/or a screen capture when a trigger event occurs.

Trigger events are defined on the Event (see page 323) and Time Qualified (see page 330) tabs.

Action tab settings
Setting Description
Save acq data on Trigger Enables the Save on Trigger function. The list box to the right of the Save acq

data on Trigger check box specifies the format of the saved file. Acquisition
data files can be saved in TIQ (native) format, CSV format, and MAT (Matlab)
format. For descriptions of these file formats, see Data, Settings and Picture
File Formats (see page 335).
When TIQ is the selected file type, a file is saved after a complete acquisition,
which can include multiple frames. When CSV or MAT is the selected file type, a
separate file is saved for each frame.

Save picture on Trigger Enables saving a picture of the display when a trigger event occurs. Files can be
saved in PNG, JPG, and BMP format. For descriptions of these file formats, see
Data, Settings, and Picture File Formats (see page 335).

Max total files saved per Run Specifies the number of times a Save on Trigger action stores a file. After this
limit is reached, no more files are saved. The instrument will continue to run, but
no additional files are saved when a trigger event occurs.
Keep in mind when setting this number that picture files are counted as part of the
total number of files. For example, if you set Max total files to 100, the instrument
will save 100 acquisitions if only acquisitions are saved or only pictures are
saved. But, if both acquisitions and pictures are saved, then 50 acquisitions
and 50 pictures will be saved.

xxx
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Saving and Recalling Data, Settings, and Pictures
You can save different types of data for later recall and analysis.

Data type Description Save as type
Setup files Saves all of the setup information for

all displays, except those settings that
are not part of Preset.

Setup (.Setup)

Picture of Selected Display
(PNG/JPG/BMP)

Saves a capture of the screen in the
specified format. This option is useful
for including the graphic in reports or
other applications. Marker readouts
and other information are included.

Picture (.BMP, .PNG, .JPG)

Results Export files Saves the trace and numeric data for
the selected display. The trace and
numeric data are saved as CSV files.

Results export (various)

Measurement Settings Saves a list of settings relevant to the
selected measurement to a text file.
This option is useful for including the
measurement settings in reports.

Measurement settings export (TXT)

Trace Saves a trace for later recall into the
display from which it was saved.

Selected trace (various)

Data Saves data for reanalysis by
RSA6100A Series Real-Time
Spectrum Analyzers or as data to use
with external software (either CSV
(comma-separated value) or MAT
(MATLAB format). For fastest capture
of data files in TIQ or MAT format,
use FastSave. This function disables
caching and analysis of incoming data,
greatly decreasing the time required to
save files to local or network storage.

Acquisition data with setup (TIQ); or
Acquisition data export (CSV or MAT)

xxx

Saving Files
Saving files follows the same procedure regardless of the type of data being saved. To save setups
(including application presets), pictures, results, or acquisition data:
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1. Select Save As. . . from the File menu to open the Save As dialog box.

2. Navigate to the folder where you want to save the setups, or use the default location.

To save setups so that they appear in the Application Presets window, save your setup in the
folder C:\RSA6100A Files\Application Presets. The saved setup will appear in the Application
Presets window with the name you give the file.

3. Enter a file name.

4. Select the type of file to save from the Save as type drop-down list.

5. Click Save.

Saving Data with FastSave
To save data using FastSave, use the procedure Preparing for a FastSave Acquisition .

Recalling Files
You can recall three types of files: Setup files, Selected Trace, and Acquisition data with setup. Recalling
data follows the same procedure regardless of the type of data being recalled.

1. Select Recall. . . from the File menu to open the Open dialog box.

2. Navigate to the folder containing the file you want to recall.

3. Select the type of file to recall from the Files of type drop-down list. This selection determines the
files that appear in the Open dialog box.

4. Select the file to recall.

5. Click Open.

Recalling Waveforms from the TekScope Application.

Setup Files
You can set up the instrument as desired and then save the settings in a setup file. This enables you to
quickly setup the instrument by recalling previously saved setups.

Exporting Results
Save for further analysis of results in other programs, such as MATLAB or Excel.

Pictures of the Selected Display
You can save pictures of the instrument display for documentation purposes. When saving pictures of
the display, you can select from three file types: BMP, JPG, or PNG.
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Measurement Settings
You can save a list of settings relevant to the selected display to a file for documentation purposes. The
exported file uses tab characters to separate values. The settings included in the file depend on the selected
display. The contents of the file are the same as a Results export except it does not include the results.

Saving Acquisition Data with Setup
Save for later analysis with the analyzer. The setup is saved as part of the acquisition data file so you can
choose when recalling data whether or not to also recall the associated acquisition and analysis parameters.

Saving Acquisition Data Export in CSV Format
Save for examining results in other programs, such as MATLAB or Excel.

Data, Settings, and Picture File Formats
You can save different types of data for later recall and analysis.
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Saved File Types

File type File extension Description
Setup files .setup Setup files enable you to save instrument settings for later recall. Using

these files saves setup time and ensures consistent measurements.
Picture .png/.jpg/.bmp Screen capture of RSA6100A application window. They are useful for

documenting results in test reports.
Results Export .csv Results files contain the trace points and numeric values that were

produced by the selected measurement. The header of a Results file
includes key acquisition and analysis settings to aid in the interpretation
of the data. The file is saved as a plain text file, but the contents are
formatted as CSV (comma-separated values). Results files can be
opened from applications such as Microsoft Excel and MATLAB.

Measurement
Settings

.txt Measurement settings files contain a list of settings that describe how
the instrument is set up for the selected measurement. The list contains
measurement settings (for example, Span), trace settings (for example,
whether or not a trace is selected) and global settings (for example,
Frequency and Reference Level). The list of settings contained in the
file varies depending on which display is selected.

Selected Trace varies with display Trace files contain the trace results data in binary format. These
files are only readable by the RSA6100A application. Several of the
instrument’s measurements allow you to recall a Trace file for visually
comparing a saved trace to a live trace.

Acquisition Data
with Setup

.tiq These files contain the acquisition data record and complete instrument
setup (in binary format). Use these files to save data for later recall and
analysis. When you save an Acquisition Data file, the current Setup
is always saved with the file. At the time of recall, you will be asked
whether you want to restore only the acquisition data or both data and
setup. If the instrument is already set up for a specific measurement,
you will probably want to recall only the acquisition data. Recalling
both data and setup returns the instrument to the same state it was
in at the time you saved the file.

Acquisition Data .csv These files contain IQ sample data before it has been processed by
a measurement. The acquisition data points are saved as IQ pairs.
Use this format to import the acquisition data into Microsoft Excel for
further analysis.

Acquisition Data .mat These files contain IQ sample data before it has been processed by
a measurement. The acquisition data points are saved as IQ pairs.
Use this format to import the acquisition data into MATLAB for further
analysis.

Range file .csv These files contain a list of settings that describe how the instrument is
set up for the Spurious measurement. The file contains the number of
ranges enabled, the start and stop frequencies for each enabled range,
the limits for each enabled range, the mask type and more.

xxx
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Results Export File Format
The Results Export format contains trace points and/or scalar results produced by the measurement. The
file contains general information about the measurement settings at the top of the file and the results data in
the second part of the file. Groups of settings or results are headed with [text], as described below.

At the top of the file is the measurement name and the date and time data was acquired.

The first group of settings is [Global Parameters]. These settings include the Measurement Frequency,
Acquisition Data, Reference Level and others.

The second group of settings is [Parameters]. These settings are specific parameters which vary depending
on the measurement.

The next group is [Trace Parameters], which may not be present, depending on the measurement. Within
this group, there are parameters specific to a trace. There will be a Trace Parameters group for each
trace shown on the display.

The next group is [Results]. These are scalar results for the measurement.

Next is [Traces]. The Traces group consists of one or more [Trace] groups. There is one Trace group for
each trace. Each [Trace] group contains background information about the trace (units, number of points, x
scaling, and others depending on the measurement) at the top of the group, followed by the trace points.

Acquisition Data with Setup File (.tiq) Format
The file consists of two parts - the header that is in XML and the data that is in binary format.

Header. The header consists entirely of the DataFile element. This element is broken down into
sub-elements.

1. DataSetsCollection

2. Setup

DataSetsCollection. The DataSetsCollection contains a DataDescription element, a DataSet element,
and a ProductSpecific element.

Binary data. Binary data is a sequence of Int32 values, which are IQ pairs (I,Q,I,Q, ...) in binary Little
Endian format.

To convert these values to volts, multiply the individual values by the Scaling value in the DataDescription.

The binary data starts at an offset into the file == the "offset" attribute in the DataFile element. This
offset number will always start at the 19th character into the file (starting with 1), and will always be 9
characters long.

NOTE. You should not casually modify the XML header, because this will change the offset to the start of
the binary data.
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Acquisition Data Files (.csv)
The acquisition data files have two sections. At the top of the file is the following information:

SamplingFrequency - The sampling frequency in Hertz.

NumberSamples - The number of IQ samples in the file.

DateTime - When the data was acquired.

Frequency - The center frequency in Hertz.

AcquisitionBandwidth - The acquisition bandwidth Hz.

Following the AcquisitionBandwidth are the data. The data are IQ pairs, in volts.

Groups of settings or results are headed with [some text].

The first thing in the file is the measurement name and the date/time when the acquisition was taken.

The first group [Parameters] are global parameters. Measurement Bandwidth in this group is the
measurement bandwidth used by the General Signal Viewing measurements (Spectrum, Amplitude vs.
Time, etc). It also includes some source settings, like Acq BW, Dither, Preamp, and RF Attenuation.

The second group [Parameters] are measurement-specific parameters.

Another group which can occur is [Trace Parameters]. Within this group, there will be a set of parameters,
one for each trace that is currently shown.

Another group is [Results]. These are scalar results for the measurement.

Another group is [Traces]. It has [Trace] groups under it, one for each trace. Each [Trace] group has
some background information about the trace (units, number of points, x scaling, etc), and the trace
points themselves.

Acquisition Data Files (.mat)
The acquisition data files saved in MATLAB format contain the following MATLAB variables:

InputCenter - The center frequency in Hertz.

XDelta - The sample period in seconds.

Y - A complex array containing IQ pairs.

InputZoom - Always 1, and indicates complex data.

The MATLAB format used to save acquisition data has the following properties and limitations:

Files are stored in MATLAB Level 5 format.

MATLAB Level 5 file size is limited to 2 GB.

RSA6100A Series Real-Time Spectrum Analyzers Help 339



Managing Data, Settings, and Pictures Printing Screen Shots

The instrument acquisition memory limit is 1 GB (1.024 Gigabytes). Because of the way acquisition
data is processed, 1 GB of acquisition memory requires 2 GB of memory to store. When header
information (instrument settings) is added to the acquisition data, the resulting file size is >2 GB.

If acquisition memory is filled (1 GB), exporting the data to MATLAB format will result in a file that
is too big for MATLAB to process. To check how much acquisition memory is filled, select Setup >
Acquire > Sampling Parameters. When the instrument is stopped, or you are analyzing a recalled data
file, you can find the acquisition length under File > Acquisition Data Info.

Printing Screen Shots
You can print shots (screen captures) two ways: use File > Print or save a picture file and print the file
using a separate graphics program. Printing a screen capture is the same as printing with any windows
program. For details on the available file formats for saving a screen capture, refer to Data, Settings, and
Picture File Formats (see page 335). For details on saving a picture to a file, see Saving and Recalling
Data, Settings, and Pictures (see page 333).

To print a screen from the instrument:

1. Select File > Print.

2. Select File > Print Preview if you wish to review the screen shot before sending it to the printer.

3. Select File > Print to print the file to a printer.
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Online Help
Menu Bar: Help > User Manual

This menu item displays this online help. The online help is a standard Windows help system. The
Online Help menu item is the only method available to display the online help; there are no other links
to the online help within the software.
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About the RSA6100A Series
This window displays information about the software and hardware versions for the spectrum analyzer.

Version
At the top of the window is a line that displays the version of the spectrum analyzer application software.

Installed Options
This text box lists the instrument options installed on the spectrum analyzer. This window does not list
every option installed on the instrument, just those that can be detected by the software.

Hardware Information
This text box lists information about the instrument hardware versions.

Copy Info
The Copy Info button copies information about the instrument to the Windows clipboard. This information
may be useful if you need to have your instrument serviced.
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Configure In/Out Settings
Menu bar: Setup > Configure In/Out.

The Configure In/Out control panel enables you to configure the spectrum analyzer inputs. The settings in
this control panel are shared by all application windows.

Settings tab Description
Trigger I/O Specifies the impedance for the Trig 1 input.
Frequency Reference Specifies the source of the Frequency Reference. You can select between an Internal

(10 MHz) source and an external source.
Other Outputs (see page 346) Specifies whether the 28 VDC, Analog IF and IQ outputs are on or off. Additional settings

are available for IF and IQ outputs.
xxx
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Connecting an RF Signal
The spectrum analyzer has a single RF signal input located on the front panel. The input impedance is
50 Ω. The input frequency range is 9 kHz to 6.2 GHz (RSA6106A), 9 kHz to 14 GHz (RSA6114A). The
maximum measurable continuous input power is 1 W.

To connect an RF signal:

1. If the source signal is greater than 1 Watt (+30 dBm), connect the source signal to an attenuator.
Connect the attenuator output to the RF Input connector.

CAUTION. To prevent damage to the spectrum analyzer, do not connect signals greater than +30 dBm
(1 Watt).

CAUTION. To prevent damage to the spectrum analyzer, do not turn the equipment under test on or off
with a LISN (Line Impedance Stabilization Network) RF cable connected to the spectrum analyzer. The
power cycling of the equipment under test causes surge currents that can damage the sensitive input of
the spectrum analyzer.

2. Connect the signal to the RF INPUT connector.

The maximum limits for the input signal are as follows:

Characteristic Description
Maximum DC Voltage ± 40 V (RF input)

+ 30 dBm (RF input, RF ATT Auto)Maximum Measurable Input Power
75 Watts peak (RF Band, RF ATT Auto (<10 ms pulse width,
1% Duty Cycle repetitive pulses)

xxx
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Connecting a Signal Using a TekConnect Probe
You can connect a signal to the spectrum analyzer using a TekConnect Probe by using an RTPA2A
Real-Time Spectrum Analyzer TekConnect Probe Adapter. The RTPA2A enables you to use Tektronix
P7000 Series active and differential probes to connect to signals. See the RTPA2A Instruction Manual for
instructions on how to connect the probe adapter and a probe to the spectrum analyzer.

To use the RTPA2A probe adapter with the RSA6100A Series instruments, you may need install a device
driver for the RTPA2A probe adapter.

Installing the RTPA2A Probe Adapter Device Driver
When the RTPA2A probe adapter is connected to the instrument’s USB port for the first time, the Windows
XP Add Hardware wizard may automatically start. If the wizard does start, use the procedure below to
install the device driver for the new hardware. (If the wizard does not start, the probe adapter device
driver is already installed.)

To properly install the probe adapter device driver:

1. Select the option for Windows to install from a specific location (then select Next).

2. Only search for the driver in C :\Program Files\Tektronix\RSA6100A\RSA\ProbeAdapter.

3. If Windows XP warns about Windows Logo testing, select Continue Anyway.

4. Select Finish after the Found New Hardware wizard completes.

Connecting External Trigger Signals
External trigger signals are connected to the spectrum analyzer using the Trig In connector on the front
panel. There is also an additional trigger input on the rear panel, the Trig 2 In.

To connect a trigger signal to the spectrum analyzer, connect the signal to the Trig In connector on the
front panel, or the Trig 2 In connector on the rear panel.

Table 6: External trigger signal input requirements
Input Level Impedance
Trig In -2.5 V to +2.5 V 50 Ω or 5,000 Ω
Trig 2 ln +5 V (TTL) 10,000 Ω
xxx

Enabling External Trigger
To use an external trigger signal, select either Trig In (front) or Trig 2 In (rear) in the Source control on
the Trigger control panel’s Event tab (see page 323).
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Digital I/Q Output
The Real-time Digital I/Q Output is a means for the you to obtain the spectrum analyzer digital baseband
I/Q signals in a real-time data stream. This output enables you to use the spectrum analyzer as a
down-converter and then pass the down-converted baseband I/Q signals to external equipment for either
additional processing or storage.

IQ Outputs
Connect to the IQ output signals on the rear panel of the spectrum analyzer. The rear panel connectors
are LVDS connectors. For full details on the connectors, see the RSA6100A Series Specifications
and Performance Verification Technical Reference, part number 077-0251-XX. A PDF file of the
manual is located on the Documents CD that shipped with your instrument. If you do not have
access to the Documents CD, a PDF of the manual can be downloaded from the Tektronix Web site,
www.tektronix.com/manuals.

NOTE. The IQ and IF outputs are disabled when an alignment is running.

Analog IF Output
The Analog IF Output is a means for you to observe the spectrum analyzer analog IF signal with an
oscilloscope.

The output level is amplified and filtered especially for use with oscilloscopes. The output frequency varies
with changes in center frequency of the instrument. Additionally, the output spectrum of the IF is inverted
from the input spectrum to the instrument. This means that a signal above the center frequency of the
input will be converted to a frequency below the center of the IF. The output-frequency variations and
spectral inversion makes the IF output unsuitable for use with receivers.

The IF bandwidth can be switched between 150 MHz (wide open) and 60 MHz (Gaussian-shaped to
–12 dB). The ‘wide-open’ selection will result in the fastest transient response for measurement of rapidly
changing levels such as pulse rise times. However, the 150 MHz filter may create significant overshoot
and ringing in the output signal. To control transient responses, a 60 MHz filter with an approximately
Gaussian shape is available. Selection of the 60 MHz filter reduces IF-induced overshoot to less than
approximately 5% for a rectangular-shaped input envelope.

NOTE. Spectral inversion is performed in the IF conversion process. Signals above the center frequency of
the instrument will appear below the center frequency of the IF output.
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Other Outputs
The IF and IQ output settings appear only when the option is installed.

Analog IF Output
Analog IF Output enables you to use the spectrum analyzer as a high-quality downconverter. The
instrument will shift the RF input signal down to a frequency that an oscilloscope can display.

The BW drop-down list allows you to apply filters to the signal. The 120 MHz flat-top filter selection
provides the widest possible bandwidth out, which means faster rise times but results in more overshoot
and other aberrations. The Gaussian filter reduces the bandwidth out and reduces aberrations. The BW
setting is enabled only when the IF Output is On. The selections are 120 MHz (Flat-Top) and 60 MHz
(Gaussian). Default: 120 MHz.

IQ Output
The Digital IQ Output transmits the digitized RSA6100A data for capture and storage by external
equipment. The I/Q data is provided in 16-bit, two’s complement format, along with clock and data-valid
signals.

There are three selections available for the IQ Output: Off, On, and Test. When in the “Off” position, the
IQ Output is disabled, and all lines are static. When in the “On” position, the data is output as described in
the RSA6100A Series Real-Time Spectrum Analyzer Specifications and Performance Verification
Technical Reference (Tektronix part number 077-0251-XX).

Use the “Test” position to verify operation when setting up your equipment. When in the “Test (Counting
Pattern)” position, the I channel data will be counting up and the Q channel data will be counting down.
The EXT_IQ_CLK and EXT_IQ_DAV signals will operate at a rate consistent with the instrument SPAN
setting.
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Menu Overview
The main menus are:

Menu Description
File (see page 348) Select measurements, open and save files, print documents, and preset.
View (see page 353) Change display size, display the Marker toolbar and Status bar.
Run (see page 355) Start, stop and abort acquisitions, replay measurements, select single or continuous

acquisition mode.
Markers (see page 358) Define markers and search for signal peaks.
Setup (see page 359) Change settings for acquisition, trigger, analysis, measurements, amplitude, alignments,

and configure in/out settings.
Setup (see page 359) Change settings for acquisition, analysis, and measurements.
Tools (see page 360) Perform searches, access diagnostics, install upgrades and configure user preferences.
Window (see page 363) Controls the size and layout of displays within the RSA6100A application.
Help (see page 364) Access the online help, display information about the instrument hardware and software.
xxx
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File Menu
Command Description
Recall (see page 349) The Recall dialog enables you to recall saved data, setups and traces.
Save (see page 349) Saves a file without asking for a file parameters (based on most recent settings).
Save As... (see page 349) Displays the Save dialog enabling you to specify the parameters of the save operation.
Save on trigger... (see
page 332)

Displays the Actions tab of the Trigger control panel which allows you to configure the
Save on Trigger function.

Acquisition save options (see
page 24)

Displays the Save and Export tab of the Options control panel which allows you to specify
how much data is saved in acquisition files.

Acquisition data info Displays the Acquisition Info tab of the Replay control panel. The info on this tab
describes such acquisition parameters as acquisition bandwidth, sampling rate, RF
attenuation, and acquisition length.

FastSave Acquisitions Displays the FastSave tab of the Acquire control panel which allows you to configure
FastSave acquisitions.

Measurement Data Info (see
page 351)

Displays the characteristics of the most recently analyzed record in the display.

Print... (see page 351) Prints the selected display.
Print Preview (see page 351) Displays a preview of the print output.
Preset (see page 352) Preset resets the instrument to factory defaults. Acquisition data and settings that have

not been saved will be lost.
Application Presets (see
page 352)

Displays a dialog box where you can recall presets tailored to specific application areas.

Exit Closes the RSA6100A application. Exit does not shut down the instrument.
xxx
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Recall
Menu Bar: File > Recall

Front Panel: Recall

Use the Recall command to load previously saved acquisition data, setups or trace data.

To Recall Data or Setups
1. Select File > Recall. This displays the Open dialog box.

2. Select the file type to be recalled and click Open.

Save / Save As...
Menu Bar: File > Save / Save As...

Use Save / Save As... to store acquisition data, setups, and traces. Save is also used to export traces, results
and pictures of the display for use in other programs.

Difference Between Save and Save As
Use Save As to specify what kind of data you want to save and where the data should be saved. Use Save
to quickly save the same data as you saved the last time you executed a Save, without having to specify the
data type and location.
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For example, suppose you want to save a picture of a spectrum trace each time you adjust a circuit to
document how the adjustments affect the output of the circuit. The first time you want to save a picture of
the display, you will need to select Save As. From the Save As dialog box, you specify the type of data
you want to save (Picture of Selected Display) and specify the location of the saved file. As long as the
Save and Export option (see page 24) is set to automatically name saved files, the next time you want to
save a picture of the display, you can just press Save on the front panel and a picture of the selected display
will be saved without requiring you to type a file name or the location of the file to be saved.

What Data Types Can Be Saved

Data type Description
Acquisition Data Data collected during acquisition that can be recalled for later analysis. Data is saved

in a format readable only by RSA6100A Series instruments or oscilloscopes running
SignalVu software.

Setup Configuration information detailing instrument settings. Data can be saved in a format
readable only by RSA6100A Series instruments or oscilloscopes running SignalVu
software or in a text file.

Selected Trace Saves the selected trace for later analysis by the analyzer. Data is saved in a format
readable only by RSA6100A Series instruments or oscilloscopes running SignalVu
software.

Exported Traces and Numeric
Results

Save traces and results in a file format that can be used by other programs.

Pictures of the Display Save screen images in graphic image file formats that can be used in other programs.
Exported Acquisition Data Save acquisition data records in a file format that can be used by other programs.

Acquisition data can be saved in either comma-separated-variable format or MATLAB
format.

xxx

Data, Settings, and Picture File Formats (see page 335).

Options for Saving Pictures of the Display

Option Setting Description
PNG Saves exported screen captures in Portable Network Graphics format.
JPG Saves exported screen captures in Joint Photographic Experts Group (JPEG)

format.

Image
Format

BMP Saves exported screen captures in Windows bitmap format.
xxx
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Measurement Data Info
The Measurement Data Info command in the File menu displays a listing of acquisition-related information
about the last data analyzed by the selected measurement. The last data can be from the current acquisition
or it could be from a recalled data file.

Print
Menu Bar: File > Print

Front Panel: Print

Print displays the Windows Print dialog box for printing a screen capture of the display. To save ink when
printing, use the Colors tab to set the color scheme. See Options Settings (see page 24).

Print Preview
Menu Bar: File > Print Preview

Print Preview shows how a print out will appear when it is printed.
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Preset
Menu Bar: File > Preset

Preset resets settings and clears all acquisition data. Settings and acquisition data that have not been saved
will be lost. Settings in the Config In/Out (see page 342) control panel are not reset by Preset.

After Preset resets the analyzer settings, it displays the Spectrum view.

Preset does not affect time or date settings; the Windows XP operating system settings, or Tools >
Alignments or Tools Options menu items.

Application Presets...
The spectrum analyzer includes a set of configuration files that are tailored to specific applications. These
configuration files, referred to as Application Presets, open selected displays and load settings that are
optimized to address specific application requirements. You can add to the default application presets by
creating your own application presets. For detailed information about these presets, see Application
Presets (see page 20). See Creating Application Presets (see page 24).
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View Menu
The View menu enables you to control the display of items in the application window.

Command Description
Full Screen (see page 353) Toggles all views between full-screen size and user-selected size.
Marker Toolbar (see page 287) Shows or hides the Marker toolbar. Enables you to define Markers and perform Peak

searches.
Status Bar (see page 354) Shows or hides the Status bar.
xxx

Full Screen
Menu Bar: View > Full Screen

When unchecked, clicking Full Screen resizes the application window to fill the screen. Full Screen mode
maximizes the application window, and turns off the application title bar.

When checked, clicking Full Screen restores the application window to its previous size. The application
title bar is restored.
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Status Bar
The Status Bar displays information on specific instrument settings. It contains only status information; it
does not display any error information. The Status bar has no controls. It can be hidden.

Elements of the Status Bar

Area within Bar Description
Run Status Displays the running state. For example, some run states are Arm, Ready, Triggered,

Analyzing, or Stopped.
Status message area Displays status messages (for example, ADC Overrange). When there no status

messages to report, displays current acquisition parameters (for example, Acq Length:
22.320 us).

Acquisition mode Displays either Real Time or Swept. Indicates how the next acquisition will be acquired.
Trigger Settings Displays Trigger settings. For example, you will see Free Run, Power, Trig In (front),

Frequency Mask and others.
Frequency Reference Setting Indicates whether the internal or external reference source is selected. Displays Ref:

Int or Ref: Ext.
Internal Attenuator setting Displays the setting of the internal attenuator.
Preamp Setting If Option 01 is installed, this indicates whether the preamp is on or off. If the preamp is

on, displays Preamp: ON, 3 GHz max. as a reminder that the input frequency range is
restricted when using the preamp.

xxx

Run Status Indicators

Indicator Description
Acquiring The analyzer is capturing the signal.
Analyzing The analyzer has captured the signal and is processing the signal record.
Arm The trigger circuitry is filling the pretrigger portion of the signal record.
File Data The analyzer is analyzing recalled acquisition records.
Stopped If Stopped is displayed, Signal acquisition has been halted. This can occur because the

Run button has been pressed or because a trigger event has occurred, signal acquisition
has occurred and Run mode was set to Single.

Triggered If Triggered is displayed, the analyzer has recognized a valid trigger and is filling the
posttrigger portion of the signal record.

xxx

Showing or Hiding the Status Bar
Select View > Status to toggle the display of the Status bar.
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Run Menu
The Run menu provides access to commands that control the signal acquisition.

Command Description
Run (see page 315) If acquisition mode is Stopped, selecting Run begins a new measurement/acquisition

cycle. If acquisition mode is Run, pressing Run halts the current measurement/acquisition
cycle after it completes.

Resume Restarts data acquisition, but does not reset accumulated results, such as Average
or MaxHold. This allows you to stop acquisitions temporarily, then continue. If the
accumulation is already complete, for example, 10 acquisitions or 10 averages have
already been completed, each subsequent Resume command will cause one more
acquisition to be taken, and its results added to the accumulation. Resume is not
available if instrument settings have been changed.

Abort (see page 315) Immediately halts the current measurement/acquisition cycle.
Single Sequence (see
page 355)

Selects the single-sequence acquisition mode. This is only a mode selector; it does
not initiate an acquisition.

Continuous (see page 356) Selects the continuous acquisition mode. Selecting Continuous does initiate acquisitions.
xxx

Single Sequence Acquisition Mode
Menu Bar: Run > Single

Selecting Single sets the Run mode to Single. In Single mode, as soon as one acquisition sequence
completes, acquisition stops.

Note that a single acquisition sequence can require more than one acquisition. For example, in a spectrum
view, the trace function might be set to Average 100 acquisitions. Thus, a complete acquisition sequence
would consist of 100 acquisitions to produce 100 intermediate traces that are averaged together to create
the final trace that is displayed. Once the 100 acquisitions have been completed, acquisition stops.

This is only a mode selector, it does not initiate an acquisition.
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Continuous Acquisition Mode
Menu bar: Run > Continuous

Selecting Continuous places the analyzer in the Continuous acquisition mode. In Continuous mode, the
analyzer acquires and displays acquisitions repeatedly. The Continuous and Single Sequence acquisition
modes are mutually exclusive.

Selecting Continuous restarts acquisitions.
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Replay Menu
The Replay Menu (see page 357) allows you to rerun measurements using the data in acquisition memory
or a recalled TIQ file. You can use this to compute new results for old data after you change settings
or measurements.
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Markers Menu
The Markers menu provides to settings that define and control the location of markers.

Setting Description
Peak (see page 284) Moves the selected marker to the highest peak on the trace.
Next Peak > Moves the selected marker to next peak depending on the setting chosen.
Marker to Center Frequency Sets center frequency to the frequency of the selected marker.
Define Markers (see page 285) Displays the Define Marker control panel.
xxx
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Setup Menu
The Setup menu provides access to control panels that specify parameters for numerous spectrum analyzer
functions.

Command Description
Displays (see page 26) Displays the Displays control panel.
Settings (see page 378) Displays the Settings control panel for the selected display.
Trigger (see page 323) Displays the Trigger control panel.
Acquire Displays the Acquire control panel.
Analysis (see page 296) Displays the Analysis control panel.
Amplitude (see page 307) Displays the Amplitude control panel.
Configure In/Out (see
page 342)

Displays the Configure In/Out panel.

Preset (see page 359) Initiates the Preset.
Application Presets (see
page 352)

Displays the Application Presets window.

xxx

Preset
Menu Bar: Setup > Preset

Preset resets settings and clears all acquisition data. Settings and acquisition data that have not been saved
will be lost. Settings in the Config In/Out (see page 342) control panel are not reset by Preset.

After Preset resets the analyzer settings, it displays the Spectrum view.

Preset does not affect time or date settings; the Windows XP operating system settings, or Tools >
Alignments or Tools Options menu items.
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Tools Menu
Provides access to several utilities for controlling instrument functions.

Command Description
Search... (see page 290) Enables you to locate and highlight specified signal levels in Spectrum displays.
Alignments (see page 19) Displays the Alignments dialog box.
Diagnostics (see page 362) Displays the Diagnostics dialog box.
Install Upgrades... (see
page 362)

Used to activate upgrades you have purchased.

Options (see page 24) Displays the Options control panel.
xxx
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Alignments Dialog
Menu Bar: Tools > Alignments

The spectrum analyzer can adjust itself, optimizing the internal signal path used to acquire the signal you
measure. Alignment optimizes the spectrum analyzer to take more accurate measurements based on
the ambient temperature. The Alignments dialog enables you to specify when alignments occur, either
automatically or only when manually initiated.

Elements of the Alignments Dialog

Setting Description
Automatically align as needed Specifies that alignments run as ambient conditions require.
Run alignments only when
"Align Now button is pressed.

Specifies that alignments will never run unless manually initiated.

Align Now Use to manually initiate an alignment.
Abort Stops the alignment process.
Close Closes the Alignments dialog box.
xxx
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Diagnostics
Menu Bar: Tools > Diagnostics

The Diagnostics menu item displays the Diagnostics Tests window, which enables you to run variety of
tests to verify the operation of the spectrum analyzer. For detailed information on running diagnostics,
refer to the RSA6100A Series Real-Time Spectrum Analyzer Service Manual, Tektronix part number
077-0250-XX.

Install Upgrades
You can install upgrades on your instrument as your needs change. To install upgrades, you will need an
Option Installation Key. For information about available options or to make a purchase in North America,
call 1-800-833-9200. Worldwide, visit www.tektronix.com to find contacts in our area.

Full instructions on how to install your upgrade and activate the option with the Option Installation
Key are provided in the upgrade kit instructions.
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Arranging Displays
Use the Window menu to arrange how windows are displayed. Displays can be set to appear full screen
(one display at a time) or with all (selected) displays visible at once. When all displays are visible at
once, you can rearrange the displays by dragging the title bar of a window (deselect Window > Lock
Windows to move displays around).

Command Description
Close View Closes the selected view.
Cascade Positions windows in a cascade view (not available when Lock Windows is selected).
Tile Horizontally Positions widows in a horizontal orientation (top to bottom).
Tile Vertically Positions widows in a vertical orientation (side by side).
Lock Windows Locks the windows into their current position, preventing them from being moved. If the

windows are locked, the Cascade arrangement is not selectable.
(List of windows) A numbered list of open windows.
xxx
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Help Menu
The Help menu provides access to the online help and version information about the spectrum analyzer
hardware and software.

Command Description
Online Help Displays the online help.
Printable Online Help Displays a PDF version of the online help.
Quick Start Displays a PDF version of the RSA6100A Series Quick Start User Manual.
Apps Manual Displays a PDF version of the RSA6100A Series Applications Manual.
About Tektronix Real-Time
Spectrum Analyzer

Displays information about the spectrum analyzer model and installed options.

xxx
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Error and Information Messages
The following list describes some of the common error and information messages that might appear
during instrument operation. Messages that apply specifically to one or more measurements appear in the
displays. Messages that pertain globally, such as those about hardware status, are shown in the Status Bar
at the bottom of the analyzer application window.

Acq BW too small for current setup

The display needs a wider acquisition bandwidth than what the current data record contains. This can be
due to any of the following reasons:

The sampling parameters are being manually controlled.

In the Acquire control panel > Sampling Parameters tab, set the Adjust control to All Auto to allow the
software to pick the sample rate and record length that it needs.

A display other than the one you intended has been selected. The selected display has requested
a smaller acquisition bandwidth to achieve a better accuracy or dynamic range for its particular
measurement.

Select the display that contains the message. Click Run if the instrument is not already acquiring data.

Acquisitions are not running and the measurement now requests a wider bandwidth than the last
acquisition.

Click Run to perform a new acquisition with a wider bandwidth.

The data is from a recalled TIQ file.

There is no way to increase the acquisition bandwidth for saved IQ data. You must adjust the measurement
settings so that less bandwidth is required.

The current Frequency setting is different than that of the data record, causing the measurement
bandwidth to fall at least partly outside the bandwidth of the data.

Analysis failure: <description of error>

The instrument is unable to complete a measurement due to difficulty in characterizing the signal. For
example, due to either the signal or settings, the instrument may not be able to recognize a pulse so it
can compute the pulse measurements.

Try changing settings to improve analysis. For example, when Pulse Trace is displayed, try changing
the settings on the Settings > Params.

Analysis failure: Carrier detection failed

The instrument was unable to locate a carrier signal. Try adjusting the Carrier Threshold or Integration
BW values, if the measurement has these controls.

Analysis Length was limited
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This message appears if the "Results Length", the time over which the measurement computed its results,
is less than the Actual Analysis Length reported in the Analysis Time control panel tab and the Time
Overview display. The Results Length is indicated by the magenta line below the Time Overview graph.
This can occur because the acquisition contained more data samples than a measurement can process (for
example, digital demodulation is limited to 80,000 samples) or the measurement had to use some of the
first and last samples for pre-measurement processes.

Analysis length too small for current setup

Increase the Analysis Length or decrease the RBW (Spectrum, ACPR, MCPR).

Avg Tx not available in Volts units

The Average Transmitted Power measurement is not defined for Volts.

Cache file missing. Unable to create new cache file. Not enough free space (need XXX GB).
Remove unnecessary files, defragment the hard drive using a standard disk management utility,
then relaunch application.

The instrument is unable to create a required cache file. To resolve this issue, use a standard disk
management utility to defragment the hard disk. If this error persists, backup your data (including any
setup files you have saved), any applications and associated files you have installed and perform an OS
restore on the hard disk. After restoring the OS, reinstall the RSA6100A Series product software.

NOTE. The specific OS restore procedure required for your instrument depends on when your instrument
was manufactured. Go to www.tektronix.com/manuals and download the RSA6100A Series Service
Manual, Tektronix part number 077-0249-00 or later. Review the OS restore procedure in the manual to
determine the procedure appropriate to your instrument.

Can’t get acquisition data record

No acquisition record currently exists in memory (run an acquisition or recall a file), or an error has
occurred. Repeat the acquisition.

Can’t replay data from swept acq

The measurement could not produce results because it is a real-time only measurement but was asked to
reanalyze (Replay) an acquisition taken in swept mode.

Can’t replay. Live data needed for swept settings

The measurement could not produce results because it was asked to reanalyze (Replay) the acquisition but
it is in Swept acquisition mode. Swept-mode measurements cannot analyze recalled data.

CISPR accuracy limited by acq memory. Adjust RBW or freq range

The CISPR function was applied, but the available data did not represent a long enough time to satisfy
CISPR requirements. Increasing RBW reduces the amount of time needed for analysis. Reducing
frequency range (for example, by reducing Span), decreases sample rate, allowing the available memory
to cover a longer time period.

Data acquired during hardware failure
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An acquisition was completed even though a hardware failure was detected. This message refers to the
acquisition data currently being analyzed, but not necessarily to the current status of the instrument. See
the explanation for "Hardware Failure".

If this data is from a saved file, the error cannot be cleared.

Data acquired during RF ADC overrange

An acquisition was completed but the signal was outside the range of the analog-to-digital converter at the
time this data was acquired. This message refers to the acquisition data currently being analyzed, but not
necessarily to the current status of the instrument. See the explanation for "RF ADC overrange".

If this data is from a saved file, this error cannot be cleared.

Data acquired during RF digital gain overflow

This data was acquired when the input signal contained peaks greater than 6 dB above the Reference
Level setting.

See the definition for "RF digital gain overflow".

If the data is from a file, this error cannot be cleared.

Data acquired during warm-up

This data was acquired while the instrument was warming up. The warm-up period is 20 minutes. Until
this warm-up period is completed, the instrument is considered uncalibrated.

Data from unaligned instrument

The acquisition data was captured when the instrument was not aligned. This message refers to the
acquisition data currently being analyzed, but not necessarily to the current status of the instrument.
Measurements made on this data might not be accurate.

Data from uncalibrated instrument

The acquisition data was captured when the instrument was not calibrated. This message refers to the
acquisition data currently being analyzed, but not necessarily to the current status of the instrument.
See the definition for "Not calibrated".

If this data is from a file, the error cannot be cleared.

Data acquired with 3 GHz preamp

This is a warning that signals above 3 GHz are likely to be severely attenuated because the Preamp was on
when the data was acquired. The (optional) Preamp is not specified for operation above 3 GHz.

Disabled: data is from swept acquisition

The display needs to run in real-time mode. The display associated with this message cannot run now
because it is not the selected display, and the selected display is performing multiple acquisitions (it is
in swept mode).

Change the settings of the selected display so it is performing real-time acquisitions.

Select the associated display to make it the selected display. When it is selected, it will force the
acquisition parameters to change to meet its own needs.
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Disabled: Freq Mask Trigger in use

The DPX Spectrum display cannot run while the instrument is set to use Frequency Mask Trigger.

To run the DPX Spectrum display, you must turn off Frequency Mask Trigger.

DPX disabled: RefLev too low for Volts/Watts units

The Reference Level value is set too low. It is possible to set a RefLev value so low that DPX can’t run if
volts or watts are the selected amplitude units. Reset the Reference Level to a higher value.

Needs swept acq or larger AcqBW - Acquire data while display is selected

The display is not running because it needs to perform multiple acquisitions (it must be in swept mode) but
it is not the selected display. Only the selected display can perform multiple acquisitions.

Select the display showing this message to give it control of acquisitions parameters.

Sometimes, only one display can work and the others will be blank and show errors. This happens when
different displays have conflicting demands on the acquisition data record.

Dither: manual control

This is a reminder that the Dither control has been set to manual, which might affect the quality of
measurement results.

Export failure: file not saved

An error occurred while exporting Results. The file was not created.

Export the results again.

Export failure: unable to open results file for export. File not saved.

The Export Results file could not be opened for writing, so the export of results was not completed.

Verify that there is sufficient free space on hard disk.

External Frequency Reference signal not valid.

The instrument is no longer locked to the external reference signal because it can no longer detect a signal
with proper amplitude and frequency.

Verify that the external reference signal is still connected to the instrument.

Hardware failure detected by Diagnostics

A hardware failure was detected while running Diagnostics. To see a description of the event initiated
by the failure, display the Windows Event Viewer (see page 373). There is a shortcut to the Windows
Event Viewer on the Windows desktop.

Hardware failure - see Windows Event Viewer

A hardware failure has occurred. To see a description of the event initiated by the failure, display the
Windows Event Viewer (see page 373). There is an shortcut to the Windows Event Viewer on the
Windows desktop.

Insufficient data for CISPR. Acquire while display is selected
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This message appears when a measurement is not the selected measurement and CISPR filters are selected.
Set the measurement to be the selected measurement and reacquire the signal.

IQ Processing Error: 8012

This message occurs in GP Digital Modulation displays. The most likely cause for this message is that
there are not enough symbols to analyze. This can happen if

The Analysis Length is set too short. Increase the Analysis Length on the Analysis Time tab.

The Analysis Offset has pushed the Analysis Time so far out that the actual Analysis Length is too
short, even though the user-requested Analysis Length would have been long enough without the
excessive offset. Decrease the Analysis Offset on the Analysis Time tab.

The input signal is bursted, and the burst does not contain enough symbols.

Locking to ext freq ref signal...

This a status message displayed while the instrument is attempting to lock to an external reference signal.
The message disappears when the instrument locks to the reference signal.

Needs swept acq or larger Acq BW - Acquire data while display is selected

The display has one of two problems: It is not the selected display, which prevents it from controlling
the hardware acquisition parameters, and setting the acquisition mode to Swept; or its settings require a
wider data bandwidth.

Select the display that you are interested in and it will change the acquisition to meet its own needs.

Increase the acquisition bandwidth manually or by changing the selected display’s settings to cause
the wider bandwidth.

No Math trace: unmatched trace lengths

A math trace could not produced because the traces selected to generate the math trace do not have
the same number of points. This can easily happen if both traces are recalled, but were saved under
different “Points” settings. This can also occur if one of the selected traces is a live trace and the other
trace is a recalled trace.

In a Spectrum display, as long as one trace is live, you can change the “Points” setting (Setup >
Settings > Freq & Span tab) to match the recalled trace.

If you are using two recalled traces to generate the Math trace. You must recreate at least one of
the traces.

Not aligned

The instrument needs to be aligned. When the instrument is not aligned, measurements might not be
accurate.

Select Tools > Alignments > Align Now to alignment the instrument.

No burst detected

The Burst Detection Mode (see page 265) is On, but no burst was detected in the signal.

Check that the Threshold setting is properly set.
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Not calibrated

The instrument requires calibration. Calibration can be performed only at a Tektronix Service center.
Contact Tektronix ) to schedule a calibration.

Not enough samples for current setup

The measurement was not able to run because the combination of analysis length, offset, and measurement
bandwidth relative to acquisition bandwidth, were such that not enough samples were available for the
measurement to analyze. This can occur when two or more displays are shown and one display requires
a wide acquisition bandwidth and another display requires a much narrower bandwidth. The display
requiring the much narrower bandwidth must decimate and filter the acquisition record which can result in
too few samples left for the measurement.

Increase the Analysis Length to provide more samples.

Close any displays you don’t currently need.

Not enough samples – try increasing MeasBW

The measurement was not able to run because there are not enough samples available for the measurement
to analyze. The Settling Time measurement requires at least 256 samples. This can occur when two or
more displays are shown and one display requires a wide acquisition bandwidth and another display
requires a much narrower bandwidth. The display requiring the much narrower bandwidth must decimate
and filter the acquisition record which can result in too few samples left for the measurement.

Increase the Analysis Length to provide more samples.

Close any displays you don’t currently need.

No FFT (not all pulses have results)

If a pulse cannot be measured (because its shape is too indistinct or it does not meet the parameters that
define a pulse (see page 212)), its results will be “- -" for every measurement on that pulse. The instrument
cannot compute an FFT.

No pulses found

The instrument was unable to find any complete pulses in the signal.

Make sure the analysis length (see page 296) includes at least one complete pulse cycle, from before
one rising edge until after the next rising edge.

Pulse Detection Error

The instrument was unable to detect a pulse.

The pulse Measurement Filter (see page 212) needs to be smaller. Try reducing the bandwidth and/or
selecting the Gaussian filter.

Detection threshold is not set to the proper level for the signal. Adjust the Power threshold to detect
pulses (see page 212).

The pulse interval is too long for the current settings. Try decreasing the filter bandwidth (see
page 212), as this may reduce the number of data points to a manageable quantity.
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RBW conflict. Increase Span or Analysis Length

The measurement is not running because the actual RBW used by the measurement is too large for the
current acquisition span. Typically, the analysis length is too short as well.

Either increase the span or increase the Analysis Length.

RBW decreased

The current span or acquisition bandwidth is too small to allow a wider RBW filter.

Increase the span or acquisition bandwidth if the decreased RBW is not acceptable.

RBW increased

The current Spectrum Length (or Analysis Length if Spectrum Length is not Independent) is too small
to allow the requested RBW.

Increase the Spectrum Length (or Analysis Length) if the increased RBW is not acceptable.

RBW limited by AcqBW to: XX Hz

The requested RBW is too close to the acquisition BW. Increase the frequency range of the measurement
(for example, Span).

RBW too small/large for current Acq BW

If the RBW is set manually, it is possible for the acquisition bandwidth to be incompatible with the
RBW setting.

Change the RBW setting.

Adjust the Acq BW setting, either directly (Setup > Acquire > Sampling Params: select on of the
manual modes) or by adjusting the measurement bandwidth of the selected display (Setup > Acquire >
Sampling Params: All Auto).

Recall error: Setup not completely restored

An error occurred while recalling a Setup file. Thus, the current setup may be a combination of settings
from the Setup file and the previous Setup.

Recall the setup again.

Recall failure: problem with file or file contents

An error occurred while recalling a Setup, Trace or Data file. This can occur because of a problem opening
the file (operating system error) or because of a problem with the contents of the file.

Recall the file again.

Restoring acquisition data...

This is a status message displayed while data is being restored from a file.

RF ADC overrange

This input signal power is outside the range of the analog-to-digital converter circuitry.

Decrease the input signal power or increase the internal attenuation setting.
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Increase the Reference Level setting.

RF Attenuator: manual control

This message is just a reminder that the internal attenuator (see page 307) has been set to manual mode.

RF digital gain overflow

The input signal contains peaks greater than 6 dB above the Reference Level setting.

Increase Reference Level

Decrease input signal power

Save failure: file not saved

An error occurred while saving a Setup or Data file.

Save the file again.

Saving acquisition data...

This is a status message displayed while data is being saved to a file.

Selected VBW does not use full Spectrum Length

This message can occur when the Spectrum Length is greater than required for the VBW filter. If you
look at the Time Overview display, the Magenta line for Results Length indicates the part of the Spectrum
Length that was actually used. The measurement results are correct, but don’t include some of the data in
the selected Spectrum Length. To clear this message, you can set the Spectrum Length to Auto.

Setup error: <description of error>

When this message appears, it includes text that explains the problem. For example, the ACPR display
might show: “Setup error: channels can’t overlap”. Setup errors are the result of conflicts in instrument
settings. These types of errors occur when a user makes manual changes to settings. In the example
above, the channel settings in the Channel Power and ACPR display have been set so that the channels
overlap in frequency.

Adjust the instrument settings, or change a setting back to Auto, to eliminate the error.

Setup error: Integration BW exceeds Measurement BW

When this message appears, it includes text that explains the problem. Setup errors are the result of
conflicts in instrument settings. These types of errors occur when a user makes manual changes to settings.

Adjust the instrument settings, or change a setting back to Auto, to eliminate the error.

Setup error: Measurement time for Freq & Phase results

The Measurement time for Freq & Phase results (see page 214) specifies how far across the pulse top the
instrument should wait before measuring the Phase Difference and Frequency Difference for each pulse.
If this value is set too large for any of the pulses in the signal, the measurement point ends up on the
falling edge or during the pulse off time.

Decrease the Measurement time for Freq & Phase results setting (Settings > Define tab).

Swept: RF Trig invalid for most signals
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This is an status message that appears when the instrument is in swept acquisition mode and Power
Trigger mode at the same time. When the acquisition is swept, it captures the requested bandwidth using
multiple acquisitions, each for a different portion of the bandwidth. The trigger system evaluates each
of these separate acquisitions for trigger events, so unless a valid event exists in each of these smaller
frequency ranges, the acquisition will not complete.

Unexpected software error. Please cycle power and try again. If the problem persists, contact
your Tektronix Service Center.

An unrecoverable error has occurred, and the instrument application software will shut down.

Switch the instrument off and restart it or relaunch the RSA6100A application.

Unable to lock to External Frequency Reference.

The instrument is no longer locked to the external reference signal.

Verify that the external reference signal is still a valid signal.

Select External on the Frequency Reference tab in the Config In/Out control panel.

VBW not applied - Acq BW too small

Increase VBW or measurement bandwidth. Make sure Sampling Parameters are set to Auto.

VBW not applied - Spectrum Length too short

This message occurs when the requested VBW can’t be produced because the Spectrum Length is too short.

To clear this problem, set the Spectrum Length to Auto or manually increase the Spectrum Length (see
Setup > Analysis > Spectrum Time tab). If Spectrum Length is coupled to Analysis Length, set Analysis
Length to Auto or manually increase it (see Setup > Analysis > Analysis Time tab).

Displaying the Windows Event Viewer
When the analyzer generates an error message, information about the error is logged to the Windows
Event Viewer.

To display the Windows Event Viewer:

1. Select Start > Control Panels.

2. Select Administrative Tools. (If your instrument displays control panels in Category View, select
Performance and Maintenance and then select Administrative Tools.)

3. Double-click Event Viewer.

4. From the Event Viewer window, select Application. this displays a list of all errors that have been
reported to the operating system from applications.
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Errors reported to the Event Viewer from the analyzer application appear under Source as TekRSA.

5. Double-click the last error reported for TekRSA to see details on the most recently reported error.
Please note that many items reported as “errors” are simply informational and do not mean that your
instrument is impaired. Contact the Tektronix Customer Support Center or Service Center if you
are concerned about an error shown in the Event Viewer. Do not send an instrument out for repair
based solely on these event reports.
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On/Standby Switch
Use this button to power the instrument on or to shut down (set the instrument to standby).

Before shutting down, you should first exit the instrument application and any other active Windows
applications to avoid error messages on shutdown or the next power up.
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Are Available

How to Find Out If Instrument Software Upgrades Are Available
Software upgrades might be available from Tektronix. They can either be downloaded from the Tektronix
Web site or they can be ordered from your local Tektronix representative. To see if a software upgrade
is available for your instrument, use your browser to go to www.tektronix.com/software. Search by
the instrument model number.

To add additional software options or features, you will need an option key from Tektronix. When you
receive the software from Tektronix, install it on your instrument. When prompted, enter the option key,
and then follow the online instructions to complete the upgrade.
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Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The Settings menu item enables access to control panels that allow you to change settings for the selected
display. The control panel that appears when you select Settings depends on the selected display. The
Settings control panel for the Spectrum display is shown in the following figure.

The control panel for the CCDF display is shown in the following figure.

Settings Control Panels
ACPR Settings (see page 136)

Acquire

AM Settings (see page 110)

Amplitude Settings (see page 307)

Amplitude vs Time Settings (see page 90)

Analysis Settings (see page 296)

CCDF Settings (see page 168)

Channel Power and ACPR Settings (see page 136)

Configure In/Out Settings (see page 342)
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Constellation Settings (see page 226)

DPX Spectrum Settings (see page 61)

EVM vs Time Settings (see page 231)

Eye Diagram Settings (see page 234)

FM Settings (see page 118)

Frequency Deviation vs Time Settings (see page 237)

Frequency vs Time Settings (see page 93)

Magnitude Error Settings (see page 240)

MCPR Settings (see page 136)

Occupied Bandwidth Settings (see page 151)

Phase Error vs Time Settings (see page 243)

Phase Noise Settings (see page 174)

Phase vs Time Settings (see page 95)

PM Settings (see page 126)

Pulse Statistics Settings (see page 211)

Pulse Table Settings (see page 207)

Pulse Trace Settings (see page 209)

RF I Q vs Time Settings (see page 97)

Search (Limits Testing) Settings (see page 290)

Settling Time Settings (see page 190)

Signal Quality Settings (see page 249)

Spectrogram Settings (see page 85)

Spectrum Settings (see page 80)

Spurious Settings (see page 157)

Symbol Table Settings (see page 251)

Time Overview Settings (see page 74)

Trellis Diagram Settings (see page 254)
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Accuracy
The closeness of the indicated value to the true value.

ACLR
Adjacent Channel Leakage power Ratio is the ratio of the RRC (Root Raised Cosine) filtered mean power
centered on the assigned channel frequency to the RRC filtered mean power centered on an adjacent
frequency (defined in 3GPP).

ACPR Measurement
Adjacent Channel Power Ratio (ACPR) is the ratio of the mean power centered on the assigned channel
frequency to the mean power centered on an adjacent channel frequency. In the 3GPP specification, it
is called ACLR (Adjacent Channel Level Ratio) and both the main channel and adjacent channels are
required to be filtered with RRC (Root Raised Cosine) filters.

Acquisition
A series of time-contiguous frames. This is also called a Block.

Analysis Length
The length of time in the Analysis Time.

Analysis Time
The portion of the acquisition record over which one or more measurements are calculated.
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ASK
Acronym for Amplitude Shift Keying. The process, or result of a process, in which the amplitude of the
carrier is varied in accordance with the state of a digital input signal.

Block
An integer number of time-contiguous frames. See also: Acquisition.

Calibrator
A signal generator producing a specified output used for calibration purposes.

Carrier
The RF signal upon which modulation resides.

Carrier Frequency
The frequency of the CW component of the carrier signal.

Carrier Signal
The electrical signal, typically a sine wave, upon which modulation is impressed.

Carrier-to-Noise Ratio (C/N)
The ratio of carrier signal power to average noise power in a given bandwidth surrounding the carrier;
usually expressed in decibels.
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Function

CCDF - Complimentary Cumulative Distribution Function
The Complementary Cumulative Distribution Function (CCDF) represents the probability that the peak
power above average power of a measured signal exceeds a threshold.

CCDF is a plot of the percent of time that a signal’s power value exceeds it average value versus the
amount by which it exceeds the average. The CCDF plot has a log of probability on the Y-axis (100% at
the top) and dB above average amplitude on the X-axis (0 at the left).

CDMA
Acronym for Code Division Multiple Access.

Center Frequency
The frequency corresponding to the center of a frequency span of the analyzer display.

Check Mark Indicator
The check mark indicator in the upper-left corner of the display indicates the display for which the
acquisition hardware is optimized. When you have more than one display open, the display with the
check mark indicator has control over the acquisition hardware. To give a display priority over any
others, click its title bar.

CISPR
International special committee on radio interference. (Comité international spécial des perturbations
radioélectriques)

CW
Acronym for Continuous Wave.
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CW Signal
Continuous wave signal - a sine wave.

DANL
Acronym for Displayed Average Noise Level. See Sensitivity (see page 393).

dBfs
A unit to express power level in decibels referenced to full scale. Depending on the context, this is either
the full scale of the display screen or the full scale of the analog-to-digital converter (ADC).

dBm
A unit of expressed power level in decibels referenced to 1 milliwatt.

dBmV
A unit to express voltage levels in decibels referenced to 1 millivolt.

dBuV
A unit to express voltage levels in decibels referenced to 1 microvolt.

Decibel
Ten times the logarithm of the ratio of one electrical power to another.
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Detection
The process by which a long waveform is decimated (reduced) down to the desired number of trace points,
by dividing the waveform into intervals and choosing a single value to represent each interval in the trace.

Display Reference Level
A designated vertical position representing a specified input level. The level may be expressed in dBm,
volts, or any other units.

Distortion
Degradation of a signal, often a result of nonlinear operations, resulting in unwanted signal components.
Harmonic and intermodulation distortion are common types.

Dynamic Range
The maximum ratio of the levels of two signals simultaneously present at the input which can be measured
to a specified accuracy.

EVM
Acronym for Error Vector Magnitude.

Export
Save data to a file in a format other than application-native.

FastFrame
FastFrame segments the acquisition record into a series of frames and then captures acquisitions as single
frames. You can then view and measure each frame individually.

RSA6100A Series Real-Time Spectrum Analyzers Help 385



Glossary FFT

FFT
Fast Fourier Transform - a mathematical process to calculate the frequency spectrum of a discrete number
of time domain sample points.

Filter
A circuit that separates electrical signals or signal components based on their frequencies.

FM
Acronym for Frequency Modulation.

Frame
A series of time-contiguous samples, long enough in duration and at a sufficient sample rate to produce
a spectrum view of a specified span and RBW.

Frequency
A series of time-contiguous samples, long enough in duration and at a sufficient sample rate to produce
a spectrum view of a specified span and RBW.

Frequency Band
The continuous range of frequencies extending between two limiting frequencies, expressed in hertz.

Frequency Domain View
The representation of the power of the spectral components of a signal as a function frequency; the
spectrum of the signal.
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Frequency Drift
Gradual shift or change in displayed frequency over the specified time due to internal changes in the
analyzer, where other conditions remain constant. Expressed in hertz per second.

Frequency Mask Trigger
A flexible real-time trigger based on specific events that occur in the frequency domain.

Frequency Range
The range of frequencies over which the performance of the instrument is specified.

Frequency Span
A continuous range of frequencies extending between two frequency limits.

Frequency Settling Time
The time measured from a reference point to when the signal of interest settles to within user-defined
tolerance.

GPIB
Acronym for General Purpose Interface Bus, the common name for the communications interface system
defined in IEEE Std. 488.

Graticule
The calibrated grid overlaying the display screen of analyzers, oscilloscopes, and other test instruments.
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Grayed Out
An on-screen control is “Grayed Out” if it is not adjustable.

I/Q
Acronym for In-phase / Quadrature.

IF
Acronym for Intermediate Frequency.

Import
Bring data into the application from a file of some format other than application-native.

Impulse Response
The Impulse Response trace display shows normalized power on the vertical axis and time on the
horizontal axis.

Input Impedance
The impedance at the desired input terminal. Usually expressed in terms of VSWR, return loss, or other
related terms for low impedance devices and resistance-capacitance parameters for high impedance
devices.

LISN
Acronym for Line Impedance Stabilization Network.
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Local Oscillator (LO)
An oscillator which produces the internal signal that is mixed with an incoming signal to produce the IF
signal.

Marker
A visually identifiable point on a waveform trace, used to extract a readout of domain and range values
represented by that point.

Max Hold
Digitally stored display mode which, at each frequency address, compares the incoming signal level to
the stored level and retains the greater level. In this mode, the display indicates the peak level at each
frequency after several successive acquisitions.

MCPR (Multiple Carrier Power Ratio)
The ratio of the signal power in the reference channel or group of channel to the power in adjacent channels.

Min Hold
Digitally stored display mode which, at each frequency address, compares the incoming signal level to
the stored level and retains the lower level. In this mode, the display indicates the minimum level at
each frequency after several successive sweeps.

Modulate
To regulate or vary a characteristic of a signal, typically in order to transmit information.
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Modulating Signal
The signal which modulates a carrier. The signal which varies or regulates some characteristic of another
signal.

Modulation
The process of varying some characteristic of a signal with a second signal.

Noise
Unwanted random disturbances superimposed on a signal which tend to obscure it.

Noise Bandwidth (NBW)
The exact bandwidth of a filter that is used to calculate the absolute power in dBm/Hz.

Noise Floor
The noise intrinsic to a system that represents the minimum limit at which input signals can be observed;
ultimately limited by thermal noise (kTB). The analyzer noise floor appears as a “grassy” baseline in the
display, even when no signal is present.

Open (Recall)
Bring data into the application from a file of application-native format.

OQPSK
Acronym for Offset QPSK (Quadrature Phase Shift Keying).
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Phase Settling Time
The time measured from a reference point to when the signal of interest settles to within user-defined
tolerance.

PM
Acronym for Phase Modulation.

Primary Marker
The marker displayed in the Single Marker mode whose frequency and/or position is changed when
tuning with the general purpose knob.

PSK
Acronym for Phase Shift Keying. The process, or result of a process, in which the carrier phase is varied
discretely in accordance with a digital code.

QAM
Acronym for Quadrature Amplitude Modulation. The process, or result of a process, in which the amplitude
and phase of the carrier are varied concurrently by synthesizing two orthogonal ASK waves (see ASK).

Real-Time Analysis
Measurement technique based on triggering on an RF signal, seamlessly capturing it into memory, and
analyzing it in the frequency, time, and modulation domains.

Real-Time Bandwidth
The frequency span over which real-time seamless capture can be performed, which is a function of the
digitizer and the IF bandwidth of a Real-Time Spectrum Analyzer.
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Real-Time Seamless Capture
The ability to acquire and store an uninterrupted series of time domain samples that represent the behavior
of an RF signal over a long period of time.

Reference Level
The signal level represented by the uppermost graticule line of the analyzer display.

Residual FM (Incidental FM)
Short term displayed frequency instability or jitter due to instability in the analyzer local oscillators. Given
in terms of peak-to-peak frequency deviation and expressed in hertz or percent of the displayed frequency.

Residual Response
A spurious response in the absence of an input signal. (Noise and zero pip are excluded.)

RBW
The RBW determines how well the analyzer can resolve or separate two or more closely spaced signal
components.

Ripple
The Ripple measurement result is displayed in either Watts or Volts. The amplitude units selected on
the Setup > Analysis > Units tab determine whether the measurement is presented in Watts or Volts.
Volts are shown for linear units (for example, volts or amps); Watts are shown for non-linear units (for
example, watts or dBm).
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The Ripple measurement, in Watts, is calculated as follows:

Where:

DelPos = Delta Positive in Volts

RefPos = Reference Positive in Volts

DelNeg = Delta Negative in Volts (this is a positive value)

RefNeg = Reference Negative in Volts

The Ripple measurement, in Volts, is calculated as follows:

Where:

RatioPosV = DelPos/RefPos

RatioNegV = DelNeg/RefNeg

RTSA
Acronym for Real-Time Spectrum Analyzer.
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Secondary Marker
The “second” marker displayed only in the Delta Marker mode.

Sensitivity
Measure of a analyzer’s ability to display minimum level signals, usually expressed as displayed average
noise level (DANL (see page 383)).

Shape Factor (Skirt Selectivity)
The ratio of the frequency separation of the two (60 dB/3 dB) down points on the response curve to the
static resolution bandwidth.

Signal
As used in this online help, the signal refers to the input signal before it is processed. The signal is an input.

Span
Span is the range of frequencies displayed in a spectrum window. Span, start frequency and stop frequency
are related by the following equation: Span = (stop frequency) - (start frequency). The settings for center,
start and stop frequencies are related to the setting for span; when one parameter is changed, the others are
changed automatically.

Span Per Division (Span/Div)
Frequency difference represented by each major horizontal division of the graticule.

Spectrogram
Frequency vs. time vs. amplitude display where the frequency is represented on the x-axis and time on the
y-axis. The power level is indicated by variations in color.
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Spectrum
The frequency domain representation of a signal showing the power distribution of its spectral component
versus frequency.

Spectrum Analysis
The technique or process of determining the frequency content of an RF signal.

Spectrum Analyzer
A device for determining the frequency components of a signal.

Spectrum Time
Analysis Time for spectrum analysis views. Spectrum time can be the same as Analysis Time, but it
can be different.

Spur
A spur is a signal peak that exceeds a user-definable threshold (See Spurious > Settings > Ranges) and
excursion setting. A spur that also exceeds a limit (either Absolute or Relative) specified on the Settings
> Limits tab is considered a violation.

Spurious Response
A response to a analyzer wherein the displayed frequency is not related to the input frequency.

Time Measurement
This is the time in seconds relative to the time reference point in the first acquisition record in the data set.
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Glossary Time Reference

Time Reference
The point in time during the acquisition record used as the zero point for counting time. The time reference
can be set to either the start of the acquisition record or the trigger point.

Trace
As used in this online help, trace refers to the displayed signal. The displayed signal can be a processed
version of the input signal (for example, it may be averaged.) The trace is a result or output.

Vector Signal Analyzer
Like a spectrum analyzer, a device for determining the frequency components of a signal. However, unlike
a standard spectrum analyzer, the vector signal analyzer is optimized for analyzing digitally modulated
RF signals.

Vertical Scale Factor, Vertical Display Factor
The number of dB, volts, etc., represented by one vertical division of a spectrum analyzer display screen.

Violation
A violation is a spur that exceeds either an Absolute or Relative limit (depending on the selected mask)
specified on the Settings > Limits tab. A spur is a signal peak that exceeds a user-definable threshold (See
Spurious > Settings > Ranges) and excursion setting.
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Symbols and Numbers
-6dB RBW (MIL) Filter shape

Spectrum display BW
tab, 103

3-D Spectrogram display, 82

A
Abort acquisition, 316
About the RTSA, 342
Accessories, 5
accuracy, 381
ACLR, 381
ACLR measurement, 135
ACPR measurement, 381
acquisition, 381
acquisition data

saving, 334
Acquisition data files, 24
Acquisition Info tab, 303
Actions tab

Search, 296
Triggering, 333

Adjacent Channel Power
measurement, 136

Advanced Params Tab
GP Digital Modulation

displays, 263
Advanced tab

Triggering, 332
Alignments, 362

Align Now, 19
Auto button, 19
Off button, 19

–AM
AM display, 30

+AM
AM display, 30

AM display, 109
AM measurements, 30
Amplitude control panel, 308
Amplitude vs. Time display, 89
Amplitude vs. Time display

Settings, 90

Analog IF output, 346
Analysis control panel, 297
analysis length, 381
analysis time, 381
Analysis Time tab

GP Digital Modulation
displays, 266

Analysis Time tab (Analysis
control panel), 297

application presets, 20
saving, 334

Apply ampl corrections, 216
arranging windows, 364
ASK, 382
attenuator settings, 308
Audio Demod tab, 69
Auto button (Alignments

dialog), 19
automatically generate

filenames, 24
Automatically increment

filename/number, 24
Autosave acquisition on

Trigger, 332
Average Channel Power

measurement, 135
Average ON Power, 31
Average Transmitted Power, 31

B
black text

settling time
measurements, 184

Blackman-Harris 4B Filter Shape
Spectrum display BW

tab, 103
Blizzard color scheme, 25
block, 382
Blue background (cells), 153
Burst detect threshold, 119
BW Tab

Amplitude vs. Time
display, 91

Spectrum display, 103

C
C4FM modulation type

measurements, 30
C4FM signal quality

measurements, 249
calibration, 20

See also Alignments
calibrator, 382
carrier, 382
carrier frequency, 382
Carrier frequency detection, 119
Carrier Frequency Error, 30
carrier signal, 382
carrier-to-noise ratio (C/N), 382
CCDF - Complimentary

Cumulative Distribution
Function, 383

CCDF display, 167
CDMA, 383
center frequency, 383
Channel Power and ACPR

(Adjacent Channel Power
Ratio) display, 133

Channel Power and ACPR
Settings control panel, 136

Channel Power measure-
ment, 135

Channels tab
Channel Power & ACPR

display, 136
Channels tab (MCPR), 146
check mark indicator, 14
CISPR, 383
CISPR Filter shape

Spectrum display BW
tab, 103

Classic color scheme, 25
Colors tab, 25
Configure In/Out control

panel, 343
connecting signals, 344
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connecting trigger signals, 345
Constellation display, 226
Constellation display

settings, 227
Continuous Acquisition

Mode, 357
Correct for Noise Floor

Channel Power & ACPR
display, MCPR
display, 144

correction tables, 311
creating a mask, 320
creating application presets, 20
CW, 383
CW signal, 384

D
DANL, 384
Data file formats, 336
Data properties

File menu, 352
dBfs, 384
dBm, 384
dBmV, 384
dBuV, 384
decibel, 384
default settings, restore, 19
Define Markers, 286
Define Peaks tab, 286
Define tab, 291

Pulsed RF displays, 215
Settling Time displays, 190

Delay
Triggering, 332

Delta Markers, 286
Demod I&Q vs Time display

settings, 230
Density tab, 68
description

RSA6100A Series, 2
detect, 200

AM display, 112
DPX Spectrum display, 64
FM display, 120
General Signal Viewing

displays, 100
PM display, 128
Time Overview, 75

detection, 385
AM display, 112
DPX Spectrum display, 64
FM display, 120
General Signal Viewing

displays, 100
PM display, 128
Time Overview, 75

detector, 200
AM display, 112
DPX Spectrum display, 64
FM display, 120
General Signal Viewing

displays, 100
PM display, 128
Time Overview, 75

Deviation, 30
Diagnostics, 363
Digital I/Q output, 346
Digital Phosphor Spectrum, 57
display reference level, 385
Displays

arranging, 26
Frequency Settling Time, 182
interactions between, 26
Phase Settling Time, 182
selecting, 26

distortion, 385
documentation, 4
Dot Persistence, 61
DPX Density, 68
DPX Density Trigger, 319
DPX Spectrum

Bitmap Settings, 61
DPX Spectrum display, 57
DPX Spectrum settings, 61
Droop, 32
Droop dB, 32
Duty Factor (%) measurement, 31
Duty Factor (Ratio)

measurement, 31
Dwell Time, 98
dynamic range, 385

E
Elements of the display, 14
error message

Windows Event Viewer, 374

Error messages, 366
Event tab (Triggering), 324
Event Viewer, 374
EVM, 385
EVM vs. Time display, 231
EVM vs. Time Settings, 232
export, 385
External Gain value, 311
External Gain/Loss Correction

tab, 311
External Loss Tables, 311
External Probe Correction

tab, 315
external trigger

enabling, 345
external trigger signals

connecting, 345
Eye Diagram display settings, 235

F
Fall Time, 31
FastFrame, 385
FFT, 386
File formats, 336
File Menu, 349
filter, 386
Filter Parameter

GP Digital Modulation
displays, 257

Filter Shape
Spectrum display BW

tab, 103
Find tab

GP Digital Modulation
displays, 266

finding bursts in data
GP Digital Modulation

displays, 266
FlatTop (CW ampl) Filter Shape

Spectrum display BW
tab, 103

FM, 386
FM display, 116
FM measurements, 31
FMT (Frequency Mask

Trigger), 320
frame, 386
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Freq & BW Tab
GP Digital Modulation

displays, 262
Freq & Span tab

General Signal Viewing
displays, 98

Freq Deviation, 32
Freq Diff, Phase Diff setting, 217
Freq Error, 30
Freq Estimation tab

Pulsed RF displays, 221
Freq, Span & RBW tab

Channel Power & ACPR
display, MCPR
display, 143

RF Measurements
displays, 199

Freq-domain Linearity
setting, 215

frequency, 386
frequency band, 386
Frequency Deviation vs. Time

settings, 238
frequency domain view, 386
frequency drift, 387
Frequency Error, 28

GP Digital Modulation
displays, 262

Frequency Mask Trigger
(FMT), 324

Frequency Offset
GP Digital Modulation

displays, 262
frequency range, 387
frequency settling time, 387

measuring, 186
Frequency Settling Time

display, 182
Frequency Settling Time

settings, 189
frequency span, 387
Frequency tab, 299
Frequency tab (Phase Noise), 174
Frequency vs. Time display, 92
Frequency vs. Time Settings, 93
Front panel connectors, 8
Front panel controls, 8
Full Screen, 354

G
Gain Imbalance, 28
GPIB, 387
GPIB tab, 24
graticule, 387
Graticule On/Off

RF Measurements
displays, 204

grayed out, 388

H
Hanning Filter Shape

Spectrum display BW
tab, 103

Help Menu, 365
Hide sensitive readouts, 24
Hide Sensitive readouts, 24
Histogram readout

Pulsed RF displays, 223
Holdoff

Triggering, 332

I
I/Q, 388
IF, 388
import, 388
Impulse Response Amplitude, 32
Impulse Response setting, 216
Impulse Response Time, 32
Information messages, 366
input impedance, 388
Inside

Time Qualified tab, 331
Installed options, 6
Internal Attenuator

Internal Settings tab, 308
Internal attenuator (Internal

Settings tab), 308
Internal Preamp

Internal Settings tab, 309
Internal Settings tab, 308
IQ Origin Offset, 28
IQ output signals, 346
IQ vs. time view, 96
is greater than (search), 293
is inside mask, 291
is inside mask (search), 293

is less than (search), 293
is outside mask, 291
is outside mask (search), 293

K
Kaiser (RBW) Filter Shape

Spectrum display BW
tab, 103

Keep-out time, 216

L
Length, 30
Levels tab

Pulsed RF displays, 220
Limit lines, 291
Limits tab

Spurious display, 164
LISN, 388
local oscillator (LO), 389
Lock Center Frequency of

Spectrum displays, 299
Log (Horizontal)

Spectrum display, 81
Longer

Time Qualified tab, 331

M
Mag Error, 248
Magnitude Error vs. Time

display, 239
Magnitude Error vs. Time

settings, 241
manuals, 7
marker, 389
Marker Noise mode, 289
Marker Properties tab, 286
Marker to Center Frequency, 285
Markers, 288

Marker Toolbar, 288
Using Markers, 281
Using Markers in Noise

Mode, 289
Markers menu, 359
Mask Editor, 291
Mask tab

Settling Time displays, 193
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mask testing
settling time

measurement, 177
MATLAB file format, 336
Max Freq Error, 32
max hold, 389
Max number of pulses

Pulse Table display, 213
Max Number of Pulses

Params tab, 214
Max Phase Error, 32
Max total files saved per Run, 333
Max trace points, 89

Settling Time displays, 197
MCPR (multiple carrier power

ratio), 389
MCPR display, 139
MCPR settings, 142
Meas BW

Frequency Settling Time, 191
Meas Frequency

Frequency Settling Time, 190
Measurement Filter

GP Digital Modulation
displays, 257

Params tab, 213
Measurement Frequency, 299
Measurement Length

Time Params tab, 192
Measurement Params tab

Channel Power & ACPR
display, MCPR
display, 144

Measurement point, 217
Measurement settings export, 334
Measurements, 27
Measurements tab, 207
measuring settling time, 186
Menus, 348
MER (RMS), 248
min hold, 389
Min Settled Duration

Time Params tab, 192
modulate, 389
modulating signal, 390
modulation, 390
modulation measurements, 28

Modulation Params tab
GP Digital Modulation

displays, 257
modulation types supported, 258
Monitor attenuator use, 308
Monitor Attenuator Use

Internal Settings tab, 309
moving windows, 364
Multiple Carrier Power Ratio, 142

N
Network Connections, 18
nFSK modulation type

measurements, 30
nFSK signal quality

measurements, 248
noise, 390
noise bandwidth (NBW), 390
noise floor, 390
Noise markers, 289

O
OBW Level Left/Right, 149
OBW Ref Power, 149
Occupied Bandwidth, 151
Occupied Bandwidth

settings, 151
Occupied BW display, 149
Off button (Alignments

dialog), 19
Offset EVM, 248
On/Standby switch, 377
online help, 341
Open (Recall), 390
Optimization

Channel Power & ACPR
display, MCPR
display, 144

Options
installed, 6

Options control panel, 24
OQPSK, 390
OQPSK and SOQPSK modulation

type measurements, 29
Other Outputs tab, 343
Outside

Time Qualified tab, 331

Overlap, 84
Overshoot, 32
Overshoot dB, 32
Overshoot settings, 218

P
Parameters tab

AM display, 111
CCDF display, 169
FM display, 119
Occupied BW display, 152
Phase Noise display, 176
PM display, 126
Spurious display, 157

Params tab
Pulsed RF displays, 213

Pass/Fail searches, 292
Pause

Replay menu, 305
Peak Excursion, 286
Peak FSK err, 30
Peak Mag Err, 30
Peak Power, 31
Peak Threshold, 286
Phase Deviation, 32
Phase Error, 28
Phase Error vs. Time display, 242
Phase Error vs. Time settings, 244
Phase Noise display, 170
Phase Noise settings, 174
phase settling time, 391

measuring, 186
Phase Settling Time display, 182
Phase Settling Time settings, 185
Phase vs. Time display, 94
Phase vs. Time settings, 95
pictures

saving, 334
–Pk

FM display, 31
PM display, 31

+Pk
FM display, 31
PM display, 31

Pk-Pk
FM display, 31
PM display, 31
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Pk-Pk/2
FM display, 31

Play all selected records
Replay menu, 305

Play current record
Replay menu, 305

Play from selected
Replay menu, 305

PM, 391
PM measurements, 31
Position

Triggering, 332
power measurements, 27
Power Threshold to Detect Pulses

Params tab, 214
Prefs tab

AM display, 115
FM display, 123
General Signal Viewing

Displays, 106
GP Digital Modulation

displays, 270
PM display, 131
Pulsed RF displays, 223
RF Measurements

displays, 204
Settling Time displays, 197

Preset (File menu), 353
Preset (Settings menu), 360
presets

application, 20
primary marker, 391
Print, 352
Print Preview, 352
Probes, 345
Product Description, 2
PSK, 391
pulse measurements, 31
Pulse Statistics display, 210
Pulse Statistics display

settings, 212
Pulse Table display, 206
Pulse Table settings, 207
Pulse Trace display, 208
Pulse Trace display settings, 209
Pulse Width, 31
Pulse-Pulse Freq Difference, 32
Pulse-Pulse Phase Difference, 32

pulses
how many can be

analyzed, 214

Q
QAM, 391
Quadrature Error, 28

R
Range file, 336
Ranges Tab

Spurious display, 162
RBW, 392
real-time analysis, 391
real-time bandwidth, 391
real-time seamless capture, 392
rear panel connectors, 18
Red background (cells), 153
red text

settling time
measurements, 184

Ref level (Internal Settings
tab), 308

Reference Filter
GP Digital Modulation

displays, 257
Reference Level, 392
Reference tab

Spurious display, 159
Repeat, 316
Repetition Interval, 31
Repetition Rate, 31
Replay control panel, 303
Replay menu, 305
Replay Speed tab, 304
Replay toolbar, 306

Replay menu, 305
residual FM (incidental FM), 392
residual response, 392
results

saving, 334
Resume, 316
RF & IF Optimization

Internal Settings tab, 309
RF Channel Power

measurement, 135
RF I & Q vs. Time display, 96

RF I & Q vs. Time settings, 97
Rho ρ, 28
Rho &#x3c1;, 247
Ripple, 31
Ripple dB, 32
Ripple measurement

calculation, 392
Ripple settings, 218
Rise Time, 31
RMS

Detection, 200
FM display, 31
PM display, 31

RMS Error Magnitude, 30
RMS FSK Err, 30
RMS Mag Err, 30
RMS Phase Error, 32
RTPA2A, 345
RTSA, 393
Run, 316
Run menu, 356

S
Save acq data on Trigger, 333
Save and Export tab, 24
Save on trigger, 333
Save picture on Trigger, 333
saved file types, 334
saving

acquisition data, 334
application presets, 20
pictures, 334
results, 334
setups, 334

Saving and Recalling Data, 334
Scale tab

AM display, 114
DPX Spectrum display, 67
FM display, 122
General Signal Viewing

displays, 105
GP Digital Modulation

displays, 269
Phase Noise display, 130
Pulsed RF displays, 222
RF Measurements

displays, 203
Settling Time displays, 196
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Spectrogram display, 86
Spectrum display, 81

Search, 291
Search control panel, 296
Search For, 292
Search In, 292
search using a mask, 293
secondary marker, 394
Security tab, 24
Select all

Replay menu, 305
Select data records tab, 303
Select records from history

Replay menu, 305
sensitivity, 394
settings

Constellation display, 227
Demod I&Q vs Time

display, 230
DPX Spectrum, 61
EVM vs. Time display, 232
Eye Diagram display, 235
Frequency Deviation vs.

Time, 238
Frequency vs. Time, 93
Magnitude Error vs.

Time, 241
MCPR, 142
Occupied Bandwidth, 151
Options, 24
Phase Error vs. Time, 244
Phase Noise, 174
Phase vs. Time, 95
Pulse Statistics display, 212
Pulse Table display, 207
Pulse Trace display, 209
restoring defaults, 19
RF I & Q vs. Time, 97
Signal Quality, 250
Spectrogram display, 85
Spectrum display, 80
Spurious display, 157
Symbol Table display, 252
Time Overview display, 74
Trellis Diagram display, 255
Trigger, 324

Settings, 379
AM display, 110

CCDF display, 168
FM display, 118
Frequency Settling Time, 189
Phase Settling Time, 185

Settled Frequency
definition, 177

Settled Phase
definition, 177

settling time
measuring, 186

Settling Time, 177
definition, 177

Settling Time decimal places
Settling Time displays, 197

settling time measurement
text color, 184

Setup Menu, 360
setups

saving, 334
shape factor (skirt

selectivity), 394
Shorter

Time Qualified tab, 331
Show graticule

General Signal Viewing
Displays, 106

Pulsed RF displays, 223
Settling Time displays, 197

Show Marker Readout in Graph
General Signal Viewing

Displays, 106
Pulsed RF displays, 223
RF Measurements

displays, 204
Settling Time displays, 197

Show Parameter Readouts, 106
Show recalled trace, 99

AM display, 112
FM display, 120
PM display, 127
Time Overview display, 74

signal, 394
Signal Quality display, 245
Signal quality measurements, 247
Signal Quality settings, 250
Single, 356
span, 394
span per division, 394

Span/RBW Ratio
Spectrum display BW

tab, 103
spectrogram, 394
Spectrogram display, 82
Spectrogram display settings, 85
Spectrogram trace

Time Overview display, 74
spectrum, 395
spectrum analysis, 395
spectrum analyzer, 395
Spectrum Center Frequency, 299
Spectrum display, 78
Spectrum display settings, 80
Spectrum Monitor

Spectrogram, 87
spectrum time, 395
Spectrum Time tab, 299
Spectrums/line, 84
spur, 395
Spurious, 153
Spurious display settings, 157
spurious response, 395
Standard Settings button, 257
Status Bar, 355
Stop

Replay menu, 305
symbol maps, 271
Symbol Rate, 30
Symbol Rate Error, 30
Symbol Table display, 251
Symbol Table display

settings, 252

T
Target Reference

Frequency Settling Time, 191
Thunderstorm color scheme, 25
Time, 32
Time & Freq Scale tab

Spectrogram display, 86
Time 1 / Time 2

Time Qualified tab, 331
Time measurement, 395
Time Overview, 72
Time Overview display

settings, 74
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Time Params tab
Settling Time displays, 192

Time Qualified tab, 331
time reference, 396
time scale status readout, 84
TIQ acquisition data files, 24
TIQ acquisition data files

parameters, 24
Tolerance (+/-)

Frequency Settling Time, 191
Tools Menu, 361
Total AM

AM display, 30
Touch Screen, 11
Touch Screen Off, 8
Touch-screen Actions, 11
trace, 396
Trace tab

AM display, 112
FM display, 120
GP Digital Modulation

displays, 268
PM display, 127
Settling Time displays, 193
Time Overview display, 74

Traces tab
DPX Spectrum Bitmap, 61
DPX Spectrum display, 63
General Signal Viewing

displays, 99

RF Measurements
display, 200

Spectrogram display, 85
Traces tab – Math Trace

General Signal Viewing
displays, 103

Transform Window
Spectrum display BW

tab, 103
Trellis Diagram display

settings, 255
Trigger On This, 319
Trigger settings, 324

Advanced tab, 332
Event tab, 324

trigger signals
connecting, 345

triggering
frequency mask trigger, 317

troubleshooting, 363

U
Uniform (None) Filter Shape

Spectrum display BW
tab, 103

Units tab, 302
Upgrades, 363
User Filters

file format, 277

loading, 277
User Symbol Map, 264

V
VBW, 82

Channel Power & ACPR
display, MCPR
display, 143

RF Measurements
displays, 199

Spectrum display BW
tab, 103

vector signal analyzer, 396
vertical scale factor, vertical

display factor, 396
View Menu, 354
violation, 396
violation (frequency mask

trigger), 328

W
watch icon, 331
Window menu, 364
Windows Event Viewer, 374

X
x dB BW Ref Power, 149
x dB Level, 152
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